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1 Introduction 

1.1 Documentation Contents 
This documentation covers the following topics: 

 What is New in ThinManager 6.0?  
 A Quick Start Checklist  
 Standard ThinManager Installation  

 ThinManager Licensing  

 Redundancy  

 The ThinManager Interface  

 The Menu items  

 Adding thin client hardware  

 Configuration Wizards  

 The Terminal Configuration Wizard  

 The PXE Server Configuration Wizard  

 Display Servers 

 Display Clients (formerly Terminal Server Groups and Application Groups) 

 Failover and Instant Failover  

 Modules  

 Citrix ICA 

 Hotkeys 

 MultiMonitor  

 Reports  

 WinTMC  

 Shadowing  

 ThinManager Security  

 TermSecure  

 TermMon ActiveX Control  

 A ThinManager Troubleshooting Guide to aid in deployment  
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1.2 ACP ThinManager 6.0 
ThinManager is a server-side configuration, management, and hardware enabling software for Terminal 
Services based thin client systems.  

ThinManager is a software program that allows thin clients to boot, receive a configuration, and connect 
to a terminal server. ThinManager provides terminal configuration, session management, and session 
status monitoring. ACP ThinManager provides quick replacement of terminals and an almost seamless 
switch from terminal server to terminal server in case of terminal server failure. 

A thin client is a device that connects to a server, logs onto a separate independent session, and runs its 
applications on the server and not locally on the thin client. Thin Clients first connect to a ThinManager 
Server where it receives its configuration. This configuration sends the terminal to a terminal server where 
it logs in. 

Note: The terms Thin Client and Terminal are used interchangeably in this document. 

The keystrokes and mouse movements from the thin client are sent to the terminal server. The terminal 
server session determines the response and sends the screen display back to the terminal. This 
simplifies maintenance and management by eliminating the need to install and configure operating 
systems and applications on the thin client. All configuration, management, installation and applications 
are on the server, not the thin client. 

Note: All trademarks, service marks, and copyrights belong to their respective companies. 

Microsoft, Windows, Windows XP, Windows 2000, Windows 2000 Server, Windows 2003, Windows 
2003, Server Windows 2008, and Windows 2008 Server are trademarks of the Microsoft Corporation, 
Redmond, Washington. 

Citrix, ICA, and Citrix Device Services are trademarks of Citrix Systems, Fort Lauderdale, Florida.  

ESX and vCenter is a trademark of the VMware Company, Palo Alto, California. 

ACP, ACP Enabled, AppLink, MultiSession, MultiMonitor, SmartSession, SessionTiling, 
TermSecure, ThinManager, ThinManager Ready, and ThinServer, are trademarks of Automation 
Control Products, Atlanta, Georgia. 
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1.3 What is New in ThinManager 6.0? 
New – Firmware Packages 

ThinManager 6.0 introduces the deployment of the firmware and modules as a package. Different 
versions of the package can be assigned to individual modules. This allows legacy hardware to keep a 
version that works for it while new hardware can use newer package versions to take advantage of new 
features. 

See Packages for details. 

New – Menu Items 

ThinManager 6.0 includes new menu items to support the use of Firmware Packages. These include 
Manage>Packages, Install>Firmware Packages, Install>Boot Loader, and Install>Chain Loader. 

New – Terminal Description Field 

ThinManager 6.0 adds a Description field to the Terminal Configuration so that additional info can be 
assigned to a terminal.  

See Terminal Description for details. 

New – USB to VGA MultiMonitor Support 

ThinManager 6.0 supports a USB to VGA converter to turn single monitor thin clients into MultiMonitor 
thin clients. 

See www.thinmanager.com for details. 

New – iTMC iPad  

ThinManager 6.0 supports the new ThinManager iPad client. This will turn an iPad into a mobile terminal 
complete with Display Client application deployment, MultiSession, and Failover. 

See www.thinmanager.com for details. 

New – Subscription Licensing 

ThinManager 6.0 introduces subscription based licensing. 

See www.thinmanager.com for details. 

New – Web ThinManager Access  

Screentronix provides a secure VPN that allows you to connect to a ThinManager Server from a remote 
browser to aid in management. 

See Web Management for details. 

New – Block Mouse Button Functions 

The Mouse Configuration Module has the ability to lock down the mouse buttons, scroll buttons, and 
scroll wheel. 

See Mouse Configuration Module for details. 
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1.4 Evolution of ThinManager Terminology 
ThinManager has evolved over the years leading to changes in terminology and function. 

1.4.1 Essential ThinManager Functionality 
The booting of a thin client is a two-step process: 

 The thin client connects to ThinManager to receive its configuration. 

 This configuration sends the thin client to a terminal server to login and run a session. 

The ThinManager may be on the same physical computer as the terminal server or it may be on a 
different computer. 

1.4.2 The Client/Server Relationship in Terminal Services 
This is how the client/server relationship works in terminal services: 

 The client (fat or thin) connects to a terminal server, logs on, and starts a session. 

 The client sends mouse and keystrokes to the terminal server for processing. 

 The terminal server processes the input, generates the corresponding graphics, and sends 
the graphics calls to the client for display. 

 The client displays the graphics locally for the user. 

1.4.3 Hardware Configuration Tool 
Early versions of ThinManager functioned as a tool for configuring the thin client hardware. 
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ThinManager 2.3.1 Interface 

The status of the terminal was limited to indicating if a terminal was on or off by use of green or red colors 
on the terminal icons. 

1.4.4 Wizards 
Configuration wizards were added in ThinManager 2.4. 

 

ThinManager 2.4 Interface 

The tree was expanded to show what terminal servers the terminals were assigned to. Green and red 
lightning bolts indicated whether a terminal had an active connection to the terminal server. 
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1.4.5 Terminal Server Groups 
ThinManager 2.5 introduced Terminal Server Groups. These were collections of terminal servers that a 
terminal could connect to and run a session on.  

 

ThinManager 2.5 Interface 

The use of Terminal Server Groups increased the power of ThinManager through AppLink and 
MultiSession. 

AppLink is the deployment of specific applications and MultiSession is the ability to run multiple sessions 
on a terminal at the same time. In the example Terminal2 is using MultiSession to run two AppLink apps 
(HMI and Reports). 
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1.4.6 Application Groups 
Terminal Server Groups were renamed Application Groups in ThinManager 3.2.  

 

ThinManager3.2 Interface 

Terminal Server Groups didn’t describe Terminal-to-Terminal shadowing accurately because that function 
isn’t coming from the terminal server but is coming from the shadowed terminal. 
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1.4.7 Display Servers and Display Clients 
ThinManager 4.0 added IP cameras, an additional source to display on the ThinManager Ready thin 
client leading to a major change in terminology. 

 

ThinManager 4.0 Interface 

Important Definitions: 
A server is defined as device, computer, or application that provides applications, files, or data for use by 
other computers.  
A client is defined as device, computer, or application that requests data, resources, or services from a 
server or software program that shares data with the server. 

Display Servers – ThinManager 4 uses Display Servers to denote devices that provide content that can 
be displayed on the client. Examples include the traditional terminal server and IP cameras. 

Display Clients - ThinManager 4 uses Display Clients to denote the graphic rendering of the output from 
a Display Server. This could be a traditional Terminal Server session, IP Camera display, or a Terminal-
to-Terminal Shadow session.  
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ThinManager 4.1 Interface 

ThinManager 4.1 added the Workstation Display Client to allow a workstation desktop to be ported to a 
terminal. This could be an XP, Vista, or Windows 7 workstation and could be a virtual or physical device. 
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2 System Overview 

2.1 Quick Start Checklist 

Microsoft 

 Build a terminal server with the Microsoft Windows 2003 or 2008 Server operating system. Add 
the Terminal Services/Remote Desktop Services Role. See Non-ThinManager Components.  

 Create a Microsoft Licensing Server and add a TS/RDS CAL (Terminal Server/Remote Desktop 
Services Client Access License) for each thin client. They also require a normal CAL. See 
Microsoft Licenses. 

 Create a Microsoft user profile for each terminal on the terminal server. Make sure that the user is 
a member of the Remote Desktop Users Windows group. See Creating Microsoft User Profiles. 

 Apply appropriate security to each user profile using the standard Microsoft techniques. 

ThinManager 

 Install ACP ThinManager software onto a computer to create a ThinManager Server. See 
Installation of ThinManager. 

 Create a Master ACP License and add enough Product Licenses for each thin client. Activate and 
apply to the TMS See Adding a Master License to ThinManager. 

Hardware 

 Establish the IP addressing scheme for the thin clients, Static IP or DHCP. See IP Address 
Assignment. 

 If using DHCP, configure Option 066 to list the IP address of the ThinManager Server. See 
DHCP. 

 Attach the terminals to ThinManager by either: 

o Turning on the terminal and selecting the "Create New Terminal" option when the offline 
terminals are listed. 

o Pre-creating the terminals in ThinManager and selecting the proper terminal name when 
the terminal is turned on and offline terminals are listed. 

Results 

 Step 1: The clients will connect to the ThinManager Server and download the firmware and 
configuration.  

 Step 2: The configuration will send them to the terminal server to login and start a session. 
 

Note: It is a good idea to schedule an automatic backup of your configuration. See Scheduling for details. 
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2.2 Required Components  
 

Thin Clients require a number of components to function properly. These include: 

 Terminal Services from Microsoft (renamed Remote Desktop Services in Windows 2008 R2) 

 Client Communication Protocol, either Microsoft RDP or Citrix ICA 

 ACP ThinManager software 

 ThinManager Ready or PXE Compatible Thin Client Hardware 

 Standard TCP/IP network infrastructure 

2.2.1 Windows Terminal Server Operating System 
The first component is the Terminal Server. This is a computer with a version of Microsoft's Windows 
2003 or 2008 Server that has the Terminal Services functionality activated. The operating system allows 
multiple users to log into the server and run independent, isolated sessions. The operating system 
controls the server, provides security, controls user access, and runs the applications.   

The terminal servers need a Microsoft Terminal Services Licensing Server  with Terminal 
Services/Remote Desktop Services Client Access Licenses (TS/RDS CALs) added. 

See Microsoft Licenses for details. 

2.2.2 Client Communication Protocol 
The second component is the Client Communication Protocol. The Client Communication Protocol is 
the protocol used for client-to-server communications in the Terminal Services Environment. The protocol 
handles all video, information, and user input such as keyboard and mouse input. This can be either the 
default RDP protocol that is installed by default with any Windows Terminal Server operating systems or 
an ICA protocol available separately from Citrix. 

The RDP (Remote Desktop Protocol) is the Client-Communication Protocol that is included with 
Microsoft Terminal Services and can be used by Thin Clients to connect to Windows 2000/2003/2008 
Terminal Servers. The RDP connection to a Windows 2000 Terminal Server is limited to a 256-color 
depth (8-bit) while the Windows 2003/2008 Server connection can be made at a higher color depth. 

The ICA (Independent Computer Architecture) Protocol is available by installing and licensing a Citrix 
component on the Terminal Servers.  

2.2.3 ThinManager Administrative Software 
The third component is ACP ThinManager software from Automation Control Products. ThinManager is 
used to configure, manage, and control the ThinManager thin clients. Although ThinManager is treated as 
a single entity, it really has two main components, the ThinManager interface and the ThinServer service.  

 ThinServer is a service that is the engine of the program. It starts automatically, runs in the 
background, and provides essential functions to control the thin clients. ThinServer is installed 
during ThinManager installation if selected.  

 ThinManager is the administrative software that facilitates the configuration and organization of 
the thin clients. This is the visible component of the ThinManager software. ThinManager displays 
information generated by ThinServer. ThinManager can be installed on any computer on the 
network, including the terminal server.  
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Note: ThinManager Server is used to describe a computer running ThinManager and ThinServer that 
provides control and configuration to Thin Clients, even if the computer is a workstation. 

One instance of ThinManager can provide client connection to several terminal servers. The thin clients 
would boot from the ThinManager server but could be assigned to any of several terminal servers.  

2.2.4 ThinManager Ready Thin Client Hardware 
ACP ThinManager is designed to control and configure ACP Enabled Thin clients. These are 
ThinManager Ready thin clients produced by a variety of manufacturing partners and displaying the 
ThinManager Ready sticker. These devices have a ThinManager BIOS on board that allow them to 
connect to a ThinManager Server and operate as thin clients without a hard drive or embedded operating 
system. 

              

ThinManager Ready Logos 

ThinManager Enabled thin clients should display a ThinManager Ready Logo. The ACP website 
(www.thinmanager.com) has links to the ACP Partners. 

2.2.5 ThinManager Compatible Thin Client Hardware 
ThinManager 5.0 introduced a PXE Server (Preboot Execution Environment) to the ThinManager System. 
The PXE server has the ability to take generic off-the-shelf devices and have them boot the ThinManager 
firmware to become full functioning ThinManager thin clients. These are called ThinManager Compatible 
thin clients. 

ThinManager Compatible thin clients do not have a distinguishing logo. See the list of tested and 
compatible thin clients at http://www.thinmanager.com/complist/index.php.  
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2.3 Connection Overview 
When a terminal is powered on: 

 For ThinManager Ready thin clients: 

 An IP address is requested from a DHCP server by default. The DHCP server needs to 
have Option 066 set to the ThinManager Server IP address and Option 067 set to 
firmware.acp to specify a ThinManager Server IP address. Units with the ACP 
BootLoader 5.01 and later can use DHCP and have the ThinManager Server statically 
assigned on the unit. 
See DHCP Server Setup and Boot Process for details. 

 Alternately, the terminal may be assigned a static IP address and the ThinManager 
Server IP address.  

 For ThinManager Compatible PXE thin clients: 

 PXE clients must use DHCP.  
ThinManager Compatible thin clients make a DHCP request for an IP address and make 
a PXE request for a PXE server and boot file. These can come from a DHCP server or 
ThinManager depending on system configuration. 
See PXE Server Configuration Wizard for details. 

 The terminal connects to the ThinManager Server to download its configuration. 

 The ThinManager configuration will tell the terminal which terminal server to connect and login to. 

 The terminal will connect to that terminal server and display the Windows login dialog box or will 
automatically login with help from the ThinManager configuration. 

 The terminal will create a session on the terminal server, allowing applications to run. 

The Thin client can be assigned to a single terminal server, or it can be assigned to multiple terminal 
servers in case of terminal server failure. Display Clients are groups of terminal servers that have added 
functionality for the thin client. 

2.4 Failover Overview 
Server failures in any network or system can disrupt productivity and data management. ACP 
ThinManager, version 2.3 and later, has a failover capability built into it that allows terminals to connect to 
a secondary terminal server if the terminal server that they are logged into fails. This will lessen the effect 
of server failures on the terminal server network. The terminals can detect the server crash, drop the 
connection to it, and connect to a secondary server in seconds.  

To initiate ACP ThinManager Failover protection, four steps are needed: 

 Multiple Servers: The first step is to have multiple terminal servers, with appropriate 
applications and licenses installed. 

 Terminal Server Addressing In ThinManager: When configuring the display clients to use 
individual terminal servers, list the terminal servers, in the order of preferred connection, in 
ThinManager. Upon boot, each terminal will try to connect to the first server in the list (the 
primary server). If it is not available, it will try the next on the list (a secondary server) until a 
connection is made. 
 When using a SmartSession Display Client the terminal will connect to the terminal server 
with the lightest load. 



 

24    System Overview ACP ThinManager 6.0 

 Sufficient Memory: The third step is to have sufficient memory capacity on the servers to 
accommodate the addition of terminals during failover. If you do not plan for the extra 
capacity, the servers can be taxed with the addition of the new terminals. 

 User Permissions: Each terminal server needs the appropriate Windows 2003/2008 user 
profiles and permissions. The terminals will not log into a secondary session unless it has a 
user profile on that server. 

ACP ThinManager allows the use of several terminal servers, defined as the primary and as backups. If 
the primary terminal server fails, the thin client will detect the server failure and will initiate a new session 
on a backup server. This allows the operator to continue their work and minimize the effect of a server 
failure. 

 

Failover Configured for Display Clients in the Display Client Wizard 

Failover when using Display Clients is configured in the Display Client Wizard by adding multiple terminal 
servers to the Display Client. See Display Client List for details. 

Instant Failover is an advanced configuration of failover. The terminal will log into two terminal servers 
and start a session on each one. The primary session will be displayed, with the secondary session 
cascaded behind it. If the primary terminal server fails, the terminal will switch focus to the already 
initiated secondary session and display the secondary session, saving the time needed to switch terminal 
servers and load applications. 

See Instant Failover for further details. 
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2.5 MultiSession Overview 
MultiSession is the ability for a Terminal to display several Display Clients at one time. Normally the 
Display Clients are cascaded with only one active at a time. Tiling allows a thumbnail of each Display 
Client to be displayed at the same time. 

 

Display Client Selection Page of Terminal Configuration Wizard 

MultiSession is initiated by adding multiple Display Clients on the Display Client Selection page of the 
Terminal Configuration Wizard. 

See SessionTiling Options for details. 

2.6 MultiMonitor Overview 
MultiMonitor is the ability of some thin clients to use up to five monitors on the thin client. These monitors 
can be used to display single screen Display Clients or the monitors can be merged to form spanned 
windows of two or more monitors. 

The MultiMonitor function can be applied to the WinTMC client running on a Windows PC with multiple 
monitors. 

Note: MultiMonitor requires the usage of Display Clients instead of using individual terminal servers.  
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See MultiMonitor for more details. 

2.7 TermSecure Overview 
TermSecure is a new ThinManager feature that allows users to logon to a thin client and access user-
specific or terminal-specific Display Client. This does not replace the Windows logon but adds an 
additional layer of security and control.  

Terminals and Display Clients can be assigned Access Group permissions. A TermSecure User can use 
those terminals and Display Clients only if the TermSecure User has been assigned to the same Access 
Group Display Clients 

TermSecure has two main attributes: 

 SecureAccess: Manages user access to terminal servers and sessions through ThinManager 
authentication and group permissions. 

 SmartContext: Allows the movement of the display of a TermSecure User’s terminal server 
sessions between multiple thin clients; initiated by either manual login or the use of an 
authentication device. This allows a user to leave one terminal, logon to a different terminal, and 
reconnect to their session, essentially having the session follow him from terminal to terminal. 

TermSecure logins can be initiated by a manual login or by the use of an ID device like USB drives or 
ProxCards for login. 

See TermSecure User Configuration Wizard for details. 

Note: TermSecure requires the usage of Display Clients instead of using individual terminal servers.  

2.8 PXE Boot Overview 
PXE (Preboot Execution Environment; sometimes pronounced "pixie") is an environment that allows a 
computer to boot over a network. ThinManager provides a complete PXE boot environment that does not 
require any additional software components. The ThinManager PXE Server conforms to version 2.1 of the 
Intel PXE boot specification. 

The Thin Client computer must be capable of PXE Booting. Most standard BIOS ROMS include a PXE 
Option ROM. In order to PXE boot, the PXE Option ROM must be enabled in the BIOS. The PXE boot 
method (boot from network) should be set to first in the boot order. Disabling the other boot devices in the 
BIOS will ensure that the unit will only boot via PXE. 

See PXE Server Configuration for more details. 
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3 Installation of ThinManager  

3.1 Standard ThinManager Installation 

3.1.1 Windows Server 2003  

Note: The installation of the latest Microsoft .NET Framework may require a restart. 

ThinManager can be installed on a Windows server or a workstation (NT 4.0 SP5 and later). On Microsoft 
Windows 2003/ 2008 Servers, software needs to be added in the Install Mode through the Control 
Panel > Add/Remove Programs. Failure to use the Install Mode can prevent an application from working 
properly. 

Select Start > Settings > Control Panel > Add/Remove Programs to open the Add/Remove 
Programs dialog box.  



 

28    Installation of ThinManager ACP ThinManager 6.0 

 

Add/Remove Programs 

Select the CD or Floppy button on the Add/Remove Programs Properties dialog box to open the 
Installation wizard. The wizard will prompt for the insertion of the ThinManager CD. When the CD is 
inserted, the wizard will ask for the path to the setup program.  
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Install CD File System 

The ThinManager CD has 4 folders.  

 Documentation – This folder contains a copy of this documentation in *.pdf format. 

 Terminal ActiveX – This folder contains the Terminal Monitor ActiveX and companion 
documentation. See TermMon ActiveX Control for details. 

 ThinManager– This folder contains the ThinManager setup program. 

 WinTMC – This folder contains the WinTMC setup program. See WinTMC Installation for 
details. 

Browse to the setup.exe file in the ThinManager folder to install ThinManager. 



 

30    Installation of ThinManager ACP ThinManager 6.0 

 

Run Installation Program Window 

Once the ThinManager setup program is selected, select Next to continue the installation. 
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ThinManager Setup Wizard 

The ThinManager Setup Wizard will lead the user through the installation process. 

Select Next to continue. 
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End-User Licensing Agreement 

Read the End-User Licensing Agreement (EULA). If you agree to the conditions, select Yes to continue. 
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Application Selection 

The installation wizard will display the components of the ThinManager installation. Although 
ThinManager appears to be a seamless program, it has two major components and utilities. 

 ThinManager is the graphic user interface. It is installed to view and control the program.  

 ThinServer is the engine that drives the program. It is a vital component that needs to be 
installed with ThinManager to allow thin clients to boot and be configured. ThinServer is the 
component that requires licensing. It is separated from ThinManager in the installation to 
allow additional instances of ThinManager to be installed for remote administration.  

 ThinManager Utilities includes tools like the touch screen calibration program. These 
utilities need to be installed on every terminal server that have clients with touch screens 
connected to them. 

Note: If touch screens are being used with thin clients, the ThinManager Utilities program needs 
installed on every terminal server to provide the Calibrate Touch program for connected thin clients. 

The Browse button will allow the user to change the path to the folder where ThinManager will be 
installed. 

Check the desired components and select Next.  
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Installation Wizard Completion 

When the wizard has finished select the Finish button. 
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After Installation Dialog 

After the ThinManager Setup wizard has finished, one needs to complete the installation through the 
Microsoft dialog boxes. 

Select Next to continue. 

 

Finish Installation 

Select Finish to complete the installation. 

ThinManager now needs licenses installed. See Licensing ThinManager for details. 
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3.1.2 Windows Server 2008 

Note: The installation of the latest Microsoft .NET Framework may require a restart. 

It is a common practice to install ThinManager on a terminal server but ThinManager is independent of 
terminal services and doesn’t need to be installed on a terminal server.  

Applications on terminal servers need to be installed in the Install Mode. Open the Control Panel and 
click on the Install Application on Terminal Server icon to start the installation wizard. 

 

Figure 1 - Install Application on Terminal Server Icon 

Once the wizard begins navigate to the ThinManager setup.exe program and continue with the 
wizard as described in Licensing ThinManager. ThinManager will install a 32-bit version on 32-bit 
operating systems and a 64-bit version on 64-bit operating systems. 

The Install Mode can also be entered by typing change user /install at a command prompt. 
You can then run the setup.exe to install ThinManager. 

Type change user /execute when finished installing to leave the Install Mode. 

See Allow Inbound Traffic to Firewall for details on configuring the 2008 server to allow connections. 

 

3.2 WinTMC Installation 
The WinTMC program is a terminal client that is installed on a PC. When the WinTMC client is run it 
connects to a ThinManager Server, receives its configuration, and then connects to a terminal server and 
launches a session. The session is then displayed in the WinTMC client as a window or as a full screen, 
bringing terminal server computing to PCs. 

Note: Do not install WinTMC on a ThinManager Server. The two programs will compete over the 2031 
port.  

The WinTMC client needs to be installed on each PC that it is run on. 

Note: Although PCs don’t have as strict a requirement as terminal servers; it is a good idea to install the 
WinTMC client using the Add and Remove Programs feature. 

The ThinManager Install CD contains the installation for the ThinManager program and the WinTMC 
client. To install the WinTMC client on a PC select Start > Settings > Control Panel > Add/Remove 
Programs to open the Add/Remove Programs dialog box.  
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Add/Remove Programs 

Select the CD or Floppy button on the Add/Remove Programs Properties dialog box to open the 
Installation wizard. The wizard will prompt for the insertion of the ThinManager CD. When the CD is 
inserted, the wizard will ask for the path to the setup program.  
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Install CD File System 

The ThinManager CD has 4 folders.  

 Documentation – This folder contains a copy of this documentation in *.pdf format. 

 Terminal ActiveX – This folder contains the Terminal Monitor ActiveX and companion 
documentation. See TermMon ActiveX Control for details. 

 ThinManager– This folder contains the ThinManager setup program. 

 WinTMC – This folder contains the WinTMC setup program. 

Browse to the setup.exe file in the WinTMC folder to install the WinTMC client. 
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Run Installation Program Window 

Once the WinTMC setup program is selected, click the Next button to continue with the install.  

 

WinTMC Setup Wizard 

The WinTMC Setup wizard will launch. Select Next to continue. 
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License Agreement 

Read the End-User License Agreement (EULA). If you agree with the conditions select Yes to continue. 

 

Choose Destination Location 
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The Browse button will allow the user to change the path to the folder where the WinTMC client will be 
installed. 

Select Next to continue. 

 

Feature Selection 

The WinTMC installation program has two options.  

 WinTMC - This is the client application that needs to be installed to use the client. 

 WinTMC Shadow Service - This optional program allows the PC to be shadowed from within 
ThinManager by authorized users.  

Note: The WinTMC Shadow Service will function even when the WinTMC isn’t active. 

Select the Next button to continue with the WinTMC installation. 
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WinTMC Installation Completion 

When the wizard has finished select the Finish button. 

 

After Installation Dialog 

After the WinTMC setup wizard has finished, one needs to complete the installation through the Microsoft 
dialog boxes. 

Select Next to continue. 
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Finish Installation 

Select Finish to complete the installation. 
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4 Licensing ThinManager 

4.1 ThinManager Licensing 
ThinManager 5.0 introduced changes in licensing. 

Master Licenses – Each ThinManager Server or synchronized pair of ThinManager Servers use a single 
Master License to contain the product licenses. Product license codes of individual license components 
are added to the master license. When the master license is activated the product licenses are included 
in the activation and a single master license file is downloaded, containing the functionality of the member 
component licenses. 

The master license can be for a single ThinManager Server or for a Mirrored Redundant pair of 
ThinManager Servers, or a fully redundant pair of ThinManager Servers, depending on the component 
licenses. See Redundant ThinManager Servers for details on Stand Alone, Mirrored, and Fully 
Redundant systems. 

4.1.1 Standard Licensing 
Product Licenses – Product licenses are the licenses that are added to the Master License to provide 
the needed functions. The Product Licenses are:  

 Terminal Connection License – This is the main product license that allows a terminal to 
receive its configuration. It is needed by every terminal. 

 MultiMonitor – This product license, with a Terminal Connection License, allows a 
specialized thin client to use up to five monitors on a single thin client. See MultiMonitor for 
details. 

 WinTMC - This product license, with a Terminal Connection License, allows ThinManager to 
manage the RDP connection and terminal services experience of a PC. See WinTMC Fat 
Clients for details. 

 TermSecure – This product license enables additional security features for users. It can be 
used to grant them special access to hidden applications or allows access to a user’s 
application from any terminal in the system. See TermSecure for details. 
TermSecure licensing is per-user licensing. Each instance of ThinManager will install with 
licensing for five users of TermSecure included. Additional TermSecure product codes can be 
purchased to increase the number of TermSecure users beyond the initial five users.  

Components included in the ThinManager Terminal Connection Licenses include: 

 MultiSession 

 SmartSession  

 Instant Failover 



 

ACP ThinManager 6.0 Licensing ThinManager    45 

 Redundant Ethernet 

 Share Keyboard and Mouse 

4.1.2 XLi Licensing  
XLi Licenses are added to a master license the same way as standard licenses.  XLi licenses include all 
features from the standard licenses plus MultiMonitor, WinTMC, Term Secure, and PXE Boot. 

4.1.3 Master License Advantages 
The use of a Master License means that there is one license for the ThinManager Server. You only need 
to activate and transfer one master license if you need to decommission an old ThinManager Server and 
build a new one. 

New license components get added to the master license and the master license is re-activated and re-
applied to the ThinManager Server. 

4.2 License Activation 

4.2.1.1 Installation 

Install ThinManager on a computer or on two computers if you have redundant or mirrored Terminal 
Connection product licenses. 

See Installation of ThinManager and Redundant ThinManager Servers for details. 

4.2.1.2 Synchronization 

Synchronize the ThinManager Servers if you are using redundancy or mirrored redundancy. 

See Automatic Synchronization for details. 

4.2.1.3 Online Activation 

Go to www.thinmanager.com and follow the links to the License Activation to activate the license.  
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License Activation Site 

Login with an existing account or use the New User link to create a new account. 

4.2.1.4 New Account 

An account can be created on the license site by selecting the New User link. 

 

New User Entry 

Enter your e-mail address to start the creation process. 
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New User Information Entry 

Enter the required information and select the Submit button. 

A password will be sent to the e-mail address that allows access to the site. 
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4.2.1.5 Login to Site 

Select the Login link to enter the site. 

 

Login 

Enter the e-mail address used in the creation of the account. Enter the password that was sent to that 
account to login to the site. Select the Login button. 
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License Site Main Screen 

The ThinManager Licensing site has a sidebar with 6 functions: 

 Logout – This will log you out of the site and end your session. 

 Manage Account – This allows you to change the details of the account, like address and 
phone number. It also has a link that allows you to change the password to one of your 
choosing. 

 Create Master License – This creates the Master License that acts as a shell or container to 
hold the individual license product codes. 

 Manage Master License – This allows you to add the product license codes of the individual 
license components to the master license. 

 Activate Master License – This allows the master license to be activated and downloaded 
for installation. 

 History – This shows the history of actions taken by the user. 

4.2.1.6 Creating a Master License 

Select the Create Master License link to initiate the creation of a master license.  

 

Create Master License 

Enter a description of the license for your usage in the Server Name/Server Description field. 

Select the redundancy level that matches the redundancy level of your Terminal Connection product 
license and select the Submit button. 
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Master License Information. 

The site will create a master license and display the information for you. It is useful to print this page for 
your records. 

4.2.1.7 Manage Master Licenses 

Use the Manage Master License link to add product licenses to the Master License. 

 

View Master License 

Selecting the Manage Master License link will display the master licenses. 

 Download File – This link will download the master license file once the product codes of the 
component licenses are added. The Master License needs to be activated before 
downloading. If this link is selected before activation it will prompt for activation. 
See Download the Master License for details. 
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 Add Product License – This link will allow a product code of a license to be added to the 
master license.  
See Add Product License for details. 

 Edit License – This link allows the descriptions of the master license to be edited.  

 Master License Number – This link displays the master license details.  

4.2.1.8 Add Product License 

The Master License needs the product license codes of the component licenses to be added to the 
master license. This is done by selecting the Add Product License link of the Manage Master License 
page. 

 

Add Product Code Window 

Enter the product license code (license number) of the component license to the License Number field 
and select the Submit button. 

 

Add Product Code Result Window 
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When a product code of a license is successfully added to the master license the web site will show a 
confirmation message. 

Enter as many product codes as you have licenses to add to the master license. 

The master license will need activation and downloading after each group of product licenses are added. 

4.2.1.9 Redundant Master License with Non-Redundant Product Licenses 

If you have non-redundant Terminal Connection Licenses you can add them to a mirrored or fully 
redundant master license. When you add the product license it will ask which ThinManager Server you 
want to apply the license to. Apply half to the Primary and half to the Secondary. 

 

Stand-alone License on a Redundant ThinManager Server 

Once the product licenses are assigned to the target server it can be activated and applied. 
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Stand-alone License on a Redundant ThinManager Server 

Stand-alone Product Licenses applied to the Primary will show “Valid” for the Primary and “Invalid” for the 
Secondary, and vice versa. 
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4.2.1.10 Activate the Master License  

The Master License needs activated and downloaded once the product license codes of the component 
licenses have been added to the master license. This is done by selecting the Activate Master License 
link of the Manage Master License page. 

 

Activate Master License Page 

Selecting the Activate Master License link will display the Activate Master License page with a list of 
all the master licenses that are registered to the person logged in. 

Select the master license from the table or enter the master license number into the Master License 
Number field and select the Submit button.  
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Activate Master License Page 

Activation requires the entry of the Installation ID of the ThinManager Servers that the master license will 
be installed on. 

The Installation IDs will need to be added each time the Master License is activated or re-activated. 
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ThinManager Licensing Window with Installation IDs 

The Installation IDs are shown on the Licensing window that is launched by selecting Install > Licenses 
from the ThinManager menu. 

Enter the required installation IDs into the Primary Installation ID field (and the Secondary Installation 
ID field if needed) on the Activate Master License page of the License Activation web site. 

Select the Submit button to finish the activation. 
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4.2.1.11 Download the Master License 

Download the master license by selecting the Manage Master Licenses link from the main menu. 

 

Manage Master Licenses 

Select the Download File link for the master license. 

 

Master License Download 

Select the link on the page to start the download. 



 

58    Licensing ThinManager ACP ThinManager 6.0 

 

File Download Window 

The download will begin and prompt you to save the file. Do not save it directly into the ThinManager 
folder but save it to a folder that is accessible from ThinManager. 
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4.3 Adding a Master License to ThinManager 
Licenses are added to ThinManager Servers by selecting Install>Licenses from the ThinManager Menu. 

 

Licensing Window – Single ThinManager Server 

Single, unsynchronized ThinManager Servers will display the Installation ID for the local ThinManager 
Server. 
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Licensing Window – Single ThinManager Server 

Synchronized ThinManager Servers will show the Installation IDs for both redundant ThinManager 
Servers. See Automatic Synchronization for details. 

Select the Install License button to launch a file browse window. 

 

File Browser for License Files 

Browse to the folder that the master license is saved in. Highlight the master license and select the Open 
button to install the license. 
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Licensing Window with Licenses Installed 

The master license will be displayed in the Master License Number field. The product code of each 
component license will be displayed in the license window. 

4.3.1 Delete License 
The Delete License button will delete the Master License.  

 

Delete License Prompt 

Selecting the Delete License button will open a Delete License window. Selecting Yes will delete the 
license while selecting No will cancel the deletion and close the window. 

4.3.2 License Details 
The License Details button will open the License Details window with information about the Master 
License. 
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Master License Details 

The License Details window shows information about the master license, the activator of the license, 
and the owner of the license on the Master License, License Activator, and License Owner tabs. 

4.3.3 Install Demo Code 
The Install Demo Code button will open the Install Demo Code window and allow a user to add a demo 
code to give ThinManager temporary functionality. 

 

Install Demo Code Window 

A Demo Code gives ThinManager temporary functionality, normally for 30 days. 
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4.3.4 Show Old Licenses 
The Show Old Licenses button will show ThinManager 3.X licenses in a Licenses Not Included in 
Master License window. 

 

Not Included in Master License Window 

The Not Included in Master License window shows licenses installed in previous versions on 
ThinManager before the upgrade to ThinManager 5. 

4.4 WinTMC Licenses 
Each WinTMC requires a Terminal Connection License and a WinTMC License. The product license code 
for the WinTMC is added to the master license like other product license codes as described in License 
Activation. 

4.5 TermSecure Licenses 
TermSecure is licensed on a Per-User License.  Each ThinManager Server installation comes with a 5-
user TermSecure license.  This allows you to try and use TermSecure with ThinManager before buying. 

Additional user licenses for TermSecure can be purchased and added to the master license as described 
in License Activation. 
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4.6 Upgrading to ThinManager 5 from Older 
ThinManager versions 

Start the activation process by going to https://secure.randombytes.com/TM40_License. See Online 
Activation for details. 

Login to the license site. Create an account as needed. See New Account for details. 

Select the Create Master License link to create a new Master License. See Creating a Master License 
for details. 

Select the Manage Master License link to view the master license. Select the Add Product License link 
and add each of your current Product License Numbers to the newly created Master License. See Add 
Product License for details. 

The ThinManager 3.X Product License Numbers can be found by selecting Install > Licenses > Show 
Old Licenses in ThinManager. See Show Old Licenses for details. 

Activate the Master License once all the product codes are added. Select the Activate Master License 
link to activate the master license. See Activate the Master License for details. 

Once the Master License is activated it need to be downloaded and installed in ThinManager. See 
Activate the Master License; Download the Master License, and Adding a Master License to 
ThinManager for details. 
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5 Redundant ThinManager 
Servers 

5.1 Redundancy Overview 
ACP uses the term Failover to describe having two or more terminal servers that the thin clients can 
connect and run a session from. 

ACP uses the term Redundancy to describe having two or more ThinManager Servers that the thin 
clients can connect and receive a configuration from. 

ThinManager can be installed in three modes: 

 Single ThinManager Server  

 Full Redundancy 

 Mirrored Redundancy 

Single ThinManager Server – No Redundancy: A system with a single ThinManager Server will have 
all the terminals boot from that computer, receive their configuration, and then connect to the assigned 
terminal servers. If the ThinManager Server fails the terminals will continue to function as designed 
because they hold their configuration in memory. If the terminal reboots it will be unable to connect to the 
failed ThinManager Server and will not receive their configuration or connect to a terminal server until the 
ThinManager Server comes back online.  

Full Redundancy – Two ThinManager Servers: A fully redundant system has two licensed 
ThinManager Servers that are synchronized with the same configuration on each. The thin clients are 
configured to boot from either ThinManager Server to receive their configuration. If the primary 
ThinManager Server fails the terminals will continue to function as designed because they hold their 
configuration in memory. If the terminal reboots it will be unable to connect to the failed primary 
ThinManager Server but will switch and boot from the secondary ThinManager Server and will receive the 
configuration and connect to a terminal server. 

Mirrored Redundancy – Two ThinManager Servers: This is a form of redundancy that is controlled with 
a mirrored license. You use two synchronized ThinManager Servers that the terminals can boot from as in 
a fully redundant system. The difference is that administrative functions like shadowing and configuration 
changes are limited to the primary ThinManager Server. 

Mirrored redundancy is a means to provide a redundant ThinManager Server at a lower cost. It provides a 
backup ThinManager Server to keep production running until a replacement can be found for the primary 
ThinManager Server. 

Note: All Enterprise licenses include Full Redundancy. 



 

66    Redundant ThinManager Servers ACP ThinManager 6.0 

5.1.1 Redundancy Differences 
No Redundancy - Single ThinManager Server  

 Least expensive. 

 If the ThinManager Server fails the thin clients continue to run from their configuration 
loaded into RAM. 

 If the thin client reboots the thin clients cannot retrieve their configuration until the 
ThinManager Server is restored. 

 The Master License is created with “None” for its redundancy.  

Mirrored Redundancy- Two ThinManager Servers 

 Provides redundancy at a lower cost than full redundancy. 

 If the ThinManager Server fails the thin clients continue to run from their configuration 
loaded into RAM. 

 Configuration changes can be made only on the primary ThinManager Server. If it fails 
the thin clients are able to retrieve their configuration from the backup and run as 
configured. Configuration changes must wait until the primary ThinManager is restored. 

 The Master License is created with “Mirrored Redundancy”. It uses Mirrored Terminal 
Connection Product Licenses. 

Full Redundancy - Two ThinManager Servers 

 If the ThinManager Server fails the thin clients continue to run from their configuration 
loaded into RAM. 

 If a ThinManager Server fails, the other ThinManager Server will provide configuration. 

 The ThinManager configuration can be changed on either ThinManager Server at any 
time. 

 Requires a duplicate set of licenses on the backup ThinManager Server. 

 The Master License is created with “Full Redundancy”. It uses Redundant Terminal 
Connection Product Licenses. 

5.2 Creating a Redundant Pair of ThinManager 
Servers 

To create a redundant pair of ThinManager Servers: 

1. Install ThinManager on two computers. See Standard ThinManager Installation. 

2. Configure the thin clients on the primary ThinManager Server. See Terminal 
Configuration Wizard. 

3. Synchronize the two ThinManager Servers. See Synchronize Configuration. 

4. Create a Master License with Full Redundancy and add a Redundant Terminal 
Connection Product License or add two Terminal Connection Product Licenses and apply 
one to the Primary ThinManager Server and one to the Secondary ThinManager Server. 
See ThinManager Licensing for details. 

5. Configure the thin clients to boot from two ThinManager Servers using the DHCP server 
or static IP addressing. See DHCP Server Setup or Configuring New Hardware. 

See ThinManager Licensing for details about Redundant License activation. 
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5.3 Creating Mirrored Redundancy 
Mirrored Redundancy provides redundancy at a reduced cost from full redundancy. 

To set up Mirrored redundancy: 

6. Install ThinManager on two computers. See Standard ThinManager Installation. 

7. Synchronize the two ThinManager Server. See Manual Synchronization. 

8. Create a Master License with Mirrored Redundancy and add a Mirrored Terminal 
Connection Product License to the Master License. See ThinManager Licensing for 
details 

9. Configure the thin clients on the primary ThinManager Server. The configurations will be 
transferred to the secondary ThinManager Server. See Terminal Configuration Wizard. 

10. Configure the thin clients to boot from two ThinManager Server using the DHCP server or 
static IP addressing. See DHCP Server Setup or Configuring New Hardware. 

Administrative functions like changing configuration or shadowing can be only performed on the primary 
ThinManager Server. If the primary fails the thin clients will continue running from their configuration 
stored in memory. If they reboot they are able to retrieve their configuration from the backup and run as 
configured. Configuration changes must wait until the primary ThinManager is restored. 
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6 ThinManager Interface 

6.1 Opening ThinManager  
ThinManager is used for the configuration of Thin Clients in the ACP thin client environment. 

ThinManager can be started using any of the traditional Windows methods, based on the administrator's 
preference: 

 Run from the Start Menu, Start > Programs > \Automation Control Products > 
ThinManager or Run Start > Programs > \ ACP > ThinManager depending on the 
installation folder. 

 Run from the Run line, Start > Run > C:\Program Files\Automation Control 
Products\ThinManager\ThinManager.exe (default path). 

 Run from a command prompt, C:\Program Files\Automation Control 
Products\ThinManager\ThinManager.exe (default path).  

 Run from a shortcut on the desktop. 

 Run from a ThinManager icon in the system tray, if this option is selected in View > Options 
from the menu bar.  

 Run from Windows Explorer.  

Note: ThinManager can be run on a terminal with full privileges if the user is an administrator or a 
member of the ThinManager Administrator’s group. See ThinManager Server Configuration wizard for 
details on ThinManager User Groups. 
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6.2 ThinManager Graphic User Interface 

 
ACP ThinManager Graphic User Interface 

The ThinManager administrative interface provides "at-a-glance management". The groups and 
terminals are displayed in the tree pane. The configuration data is displayed in the detail panel. Color-
coded icons in the tree pane show the on-line status of terminals. 

The sections of the ThinManager interface include: 

 A Title Bar  with the standard Windows Minimize/Maximize/Close shortcut icons. 

 A Menu Bar  with commands.  

 A Tree Pane  with an expandable/collapsible tree showing the Terminals, Display Servers, 
Display Clients, TermSecure Users on the ThinManager Server. Terminals that are on-line 
have a green monitor icon, while stopped or rebooting terminals have a red monitor icon.  

 A tabbed Details Pane  with information about settings and configurations. The blue group 
icon denotes a property that was obtained from the group. The details pane is tabbed for 
organization. The tabs that are shown depend on the tree item that is highlighted. 

 A Status Bar  that shows advice and tips.  

 The Communication Indicator  shows green when ThinManager is talking to a 
ThinManager Server. ThinManager will wait until this communication is finished before 
processing additional requests. 
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6.3 Tree Pane 
The tree pane shows the members of the ACP Thin Client Network in an expandable tree. 

 
ACP ThinManager with Tree 

The Tree has five branches.  

 Terminals – This lists terminal groups and terminals. Terminal groups can be expanded to show 
member terminals and terminals can be expanded to show assigned display clients.  

 Display Servers – This lists the display server types that can be used when configuring display 
clients. 

 VCenter Servers - This allows ThinManager to list and manage VMWare VCenter servers. 

 Display Clients – This lists the display client types that can be added to a terminal configuration. 
They can be expanded to show the members of each display client type. 

 TermSecure Users – This lists configured TermSecure Users and any created groups of 
TermSecure users. 
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6.4 Icons 

6.4.1 Tree Icons 
Several of the menu tools and other features are dependent on what icon is highlighted in the tree.  

The tree is divided into five branches, Terminals, Display Servers, VCenter Servers, Display Clients 
and TermSecure Users.  

 
Five Tree Branches 

Each of the branches, shown as a blue icon, can be expanded. 
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Expanded Tree Showing Icon Variety 

Terminal Groups can be expanded to show the subgroups and terminals that are members of the group. 

Terminals can be expanded to show the display clients assigned to it. 

Display Clients can be expanded to show the members that are assigned to it. 

TermSecure User Group can be expanded to show the TermSecure Users that are members of the 
group. 

Each of the branches of the tree can be expanded. 
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6.4.1.1 ThinManager Server Icons 

 

ThinManager Server Icons 

ThinManager can connect to several ThinManager Servers, but only one ThinManager Server tree can be 
displayed at a time. The tree shows the local ThinManager Server by default. Other ThinManager Servers 
can be added to the ThinManager Server drop-down box by selecting Edit > Add ThinManager Server 
from the menu bar. 

A Green ThinManager Server icon represents a ThinManager Server that has an active communication 
link with the program. These can be collapsed or expanded to show the Group and Terminal icons that 
nest under the ThinManager Server icons. 

A Red ThinManager Server icon represents a ThinManager Server that is not communicating with the 
program. Right clicking on a red ThinManager icon and selecting Reconnect will reinitiate 
communications to the ThinManager Server. 

6.4.1.2 Terminal Icons 

The Terminals branch can be expanded to show Terminal Groups and terminals. 

 

Group and Terminal Icons 

A Group is represented by an icon of two monitors with a blue screen. Subgroups can be nested under 
Groups. 

A Terminal is represented by an icon of a single monitor. 

 A Red terminal screen indicates that the Terminal is off or not communicating with the 
ThinManager Server. 

 A Purple terminal screen indicates that the Terminal is loading the firmware during the boot 
process. 
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 A Yellow terminal screen indicates that the Terminal has loaded firmware, received its 
configuration and is in the process of establishing a monitor connection to the ThinManager 
Server. 

 A Green terminal screen indicates that the Terminal is on and communicating with the 
ThinManager Server. 

 A Terminal with a Head icon indicates that a TermSecure User is logged onto the terminal. The 
TermSecure User name will be displayed in parentheses. 

 A Terminal with a Lock or a locked group icon means that that terminal or group is being 
modified and cannot be changed by another user. If the Group or Terminal remains locked after 
its configuration wizard is closed, it can be unlocked by using Edit > Unlock from the menu bar.  

 A Terminal with a Red X indicated that an administrator has disabled the terminal. 

Note: The purple and yellow screen will not be visible before the terminal has connected the first time and 
is defined in ThinManager. 
The purple and yellow screens are only visible during a reboot and not after a restart, as a restarted 
terminal does not reload firmware. 

The Terminal icon can be expanded to show the assignment of the terminal. 

 

Terminal Assigned to Individual Terminal Servers 

A terminal that is using individual terminal servers may expand to show a terminal server icon with three 
connection states. 

 A green lightning bolt indicates an active connection to the terminal server. 

 A yellow lightning bolt indicates an active connection that is cascaded in the background while 
using Instant Failover. 

 A red lightning bolt indicates an inactive connection to the terminal server. 
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Terminal using Display Clients 

A terminal that is using Display Clients can be expanded to show the status of the Display Clients. The 
Display Clients can be expanded to show the status of the Display Client members. 

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X 
over the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but the 
ThinManager Server icon and the Group icon will not show an X, just the terminal icons. 

 

Disabled Terminal Icons 

A Red terminal screen with a Red X indicates that the Terminal is disabled and is either turned off or 
rebooted and waiting to be enabled. 

A Green terminal screen with a Red X indicates that the disabling has been applied to the terminal that 
is turned on. The terminal has a disabling screen and is waiting for enabling. 

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X 
over the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but the 
ThinManager Server icon and the Group icon will not show an X, just the terminal icons. 

Once a terminal is disabled, a disabling screen will appear on the terminal until the terminal has been 
enabled. 
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Disabling Screen 

If a terminal is active when it is disabled, it will display the Disable Screen with a message indicating the 
disabled status in the upper left corner. 

 

Disabled Terminal 

If a terminal is booted when disabled, the boot process will be halted until the terminal is enabled. 

See Disable Terminals for details. 

 



 

ACP ThinManager 6.0 ThinManager Interface    77 

6.4.1.3 Display Servers Branch 

The Display Servers section of the tree is where display sources are defined and configured. These 
definitions will be used when defining a Display Client. Examples of Display Servers are Terminal Servers 
and IP Cameras. 

 
Display Servers Tree Branch 

6.4.1.4 Terminal Server Connection Icons 

The Display Servers Terminal Servers branch can be expanded to show the Terminal Servers that are 
configured. The Terminal Servers can be expanded to show the member terminal servers. The member 
terminal servers can be expanded to show the terminals connected to them. The monitor screen color 
and the lightning bolt color indicate the terminal’s status on the Terminal Server. 

 

Terminal Server Connection Icons 

The monitor screen color indicates the ThinManager Server connection status. The lightning bolt color 
indicates the Terminal Server connection status. 

 A Red monitor screen indicates that the terminal is off or unable to communicate to the 
ThinManager Server. 

 A Green monitor screen indicates that the terminal is on and able to communicate to the 
ThinManager Server. 

 A Red lightning bolt represents a lack of active connection to the terminal server. 

 A Green lightning bolt represents a connection to the terminal server with an active session. 

 A Yellow lightning bolt represents a connection to the terminal server with a session that is the 
backup session in Instant Failover mode. 
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6.4.1.5 VCenter Server Icons 

 

VCenter Server Tree Icons 

6.4.1.6 Display Clients Branch 

The Display Clients section of the tree is where the usage of a Display Server is defined. Display Clients 
are added to the terminal configuration. Examples of Display Clients are Terminal Services Display 
Clients, IP Camera Display Clients, Terminal Shadow Display Clients, and Workstation Display Clients. 

 

Display Client Tree Branch 

6.4.1.7 TermSecure User Branch 

The TermSecure Users branch can be expanded. 
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TermSecure User Tree 

The TermSecure User branch expands to show TermSecure User Groups.  

A Two-headed icon represents a TermSecure User Group. This can be expanded to show member 
TermSecure Users. 

A Single-headed icon represents a TermSecure User. This can be expanded to show any Display 
Clients that are assigned to the TermSecure User. 

A Single-head with Terminal icon represents a TermSecure User that is logged in on a terminal. The 
terminal name is shown in parentheses. This can be expanded to show any Display Clients that are 
assigned to the TermSecure User. 

A TermSecure User that is not active or logged into a terminal server will show the normal Display Client 
icon. 

A TermSecure User that is active and logged into a terminal will show an icon of the TermSecure User 
head with the Display Client 

6.5 Details Pane 
The Details Pane has tabs to provide additional information. Highlighting different items in the tree will 
display a different set of tabs and the corresponding set of information. 

6.5.1 ThinManager Server Detail Tabs 
Highlighting the green ThinManager Server will show: 

 Configuration - These are the configuration parameters set in the ThinManager Server 
Configuration Wizard and include the Event Messaging summary.  

 Licenses - This displays the installed licenses, the quantity used and the quantity available. 
ThinManager lists all the license files and identifies whether that are valid or invalid. This tab 
will display licenses for both ThinManager Servers if the pair is auto-synchronized. 

 Versions - This displays the version numbers of ThinManager, the firmware, and the 
TermCap database. 

 Synchronization – This will show the synchronization status of the ThinManager Server. 
See Automatic Synchronization for details. 

 Event Log - This displays events for the ThinManager Server. The events and duration are 
configurable in the ThinManager Server Configuration wizard. See Event Selection Page for 
details. 

 Report – This will display the selected report for the ThinManager Server. See Reports for 
details. 
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 IP Assignment – This will display the IP address, MAC Address, and Terminal name of PXE 
boot clients when the ThinManager PXE Server is configured to assign IP addresses to 
terminals. See PXE Server Configuration Wizard for details. 

 

ThinManager Server Tabs 

6.5.2 Terminal Group Detail Tabs 
Highlighting a Group will show: 

 Configuration - These are the configuration parameters set in the Group Configuration 
Wizard and include Terminal Server assignments, video settings, and monitoring settings. 
See Terminal Group Configuration Wizard for details. 

 Modules - This lists the assigned modules and parameters for the Group. See Modules for 
details. 

 Schedule – This will display any events scheduled for the Group. See Terminal Schedule for 
details. 

 Properties - This is blank for a Group. 

 Event Log - This is blank for a Group. 

 Shadow – This is blank for a Group 

 Report – This will display the selected report for the group. See Reports for details. 
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Group Tabs – Modules 

6.5.3 Terminal Detail Tabs 
Highlighting a Terminal will show: 

 Configuration - These are the configuration parameters set in the Terminal Configuration 
Wizard and include Terminal Server assignments, video settings, and monitoring settings. 
See Terminal Configuration Wizard for details. 

 Modules - This lists the assigned modules and parameters for the Terminal. See Modules for 
details. 

 Schedule – This will display any events scheduled for the terminal. See Terminal Schedule 
for details. 

 Properties - This shows the IP address, firmware version, make and model, CPU, memory 
usage, Terminal Up Time, CPU load, and BootROM version of the Terminal.  

 Event Log - This shows the terminal events and terminal configuration events for that 
terminal, if event logging is enabled in the ThinManager Configuration Wizard. See Event 
Selection Page for details. 

 Shadow – This tab shows what the terminal is displaying on its monitor. Administrators can 
interact with the session while ThinManager Power Users can view the session but not 
control it. See ThinManager Security Groups for details. 

 Report – This will display the selected report for the terminal. See Reports for details. 
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Terminal Tabs – Shadow 

6.5.4 Terminal Server Detail Tabs 
Highlighting the blue Terminal Server branch will show: 

 Status - This shows the status of the communication connection between the local 
ThinManager Server and the defined Terminal Servers and ThinManager Servers. This 
shows whether the local ThinManager Server is able to retrieve the updated resource 
information used in determining the SmartSession Server Ranking. See Terminal Server 
Name Page for details. 

 Summary - This will report information on the terminal servers like available memory, uptime, 
CPU utilization, and operating system. 

 Event Log - This shows the terminal events and terminal configuration events for that 
terminal server, if event logging is enabled in the ThinManager Configuration Wizard. See 
Event Selection Page for details. 

The Connection Status of the Terminal Servers may have different messages: 

 OK indicates a good connection. 

 WTSAPI32.dll connection failed occurs when the terminal server is off or unreachable. 

 The RPC Server is unavailable occurs when the terminal server is off or unreachable. 

 No login information supplied indicates that the Terminal Server didn’t have a username 
and password added in the Terminal Server List Wizard.  
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 User specified does not have permission to connect indicates that the Terminal Server 
had an invalid username and password added in the Terminal Server List Wizard. 

 

Terminal Servers Tabs – Status 

Highlighting an individual Terminal Server will show: 

 Configuration - This shows the installed Client Communication Protocols and the 
SmartSession settings for the Terminal Server. See Terminal Server Capabilities Page for 
details. 

 Properties – This tab displays the server resource data like total memory, free memory, 
uptime, and CPU speed.  

 Schedule – This will display any events scheduled for the Group. See Terminal Server 
Schedule for details. 

 Users - This tab displays information from the Terminal Services Manager. It shows users 
that are logged into the Terminal Server. Right clicking on a user will show options that allow 
the session to be Reset (logged off), Disconnected, or have a message sent to it.  

 Sessions - This tab displays information from the Terminal Services Manager. It shows users 
that are logged into the Terminal Server. Right clicking on a user will show options that allow 
the session to be Reset (logged off), Disconnected, or have a message sent to it.  

 Processes - This tab displays information from the Terminal Services Manager. It shows the 
processes running on the Terminal Server and can have them sorted by Session ID (users) 
or Process Name. Right clicking on a process will give the option to kill the process.  

 Graph – This tab will display the CPU usage and memory usage of the terminal server as a 
graph. This graph can contain one hour of historical data.  
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 Event Log - This shows the terminal events and terminal configuration events for that 
terminal, if event logging is enabled in the ThinManager Configuration Wizard. Event 
Selection Page for details. 

 Connect – This tab will open a connection from ThinManager to the terminal server. This 
session allows administrators to manage the terminal server from within ThinManager. See 
Connect Options for details. 

 Report – This will display the selected report for the terminal server. See Reports for details. 

 

Terminal Server Tabs - Users 

6.5.5 Modifying a Terminal 
Modifying a terminal allows you to reconfigure the terminal or change group settings such as touch 
screen usage, video resolution, or to assign it to a terminal server.  

To modify a terminal open the Terminal Configuration Wizard or the Terminal Properties by either: 

 Highlighting the terminal in the ThinManager tree pane by clicking on the terminal name or 
icon and select Edit > Modify from the ThinManager menu bar. 

 Right-clicking on the terminal icon in the ThinManager tree pane and select Modify. 

 Double-clicking on a terminal icon in the ThinManager tree pane. 

This will launch the Terminal Configuration Wizard, allowing changes to be made. 

Note: The terminal will need to be restarted for the changes to take effect.  
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6.5.6 Deleting a Terminal 
A terminal can be deleted from the ThinManager by: 

 Highlighting the terminal in the ThinManager tree pane and selecting Edit > Delete from the 
ThinManager menu bar  

 Right-clicking a terminal icon in the tree pane of ThinManager and selecting Delete 
Terminal.  

6.5.7 Restarting a Terminal 
A restart will reload any changes to a terminal configuration or firmware without a cycling of power. 

A terminal or group can be restarted by:  

 Selecting Tools>Restart Terminal from the ThinManager menu bar. This will restart all the 
terminals on the server if the server is highlighted. If a group is highlighted, all members of 
the group will be highlighted. If a terminal is highlighted, the terminal is restarted. 

 Right-clicking a ThinManager Server icon in the tree pane of ThinManager and selecting 
Restart Terminals. This will reboot all the terminals in the tree. 

 Right-clicking a group icon in the tree pane of ThinManager and selecting Restart 
Terminals. This will reboot all the terminals in the group. 

 Right- clicking a terminal icon in the tree pane of ThinManager and selecting Restart 
Terminal. This will restart only the highlighted terminal. 

6.5.8 Rebooting a Terminal 
A reboot will cycle power to the terminal, reloading firmware and configuration. 

A terminal or group can be rebooted by:  

 Selecting Tools>Reboot Terminals from the ThinManager menu bar. This will reboot all the 
terminals on the server if the server is highlighted. If a group is highlighted, all members of 
the group will be highlighted. If a terminal is highlighted, the terminal is rebooted. 

6.5.9 Renaming a Terminal 
Terminals can be renamed by: 

 Highlighting the Terminal and selecting Edit > Rename. 

 Right-clicking the Terminal and selecting Rename. 

Note: Renaming a terminal can be accomplished the same way that files or directories are renamed in 
Windows Explorer. Single click twice on the terminal name; this will draw a box around the name and 
highlight it. Type the new terminal name. 
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Renaming a Terminal 

The terminal name should be less than 15 characters because of limitations on the terminal server. 

Tip on single clicking  twice: Click once to highlight the name, move the mouse slightly and click again. 
This will prevent Windows from confusing the two single clicks with a double click. 
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7 Menu Items 

7.1 Edit 
Edit contains commands for adding, deleting, and changing configurations. The functions listed are 
dependent on what is highlighted in the tree.  

7.1.1 Add Terminal 
Edit > Add Terminal will launch the Terminal Creation Wizard to start the process of adding a new 
terminal. This command will be displayed when the ThinManager Server, Terminals branch, or a Terminal 
Group is highlighted. 

See Terminal Configuration Wizard for details. 

7.1.2 Add Terminal Group 
Edit > Add Terminal Group will launch the Group Creation Wizard to start the process of adding a new 
group of terminals. This command will be displayed when the ThinManager Server, Terminals branch, or 
a Terminal Group is highlighted. 

See Terminal Group Configuration Wizard for details. 

7.1.3 Add ThinManager Server 
Edit > Add ThinManager Server will allow the remote administration of multiple ThinManager Servers by 
adding an additional ThinManager Server to the ThinManager Server drop-down box above the tree. A 
user logged in with administrative rights can connect to multiple ThinManager servers for management.  

Selecting Add ThinManager Server will launch a dialog box. 

 

Add ThinManager Server Dialog Box 
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Enter computer name or the IP address of a ThinManager server. This adds the ThinManager Server to 
the ThinManager Server drop-down box above the tree pane of the local ThinManager so that the 
configuration can be displayed in the tree when needed.  

Note: You should only add ThinManager Servers of the same version to the list. 

 

ThinManager Adding an Additional ThinManager Server  

The new ThinManager Server will be added to the ThinManager Server drop-down box. Selecting the 
new ThinManager Server in the drop-down will display the tree for that ThinManager Server. 

Members of the Administrator group or the ThinManager Administrators group have full control of the 
remote ThinManager Server and can make changes as needed. Members of the ThinManager Power 
Users group can monitor the connection. 

See ThinManager Security Groups for more details. 

If ThinManager is installed on a Windows XP Pro workstation, it cannot be added to a ThinManager on a 
Windows 2003 unless a security option is changed. 

In Windows XP Pro select Start > Control Panel > Administrative Tools > Local Security Policy. 
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Windows XP Pro – Local Security Settings 

Highlight the Security Options folder in the Local Security Settings program. Change the Network 
access: Sharing and Security model for local accounts from the default Guest Only to Classic to 
match the setting of the Windows 2003 terminal server.  

7.1.4 Remove ThinManager Server 
Edit > Remove ThinManager Server will delete a highlighted ThinManager Server from the tree. 
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7.1.5 Delete 
Edit > Delete will launch a message box that will remove a highlighted ThinManager Server, group or 
terminal. Deleting a remote ThinManager Server will remove it from the local list. 

 

Delete Group Message Box 

Deleting a group will give the option of deleting the group terminals or moving them under the server 
without a group. 

7.1.6 Modify 
The function of Edit > Modify depends on what tree icon is highlighted when Modify is selected. 

 Modify will launch the ThinManager Server Configuration Wizard for a highlighted 
ThinManager Server. This allows the ThinManager Server to be configured as described in 
the ThinManager Server Configuration Wizard. 

 Modify will launch the Terminal Group Configuration Wizard for a highlighted terminal 
group. Modifications can be made as described in Terminal Group Configuration Wizard. 

 Modify will launch the Terminal Configuration Wizard for a highlighted terminal. 
Modifications can be made as described in Terminal Configuration Wizard. 

 Modify will launch the appropriate Display Server Configuration Wizard for a highlighted 
Display Server member. 

 Modify will launch the appropriate VCenter Server Property Wizard for a highlighted 
VCenter member.  

 Modify will launch the appropriate Display Client Configuration Wizard for a highlighted 
Display Client member.  

 Modify will launch the TermSecure Configuration Wizard for a highlighted TermSecure 
user or group. 

7.1.7 Rename 
Edit > Rename will allow a highlighted tree item to have its name changed. 

Note: The terminal name should be less than 15 characters because of limitations of the terminal server. 
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7.1.8 Lock 
When a tree member is opened for modification, the entry in the configuration is automatically locked to 
prevent two people from making changes at one time.  

Edit > Lock will manually lock the configuration of a tree member to prevent it from being changed. A 
lock icon will designate the locked state. 

 

Lock Icons 

7.1.9 Unlock 
Edit > Unlock will manually unlock a tree member that was locked while being modified. This is used if 
the server was shut down while a tree member was locked, preventing the member from being unlocked 
automatically when the modifications are complete. 

Using the Unlock function will display a warning to alert the user. 

 

Lock Warning Message 

Unlocking a locked member can cause a loss of configuration data if another user is modifying it. 

Note: This tool is to be used only when a tree member remains locked due to an unexpected server shut 
down while a member is being configured. Using this tool while another is configuring that terminal can 
lead to corruption of the database. 

7.1.10 Find 
Edit > Find launches a Find dialog that searches the tree for the item typed into the Find field. 
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Find Dialog Box 

The Find function has several checkboxes to enhance the search: 

 Search Names – this, when checked, will search for a name entered in the Find field. 

 Search IP Addresses - this, when checked, will search for an IP address entered in the Find 
field. 

 Search Terminal Ids - this, when checked, will search for a MAC address/Terminal ID entered in 
the Find field. 

 Search Terminal Models – this, when checked, will search for a thin client model entered in the 
Find field. 

 Exact Match Only - this, when checked, will limit searches to exact matches to the name entered 
in the Find field. 

CTRL+F are the short cut key to launch Find. 

7.1.11 Find Next 
Edit > Find Next will continue searching the tree for the next instance of the text in the Find field of the 
Find dialog box.  

F3 is the shortcut key for this function.  

7.2 Manage 

7.2.1 ThinManager Server List 
Manage > ThinManager Server List will launch the ThinManager List Wizard. See ThinManager 
Server List for details. 

7.2.2 TermSecure Access Groups 
Selecting Manage > TermSecure Access Groups will launch the Access Groups window to create 
Permission Groups for use with TermSecure. 

See Permissions for more details. 
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Access Groups Window 

Select the OK button to accept the changes and close the window. 

Select the Edit button to change the highlighted Access Group. 

Select the Add button to add a new Access Group. 

Select the Delete button to remove the highlighted Access Group. 

If the Add button is selected, an Access Group Creation window will be displayed. 

 

Access Group Creation Window 

Enter a name for the new Access Group and select OK to create the group. 
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TermSecure Access Groups Added 

Defined Access Groups will be displayed in the Access Group window. See Permissions for more 
details. 

7.2.3 Packages  
A Package is a version of Firmware and the Modules that belong with it. Installing a package will install 
both firmware and modules. 

Manage > Packages will launch the Package Manager.  

 

Package Manager 
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The Package Manager window allows you to set the version of package for a make and model of the 
hardware or allows you to individually configure the package per terminal. 

Model Specific Default Package: 

 Manufacturer – This lets you select the Manufacturer of the terminals to configure. 

 Model – This lets you select the specific model of the terminals to configure. 

 Package – This lets you select what package to apply to all the terminals of the selected make 
and model. 

 Allow the settings of the Package in Terminal Configuration – The checkbox, when selected, 
will allow the individual selection of the terminal’s package in the Terminal Firmware Package 
drop-down on the Terminal Hardware page of the Terminal Configuration Wizard. 

 Install Package – This button opens a file browser to select the new package to load. These are 
found on the ThinManager web site (http://www.thinmanager.com/support/downloads.php). 
Upgrading ThinManager will update the packages. 

 Delete Package – This allows you to remove a package, if desired. 

 OK – This buttons accepts the changes and closes the window. 

 Cancel – This closes the window without making the changes. 

7.2.3.1 Delete Firmware Packages 

 

Delete Firmware Packages Window 

Selecting the Delete Packages button on the Packages Manager window will launch the Delete 
Firmware Package window. 

Select the firmware version you wish to remove from the drop-down. Select Delete to delete the file or 
select Cancel to return to the Packages Manager window. 

7.2.4 Web Management  
Screentronix (www.screentronix.com) provides a secure VPN that allows you to connect to a 
ThinManager Server from a remote browser to aid in management. This is done on the Web 
Management window. 

Select Manage > Web Management to launch the Web Management window.  
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Web Management Window 

The Web Management window allows toy to register your ThinManager Server with Screentronix to allow 
a secure VPN to be created as needed for remote support and management. 

 Machine ID – Enter the number for this machine that was generated on the Screentronix site. 

 User Name – Enter your Screentronix user name in this field. 

 Password – Enter your Screentronix password in this field. 

 Submit – Select this button to send the information and register this machine with Screentronix. 

 Install Demo Code – Use this button to enter a Demo license code. This is available from the  f 

 Done – This closes the window. 

7.2.5 DNS Configuration 
Manage > DNS Configuration will launch the DNS Configuration Wizard. See DNS Configuration for 
details. 

7.2.6 PXE Server  
Manage > PXE Server will launch the PXE Server Configuration Wizard. See PXE Server Configuration 
Wizard for details. 

7.2.7 Configure Default Terminal 
Manage > Configure Default Terminal will launch the Terminal Properties for the “Default” terminal. This 
default terminal is used as a template that terminals created during Auto-Create are based on. See Auto-
Creation of Terminals for details on Auto-Creation of terminals. 
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7.2.8 Restore Configuration 
Manage > Restore Configuration will allow a backed up ThinManager configuration to be applied to the 
ThinManager Server. Select Restore Configuration to launch the desired ThinManager Configuration file 
in the browse window and select Open. The backup copy will overwrite the existing configuration. 

 

Restore ThinManager Configuration  
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7.2.9 Backup Configuration 
Manage > Backup Configuration allows the ThinManager Configuration to be saved. Select Backup 
Configuration to launch a browse window and select the Save button to save a backup copy. 

 

Backup ThinManager Configuration 

7.2.10 Synchronize Configuration 
Manage > Synchronize Configuration allows the configuration of multiple ThinManager Servers to be 
kept identical so that a terminal will boot with the same configuration regardless of what ThinManager 
Server the terminal connects to.  

Note: ThinManager has an Automatic Synchronization feature that will keep two ThinManager Servers 
synchronized without requiring a manual input. See ThinManager Server List Page for details. 

Although Automatic Synchronization is the preferred method of synchronization, Manual Synchronization 
is useful to synchronize the configurations on the primary and backup ThinManager Servers before 
turning on the Automatic Synchronization. 

Selecting Synchronize Configuration will launch the Synchronize ThinManager Server 
Configurations Wizard. See Manual Synchronization for details. 
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7.2.11 Reconnect   
This command will reinitiate the connection between the highlighted ThinManager Server and the 
ThinServer service. 

7.2.12 Disconnect  
This command will disconnect the connection between the highlighted ThinManager Server and the 
ThinServer service. 

7.3 Install 
Install is a new menu item that contains the commands from Manage that involve installation. 

7.3.1 Licenses 
Install > License opens up the Licensing dialog box.  

 

Licensing Window 

The Master License Number field shows the number of the installed master license. See Creating a 
Master License for details. 

The Licensing window displays several columns. 

 License Number – This displays the component product license numbers included in the 
installed master license. A green monitor indicates a valid license while invalid licenses will 
display a red “X”. 

 Description – This lists the product license type. 

 Location – This lists the ThinManager Server(s) that the component product license applies to. 
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 Redundancy – This indicates whether the license type is fully redundant or mirrored. 

 Expiration – This displays the license expiration date. 

The Installation ID field displays the Installation ID number that is used in the license activation process. 
ThinManager Servers that are auto-synchronized will display the Install ID of both ThinManager Servers. 

 Install License – This button launches a file browser that allows a license file to be added. 

 Delete License – This button allows a highlighted license to be deleted. 

 Details – This button displays the details of a highlighted license. 

 Install Demo Code – This button allows a Demo Code to be added to give temporary 
functionality. 

 Show Old Licenses – This lists the previously installed ThinManager 3.x licenses on the 
ThinManager Server. 

 Done – This button closes the Licensing window. 

See ThinManager Licensing for details. 

7.3.2 TermCap Database 
ThinManager has a Terminal Capability Database (termcap.db) that provides ThinManager with 
the configuration parameters for each thin client model. At each terminal connection, the TermCap 
database is checked and an integrity check is performed. If the configuration does not match the terminal 
specifications, ThinManager may reconfigure the terminal to acceptable parameters. 

 

Terminal Capabilities Integrity Check 

The Terminal Capability database can be updated with the current release from the ThinManager web 
site (www.thinmanager.com). 

To update the Terminal Capabilities Database, select Install > TermCap Database. 
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Install New TermCap Database 

An Open dialog box will be launched.  

Select the new version of the termcap.db and select the Open button. This will install the new version. 
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7.3.3 Firmware Package   
ThinManager allows the firmware for the thin client to be upgraded with the latest version from the 
ThinManager web site (www.thinmanager.com).  

To update the Terminal Capabilities Database, select Install > Firmware Package. 

 

Install Firmware Package 

An Open dialog box will be launched.  

Select the new version of the termpack-##.pkg and select the Open button. This will install the new 
version. 
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7.3.4 Firmware  
ThinManager allows the firmware for the thin client to be upgraded with the latest version from the 
ThinManager web site (www.thinmanager.com).  ThinManager 6.0 and later have the *.fw file 
extension while ThinManager 5.0 and earlier use the firmware.acp format. 

Select Install > Firmware to launch a file browser.  

 

Install New Firmware 

Select the new type of firmware, either the new *.fw format or the earlier legacy firmware.acp 
format in the drop-down. Select the file in the window and select Open. This will install the new version of 
the firmware. 

The thin clients will download the new version of firmware the next time they are rebooted. 
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7.3.5 Boot Loader  
ThinManager uses a boot loader to initially load the bootstrap on PXE thin clients.  

To install the PXE Boot Loader, select Install > PXE Boot Loader. 

 

Install Boot Loader 

An Open dialog box will be launched 

Select the acpboot.bin file and select the Open button. This will install the file. 
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7.3.6 Chain Loader   
ThinManager uses a chain loader to help the Boot Loader on PXE thin clients during the boot process.   

To install the Chain Loader, select Install > Chain Loader. 

 

Install Chain Loader 

An Open dialog box will be launched 

Select the acpboot.bin file and select the Open button. This will install the file. 
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7.3.7 Modules   
Install > Modules open the Modules dialog box. This displays the modules that are available to the ACP 
Enabled thin clients. See Module Overview for details. 

 

Installed Modules Windows 

The Module Type drop-down allows all modules to be displayed or allows the modules to be filtered by 
type. 

The Package drop-down allows the viewing of all the modules, or the modules of a single package. Since 
the Package contains both a version of a firmware and the modules that support it, this dropdown allows 
you to filter the modules by version. 

The Modules for Server X window has three columns. 

 Description – This lists the modules by name. 

 Version – This is the version number of the module. This can be compared against the latest 
versions from http://www.thinmanager.com/support/downloads.php. 

 License Required – This shows what license is required, if any, to use the module. 

The Modules for Server X window has three buttons. 

 Install Module – This button launches a file browser that allows a module file to be added or 
updated. 

 Remove Module form All Terminals – This button will remove a highlighted module from all 
terminals. It doesn’t remove the module from the system; it just removes it from the 
configurations. 
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 Done – This button closes the Modules window. 

Selecting Install Module… will launch a dialog box that allows modules files to be selected. 

 

Open Module File 

A module can be added to the list of available modules by highlighting the desired module file and 
selecting Open. . The window will close when the license is installed. 

Note: The module files should not be saved directly into the ThinManager folder but should be saved to 
another folder and be installed using ThinManager. 

See Module Overview for details 
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7.3.8 Reports (Installation)  
Install > Reports will launch a Reports window that allows additional reports to be added to 
ThinManager. Each report has two components, an HTML template and a SQL query. 

See Reports for information on reports. 

 

Reports Window –Reports Templates 

The Reports widow has radio buttons to display report templates, SQL files, and images, finished 
reports, and assorted files. 

Selecting the Report Template radio button will display installed report templates. ThinManager installs a 
variety of templates. New templates can be downloaded from www.thinmanager.com. 

Selecting the Install button will launch a file browser to install new templates. Selecting the Delete button 
will delete a highlighted report. 
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Open File Window 

Navigated to the desired template, highlight the file, and select Open. This will install the template and 
close the file browser window. 
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Reports Window – SQL Files 

Selecting the SQL Files radio button will display installed SQL queries. ThinManager installs a variety of 
SQL queries as companions to the report templates. New SQL queries for new reports can be 
downloaded from www.thinmanager.com.  

Selecting the Install button will launch a file browser to install new SQL queries. Selecting the Delete 
button will delete a highlighted SQL query. 

 

Reports Window – Images, Finished Reports, etc. 
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Selecting the Images, Finished Reports, and etc. radio button will display installed images and reports.  

Selecting the Install button will launch a file browser to install new images. Selecting the Delete button 
will delete a highlighted image, report, or file. This is a handy way do delete older copies of backed up 
reports and configurations that were saved using the Scheduler. See System Schedule for details. 

Selecting the OK button will close the Reports window. 

7.4 Tools 
Tools contain commands that affect the terminals. 

7.4.1 Restart Terminals 
Tools > Restart Terminals will perform an intelligent restart of a terminal. It will load any changes to the 
configuration, modules, firmware, and reconnect them to the terminal server without cycling power to the 
terminal, unless it is needed to reload the firmware. 

Note: Restarting a terminal does not close the session on the terminal server nor does it unlock a frozen 
session. It reloads changes independent of the session on the terminal server. It will reconnect to the 
same session without changing the session. 

 Highlight a terminal in the ThinManager tree pane and select this command to restart a 
terminal.  

 Highlight a group in the ThinManager tree pane and select this command to restart all the 
terminals of the group. 

 Highlight a ThinManager Server in the ThinManager tree pane and select this command to 
restart all the terminals on the ThinManager Server. 

7.4.2 Reboot Terminals 
Tools > Reboot Terminals will cycle the power to the terminal, reloading the firmware and configuration, 
and reconnect it to the terminal server. The function of this command has been largely replaced by the 
Restart Terminal command. 

Note: Rebooting a terminal does not close the session on the terminal server nor does it unlock a frozen 
session. It reboots and reloads the firmware and configuration independent of the session on the terminal 
server. It will reconnect to the same session without changing the session. 

 Highlight a terminal in the ThinManager tree pane and select this command to reboot a 
terminal.  

 Highlight a group in the ThinManager tree pane and select this command to reboot all the 
terminals of the group. 

 Highlight a ThinManager Server in the ThinManager tree pane and select this command to 
reboot all the terminals on the ThinManager Server. 

7.4.3 Reboot Terminal Server 
Tools > Reboot Terminal Server will send a command to restart the highlighted terminal server.  

 Highlight a terminal server in the ThinManager tree pane and select this command to restart 
a terminal server.  
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Caution: Reboot Terminal Server will restart the terminal server and log off all sessions without giving 
users a chance to save their data. Use wisely. 

7.4.4 Disable Terminals 
The Disable Terminal command will disable any highlighted Group or Terminal by displaying a lockout 
screen. The terminal will wait until it is enabled with the Tools > Enable Terminal function to be 
functional again. This allows terminals to be locked down for security reasons, or to prevent the terminals 
from accessing the terminal servers. 

Highlighting a Terminal Server, or Group in the ThinManager tree and selecting Tools > Disable 
Terminal will disable every terminal assigned to it. 

 

Disabled Terminal Icons 

If a Group or Terminal is disabled using the Tools > Disable function, it will be displayed with a red X 
over the terminal icon. An entire ThinManager Server or an entire Group can be disabled, but only the 
terminal icons will show the X, not the ThinManager Server icon or the Group icons. 

Once a terminal is disabled, a disabling screen will appear on the terminal until the terminal has been 
enabled. 

 

Disabled Terminal Screen – Logged On 

A logged on terminal will display a screen indicating that the terminal is disabled.  
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Disabled Boot Screen 

Terminals that are booted while disabled will halt on a blue screen indicating that the terminal is disabled.  

7.4.5 Enable Terminals 
The Enable Terminal command will remove the disabling from a highlighted Group or terminal and allow 
it to continue functioning or resume the boot process. 

7.4.6 Disable Terminal Server 
The Disable Terminal Server command will disable all connections from the selected terminal server to 
all thin clients logged onto that server. The sessions will be disconnected but not reset.  

 

Disabled Terminal Server 

This is useful in updating terminal servers. Clients can be disconnected and have their sessions logged 
off, allowing the server can be updated. Once it is updated in can be enabled to allow client to connect to 
it again. 
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7.4.7 Enable Terminal Server 
The Enable Terminal Server command will enable a disabled terminal server to allow connections from 
thin clients.  

7.4.8 Calibrate Touch Screen 
ThinManager has a touch screen configuration utility that can calibrate a thin client touch screen. The 
utility can be started three ways:  

 On the thin client, select Start > Program Files > Automation Control Products > 
Calibrate Touch Screen (or Start > Program Files > ACP > CalTouchScreen). This is 
useful because it allows the operator to calibrate the touch screen without administrative 
support. 

 On the ThinManager Server, highlight the desired terminal in ThinManager and select Tools 
> Calibrate Touch Screen from the menu bar. This will launch the calibration on the selected 
terminal.  

 The Calibration Touch Down Time (seconds) setting on the touch screen module will allow 
the calibration to be triggered by holding a finger on the touch screen for the amount of time 
set in the parameter. See Touch Screen Modules for details. 

 The TermMon ActiveX can be configured to launch the calibration program. See TermMon 
ActiveX Control for details. 

 

Touch Screen Calibration Screen 

A new touch screen calibration program was released with ThinManager 2.6 and is included in the 2.6 

and later touch screen modules. When the calibration is run, a “+” appears in the lower left. Touch the 

center of the + and then touch the center of the other four +s as they appear. This provides touch 
screen mapping for the terminal.  

Note: The touch screen module must first be added through the Module page in the Terminal 
Configuration wizard. 
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To launch the calibration program from the Start menu from within the session requires that the 
ThinManager Utilities be installed on each terminal server. See Standard ThinManager Installation in 
Windows for details. 
 

7.4.9 Send Message  
Send Message will send a message to a highlighted terminal.  

 
Send Message Window  

Enter the message into the Message text box. The Message Title can be changed, if desired. 

Select the OK button to send or the Cancel button to cancel. 

 
Send Message Window 

When a message is sent, an ACP splash screen will be displayed with the message until the message is 
acknowledged. 
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7.4.10 Clear Event Log  
Selecting Clear Event Log will clear the event log. The event log is configured the ThinManager Server 
Configuration Wizard that is launched by double-clicking on the ThinManager in the tree or highlighting 
the ThinManager and selecting Edit > Modify from the menu. 

7.5 View 

7.5.1  Status Bar 
The Status Bar shows advice and comments on the bottom of the ThinManager window. When the 
Status Bar command is checked, the Status Bar text is visible. When the Status Bar command is 
unchecked, the Status Bar text is invisible. 

7.5.2 Show Connected Only 
View > Show Connected Only, if checked, will simplify the tree by removing unconnected terminals, 
terminal servers and terminal server groups. 

7.5.3 Reports (Selection) 
View > Reports will open the Select Reports window.  

 

Select Reports Window 

The Select Reports window allows the selection of the default report that will display when the Report tab 
is selected for a ThinManager Server, terminal, terminal server, or TermSecure user. 

The default reports can be changed by selecting a different report in the drop-down boxes. 

See Reports for details. 
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7.5.4 Print 
View > Print will print the highlighted tab of the Details pane. 

 

Print Reports 

A Print dialog box will appear to allow the selection of the printer and the desired number of copies. 
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7.5.5 Options 
Selecting Options will launch the Options dialog box. 

 

Options 

The Display “Create New Terminal” dialog for unknown terminals check box, if selected, will launch 
the Terminal Configuration Wizard on the ThinManager Server when a new terminal is added. 

The Display “Create New User” dialog for unknown users check box, if selected, will launch the 
TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB 
key or ID card) is read by a terminal. 

Note: Checking the Display “Create New User” dialog for unknown users check box is useful for 
assigning ID cards to TermSecure Users. See Card and Badge Configuration for a TermSecure User for 
details. 

The Minimize to the System Tray checkbox will send the ThinManager icon in the system tray when 
ThinManager is minimized.  

Warn if license will expire within __ day(s) will set the warning period before license expiration. This is 
useful for time-limited demonstration and Trialware licenses. 

7.6 RemoteView 

7.6.1 Interactive Shadow 

Interactive Shadow, if checked, allows Administrators and members of the ThinManager Security 
Groups that have interactive shadow permissions to interact and control a shadowed terminal session. If 
this value is unchecked the sessions will be viewable, but observers cannot take control of the session. 
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7.6.2 Scaled to Window 
Scaled to Windows, if checked, will scale the shadowed terminal session to fit the Details pane of 
ThinManager. If this value is unchecked the session will be viewed regular-sized, requiring the use of 
scroll bars to view portions of the screen. 

7.6.3 Go FullScreen  
This allows the connection from the Connect tab on ThinManager to the terminal server to be displayed 
full screen instead of in a window in ThinManager. 

This session can be switched to full-screen by selecting RemoteView > Go FullScreen in the menu. This 
changes the appearance from running from within a window to running as a desktop. 

The full screen session will have a tool tab at the top of the screen with controls that allow the window to 
be switched back to the window or to close the connection. 

 

Remote Session Tool Bar 

The standard Minimize, Maximize, and Close icons on the Remote Session Tool Bar allow control over 
the session. 

The hot keys of CTL+ALT+BREAK will allow you to switch to full screen mode or to exit full screen mode. 

7.6.4 Connect Options  
Selecting RemoteView > Connect Options will launch the Terminal Server Connect Options window that 
allows the terminal server Remote View connection to be configured. 

 

Terminal Server Connect Options 

The Video Settings include: 
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 Video Mode – This allows the connection to be displayed at a specific resolution or as full 
screen. 

 Width – This allows the connection to be displayed at a specific width if the Video Mode is 
set to Custom. 

 Height – This allows the connection to be displayed at a specific height if the Video Mode is 
set to Custom. 

 Color Depth - This allows the connection to be displayed at a specific color depth. Windows 
2003 is required for high-color. 

The Access Options include: 

 Allow Auto-Login – This allows the connection to login without prompting when checked. It 
will use the login information that is entered on the Terminal Server Name page of the 
Terminal Server Wizard. 

 Allow Access to Local Drives – This allows the user to access the hard drive on the remote 
computer from the remote connection.  

 Connect To Console – This allows the ThinManager user to capture the console session for 
display through ThinManager instead of starting a new session on the terminal server. 

7.6.5 Send Key  
Send Key allows the sending of key commands to the shadowed session that are normally saved for the 
local machine and don’t function in shadowing. These include:  

 CTLL+ALT+DEL 

 CTL+ESC 

 ALT+Tab 

 ALT+Shift+Tab 

 ALT+ESC 

 ALT+Space. 

Select RemoteView > Send Key and the desired key combination to send the key command to the 
shadowed session. 

Note: The Key Block module will block this command if it is used on the terminal. See Key Block Module 
for details. 

 

7.7  Help 

7.7.1  Help Topics 
Selecting Help Topics will launch the ThinManager Help file. This file can also be launched by selecting 
F1 while using ThinManager. 

7.7.2  About ThinManager… 
Selecting About ThinManager will display a dialog box with ThinManager version information, copyright 
information, and contact information for ThinManager. 
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7.8 Right Click Menus in the Tree Pane 

7.8.1 Right Click on the ThinManager Server Icon 
 Reconnect - This causes the ThinServer service to try to reconnect to the highlighted 

ThinManager Server. 

 Modify - This launches the ThinManager Server Configuration Wizard to configure the 
highlighted ThinManager Server. 

 Remove - This removes the highlighted ThinManager Server from the tree. It does not 
remove any configuration or uninstall the program. 

 See Add ThinManager Server for details. 

7.8.2 Right Click on the Terminals Branch Icon 
 Add Terminal - This launches the Terminal Configuration Wizard to create a terminal. 

 Add Group - This launches the Terminal Group Configuration Wizard to create a group. 

 Restart Terminals - This sends a signal to all the terminals to reload any changes to its 
configuration, modules, or firmware. It will only do a full reboot if needed. 

7.8.3 Right Click on a Terminal Group Icon 
 Add Terminal - This launches the Terminal Configuration Wizard to create a terminal in 

the group. 

 Add Group - This launches the Terminal Group Configuration Wizard to create a group. 

 Restart Terminals - This sends a signal to all the terminals under the highlighted icon to 
reload any changes to its configuration, modules, or firmware. It will only do a full reboot if 
needed. 

 Modify - This launches the Terminal Group Configuration Wizard to configure the 
highlighted group. 

 Rename - This allows the Group to be renamed. 

 Delete - This removes the Group from the ThinManager configuration. Member terminals can 
be deleted with the group, or moved out of the group, depending on the choice in the 
confirmation window. 
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Delete Group confirmation Window 

Selecting Yes will delete the Group and all member terminals. 

Selecting No will delete only the group. The member terminals will be moved out of the group and retain 
their configuration as individuals. 

Selecting Cancel will stop the process and allow the group to remain as it is. 

7.8.4 Right Click on a Terminal Icon 
 Modify - This launches the Terminal Configuration Wizard to configure the highlighted 

terminal. 

 Rename - This allows the terminal to be renamed. 

 Delete - This removes the terminal from the ThinManager configuration.  

 Go to TermSecure User - This changes the focus of the tree to the TermSecure User that is 
logged into the terminal. 

 Restart Terminal - This sends a signal to the terminal to reload any changes to the 
configuration, modules, or firmware. It will only do a full reboot if needed. 

7.8.5 Right Click on the Display Servers Terminal Servers Branch 
Icon 

 Add Terminal Server - This launches the Terminal Server Wizard to create and configure a 
new terminal server. 

 Add Virtual Terminal Server - This launches the Terminal Server Wizard and allows you to 
import a virtual terminal server from a configured VCenter Server. 

 Edit Terminal Server - This launches the Terminal Server List Wizard to allow the 
configuration of an existing terminal server. 

See Terminal Services Display Servers for details 

7.8.6 Right Click on a Terminal Server Icon 
 Modify - This launches the Terminal Server Configuration Wizard to allow changes to the 

configuration of the highlighted terminal server. 

 Rename - This allows the terminal server to be renamed. 

 Delete - This removes the terminal server from the ThinManager configuration.  
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Terminal Server Deletion Confirmation 

ThinManager will prompt for confirmation before deletion. 

 

Terminal Server Deletion Error 

A terminal server cannot be deleted from a configuration if it still has terminals assigned to it. 

 Restart Terminals - This sends a signal to the terminal to reload any changes to all terminals 
connected to the terminal server. It will only do a full reboot if needed. 

7.8.7 Right Click on the Display Servers Cameras Branch Icon 
 Add Camera - This launches the Camera Server Wizard to define an IP camera as a 

display server. 

 Add Camera Group - This launches the Camera Server Wizard and allows you apply group 
settings to member cameras to speed the configuration process. 

7.8.8 Right Click on a Camera Icon 
 Modify - This launches the Camera Server Configuration Wizard to allow changes to the 

configuration of the highlighted camera. 

 Rename - This allows the camera to be renamed. 

 Delete - This removes the camera from the ThinManager configuration.  

7.8.9 Right Click on the VCenter Servers Branch Icon 
The branches of the VCenter Server tree have various right-click menus: 

 VCenter Servers:  

o Add vCenter Server – Launches the VCenter Server Property Wizard to allow a 
VCenter Server to be defined. 
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 Defined VCenter Servers:  

o Remove – Removes the defined VCenter Server. 

 Imported Datacenter:  

o Rename – Allows you to rename the datacenter. 

o Delete – Allows you to delete the datacenter. 

 Virtual Machine:  

o Power Operations: 

 Power On – Turns on a stopped or suspended virtual machine. 

 Power Off – Turns off a stopped or suspended virtual machine. 

 Suspend – Suspends a running virtual machine and stores the state. 

 Reset – Cycles power to the virtual machine to restart the virtual machine. 

o Snapshot: 

 Take Snapshot – Captures and stores the state of the virtual machine. 

 Revert to Current Snapshot – Reapplies the stored state of a previously saved 
virtual machine. 

 Snapshot Manager – Launches the Snapshot management tool. 

o Rename – Allows the virtual machine to be renamed. 

o Remove from Inventory – Removes the virtual machine from the tree without deleting 
the files. 

o Delete – Removes the virtual machine from the tree AND deletes the file system. 

7.8.10 Right Click on the Display Client Branch Icon 
 Add Display Client- This launches the Display Client Wizard to create and configure a new 

Display Client. 

 Edit Display Client- This launches the Display Client List to allow the configuration of an 
existing Display Client. 

See Display Client List for details. 

7.8.11 Right Click on a Display Client Member Icon 
 Modify - This launches the Display Client Configuration Wizard to allow changes to the 

configuration of the highlighted Display Client. 

 Rename - This allows the Display Client to be renamed. 

 Delete - This removes the Display Client from the ThinManager configuration.  
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Terminal Services Display Client Deletion Confirmation 

ThinManager will prompt for confirmation before deletion. 

 
Display Client Deletion Error 

A Display Client cannot be deleted from a configuration if it still has terminals assigned to it. 

7.8.12 Right Click on the TermSecure Users Branch 
 Add TermSecure User – This launches the TermSecure User Configuration Wizard to 

allow a TermSecure User to be defined. 

 Add TermSecure User Group – This launches the TermSecure User Group 
Configuration Wizard to allow a TermSecure User Group to be defined. 

7.8.13 Right Click on a TermSecure Users Group Icon 
 Add TermSecure User – This launches the TermSecure User Configuration Wizard to 

allow a TermSecure User to be defined. 

 Add TermSecure User Group – This launches the TermSecure User Group 
Configuration Wizard to allow a TermSecure User Group to be defined. 

 Modify - This launches the TermSecure User Group Configuration Wizard to allow 
changes to the configuration of the highlighted TermSecure User Group. 

 Rename - This allows the TermSecure User Group to be renamed. 

 Delete - This will remove the TermSecure User Group from the ThinManager configuration. 
Members can be deleted with the group or moved out of the group, depending on the choice 
in the confirmation window. 
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Delete Group Confirmation Window 

Selecting Yes will delete the Group and all members. 

Selecting No will delete only the group. The members will be moved out of the group and retain their 
configuration as individuals. 

Selecting Cancel will stop the process and allow the group to remain as it is. 

7.8.14 Right Click on a TermSecure Users Icon 
 Modify - This launches the TermSecure User Configuration Wizard to allow changes to 

the configuration of the highlighted TermSecure User. 

 Rename - This allows the TermSecure User to be renamed. 

 Delete - This removes the TermSecure User from the ThinManager configuration.  

 Logoff User – This logs the TermSecure User out the terminal that it is currently logged into. 

 Go to Terminal - This changes the focus of the tree to the terminal that the TermSecure 
User is logged into. 
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8 Adding Thin Client Hardware 

8.1 The Boot Process 
 

There are two methods that an ACP Enabled thin client can use to boot. The standard method is to 
connect to a ThinManager Server and download the firmware and its configuration across the network. 
This allows for an easy update of the firmware and ensures that all the terminals share the same 
firmware. Embedded ThinManager Ready thin clients have the firmware embedded in them on a compact 
flash or disk-on-chip and boot locally then connect to a ThinManager Server to download its configuration. 
See Firmware Update (Disk On Chip / Compact Flash) Update Module for details. 

A ThinManager Ready thin client goes through a number of steps from the initial power on to the 
complete connection to a terminal server. Understanding this process will aid in terminal configuration 
and troubleshooting.  

The steps are: 

POST: Once a ThinManager Ready thin client is turned on it begins the Power On Self-Test to examine 
the hardware and to test the memory.  

IP Address Assignment: The terminal needs an IP address to connect to the network. By default, it 
receives an IP Address from a DHCP server, but this can be changed to use an assigned static IP. See 
IP Address Assignment for details. 

ThinManager Server Connection: After receiving an IP address the terminal will connect to the 
ThinManager Server. This is the Boot Server Host as defined in the DHCP scope Option 066 or the 
Primary ThinManager Server defined in the static IP address configuration.  

Firmware Loading: Next the terminal will download the firmware from the ThinManager Server.  

Terminal Configuration Download: Established terminals will receive their configuration and proceed. 
New terminals will need to be defined on the ThinManager Server, either through the Terminal 
Configuration Wizard or the Create New Terminal method. 

ACP ThinManager Logo Screen: After the terminal receives its configuration, it will display an ACP 
splash screen with the ThinManager logo.  

Client Communication Connection: Next the terminal will launch its Client Communication protocol.  

Terminal Server Connection: The thin client will connect to the terminal server(s) that it is assigned to in 
its configuration. 

Windows Login: Next the terminal will display the Windows Login dialog box, prompting for a valid 
username and password. If these have been entered into the username and password fields on the 
Terminal Configuration Wizard of ThinManager, the terminal will login automatically and display the 
Windows desktop or a defined initial program.  
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Note: Windows 2000 prevents auto-login with RDP by default. To allow auto-login see RDP-tcp Login 
Settings for details. 

Windows Session: The terminal logs onto a session on terminal server. The terminal will pass mouse 
clicks and keystrokes to the session on the terminal server. The terminal server will process the data and 
send the graphics back to the terminal for display, giving a full Windows experience to the user. 

8.2 IP Address Assignment 
ThinManager Ready thin clients are set by default to automatically receive an IP address from a DHCP 
server. Most ThinManager Ready thin clients may use a manually assigned Static IP address instead.  

Note: The ThinAdapter and ThinAdapter Plus require DHCP. 

8.2.1 DHCP 
ThinManager Ready thin clients are set to use DHCP (Dynamic Host Configuration Protocol) by default. 
The DHCP Server needs two options configured for ThinManager Ready thin clients. 

 

DHCP Options 

Option 066 - Boot Server Host Name must be set to the IP address of the ThinManager Server. If 
redundant ThinManager Servers are being used, the IP addresses of multiple ThinManager Servers can 
be entered, separated with a space. 

Option 067 - Bootfile Name must be set to firmware.acp. 
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Details are at DHCP Server Setup for details. 

ThinManager Ready thin clients use DHCP (Dynamic Host Configuration Protocol) by default. If they have 
been set to use a static IP they can be reset to DHCP from static IP by pressing any key when prompted 
during the boot sequence to open the IP Configuration Menu.  

 

IP Configuration Menu - DHCP 

Press the A key to allow a change to DHCP  and enter D key to set the configuration to DHCP. Press the 
Enter key to return to main menu. 

Press the S key to save the configuration and continue with the boot process. 

 

Boot Process - Firmware Download 

The terminal will connect to the ThinManager Server and download the firmware. 

The download bar will be purple if the terminal is using Multicast during the download. See MultiCast 
Configuration Page for details. 
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8.2.2 Static IP 
Most models of ThinManager Ready thin clients allow the usage of static IPs. These are set by 
interrupting the boot process to launch the IP Configuration Menu and adding the static IPs.  

 

Boot Process - Press Any Key Prompt 

To set the terminal to use a static IP, press any key at the appropriate moment of the boot sequence. 

 

IP Configuration Menu – Static IP 

Press the A to allow the client IP to change from DHCP. 

Type in the static IP address for the client, including the separating periods and press the Enter key. 
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IP Configuration Menu - Options 

Once the Terminal has a static IP assigned, the IP Configuration Menu will be shown to allow the setting 
of other values. 

 (A) Terminal IP Address - This should be a unique address for the terminal. 

 (B) Primary ThinManager Server IP Address - This should be the unique address for your 
main ThinManager Server. 

 (C) Secondary ThinManager Server IP Address - The Secondary ThinManager field allows 
the terminal to use two ThinManager Servers. If the terminal cannot connect to the Primary 
ThinManager Server, it will connect to the Secondary ThinManager Server to receive its 
configuration. If you are not using a Secondary ThinManager Server, set the IP address to 
0.0.0.0. 

 (D) Router IP Address - Fill in the IP address of the router or gateway if one is being used. If 
not this should be set to 0.0.0.0. 

 (E) Subnet Mask - Set this to your subnet mask. 255.255.255.0. is a standard setting. 

 (F) Password Status - Allows a password to be set to prevent unauthorized people from 
changing the configuration.  

 (H) Help - Will launch a Help to explain the IP Configuration Menu. 

 (Q) Abort Changes and Exit - This will cancel any setting changes and let the terminal 
continue to boot with the old settings. 

 (S) Save Changes and Exit - This will apply any changes and allow the terminal to continue 
to boot with the new settings. 

Type the letter of the desired setting and type the IP address, with periods. Press the Enter key on the 
keyboard to accept each change. 

Once configured the terminal will connect to the ThinManager Server and download the firmware and 
configuration. 

8.2.3 Hybrid IP Addressing  
ThinManager Ready thin clients that have BootROM version 5.01 or later have the ability to use DHCP for 
the client IP address and have the ThinManager Server IP addresses entered as static IPs to save having 
to configure the DHCP server with Option 066. 
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Selecting any key when prompted during bootup opens the IP Configuration Menu. 

  

Boot Loader v5.01 Default Values 

Typing the B key will allow the configuration of a static IP for the ThinManager Server. Type the numbers 
and periods for the address. 

 

DHCP with Static ThinManager Server 

Once a ThinManager Server is assigned, typing C will allow a redundant secondary ThinManager Server 
to be assigned. 

Type S to save the changes and allow the connection to the ThinManager Server. The terminal will now 
boot using DHCP. 

Note: The Escape key will let you exit the entry field and return to the IP Configuration Menu. 
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8.3 Configuring New Hardware 
The configuration of terminals is done in ThinManager on the ThinManager Server and not on each 
individual terminal. When a new, undefined ThinManager Ready Thin Client is first connected to a 
ThinManager Server one of three things will happen: 

 If the ThinManager Server has no terminals that are configured and offline, then the terminal 
will go into the Create New Terminal Mode and launch the Terminal Configuration Wizard 
on the ThinManager Server. Once the terminal is configured on the ThinManager Server it 
will automatically download its configuration upon boot up. 

 If the ThinManager Server has terminals that are created and offline, the terminal will go into 
Replace or Create Mode and list the offline terminals that are available for selection. Once a 
configuration is selected, the terminal will take that identity. During any following boot up the 
terminal will automatically download its configuration. 

 A third scenario is to use the Auto-Create Terminal Mode to create an array of terminals.  

8.4 Create New Terminal Mode  
Turning on a terminal for the first time will initiate the Create New Terminal mode if: 

 No terminals are defined in ThinManager, or  

 All the defined terminals are currently connected, or 

 All the defined terminals that are turned off have the Allow This Terminal To Be Replaced If 
Off Line check box unselected. 

 

Create New Terminal Mode Screen 

When a terminal enters the Create New Terminal Mode, the terminal will launch the Terminal 
Configuration Wizard on the ThinManager Server. The terminal will display a screen indicating that it will 
wait until the configuration is finished before progressing further.  

8.5 Replace or Create New Terminal Mode 
Turning on a terminal for the first time will initiate the Replace or Create New Terminal Mode if one or 
more of the defined terminals are offline and they have the Allow This Terminal To Be Replaced If Off 
Line check box selected. 
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Replace or Create Mode 

The screen will display all the offline terminals that the terminal can replace. Highlight the desired terminal 
name using the keyboard and press the Enter button. The terminal will retrieve the selected configuration 
and assume its identity.  

8.6 Auto-Creation of Terminals 
Auto-Create allows new terminals to be created and configured in an array, using the Default Terminal 
as a template. 

Turning on a terminal for the first time will initiate the Replace or Auto-Create Terminal mode if: 

 The Auto-Create mode is enabled by the selection of the Enable AutoCreate check box on 
the Unknown Terminal page of the ThinManager Server Configuration Wizard. 
The ThinManager Server Configuration Wizard is launched by selecting Manage > 
Settings from the ThinManager menu. 

And 

 The Default terminal is configured as a template for the new terminals.  
This is done by selecting Manage > Configure Default Terminal on the ThinManager menu. 

And 

 The user selects Auto-Create from the Replace or Action Menu as the terminal boots and 
connects. The user can do a replacement instead of Auto-Create. 

 

8.6.1 Enabling AutoCreate 
Open the ThinManager Server Configuration Wizard by right clicking on the ThinManager Server in the 
tree and selecting Modify, or select Manage > Settings from the menu. 

The terminal will be given the name of the Auto-Create Mask and a number, starting with “0”. The Auto-
Create Mask is configured on the Unknown Terminals page of the ThinManager Server Configuration 
Wizard.  
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Unknown Terminals 

Check the Enable AutoCreate checkbox and enter an AutoCreate Mask name. This allows new 
terminals to be added to the system and configured without additional input from the server.  

8.6.2 Configuring Default Terminal 
The Default Terminal is created by selecting Manage > Configure Default Terminal. This will launch the 
Terminal Configuration Wizard for a terminal pre-named “Default”.  
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Default Terminal Configuration 

Configure the terminal with the desired settings. The Default terminal can be added to a Group by 
selecting the Change Group button. 

Once the wizard is finished, the Default terminal will be displayed in the ThinManager Server tree. 
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ThinManager Tree with Default Terminal 

Once the Enable AutoCreate check box on the Server Properties window is checked and the Default 
Terminal is created and configured, any new terminal connected to the ThinManager Server will have 
AutoCreate Terminal as an option. 

 

Replace or Action Menu 

The user needs to scroll to AutoCreate Terminal and press the Enter key to automatically create and 
configure the terminal. 

The new terminal will be given the AutoCreate Mask and a number, starting at 0, for its name. This name 
will also be entered in the Username field of the Log In Information page of the Terminal 
Configuration Wizard. 
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9 Configuration Wizards 

9.1 Introduction to Wizards 
ACP ThinManager uses wizards for configuration. Wizards take two forms. 

 List Wizards associate Terminal Servers and ThinManager Servers with their IP addresses 
or assign server functions to groups of Terminal Servers. 

 Configuration Wizards set the parameters and options for individual terminals, groups of 
terminals, Display Servers, Display Clients, TermSecure Users, and TermSecure Server 
Groups. This is where the terminals and TermSecure Users have their settings defined. 

This help will list the wizards in the following order: 

 ThinManager Server List  

 ThinManager Server Configuration Wizard  

 DNS Configuration  

 PXE Server Configuration Wizard 

 Terminal Configuration Wizard 

 Terminal Group Configuration Wizard 

 Display Server Configuration Wizards 

 Terminal Services Display Servers  

 Camera Configuration Wizard 

 VCenter Server Configuration Wizard 

 Display Client Configuration Wizards 

 Terminal Services Display Clients 

 Camera Display Clients 

 Terminal Shadow Display Clients 

 TermSecure Configuration 

 TermSecure User Configuration Wizard 

 TermSecure Users Group Configuration Wizard 
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9.1.1 List Wizards 
The List Wizards are:  

Terminal Server List – Used to show defined Terminal Servers, or Terminal Services Display Servers. 
The Terminal Server Configuration Wizard can be launched from here. Launched by: 

 Expanding the Display Server branch, right clicking on the Terminal Servers icon, and 
selecting Edit Terminal Server List. 

See Terminal Services Display Servers for details.  

Display Client List – Used to show defined Display Clients. The Display Client Configuration Wizard 
can be launched from here. Launched by: 

 Right clicking on the Display Client icon, and selecting Edit Display Client List. 

See Display Client List for details 

ThinManager Server List – Used to define ThinManager Servers and setup Automatic Synchronization. 
Launch by: 

 Selecting Manage > ThinManager Server List. 

See ThinManager Server List for details. 

 

9.1.2 Configuration Wizards 
The Configuration Wizards are:  

Domain Name Server Wizard – Used to configure DNS, if needed. Launched by: 

 Selecting Manage > DNS Configuration. 

See DNS Configuration for details. 

PXE Server Configuration Wizard – Used to configure ThinManager for use with PXE thin clients.  
Launched by: 

 Selecting Manage > PXE Server. 

See PXE Server Configuration Wizard for details. 

ThinManager Server Configuration Wizard – Used to configure global ThinManager properties like 
scheduling, e-mail notification, and user access. Launched by: 

 Double clicking on the ThinMan icon. 

 Right clicking on the ThinMan icon and selecting Modify. 

 Highlighting the ThinMan icon and selecting Edit > Modify. 

See ThinManager Server Configuration Wizard for details 

Terminal Configuration Wizard – Used to configure Terminals, both thin clients and PCs with WinTMC 
installed. Launched by: 

 Selecting Edit > Add Terminal in the menu. 

 Right clicking on the Terminals branch icon and selecting Add Terminal. 

 Double clicking on an existing terminal icon. 

See Terminal Configuration Wizard for details. 
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Terminal Group Configuration Wizard – Used to configure groups of Terminals, both thin clients and 
PCs with WinTMC installed. Launched by: 

 Selecting Edit > Add Terminal Group in the menu. 

 Right clicking on the Terminals branch icon and selecting Add Group. 

 Double clicking on an existing terminal group icon. 

See Terminal Group Configuration Wizard for details. 

Terminal Server Wizard – Used to define and configure Terminal Servers. Launch by: 

 Expand the Display Server branch, right click on the Terminal Servers icon and select Add 
Terminal Server 

 Double clicking on an existing Terminal Server icon. 

Camera Configuration Wizard - – Used to define and configure IP cameras as Display Servers. Launch 
by: 

 Expand the Display Server branch, right click on the Cameras icon and select Add Camera. 

 Double clicking on an existing Cameras icon. 

See Camera Configuration Wizard for details 

VCenter Server Wizard - Used to create and configure VCenter Servers. These are virtual machines 
managed by VMWare’s vCenter Server. Launch by: 

 Highlighting the VCenter Server branch, right clicking, and selecting Add VCenter Server. 

Display Client Wizards - Used to create and configure Display Clients. These include the Terminal 
Services, Camera, Terminal Shadow, and Workstation Display Clients. Launch by: 

 Highlighting the Display Clients branch, right clicking, and selecting Add Display Client. 

 Expanding the Display Clients branch, highlighting Terminal Services, right clicking, and 
selecting Add Display Client. 

 Expanding the Display Clients branch, highlighting Camera, right clicking, and selecting 
Add Display Client. 

 Expanding the Display Clients branch, highlighting Workstation, right clicking, and selecting 
Add Display Client. 

 Expanding the Display Clients branch, highlighting Terminal Shadow, right clicking, and 
selecting Add Display Client. 

 Double clicking on an existing Display Client icon. 

See Display Client Configuration Wizard for details 

TermSecure User Configuration Wizard – Used to define and configure TermSecure Users. Launch by: 

 Highlighting the TermSecure User branch, right clicking, and selecting Add TermSecure 
User. 

 Double clicking on an existing TermSecure User icon. 

See TermSecure User Configuration Wizard for details. 

TermSecure User Group Configuration Wizard – Used to define and configure TermSecure User 
Groups. Launch by: 

 Highlighting the TermSecure User branch, right clicking, and selecting Add TermSecure 
User Group. 

 Double clicking on an existing TermSecure User Group icon. 

See TermSecure Users Group Configuration Wizard for details. 
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9.2 ThinManager Server List 
Selecting Manage > ThinManager Server List will launch the ThinManager Server List Wizard to allow 
the definition of ThinManager Servers. The definition of ThinManager Servers allows the connection to 
remote ThinManager Servers and allows the synchronization of ThinManager Server configurations. 

Multiple ThinManager Servers should be synchronized so that a terminal will receive the same 
configuration regardless of the ThinManager Server that it boots from. 

Automatic Synchronization will connect all of the configuration databases on the ThinManager Servers 
in this list and keep them synchronized so that a change on one is a change on all. See Auto-
Synchronization Selection Page for details. 

Manual Synchronization requires a user to synchronize the configurations after each configuration 
change. See Synchronize Configuration for details. 

 

ThinManager Server List Wizard - Introduction 

Importance of Page: This displays introductory information 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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9.2.1.1 Auto-Synchronization Selection Page 

 

Auto-synchronization Selection 

Importance of Page: Enables Auto-synchronization. 

Settings: 

 Automatic Synchronization – Check this to initiate auto-synchronization. 

Why Change from Default Settings: Auto-synchronization is required for Mirrored licenses and 
Redundant Licenses. It also makes sure that redundant ThinManager Servers have the same 
configuration. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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9.2.2 Automatic Synchronization 
Multiple ThinManager Servers should be synchronized so that a terminal will receive the same 
configuration regardless of the ThinManager Server that it boots from. 

Automatic synchronization is required for Mirrored licenses, Redundant licenses, and Enterprise Server 
licenses  

 

Auto-synchronization Selection 

Select the Automatic Synchronization checkbox and select the Next button to configure Auto-
synchronization. 
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9.2.2.1 Automatic Synchronization Configuration 

 

Auto-synchronization Configuration 

Importance of Page: Defines and displays the Primary and Secondary ThinManager Servers. This 
allows a terminal to boot from a backup if the primary fails. 

Fields: 

 Name (Primary ThinManager Server) – This field is for the NetBIOS name of the Primary 
ThinManager Server. Use its real name and not a shortcut or nickname. The name is entered by 
using the Edit button.  

 IP Address (Primary ThinManager Server) – This field is for the IP address of the Primary 
ThinManager Server. It is entered by using the Edit button. 

 Name (Secondary ThinManager Server) – This field is for the NetBIOS name of the Secondary 
ThinManager Server. . Use its real name and not a shortcut or nickname. The name is entered by 
using the Edit button. 

 IP Address (Secondary ThinManager Server) – This field is for the IP address of the 
Secondary ThinManager Server. It is entered by using the Edit button. 

Buttons: 

 Edit (Primary ThinManager Server) – This button launched the Enter the Primary 
ThinManager Server Information Window that is used to define the primary ThinManager 
Server. 
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 Edit (Secondary ThinManager Server) – This button launched the Enter the Secondary 
ThinManager Server Information Window that is used to define the backup ThinManager Server. 

Why Change from Default Settings: The Name and IP address of both ThinManager Servers need to 
be defined for auto-synchronization to work. 

9.2.2.2 Defining the ThinManager Servers 

Select each Edit button on the Auto-synchronization Configuration page to launch the Enter 
ThinManager Server Information Window for each ThinManager Server.  

 

Enter ThinManager Server Information Window 

Enter the name of the ThinManager Server in the ThinManager Server field. 

Enter the IP address of the ThinManager Server. The Discover button will enter the IP address for you. 

Select the OK button to accept the settings or the Cancel button to close without saving. 
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Auto-synchronization Configuration 

When complete, the Auto-synchronization Configuration window will show the Primary and Secondary 
ThinManager Servers. This will automatically synchronize their configuration so that a terminal will receive 
the same configuration regardless of the ThinManager Server that it boots from. 

Additionally, the status lights for the terminals will be displayed in the trees of both ThinManager Servers. 

Select Finish to save and close, or Cancel to close without saving. 



 

ACP ThinManager 6.0 Configuration Wizards    147 

9.2.3 Defining ThinManager Servers for Manual Synchronization 

9.2.3.1 ThinManager Server List Page 

 

ThinManager Server List - Blank 

Importance of Page: This page allows ThinManager Servers to be defined. 

The ThinManager Server List is the collection of ThinManager Servers on the network. These include 
ThinManager Servers that the terminal will communicate with to keep the connection status lights in the 
ThinManager tree updated. It also allows access to remote ThinManager Servers that allow network wide 
monitoring, control, and management.  

Fields: 

 List Box (Unlabeled) – The list box will display a list of defined ThinManager Servers and their 
IP addresses.  

Buttons: 

 Remove Server – This button will clear a highlighted ThinManager Server from the list.  

 Add Server – This button will launch a window that allows the entry of a ThinManager Server 
name and IP address.  

 Edit Server – This button will launch a window that allows the change of a highlighted 
ThinManager Server name and IP address. 
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 Arrows – These buttons adjust the order of the ThinManager Servers. The computer on top is 
considered the Primary ThinManager Server. 

Why Change from Default Settings: The ThinManager Servers need to be defined and listed in the 
window to be available for manual synchronization and remote access. 

Select the Add Server button on the ThinManager Server List Page to launch the Enter the new 
ThinManager Server Definition Window.  

 

ThinManager Server Definition 

Enter the name of the ThinManager Server in the ThinManager Server field. 

Enter the IP address of the ThinManager Server in the ThinManager Server IP field. The Discover button 
will enter the IP address for you. 

Select the OK button to accept the settings or the Cancel button to close without saving. 

Repeat until all ThinManager Servers are defined. 
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ThinManager Server List - Filled 

When all of the desired ThinManager Servers are added to the list, select Finish to close the 
ThinManager Server List wizard. 

9.2.4 Manual Synchronization  
Redundant ThinManager Servers should be synchronized so that the same configuration is available to 
thin clients regardless of where they boot. Auto-synchronization is the preferred method (see Automatic 
Synchronization Configuration) but the ThinManager Servers can be manually synchronized. 

Select Manage > Synchronize Configurations from the menu to initiate the manual synchronization. 
This will launch the Synchronize ThinManager Server Configurations wizard. 
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Synchronize ThinManager Server Configuration Wizard 

Highlight the primary ThinManager Server as the Configuration Source ThinManager Server and the 
secondary ThinManager Server as the Configuration Destination. Select Next to proceed. Although 
many ThinManager Servers can be defined in the ThinManager Server List it is normal to have just a 
primary and a backup ThinManager Server. 
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Synchronization Differences 

The ThinManager Synchronization Wizard will list the files being updated, including the firmware, 
TermCap database, modules, and the configuration. It synchronizes everything but the licenses. 

Note: The Synchronization tool does not compare and contrast then make changes back and forth. 
Synchronization will take the files and configuration from the source ThinManager Server and overwrite 
the corresponding files on the destination ThinManager Server. 

Select Next to continue.  
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ThinManager Server Synchronization Confirmation 

The ThinManager Server Configuration Wizard will prompt for a confirmation of the synchronization 
before proceeding. Select Finish to finalize the synchronization.   

 

Synchronization Complete Window 

A message will display the final results of the synchronization. 
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9.3 ThinManager Server Configuration Wizard 
The ThinManager Server Configuration wizard allows the configuration of global ThinManager settings. It 
can be launched by: 

 Selecting Edit > Modify while the ThinMan icon is highlighted in the ThinManager tree, or 

 Double-clicking on the ThinManager icon in the tree, or 

 Right clicking the ThinMan icon and selecting Modify. 

 

ThinManager Server Configuration Wizard 

Importance of Page: This displays introductory information 

Select Next to Configure the ThinManager Server settings. 
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9.3.1.1 Unknown Terminals Page 

 

Unknown Terminals 

Importance of Page: Controls creation and replacement of terminals through use of passwords and 
auto-creation. 

Settings: 

 Allow unknown terminals to connect - This checkbox, if selected, lets new terminals be added 
to the ThinManager Server. Replacements and new terminals are prevented if this box is un-
selected. 

 Require password on unknown terminals - This checkbox, if selected, allows use of a 
password so that only authorized personnel can add terminals to the ThinManager Server. If 
checked, the password fields become active and allow the addition of a password. 

 Enable AutoCreate - This checkbox, if selected, allows the auto-creation of an array of terminals 
as described in Auto-Creation of Terminals.  

 AutoCreate Mask - This field is the base name used in the array of terminals when using Auto-
Creation of Terminals. 

Why Change from Default Settings: requiring a password can control who adds terminals. Using auto-
creation can be helpful is some large deployments. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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9.3.1.2 Terminal Replacement Page 

 

Terminal Replacement 

Importance of Page: Sets the global setting for enabling replacement of offline terminals.  

Note: Terminals that are on cannot be replaced until they are turned off. 

Settings: 

 Enable Replacement – This checkbox gives global permission for terminals to be replaced. 
Un-selecting this will prevent all terminals from showing up in the replacement list when a new 
terminal is added, making Create New Terminal the only option. This feature is also available for 
the Group and terminal level on the first page of the corresponding wizard. However, if this 
checkbox is unselected in the ThinManager Server Configuration Wizard, checking it in a 
Terminal Configuration Wizard will have no effect. 

Why Change from Default Settings: Un-selecting this will prevent all terminals from showing up in the 
replacement list when a new terminal is added, making Create New Terminal the only option. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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9.3.1.3 Historical Logging Page 

 
Historical Logging 

Importance of Page: Sets the duration that logs are maintained. 

Settings: 

 Maintain Historical Log for X days - This field determines the length of time that the terminal 
server CPU and memory data from the Terminal Server Graph tab is stored. See Details Pane 
for an example of the graph. 

 Maintain Event Log for X days - This field determines how long the event log is kept. 

 Choose events to log - These checkboxes determine what events are stored in the log. 

 Terminal Server Events - This checkbox, when selected, records events of the terminal 
servers.  

 Terminal Events - This checkbox, when selected, records events of the terminal. 

 Terminal Configuration Changes - This checkbox, when selected, records changes to 
the terminal configuration. 

 User Configuration Changes - This checkbox, when selected, records changes to the 
TermSecure User configuration. 
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Buttons: 

 Clear History - This button will erase the Historical log. 

 Clear Event Log - This button will erase the Event log. 

Why Change from Default Settings: You can add Terminal Server events and TermSecure User events 
that aren’t collected by default. You can change the duration of the logs. 

Selecting the Event Log tab will show the events for the highlighted tree icon. 

 

Event Log Tab 

Details of an event can be obtained by double-clicking on an event. 
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Event Detail 

The Event Details window shows details of the selected event. Select either the OK or Cancel button to 
close. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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9.3.1.4 System Schedule 

 

System Schedule 

Importance of Page: Allows schedules to be setup for ThinManager and the ThinManager system. 

Buttons: 

 Edit Schedule – This button launched the Event Schedule window. 
See Scheduling for details. 

Why Change from Default Settings: Automating backups, reports, and actions with the Scheduler 
saves time. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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9.3.1.5 ThinManager Security Groups 

Access to ThinManager can be assigned to Windows User Groups on the ThinManager Security 
Groups page. 

 

ThinManager Security Groups 

Importance of Page: Normally administrators are the only people who have access to ThinManager 
functions. This page allows access to be granted to people so they can perform specific jobs without 
being elevated to the administrator role. 

Settings: 

 Windows User Group – This dropdown shows the group that is being configured. 

Fields: 

 Available – This list box shows the ThinManager functions that are available to the Windows 
group displayed in the Windows User Group box. These functions can be added to the Allowed 
list by double clicking. 

 Allowed – This list box shows the ThinManager functions that are granted to the Windows group 
displayed in the Windows User Group box. These functions can be removed from the Allowed 
list by double clicking. 
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Buttons: 

 Delete Group – This button will remove the highlighted group in the Windows User Group box. 

 Add Group – This button launched the New Window Group window where a new Windows© 
group can be added to the configuration. See Add Windows Group for details. 

Why Change from Default Settings: Creating a Windows Group and granting access to ThinManager 
functions allows people to use ThinManager without being an administrator.  

 

ThinManager allows different levels of access and functionality based on standard Windows groups. By 
default only members of the Windows Administrator group has the ability to connect to ThinManager and 
use the application. The ThinManager Security Groups allows other Windows groups to be granted 
privileges in ThinManager. 

ThinManager comes with privileges pre-defined for six groups. Each of these groups (except 
Administrators) needs to be created on the domain controller or in the Local Users and Groups on the 
Computer Management console and members added before they can be used. 

 Administrators - The Microsoft defined Administrator group is given all privileges by default in 
ThinManager. This may be denied by unselecting the various allowed Windows User Group 
Permissions. 

 ThinManager Administrators have full permission to do anything within ThinManager including 
the power to logoff sessions, kill processes, send messages, restart terminals, calibrate touch 
screens, change terminal configurations, update firmware, update the TermCap, and restore 
configurations. Administrators and members of ThinManager Administrators can shadow 
terminals and interactively control the terminal session. These privileges may not be removed 
and will be grayed out. 

 ThinManager Interactive Shadow Users - Members of this group may shadow a terminal 
interactively. 

 ThinManager Power Users can logoff sessions, kill processes, send messages, restart 
terminals, and calibrate touch screens. They cannot change terminal configurations, update 
firmware, update the TermCap, and restore configurations. ThinManager Power Users can 
shadow terminals from within ThinManager but cannot interact with the session. 

 ThinManager Shadow Users - Members of this group may shadow a terminal but not 
interactively. 

 ThinManager Users can view only. They cannot logoff sessions, kill processes, send messages, 
restart terminals, or calibrate touch screens. ThinManager Users cannot shadow a terminal. 

Selecting the Add Group button to launch the New Windows Group window will allow the configuration 
of additional Windows User Groups. 

9.3.1.6 Add Windows Group 

 

New Window User Group Window 
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Adding a Windows Group name in the Enter Windows User Group Name field of the New Window 
Group window and selecting the OK button will add the Windows User Group to the drop-down list. 

Note: This doesn’t create the user group on any servers. This just adds the name of an existing group to 
the list that ThinManager is maintaining. 

 

ThinManager Security Groups Page 

Select the group from the Windows Users Group drop-down. Choose the permissions you want to grant 
to the group by double clicking on the function in the Available Windows User Group Permissions list. 
Members of the Windows User Group will have the selected permissions the next time they login. 

Although ThinManager has Windows User Groups pre-configured with privileges, these groups have not 
been created on the terminal servers. 

To create a Windows User Group, open the Computer Management Console by selecting Start > 
Settings > Control Panel > Administrative Tools > Computer Management. 



 

ACP ThinManager 6.0 Configuration Wizards    163 

 

Created ThinManager Security Groups 

Highlight Groups in the tree and select Action > New Group to launch the New Group window. 

 
Microsoft New Group Windows 

Enter the group name in the Group name field. 

Add Users to the Windows User Group by selecting the Add button. 

Select the Create button to finish the Windows User Group creation. Members of the Windows User 
Group will have the selected permissions the next time they login. 
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Note: The ThinServer service may need to be stop and restarted to load the new ThinManager Security 
Group settings. 

Select Next to continue the ThinManager Server Configuration Wizard, Finish to save and close, or 
Cancel to close without saving. 

9.3.1.7 Event Selection Page 

 

Event Selection 

Importance of Page: ThinManager has event notification. E-mails or Windows messages can be sent by 
ThinManager to identify changes in the setup, configuration or status. 

Settings: 

 Email – Checking the E-mail checkbox will send an e-mail message when that event occurs. The 
e-mail needs to be set up on the next page of the wizard. 

 Windows Messages – Checking the Windows Message checkbox will send a message to a 
terminal when that event occurs. The terminal needs to be defined on the next page of the 
wizard. 

Why Change from Default Settings: Information about these events can be useful. The event needs 
checked to add the notification. 
The ThinManager Server Stop/Start, Terminal Server Monitor Connection, and Terminal Monitor 
Connection events may indicate the failure of the ThinManager Server, Terminal Server, or terminal. 
Sharing information on configuration changes, firmware, TermCap, or license installation can be useful 
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when management is shared among a group. Sending an e-mail to all group members keeps them 
informed of all changes. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

 

9.3.1.8 E-Mail or Windows Message Recipients Page 

 

Email or Windows Messaging Recipients  

Importance of Page: This page defines what users are notified of event changes from the Event 
Selection page. 

Fields: 

 SMTP Server - Enter the SMTP (Simple Mail Transfer Protocol) server to be used by the 
ThinManager Server in the field. 

 E-Mail Return Addresses - Enter the return e-mail address to be used by the ThinManager 
Server in the field  

 E-Mail Addresses - ThinManager will send an e-mail message to the addresses in this text box 
when an event selected on the Event Select page occurs. 

 Terminals - ThinManager will send a message to the terminals in this text box when an event 
selected on the Event Select page occurs. 
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Buttons: 

 Add (E-Mail Addresses) - Select this button to add e-mail addresses through the Enter the E-
mail address window. 

 Delete (E-Mail Addresses) - Select this button to delete a highlighted e-mail address from the E-
mail Addresses list. 

 Add (Terminals) - Select this button to add a terminal through the Select Terminal(s) window. 

 Delete (Terminals) - Select this button to delete a highlighted terminal from the Terminals list. 

Add (E-Mail Addresses) - Select this button to add e-mail addresses through the Enter the E-mail 
address window. 

 

Enter the E-mail Address Window 

Enter the desired e-mail address in the entry form and select OK. Select the Cancel button to close the 
window without making changes. 

Add (Terminals) - Select this button to add a terminal through the Select Terminal(s) window. 

 

Terminal Selection Window 
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The Select Terminal(s) windows will list the terminals configured on the ThinManager Server. Highlight 
the desired terminal and select the OK button.  

Why Change from Default Settings: You need to add recipients for event notification to work. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

9.3.1.9 Multicast Configuration Page 

 

Multicast Configuration Page 

Importance of Page: Allows multicast to be configured for ThinManager Servers. 

Fields: 

 Maximum Packet Size – This allows the firmware download packet size to be changed, if 
needed. 

Settings: 

 Enable Multicast - This checkbox, if selected, enables Multicast. 

 Enable Smart Multicast - This checkbox, if selected, enables Smart Multicast. 

Buttons: 

 Advanced - This button, if selected, displays the advanced settings. 

 Set to Defaults - This button, if selected, sets the advanced settings back to the defaults. 
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Why Change from Default Settings: You may need to change the settings if there is a conflict with 
another multicast server on the network. 

Multicast provides the ability for an unlimited number of terminals to boot simultaneously from the same 
data stream. This feature reduces the amount of network traffic and reduces the amount of load on the 
ThinManager Server when multiple terminals are booting concurrently. This function is especially useful 
for low bandwidth connections and highly utilized networks. 

Smart Multicast allows the terminal firmware to be sent directly to the terminal while a single terminal is 
booting. If additional terminals request the terminal firmware during this time, the firmware will be 
multicast so that all terminals can receive the firmware from a single data stream. If Smart Multicast is 
disabled, the firmware will always be sent as a multicast transmission. 

Multicast is only available on terminals with ACP Boot Loader Version 5.0 and later. No local terminal 
configuration is needed to use Multicast. 

Unicast – ThinManager has error checking that will switch a terminal’s firmware download to unicast if 
the multicast download fails.  

The thin client will continue to try to use multicast at each boot but will use unicast if multicast keeps 
failing. 

Advanced Settings – Selecting the Advanced button will reveal advanced settings for multicast. 

 

Advanced Multicast Options 

Importance of Page: This allows changing the multicast settings if there is a conflict with another 
multicast server on the network. 
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Settings: 

 Multicast Settings 

o Address – This is the IP address that will be used for Multicast transmissions. 

o Port – This is the destination port that will be used for Multicast transmissions. 

o Time-to-Live (TTL) – This is the maximum number of router hops for Multicast packets. 
Setting this value to 255 allows for unlimited hops. 

 IGMP Settings (Internet Group Management Protocol) 

o Version – This sets the IGMP version for use with multicast capable routers. 

o Time-to-Live (TTL) – This sets the time-to-live value for IGMP packets. 

Buttons: 

 Advanced - This button displays the advanced settings. 

 Set to Defaults - This button sets the advanced settings back to the defaults. 

Why Change from Default Settings: Change these if a conflict develops. 

 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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9.3.1.10 Shadow Configuration Page 

ThinManager allows the port used for shadowing to be configured. 

 

Shadow Configuration Port 

Importance of Page: This allows the port that is used for shadowing to be changed. 

Settings: 

 Shadow Port – ThinManager uses port 5900 as the default port for shadowing. Entering a 
different port number into the Shadow Port field will change the port used if it is in conflict with 
another processes use of the port. 

Why Change from Default Settings: ThinManager uses the save port as VNC. If VNC is installed on a 
WinTMC PC then there could be a conflict between shadowing services. If this happens the port can be 
changed in ThinManager.  

Select Finish to accept changes or select Cancel to close without making changes. 
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9.4 DNS Configuration 
Selecting Manage > DNS Configuration will launch the Domain Name Server Wizard to allow the 
definition of Domain Name Servers.  

 

Domain Name Service Wizard - Introduction 

Importance of Page: This allows you to use a DNS server to identify terminal servers instead of relying 
on IP addresses. 

Settings: 

 System without a DNS server - This is selected if you are not using a DNS server for computer 
identification. No configuration is needed. Select the Finish button to close the wizard. 

 System using a DNS server - This is selected if you are not using a DNS server for computer 
identification. Select the Next button to launch the Domain Name Service Configuration 
screen. 

Why Change from Default Settings: Using a DNS server allows you to point to a server by name 
instead of IP address as the DNS server will handle name resolution. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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9.4.1.1 Domain Name Server Configuration Page 

 

Domain Name Server Configuration 

Importance of Page: This is the page where the DNS server is defined in ThinManager. 

Fields: 

 DNS Servers – The DNS Servers that ThinManager and the terminals will use need to be listed 
in this list box. They are added with the Add DNS Server button. See DNS Server Entry Window 
for details. 

  Domain - This is a field for the DNS domain name. 

 Search Domain   - This field will be added as a prefix to any DNS searches.  

Buttons: 

 The Add DNS Server - This button will launch the DNS Server dialog box that allows a DNS 
Server to be added to the list. 

 Remove DNS Server - This button will remove a highlighted DNS server from the list. 

 Arrows (Up/Down) - The arrow keys will change the order of DNS servers used. Highlight a 
DNS server in the list and select the appropriate arrow. 

 Read DNS Setting from this computer  - This button will transfer the DNS settings from the 
current computer into ThinManager 

Why Change from Default Settings: The default is blank. You need to add values for this to work. 
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Select Finish to save and close, or Cancel to close without saving. 

9.4.1.2 DNS Server Entry Window 

 

Domain Name Server Configuration - Add DNS Server 

Selecting the Add DNS Server button will launch a DNS Server dialog box that allows the IP address of 
the DNS server to be entered. 

Add the IP address of the DNS server into the DNS Server dialog and select OK. Additional IP addresses 
can be listed by selecting the Add DNS Server button again. 

Select the Finish button when the DNS configuration is done. 
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10 Terminal Configuration  

10.1 Terminal Configuration Wizard 
The Terminal Configuration Wizard is used to configure terminals for use with ThinManager.  

If a terminal is a member of a terminal group that has a group setting in use then the terminal will have 
that setting grayed out and deactivated. The setting will need to be changed at the group level in the 
Group Configuration Wizard and not the Terminal Configuration Wizard. 

Launch the Terminal Creation Wizard by:  

 Selecting the ThinManager Server in the ThinManager tree and selecting Edit > Add Terminal 
from the menu bar, or  

 Selecting the Terminals branch in the ThinManager tree, right-clicking on the Terminals icon, and 
selecting the Add Terminal option, or  

 Selecting a Group in the ThinManager tree, right-clicking on the Group icon, and selecting the 
Add Terminal option. This puts the terminal in that group. 
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10.1.1.1 Terminal Name Page 

 

Terminal Configuration Wizard - Terminal Name 

Importance of Page: Names the terminal and allows it to be added to a group. 

Settings: 

 Terminal Name – Required field for unique terminal name. Keep it under 15 characters. 

 Terminal Group –Adds the terminal to a group of terminals by using the Change Group button. 

 Copy Settings – Allows the terminal to be created quickly by copying configuration from an 
existing terminal. 

Buttons: 

 Description – This launches the Terminal Description Window to allow the entry of additional 
data. 
See Terminal Description for details. 

 Change Group – Launches tree to select group for the terminal to join. See Changing a 
Terminal’s Group for details. 

 Copy From – Launches tree that allows an existing terminal configuration to be applied to the 
new terminal. Only active when checkbox is selected.  

 Permissions – Applies TermSecure permissions to the terminal. See Permissions for details. 
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Why Change from Default Settings: 

Terminal needs a unique name. It can have setting from another terminal applied to speed configuration. 
Adding to a group will speed configuration and management. 

10.1.1.2 Terminal Description 

The Description button launches the Terminal Description window.  

 

Terminal Description Window 

The Terminal Description allows you to add additional information about the terminal in the Terminal 
Description field.  

 

Terminal Description in Configuration Tab 

Data entered in the Terminal Description field will be displayed on the terminal’s Configuration tab. 

10.1.1.3 Joining a Group 

The Change Group button launches the Select Group window to allow the terminal to join a group of 
terminals. 
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Select Group Window 

Expand the Terminals tree to show the created groups. Highlight the desired group and select OK to join. 
This will close the window. 

To remove a terminal from a group highlight Terminals and select the OK button. 

Cancel will close without changes. 

10.1.1.4 Copy Settings 

Terminal configuration can be sped up by copying the settings from an established terminal. 

Select the Copy Settings from another Terminal checkbox and then select the Copy From button: This 
will launch the Select Terminal window that allows the terminal to copy settings from another terminal. 
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Select Terminal Window 

The Select Terminal window will show a tree of the configured Terminal Groups and terminals. Highlight 
the terminal that you wish to copy and select the OK button to load the settings and return to the Terminal 
Configuration Wizard. 

The Cancel button will close the Select Terminal window without making changes. 
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10.1.1.5 Terminal Hardware Page 

 

Terminal Configuration Wizard - Hardware Configuration 

Importance of Page: Defines the hardware used for the terminal. 

Settings: 

 Make/OEM: This dropdown allows the make of the hardware to be selected. 

 Model: This dropdown allows the model of the hardware to be selected. 

 OEM Model: This displays the actual model used once the terminal connects to ThinManager.  

 Video Chipset:  This displays the video chipset used once the terminal connects to 
ThinManager. 

 Touch Type: This displays the touch screen controller used if the thin client has an integrated 
touch screen. 

 Terminal ID – This displays the MAC address of a connected terminal. We use it to identify the 
thin client. On WinTMC c clients this will be the terminal name. 

 Terminal Firmware Package – This dropdown allows the firmware package that the terminal will 
use to be changed. This must be allowed on the Package Manager Page (Manage >Packages). 
See Packages for details. 

Buttons: 
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 Clear: This will remove the Terminal ID identifier from the configuration of an inactive terminal. 
The MAC address of a terminal is used for the Terminal ID. Clearing the Terminal ID will free 
hardware that has already been tied to a configuration and allow the terminal to be tied to a 
different configuration, without deleting its original configuration. It will also allow the make and 
model of the hardware to be changed. 

 Edit: Selecting this button will launch the Edit Terminal ID window that allows you to manually 
change the MAC address of the configuration. This allows you do a replacement of an old 
terminal by entering the MAC address of the replacement. Entering the new MAC address allows 
the new terminal to boot and retrieve its configuration without selecting the terminal from the list.  

 

Edit Terminal ID Window 

Why Change from Default Settings: Using the correct make & model of the hardware during 
configuration allows the wizard to display only settings that are appropriate for that specific model, making 
configuration more accurate. 

If you add a different model than you used in configuration then ThinManager will adjust the configuration 
to match the new hardware. This is down with help from the TermCap database. See TermCap Database 
for details.  

A WinTMC connection needs to be configured as Generic/Personal Computer. See WinTMC Overview 
for details. 

Note: The default Make and OEM Model is set to the oldest unit, the ACP DC-30-100 because all 
following units exceed its capabilities. If you configure your units as a DC-30-100 you will want to adjust 
the video setting once the actual hardware is attached, as the DC-30-100 video is limited to 800x600, 
256-color resolution. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 



 

ACP ThinManager 6.0 Terminal Configuration    181 

10.1.1.6 Terminal Options  

 

Terminal Options Page 

Importance of Page: Provides configuration of a few terminal functions. 

Settings: 

 Allow replacement at terminal if offline – This allows the terminal to show up in the 
replacement list during a new terminal connection 

 Set Schedule – This will allow the Schedule button to become active. See Scheduling for details. 

 Enable Terminal Effects - This allows the desktops in MultiSession to slide smoothly into the 
desktop instead of appearing instantaneously. 

 Show terminal status messages, - This allows the terminal to display status messages in the 
upper left corner of the screen.  

 Allow terminal to be shadowed – This dropdown sets the Shadowing setting allowing the 
configuration of Shadowing Options. 

 Allow Interactive Shadow – This allows users with Shadowing permission to interactively 
shadow the terminal. See Interactive Shadow for details. 

Buttons:  

Schedule – This launches the Event Schedule window for the terminal. See Scheduling for details. 
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Why Change from Default Settings: 

 Allow replacement at terminal if offline – This prevents an offline terminal from being selected 
when adding a new terminal. Turning this off prevents a critical configuration from being 
transferred.  
If this is turned off then an administrator will need to turn it back on if this terminal needs 
replaced. 

 Show terminal status messages -Suppressing incidental messages like Display Client 
switching and TermSecure logins can keep an operator from worrying about non-essential 
messages. 

 Allow terminal to be shadowed  - Changing the setting controls connection settings: 

o No – This will prevent the terminal from being shadowed by anyone. 

o Ask – This will ask the user to allow shadowing. The user will need to say Yes on a 
message window before the shadowing is allowed. 

o Warn - Will display a message window alerting the terminal that it is to be shadowed, but 
doesn’t require user input before the shadowing is allowed. 

o Yes – Will allow shadowing to occur without warning or user input. 

Allow Interactive Shadow – Unselecting will prevent the observer from controlling the session. This 
“Look but don’t touch” mode prevents an observer from clicking the wrong buttons.  

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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10.1.1.7 Terminal Mode Selection Page 

 

Terminal Server Specification 

Importance of Page: This page has the settings that allow the use of Display Clients, TermSecure, and 
MultiMonitor. 

Settings: 

 Use Display Clients - This setting is required to use most features and functions like 
SmartSession load balancing, MultiSession, and Terminal-to-Terminal shadowing. 

If Use Display Clients is selected, two other settings may become available: 

 Enable TermSecure – This checkbox enables TermSecure on the terminal. This checkbox will 
only be displayed if the ThinManager Server has a TermSecure license installed. See 
TermSecure for details on this function. 

 The Enable MultiMonitor checkbox will be displayed if the hardware selected on the Terminal 
Hardware page is a MultiMonitor-capable thin client. Selecting this will allow the terminal to be 
configured for MultiMonitor. See MultiMonitor for details. 

Why Change from Default Settings: 

We recommend using Display Clients because that expands the features and functions available. 

Select Next to continue, Finish to save and close, or Cancel to close without saving.
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10.1.2 Terminals Using Individual Terminal Servers 
Terminals may connect to a series of individual terminal servers by not selecting the Use Display Clients 
on the Terminal Mode Selection page. Although this is not the recommended method this is covered 
here. 

 

Terminal Configuration Wizard - Terminal Server Specification 

Importance of Page: Used to select the legacy individual terminal server method. 

Note: We strongly recommend using Display Clients because that expands the features and functions 
available. 

Settings: 

 Not Selecting Use Display Clients is a legacy setting from earlier versions of ThinManager. 
Using this setting will limit the features available. 
Selecting this enables use of the individual terminal server method. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

The Terminal Connection Type page is displayed next to allow the selection of the desired Client 
Communication Protocol. 
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Terminal Configuration Wizard - Connection Type 

Importance of Page: Selects the client/server communication protocol. 

Settings: 

 Citrix ICA – This allows the use of the Citrix© ICA protocol in client to server communications. 

 Citrix Device Services – This is a legacy version of the ICA protocol used on Windows NT and 
Windows 2000 terminal servers. 

 Remote Desktop Protocol (RDP) – This is the default protocol from Microsoft©. It is 
automatically installed on Microsoft© terminal servers. 

Why Change from Default Settings: This is where the terminal is configured to use the Citrix© ICA 
protocol if the Citrix© ICA protocol is going to be used instead of the default RDP. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

Selecting the Citrix ICA setting will change the path of the Terminal Configuration Wizard to display 
additional configuration pages. See Citrix for details. 
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Terminal Server Selection 

Importance of Page: This allows the selection of the terminal servers that the terminal will use. Adding 
multiple terminal servers to the Selected Terminal Server list will establish failover. 

List Box: 

 Available Terminal Servers – This is the list of the terminals configured in the Terminal Server 
Configuration Wizard and available to the terminal. 
If the Available Terminal Server list box is empty the Terminal Server Configuration Wizard can 
be launched with the Edit Server List button to define the terminal servers. 

 Selected Terminal Servers – This is the list of terminal servers that the terminal will connect to, 
in the order that they will connect. Move the terminal servers to this list with the left and right 
arrow or by double clicking on the name.  
Listing two or more terminal servers configures Failover. The terminal will connect to the first in 
the list. If it fails than the terminal will try the next in the list. 

Buttons: 

 Arrows – The left and right arrows move the terminal servers between list boxes. The up and 
down arrow change the order that the terminal servers are used. The top terminal server is 
considered the primary terminal server.  
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 Edit Server List – This launches the Terminal Server Configuration Wizard that allows 
terminal servers to be defined within ThinManager. Selecting Manage > Terminal Server List 
from the ThinManager menu will also launch the Terminal Server Configuration Wizard. 

 Override – This is not used with individual terminal servers. 

Settings: 

 Enforce Primary Terminal Server Connection – This will cause a terminal that failed over to a 
backup terminal server to return to the primary terminal server whenever that server becomes 
available. 

Why Change from Default Settings: It is critical to list the terminal servers that the terminal will use. The 
wizard will not advance without a terminal server selected.  

If the Available Terminal Servers column is empty, the Terminal Server List Wizard needs to be run to 
define the terminal servers. Select the Edit Server List to launch the Terminal Server Configuration 
Wizard and define the terminal servers. 

 

Terminal Configuration Wizard - Terminal Server Selection 

This is an example of a terminal with the terminal servers selected. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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10.1.3 Terminals Using Display Clients 
Terminals may be configured to use Display Clients by selecting the Use Display Clients on the 
Terminal Mode Selection page. 

 

Terminal Configuration Wizard - Terminal Server Specification 

If the Use Display Clients is selected, two other settings may become available: 

 Enable TermSecure, when checked, will enable TermSecure functionality. This checkbox will 
only be displayed if the ThinManager Server has a TermSecure license installed. See 
TermSecure for details on this function. 

 The Enable MultiMonitor checkbox will be displayed if the hardware selected on the Terminal 
Hardware page is a MultiMonitor-capable thin client. Selecting this will allow the terminal to be 
configured for MultiMonitor. See MultiMonitor for details. 

Select Next to continue configuration. 

10.1.4 Display Client Selection  
The Display Client Selection page is displayed next to allow the selection of the desired Display Clients. 
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Terminal Configuration Wizard – Display Client Selection 

Importance of Page: This allows the selection of the Display Clients that the terminal will use. Adding 
multiple Display Clients to the Selected Display Clients list will establish MultiSession. 

List Box: 

 Available Display Clients – This is the list of the Display Clients configured in the Display Client 
Configuration Wizard and available to the terminal. 
If the Available Display Client list box is empty the Display Client Configuration Wizard can be 
launched with the Edit Display Clients button to define the Display Clients. 

 Selected Display Clients– This is the list of the Display Clients that the terminal will connect to, 
in the order that they will connect. Move the Display Clients to this list with the left and right arrow 
or by double clicking on the name.  
Listing two or more the Display Clients configures MultiSession. The terminal will display the first 
in the list and cascade the others. 

Buttons: 

 Arrows – The left and right arrows move the Display Clients between list boxes. The up and 
down arrow change the order that the Display Clients are used. The top Display Clients is 
displayed on top at startup.  

 Edit Display Clients – This launches the Display Client Configuration Wizard that allows 
Display Clients to be defined within ThinManager. 
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 Override – This allows a highlighted Display Client to use a different login or screen resolution 
than the terminal. 
See Display Client Override for details. 

Why Change from Default Settings: It is critical to list the Display Clients that the terminal will use. The 
wizard will not advance without a Display Client selected.  

If the Available Display Clients column is empty, the Display Clients List Wizard needs to be run to 
configure Display Clients. Select the Edit Display Clients button to launch the Display Client List 
Wizard as shown in Display Client List. 

 

Terminal Configuration Wizard – Display Client Selection 

This is an example of a terminal with the Display Clients selected. 

10.1.4.1 Display Client Override 

ThinManager has an Override button that will allow any Display Client to be configured to login with a 
different user account than the terminal. The Override button becomes active when two or more Display 
Client are added to the Selected Display Client column. 
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Override Settings Window 

Importance of Page: Allows a Display Client to use a different login or screen resolution than the 
terminal. 

Settings: 

 Override - Login Settings– This needs checked to use this setting. 
Using this override with a blank username and password will force the user to manually login. 

o Username – Field for the username of the Windows© user account you want to use. 

o Password – Field for the password for the username. 

o  Verify Password – Field to confirm the password. 

 Override - Domain– This needs checked to use this setting. 

o Domain – Field for the domain of the user account. 

 Override - Video Settings– This needs checked to use this setting. 

o Resolution – Dropdown for the video resolution to use for the Display Client. 

o Color Depth – Dropdown for the color depth to use for the Display Client. 

Buttons: 

 OK – Accepts changes and closes window. 

 Cancel – Closes window without changes. 

Why Change from Default Settings: The defaults are blank and will not override anything until changed. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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10.1.4.2 Virtual Workstations 

If you choose a Workstation Display Client you will need to associate it to an available workstation. This is 
done on the Complete the Workstation Display Client Configuration page. 

 

Complete the Workstation Display Client Configuration Page 

Importance of Page: Allows a workstation to be associated with a Workstation Display Client so that the 
terminal can display a workstation. 

Buttons: 

 Add Workstation – Accepts changes and closes window. 

 Add Virtual Workstation – Closes window without changes. 

 Remove – This removes a highlighted workstation. 

 Edit – This allows a highlighted workstation to be changed. 

 Arrows –The up and down arrow change the order that multiple workstations are used.  

Why Change from Default Settings: The default is blank and will not deploy a workstation until a 
workstation is added. 

Selecting the Add Workstation button will launch the Add Workstation window. 
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Add Workstation Window 

Enter the Workstation name and IP address in the Workstation Display Name and Workstation IP 
Address fields. 

Selecting the Add Virtual Workstation button will launch the Add Virtual Workstation window. 

 

Add Workstation Window 

The Add Virtual Workstation window will show the configured VCenter Servers. Expand the tree and 
select the desired virtual workstation. Select the Add button to apply that virtual workstation. 

 

Error Message 
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Each virtual machine can only be used once since workstations have a one-to-one relationship with the 
accessing terminal. If you try to apply a workstation twice you will receive and error message. 

 

Complete the Workstation Display Client Configuration Page 

Once a workstation has been applied for that display client it will be listed in the Selected Workstations 
textbox. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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10.1.4.3 Terminal Interface Options 

 

Terminal Interface Options Page 

Importance of Page: This page contains the setting that allows navigation between sessions when using 
MultiSession. 

Settings: 

 Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-
down menu that can be activated by mouse.  

 Enable Tiling – This checkbox, when selected, allows the Display Clients to be tiled on the 
monitor to provide an overview of all the sessions at once. See SessionTiling Options for details. 

 Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

Buttons: 

Selector Options – This button launches the Group Selector Options window that has the settings for 
switching between sessions when using MultiSession. See Terminal Interface Options Hotkeys for 
details. 

Tiling Options– This button launches the Tile Options window that has the settings for tiling sessions 
when using MultiSession. See Terminal Interface Options Hotkeys for details. 
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Main Menu Options – This allows configuration of the TermSecure Main Menu. See TermSecure Menu 
for details. 

Why Change from Default Settings: These settings allow you to control how MultiSession is displayed 
and navigated. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

 

10.1.4.4 Hotkey Configuration Page  

 

Hotkey Configuration Page 

Importance of Page: Used to configure hotkeys to make it easier to access sessions and functions. 

Settings: 

 Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching 
between the two active sessions of a Terminal Services Display Client that is using Instant 
Failover. 

 Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between 
different sessions of a terminal using MultiSession. 

 Enable Tiling Hotkey – This checkbox, if selected, allows SessionTiling to be activated by a 
hotkey combination. 
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 Enable Main Menu Hotkey – This checkbox, if selected, allows the TermSecure Main Menu to 
be activated by a hotkey combination. 

Buttons: 

 Change Hotkeys (Enable Instant Failover Hotkeys) – This button launches the Select 
Hotkeys window that has the settings for hotkeys when using Instant Failover. See Hotkey 
Configuration for details. 

 Change Hotkeys (Enable Group Hotkeys) – This button launches the Select Hotkeys window 
that has the settings for hotkeys when using MultiSession. See Hotkey Configuration for details. 

 Change Hotkeys (Enable Tiling Hotkeys) – This button launches the Select Hotkeys window 
that has the settings for hotkeys when using Tiling. See Hotkey Configuration for details. 

 Change Hotkeys (Enable Main Menu Hotkeys) – This button launches the Select Hotkeys 
window that has the settings for hotkeys when using TermSecure. See Hotkey Configuration for 
details. 

Why Change from Default Settings: These settings allow you to control sessions with hotkeys. 

 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

10.1.5 Continuation of the Terminal Configuration 
The configuration paths (Independent Terminal Servers vs. Display Clients, ICA vs. Device Services and 
RDP) unite at the Login Configuration. However, the Log In Information page varies depending on it the 
terminal is using individual Terminal Servers or Display Clients. 
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10.1.5.1 Login for Display Client Users 

 

Login Information - Use Display Clients  

Importance of Page: This page allows a terminal to automatically login without user action. 

Settings: 

 Username – Enter a valid Windows user account. 

 Password – Enter the password. 

 Verify Password – Re-enter the password for confirmation. 

 Domain - Enter the domain, if Domain accounts are being used. 

 Path - Enter the path to the desired application in the field. This will be the only program to run 
and the desktop, icons, and start menu will be hidden.  

 Command Line Options – This field provides a space for command line options and switches. 
This field may not be required.  

 Initial Folder - This field is provided in case you need to specify the working directory for the 
program when using a relative path for the initial program. This field may not be required. 

Buttons: 
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 Verify - The Verify button will contact the domain controller to validate the accuracy of the 
domain user account. 

Select the Verify button to check the user. 

 

Validate Users Window 

A Validate Users window will be displayed with the status of the user. If the user account is a valid 
domain account, the results will show valid. If the results show invalid, try another account. 

Why Change from Default Settings: Using the auto-login feature allows a terminal to connect and load 
sessions without requiring user input. It also hides the login account so the user doesn’t know the account 
and can’t use it for unauthorized access to the network. 

 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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10.1.5.2 Video Resolution Page 

 

Terminal Configuration Wizard - Video Configuration 

Importance of Page: This page sets the video resolution that the terminal will use. 

Settings: 

 Resolution – Select the desired screen size. The list will contain the sizes available for the 
hardware that was chosen on the Terminal Hardware page. 
WinTMC configurations show a Full Screen option. 

 Color Depth – Select the desired color depth. The list will contain the values available for the 
hardware that was chosen on the Terminal Hardware page. 

 Refresh Rate – Select the desired refresh rate for the monitor. The list will contain the values 
available for the hardware that was chosen on the Terminal Hardware page. 

Why Change from Default Settings: The monitor that is used may have a different resolution than the 
default value. A Windows© 2003 or 2008 terminal server can display 16K colors but a Windows© 2000 
terminal servers can only display 256 colors. 

A terminal that is using MultiMonitor can have the screen resolution of each monitor set. See MultiMonitor 
for more details. 
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MultiMonitor Video Settings 

Importance of Page: Configures the video resolution of each monitor for a MultiMonitor terminal. 

Settings: 

 Number of Monitors – These radio buttons allow you to define how many monitors the terminal 
will use. 

 Color Depth – Select the desired color depth. The color depth will be used for all monitors. 

 Resolution – Select the desired screen size for each monitor used.  

 Color Depth – Select the desired color depth for each monitor used. 

 Refresh Rate – Select the desired refresh rate for each monitor used. 

Buttons: 

Why Change from Default Settings: MultiMonitor allows you to use different sized monitors instead of 
requiring that all are the same. This page allows you to adjust the settings to match your configuration. 

 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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10.1.5.3 WinTMC Settings Page 

A terminal that is set for use as a WinTMC PC client by using Generic/PersonalComputer in the Make 
and Model field of on the Terminal Hardware page will display a page for WinTMC settings. It is not 
shown for normal terminals. 

 

WinTMC Settings 

Importance of Page: Used to configure the WinTMC client that converts a PC into a terminal services 
client that is controlled and managed through ThinManager. 

Settings: 

 Redirect Local Resources: 

o Redirect Serial Ports – Enable this setting to make local serial ports available in a 
session. Serial Port redirection does not work when you connect to a terminal server 
running Windows 2000 or earlier. 

o Redirect Drives – Enable this setting to make local drives available in a session. Drive 
redirection does not work when you connect to a terminal server running Windows 2000 
or earlier. 

o Redirect Printers – Enable this setting to make your local printer available in a session.  

o Redirect Sound –Enable this setting to allow audio played in your session to play locally. 
Sound redirection does not work when you connect to a terminal server running Windows 
2000 or earlier. 
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o Redirect Smart Cards – Enable this setting to make your smart card available in a 
session. Smart card redirection does not work when you connect to a terminal server 
running Windows 2000 or earlier. 

 Client Control Settings: 

o Allow client to be closed – Enable this setting if you want your user to be able to close 
the client. 

o Allow client to be sized – Enable this setting if you want your user to be able to resize 
the client. 

o Always maintain monitor connection – Enable this setting to keep the monitoring 
connection active when WinTMC is closed to allow shadowing. Unselecting this checkbox 
will release the WinTMC license when the WinTMC program is closed but will deny 
shadow access. 

o Show groups in separate windows – This checkbox, if selected, will display multiple 
Display Clients as separate windows rather than in one window shell. 

 Experience Settings:  

o Show Desktop Background – Enable this setting if you want your user to be able to 
select a Windows Desktop Background. If not set, the background will be a solid color.  

o Show window contents while dragging – Enable this setting if you want the window 
contents of a window to be shown while the window is being dragged.  

o Show menu/window animations – Enable this setting if you want menu/window 
animations to be enabled on the client.  

o Show Themes – Enable this setting if you want your user to be able to select a Windows 
Theme.  

Note: These functions may be denied by user policies or terminal server configuration. Check the 
Microsoft© Local Policy, Group Policy, and Terminal Services Configuration. See Non-ThinManager 
Components for details. 

Why Change from Default Settings: The Redirect Local Resources settings allow the user to access 
the resources on the PC. 

The Client Control Settings can be set to prevent the WinTMC from being closed. If you want to convert 
a floor PC to a dedicated terminal you can install WinTMC on the PC and have it launch automatically by 
placing it in the Startup folder (C:\Documents and Settings\%username%\Start Menu\Programs\Startup). 
The user can’t close WinTMC if the Allow client to be closed and the Allow client to be sized settings 
are unchecked. 

The Experience Settings give a PC-like desktop experience but use more resources. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 
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10.1.5.4 Terminal Module Selection Page 

 

Terminal Configuration Wizard - Module Selection 

Importance of Page: This page attaches modules to a terminal so that it can use touch screens, sound, 
USB drives, etc. 

Settings: 

 Installed Modules – This list box displays the modules that are added to the terminal. Modules 
added to a group will show a group icon. 

Buttons: 

 Move Up & Move Down    – These buttons changes the order that the modules load during boot 
up by rearranging the module list. They are rarely used. 

 Add… – This opens the Attach Module to Terminal window to allow a module to be added to 
the terminal. 

 Configure… – Open the Modules Properties window by highlighting the module in the Module 
list box and clicking the Configure button. 

 Remove – Remove a module by highlighting it in the Module list box and clicking the Remove 
button. 

Why Change from Default Settings: Certain features and functions are activated by use of modules.  
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Select Next to continue, Finish to save and close, or Cancel to close without saving. 

10.1.5.5 Attaching a Module 

A Module is a component of the firmware that is not needed for the basic functionality but may be desired 
for advanced functionality. These features include Touch Screen drivers, serial mouse drivers, High 
Speed Serial drivers, Shared Keyboard and Mouse, USB Memory Card Reader, and Instant Failover. See 
Module Overview for details. 

To attach a Module to a Terminal, select the Add… button to launch the Attach Module to Terminal 
window. 

 

Attach Module to Terminal 

The Attach Module to Terminal window will show the modules that are available to the terminal. The 
Module Type drop-down box sorts the modules by categories to make the modules easier to find. 

Highlight the desired module and select the OK button to add the module to the configuration. 
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Terminal Configuration Wizard - Module Selection 

Terminals that are members of a Group may show icons to represent the properties of added modules. 

  The Group icon represents modules assigned to a parent Group. 

 No icon indicates that the module was added to that particular Group or Terminal and not a 
parent Group. 
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Module Configuration 

Highlighting a module and selecting the Configure button will open the Module Properties window and 
allow changes to the module configuration. 
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Module Properties 

On the Modules Properties window, select the parameter to change, select the new value in the drop-
down list, and click the Set button. This will change the setting.  

The Set to Default button will restore the module to the default settings. 

Select the Done button to close the Module Properties window and to return to the Terminal 
Configuration Wizard. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

10.1.5.6 ThinManager Server Monitor List Page 

This page is not displayed when Auto-synchronization is used. See Auto-synchronization. 
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Terminal Configuration Wizard - ThinManager Server Monitor List 

Importance of Page: If you are using two ThinManager Servers without automatic synchronization them 
the terminal will normally only send its connection status (green light) to the ThinManager Server that it 
booted from. This page allows you to list multiple ThinManager Servers so that the terminal will send its 
status information to all the ThinManager Servers 

Settings: 

 Available ThinManager Servers – This is the list of defined ThinManager Servers. Selecting 
the Edit Server List button will launch the ThinManager Server List Wizard to add new 
ThinManager Servers. 

 Selected ThinManager Server – This is the list of ThinManager Servers that the terminal will 
send its connection status to. Move ThinManager Servers from the Available list to Selected list 
by double clicking or using the arrow buttons while highlighted. 

Buttons: 

 Arrows – These buttons move highlighted ThinManager Servers from one list to the other or 
rearrange the order listed. 

 Edit Server List – This launches the ThinManager Server List Wizard that allows the defining of 
ThinManager Servers. 



 

210    Terminal Configuration ACP ThinManager 6.0 

Why Change from Default Settings: Adding ThinManager Servers to the Selected ThinManager 
Server allows control, configuration, shadowing, and rebooting of a terminal from a backup ThinManager 
Server if the primary ThinManager Server fails. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

 

10.1.5.7 Monitoring Configuration Page 

 

Terminal Configuration Wizard - Monitoring Configuration 

Importance of Page: This page sets the speed that failover is detected and initiated. A thin client creates 
a socket connection to the terminal server. If the socket is disconnected the terminal will try to reconnect 
and failover based on these settings. 

Settings: 

 Monitor Interval 

o Monitor Interval (Fast/Medium/Slow) – These settings have a set rate for the frequency 
that the terminal server status is checked. 

o Monitor Interval (Custom) – This setting allows the administrator to change the settings 
from the defaults. 

 Monitor Interval – This is the period of time the terminal will wait after losing the socket 
connection before it tries to reconnect. 
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 Monitor Timeout  – This is the period of time the terminal will wait between tries. 

 Monitor Retry - This is the number of times the terminal will try to reestablish a connection 
before failing over. 

 Primary Up Delay Multiplier - This is a constant used to generate the Primary Up Delay time. 

Field: 

 Primary Up Delay - This is a delay added (usually set to 30 or 60 seconds) to allow a Terminal 
Server to get fully booted before the terminal will try to login. This time period is equal to the 
Monitoring Interval times the Primary Up Delay Multiplier. 
This prevents a terminal using Enforce Primary from switching back to its primary terminal server 
before it is ready.  

Why Change from Default Settings: Faster rates will cause a quicker failover but will check on terminal 
server status more often, causing more network traffic. Slowing down the rate will cause less traffic but 
will slow the failover speed a little. 

Select Finish to save and close, or Cancel to close without saving. 
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11 PXE Server Configuration  

11.1 Overview  
PXE (Preboot Execution Environment; sometimes pronounced "pixie") is an environment that allows a 
computer to boot over a network. ThinManager provides a complete PXE boot environment that does not 
require any additional software components. The ThinManager PXE Server conforms to version 2.1 of the 
Intel PXE boot specification. 

11.2 Thin Client Hardware Requirements  
The Thin Client computer must be capable of PXE Booting. Most standard BIOS ROMS include a PXE 
Option ROM. In order to PXE boot, the PXE Option ROM must be enabled in the BIOS. The PXE boot 
method (boot from network) should be set to first in the boot order. Disabling the other boot devices in the 
BIOS will ensure that the unit will only boot via PXE. 

11.3 Methods of Operation 

11.3.1 ThinManager Only Method 
Using this method, the Thin Client will acquire an IP address and PXE boot options from the ThinManager 
PXE Server. No standard DHCP Server is required.  You must have the ThinManager PXE Server 
enabled and the desired network interfaces enabled. Select the “Not using standard DHCP Server” server 
mode. 

11.3.2 ThinManager Proxy Method 
Using this method, the Thin Client will acquire an IP address from a standard DHCP server. There is no 
need to set any PXE related boot options in the DHCP server configuration. These options will be sent to 
the Thin Client by the ThinManager PXE Server. You must have the ThinManager PXE Server enabled in 
ThinManager and you must select the “Using standard DHCP server with Boot Options” server mode. 

11.3.3 Stand-Alone DHCP Server Method   
Using this method, the Thin Client will acquire an IP address from a standard DHCP server including the 
specified PXE boot options. This method is required if your DHCP server is installed on the same 
machine as ThinManager. You must set Option 66 (Boot Server Host Name) to the IP address of your 
ThinManager Server and Option 67 (Boot File Name) to “acpboot.bin”. You must have the 
ThinManager PXE Server enabled and you must select the “Using standard DHCP server” server mode. 
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See Network Interface Configuration for details. 

11.4 PXE Server Configuration Wizard 

11.4.1 Enabling the ThinManager PXE Server 
Open the ThinManager PXE Server Configuration Wizard by selecting Manage > PXE Server from the 
menu. 

 

PXE Server Configuration 

Enable PXE Server must be selected to boot PXE thin clients from ThinManager. 
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11.4.2 Network Interface Configuration 

 

Network Interface Configuration 

Select a network interface from the drop down list to configure from the Select Interface to Configure 
dropdown.  This allows each network adapter to be configured individually.  The primary IP Address 
reflects the current IP address for the selected adapter. 

PXE Server Mode 

 Select Using Standard DHCP server if you want to have a standard DHCP server assign IP 
addresses to thin clients on the same network as the selected network adapter. The PXE Boot 
options will be provided by ThinManager automatically. This selection will require no changes to 
your DHCP server configuration. 

 Select Standard DHCP server with Boot Options if you want a standard DHCP server to assign 
IP addresses and PXE boot options to thin clients on the same network as the selected network 
adapter. Set Option 66 (Boot Server Host Name) to the IP address of your ThinManager Server 
and Option 67 (Boot File Name) to “acpboot.bin”. The PXE boot options will not be 
provided by ThinManager. You must use this mode if your DHCP server is installed on your 
ThinManager Server.  

 Select Not using standard DHCP server if you want ThinManager to assign IP addresses to thin 
clients without the need for a DHCP server. Using this mode requires that you set up IP address 
ranges. Use this mode if you want to use static IP assignments (reservations). ThinManager will 
not assign IP addresses to non-PXE booting devices. 
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Allow New PXE clients allows unknown PXE thin clients to connect to ThinManager through the 
selected network interface. Uncheck this option if you only want known clients to connect.  

Note: Uncheck this setting if you are planning to have more than one non-synchronized ThinManager 
Server on your network. You will need to temporarily enable this option to add a new thin client. For 
proper operation, you can only have this option enabled on one ThinManager Server at a time. 

11.4.3 Network Interface Configuration for Synchronized 
ThinManager Servers 

 

Network Interface Configuration for Synchronized ThinManager Servers 

The Network Interface Configuration page will display a network interface dropdown for each 
ThinManager Server if you are using auto-synchronization.  

Select a network interface from the Select Interface to Configure to configure the primary ThinManager 
and select a network interface from the Synchronization Interface to configure the secondary 
ThinManager dropdown.  This allows a network adapter on each ThinManager Server to be configured 
individually. 
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11.4.4 IP Address Range Configuration  
The IP Address Range Configuration page displays the current ranges of IP Address being used by 
ThinManager to assign to thin clients.  It also gives the ability to edit the IP ranges.  

Note: This section of the PXE Server Wizard is only used when the Not using standard DHCP server 
option is selected in the Network Interface Configuration. 

 

IP Address Range Configuration 

Select the Add button to launch the IP Address Range window to add a range of IP addresses for the 
PXE Server. 
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11.4.4.1 Adding or Editing an IP Address Range 

 

IP Address Range 

The IP Address Range window has fields for the IP addresses to be assigned. 

Fields: 

 Starting IP Address: This is first IP address you want the PXE Server to pass out. 

 Ending IP Address: This is last IP address you want the PXE Server to pass out. 

 Subnet Mask: This is the subnet mask of the network.  

 Router IP Address: This is the IP address of your router, if needed. Leave as 0.0.0.0 if not 
needed.  

Buttons:  

 Exclusions launches the Exclusion window to exclude a specific IP addresses from the 
available range. 

 Reservations launched the Reservation window that allows reserve a specific IP address to be 
assigned to a thin client based on the thin client MAC address. 

 Advanced launches the Advanced IP Range Settings window that allows DHCP options to be 
added. 

 Clear IP Assignments will clear the setting from the IP Address Range window. 
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11.4.5 Exclusions 

 

Exclusion Window 

Selecting the Add button will launch the Exclusion Range window that allows you to remove one or more 
IP addresses from the range of IP addresses passed out by the PXE server. 

 

Exclusion Range Window 

Enter the first and last IP addresses of the range you want to exclude in the Exclusion Start IP Address 
and the Exclusion End IP Address. If you have a single IP address you want to exclude then enter it in 
both the Exclusion Start IP Address and the Exclusion End IP Address fields. 
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11.4.6 Reservations  

 

Reservation Window 

Reservations allow you to associate a specific IP address to a specific thin client by associating the IP 
address with the MAC address of the thin client. 

Select the Add button to add a reservation. 

 

Reservation Window 

Hardware Address is the primary MAC address of the thin client. 

Secondary Hardware Address is the MAC address of the second network interface of the thin client (if 
present). 

IP Address sets the IP address to be reserved for the desired thin client.  This will be the address 
assigned to the thin client when connected through either the primary or the secondary thin client network 
interface. 
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11.5 Terminal Group Configuration Wizard  
Using Terminal Groups allows a configuration to be defined for a group of terminals. Terminals added to 
a group will inherit the group properties to speed the configuration process. Using Groups can also aid in 
management because many tasks can be done on the group level instead of repeating them for multiple 
terminals. 

 Groups can be nested within groups, providing deeper levels of organization. 

 All Group Settings use a forced inheritance because of the use of nested Groups. Once a setting 
has been selected as a group property, every terminal group and terminal beneath it will use that 
setting. 

 Group Settings will be designated on the Configuration and Modules tabs with the Group icon of 
two blue monitors.  

11.5.1.1 Group Settings Checkbox 

The Terminal Group Configuration Wizard establishes the terminal settings for a group of terminals, while 
the Terminal Configuration Wizard establishes the terminal settings for the individual terminal. The 
Terminal Configuration Wizard and the Group Configuration Wizard use the same forms so they are very 
similar, with a few different settings.  

Note: This Help document will only show the differences between the Group Configuration Wizard and 
the Terminal Configuration Wizard. See Terminal Configuration Wizard for configuration details. 

The Group wizard will have Group Setting checkboxes for each setting. Selecting this checkbox will 
force that setting to be inherited by nested sub-groups and member terminals. The Group Settings of any 
sub-group or terminal will be grayed out to prevent changes if the group setting is selected on the parent. 
Changes need to be made at the Group level. 
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Group Setting Example 

This example shows variations in the use of four Group Settings on the Terminal Group Options page 
of a nested group. 

Note: The Group Configuration Wizard shows “Terminal Configuration Wizard” in the title because it 
uses the same framework as the Terminal Configuration Wizard. 

Terminal Replacement (1) and Terminal Schedule (2) were configured in the parent group and cannot 
be changed in this child group. Terminal Replacement (1) was set as checked, while Terminal 
Schedule (2) was set as unchecked. 

The Terminal Effects (3) Group Setting is selected for this Group. It will be grayed out in child groups 
and member terminals. 

The Shadowing (4) Group Setting is unselected, making it available to be set for child groups and 
member terminals.  
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11.5.1.2 Group Name Page 

The Group Configuration Wizard can be launched by selecting Edit > Add Terminal Group or by or 
right clicking on the Terminals branch in the tree and selecting Add Group. 

 

Group Configuration Wizard – Terminal Group Name 

Importance of Page: This page allows the Group to be named. 

Fields: 

 Group Name – This is the name given to the group. Keep it under 15 characters. 

 Terminal Group – This is the name of a parent group if this group is a sub-group. 

Buttons: 

 Change Group – This launches a window that allows the group to be added as a sub-group to 
another group. 

 Permissions – This allows the Terminal Group to be assigned Access Groups for security. This 
is a function of TermSecure. See Permissions for details. 

Checkbox: 

 Group Setting – This will make the Permission a group setting that is inherited by all members. 
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Why Change from Default Settings: A group needs a name at creation. The group can be added to 
another group using the Change Group button. 

 

Duplicate Name Warning 

If an existing name is selected, a Duplicate Name Warning popup will be displayed when the Next 
button is selected. 

Terminal Groups can be added to other Terminal Groups, creating a multi-level hierarchy. This is done 
with the Change Group button that launches the Select Group window. 

 

Select Terminal Group Window 

The Select Group window will show a tree displaying the group hierarchy. Highlight the Terminal Group 
that you want to join and select the OK button to join or select the Cancel button to quit without joining.  



 

224    PXE Server Configuration ACP ThinManager 6.0 

 

Terminal Group Configuration Wizard – Terminal Group Name Page 

The parent Terminal Group you joined will be displayed in the Group field.  

Select the Next button to continue or select the Cancel button to close the configuration wizard without 
saving. 

11.5.2 Changing a Terminal’s Group 
A terminal is added to a group from the Terminal Name page of the Terminal Configuration Wizard. 

Open the Terminal Configuration Wizard by either: 

 Highlighting the terminal in the ThinManager tree pane by clicking on the terminal name or icon 
and select Edi t >Modify from the ThinManager menu bar. 

 Right clicking on the terminal icon in the ThinManager tree pane and select Modify. 

 Double clicking on a terminal icon in the ThinManager tree pane. 

This will launch the Terminal Configuration Wizard.  
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Terminal Configuration Wizard - Terminal Name Page 

The first page of the wizard, Terminal Name, has a Change Group button. Select the Change Group 
button to launch the Select Terminal Group window. 
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Select Group Window 

The Select Terminal Group window has a tree of the Terminal Groups. Highlight the desired Terminal 
Group and select the OK button. Selecting Terminals will remove the terminal from group membership. 

The Cancel button will close the Select Group window without making changes. 
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Terminal Group Display 

Once a group is selected for the terminal the group will be displayed in the Terminal Group field. 

Note: The terminal will need to be restarted for the changes to take effect.  

 

11.5.3 Unique Group Configurations 
Several pages of the Group Configuration Wizard are different than the Terminal Configuration 
Wizard. These include the Log In Information page, the Group Video Resolution, and Module pages. 
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11.5.3.1 Group Login Information Page 

 

Log In Information - Use Application Groups  

The Log In Information page is different in the Group Configuration Wizard than the Terminal 
Configuration Wizard.  

It is recommended that each terminal login to a Terminal Server with a unique profile. For this reason, the 
Group Username, Password, and Domain are inactive in the Terminal Group Configuration. These need 
to be set individually during the Terminal Configuration. 
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11.5.3.2 Group Video Resolution Page 

 

Group Configuration Wizard - Video Configuration 

The Group Video Resolution page has a drop-down box that allows the video resolution to be set for all 
members of the Group.  

The Windows 2000 terminal connection uses a 256-color depth. The 64K-color depth is available by 
using RDP connected to a Windows 2003 or 2008 Terminal Server. 

The Group Setting checkbox will lock the settings for the group and all member terminals. 

Note: It is not recommended to set the Video Resolution as a Group Setting because of the variety of 
monitor sizes and the ease at which they are changed. These settings are better set as an individual 
terminal setting to provide the flexibility to switch monitors. 
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11.5.3.3 Group Module Selection Page 

 

Terminal Configuration Wizard - Module Selection 

A Module is a component of the firmware that is not needed for the basic functionality but may be desired 
for advanced functionality. These features include Touch Screen drivers, serial mouse drivers, High 
Speed Serial drivers, Shared Keyboard and Mouse, USB Memory Card Reader, and Instant Failover. See 
Module Overview for details. 

The Add button will allow Modules to be added to the Group.  

The Installed Modules box will show the Module names and the Packages (firmware version) they are 
valid with. 

See Modules for Details. 

 



 

ACP ThinManager 6.0 PXE Server Configuration    231 

 

11.5.3.4 Group Modules on Terminals 

Terminals that are members of a Group may show icons to represent the properties of added modules. 

 

Terminal Module Selection Page 

  The Group icon represents modules assigned to a parent Group. 

  The Group icon with yellow plus sign represents properties that are changed on the 
terminal from the Group settings. This is limited to touch screen calibration.  

  The Group icon with the No circle represents a module that isn’t supported by the 
firmware package used by the terminal. 

 No icon indicates that the module was added to that particular Group or Terminal and not a 
parent Group. 

If you add a module to a group it will display the group icon and any configuration will need to be made at 
the group level.  
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The rest of the Group Configuration Wizard pages follow the Terminal Configuration Wizard pages. 
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12 Display Servers 

Display Servers are devices that provide content that can be displayed on the client. Examples include 
the traditional terminal server and IP cameras. 

The Terminal Server List Wizard allows configuration of Terminal Services Display Servers. The Camera 
Configuration Wizard allows configuration of Camera Display Servers 

12.1 Terminal Services Display Servers   
The Terminal Server List Wizard can be launched by: 

 Right clicking on the Display Servers Terminal Servers branch and choosing the Add Terminal 
Server command 

 Right clicking on the Display Servers Terminal Servers branch and choosing the Edit Terminal 
Server command. 

 

Terminal Server List Wizard 

Importance of Page: This allows you to define the terminal servers that will be used within ThinManager. 
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Fields: 

 {Unnamed) – The list box will contain the names and IP addresses of defined terminal servers. 

Buttons: 

 Edit Server – This will open the properties for a highlighted terminal server in the list. 

 Add Server - This will launch the Terminal Server Configuration Wizard to allow a new terminal 
server to be defined.. See  

 Remove Server – This will remove a highlighted terminal server from the list. 

 Find Servers - This will launch the Available Terminal Servers window for automated terminal 
server addition. 

 Cancel - This will close the wizard without action. 

 OK – This will close the wizard after accepting changes. 

Why Change from Default Settings: The terminals require terminal servers to connect and run sessions 
on.  

12.1.1.1 Available Terminal Servers Search 

 

Available Terminal Server Window 

The Available Terminal Servers window will display any Microsoft© terminal servers that are a member 
of the same domain or workgroup as ThinManager. Select the Find button to display the member servers. 
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Available Terminal Server Window 

The Domain or WorkGroup to Search field will allow ThinManager to search a different domain or 
workgroup. Enter the domain of workgroup to search and select the Find button to display the member 
servers. 

Once the terminal servers are listed, highlight one and select the OK button to add it to the Terminal 
Server Configuration Wizard. This will launch the Introduction page of the Terminal Server Wizard. 
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12.1.1.2 Terminal Server Wizard Introduction Page  

 

Terminal Server List Wizard Introduction 

Importance of Page: This displays introductory information. 

Select Next to continue or Cancel to close without saving. 
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12.1.1.3 Terminal Server Name Page  

 

Terminal Server List Wizard – Terminal Server Name 

Importance of Page: This page defines the terminal server and allows the addition of an administrative 
user account for increased management. 

Fields: 

 Terminal Server Name - Enter the computer name as found in the Microsoft© System Properties 
(NetBIOS name). The name will already be entered if the Find function on the Available 
Terminal Servers window was used.  

 Terminal Server IP – Entered the IP address of the terminal server. 

Login Information – Enter a Windows user account with administrative rights for the terminal server if 
you wish to display data from the terminal server within ThinManager. This is required to populate the 
User, Sessions, and Process tabs of the details pane. See Details Pane for details. 

 Domain - Enter the domain for the computer, if it is a member of a domain. 

 User Name – Enter the user name of the administrative account here. 

 Password - Enter the password for the administrative account used in the User Name field.  

 Verify Password – Re-enter the password for the administrative account used in the user name 
field. Passwords that do not match will be indicated by a warning message on the page. 

Buttons: 
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 Discover – The Discover button will automatically fill in the IP address for a terminal server listed 
in the Terminal Server Name field. 

 Schedule – The Schedule button will launch the Event Schedule for the terminal server. This 
allows the scheduling of repeated functions like rebooting and disabling. 
See Scheduling for details. 

Why Change from Default Settings: ThinManager uses a connection to the terminal server to pull the 
process, user, and session information for the detail pane tabs and to determine the load for 
SmartSession load balancing. Entering a username and password in the User Name and Password 
fields allows ThinServer to connect to the server for this data. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

12.1.1.4 Terminal Server Capabilities Page  

 

Terminal Server Capabilities 

Importance of Page: This allows a terminal server to be used for SmartSession. It also defines what 
communication protocols the server can use. 

Settings: 

 Supported Connections – This is a list of client/server communication protocols that the 
terminal server can use.  

o Citrix ICA – Check this checkbox if a Citrix server-side program is installed on the 
terminal server to provide the ICA protocol.  
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o Citrix Device Services - Check this checkbox if Citrix Device Services is installed and 
licensed on the terminal server. Citrix Device Services is a legacy deployment of the ICA 
client but is no longer supported by Citrix. Thin clients can still connect to terminal servers 
with Device Services, but no new Device Services terminal servers can be licensed. 

o Microsoft Remote Desktop Protocol  - RDP is installed by default on Windows 
Terminal Servers. Uncheck the Microsoft Remote Desktop Protocol checkbox if you 
don’t want to access to the terminal server with the protocol. 

 Available for Smart Session Server – This checkbox makes the terminal server available 
for Application Groups that use SmartSession to provide load balancing. See Display Client 
SmartSession Settings Page for more details. 

Why Change from Default Settings: Add SmartSession if you want to use SmartSession. Add Citrix ICA 
if that is being used. 

Note: Configuring a terminal server to use SmartSession uses a SmartSession license.  

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

 

12.1.1.5 Data Gathering Page 

 

Data Gathering 
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Importance of Page: This page sets the frequency that ThinManager polls the terminal servers for user, 
session, and process information. 

Settings: 

 Data Gathering Intervals (Fast/Medium/Slow) -  These settings set the rate of the frequency 
that ThinManager polls the terminal server for data. 

 Data Gathering Intervals (Custom) -  This setting allows the polling speeds to be set. 

o Smart Session Data Update Interval is the amount of time between the retrieval of 
SmartSession data, CPU usage, memory usage, and session count, from the terminal 
server. This setting affects the update speed of the Server Rankings used in 
SmartSession load balancing. 

o Process Update Interval is the amount of time between the retrieval of the process 
information on the terminal server. This setting affects the speed of the update of the 
process information on the Processes tab for the terminal server. 

o Session Update Interval is the amount of time between the retrieval of session data 
from the terminal server. This setting affects the speed of the update of the user 
information for the sessions on the Users and Sessions tabs for the terminal server. 

Why Change from Default Settings: Faster rates will lead to quicker updates but will add more network 
traffic. Slowing down the rate will cause less traffic but will slow the update rate a little. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

If this terminal server is used as a SmartSession server, the Next button will go to a SmartSession 
Configuration page. If this terminal server is not configured as a SmartSession server, the Next button will 
be grayed out and the Finish button will close the wizard. 
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12.1.1.6 SmartSession Configuration Page 

 

Terminal Server List Wizard - SmartSession Configuration 

Importance of Page: This allows SmartSession data to be tweaked. 

ThinManager uses the CPU utilization, Memory utilization, and number of sessions on the terminal 
server to define the SmartSession terminal server’s available resources. ThinManager uses these 
resource values to rank the load of the SmartSession servers. ThinManager supplies this load data to the 
terminals to allow the terminals to connect to the terminal server with the lightest load and greatest 
available resources.  

The SmartSession Configuration page allows the configuration of the three parameters that 
ThinManager uses to determine availability for SmartSession. ThinManager will scale the range between 
the Minimum field and Maximum field as 100%. 

Settings - The three values used in SmartSession are: 

 CPU Utilization – The percentage of CPU usage on the terminal server. 

 Memory Utilization - The percentage of CPU usage on the terminal server. 

 Sessions – The number of sessions on a terminal server. 

Fields: 

 Minimum – the value that ThinManager will use as the starting point of the load. A value below 
the Minimum is considered to be unused. 



 

242    Display Servers ACP ThinManager 6.0 

 Maximum – the value that ThinManager will consider the parameter as reaching 100% utilized 
and is unavailable. 

Why Change from Default Settings: Changing the Minimum and Maximum values will change the range 
used to calculate SmartSession loads and can influence SmartSession behavior. 

Select Finish to save and close or Cancel to close without saving. 

 

12.2 Camera Configuration Wizard 
The Camera Configuration Wizard allows an IP Camera to be configured as a Display Server within 
ThinManager. 

Launch the Camera Configuration Wizard by right clicking on Cameras in the Display Servers branch 
and selecting Add Camera. 

12.2.1.1 Camera Name Page 

 
Camera Configuration Wizard 

Importance of Page: This page names and addresses the IP Camera. 

Fields and Settings: 
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 Camera Name and Group 

o Camera Name – Enter a name for the camera. 

o Change Group – This button allows the camera to be added to a Camera Group. 

 Camera Model 

o Make – Use the drop-down to select a manufacturer. 

o Model – Use the drop-down to select a model. 

 Camera Network Setup 

o IP Address – Enter the IP address of the IP camera. 

o Port – Enter the port used. 

Why Change from Default Settings: Each camera needs to be defined. 

The first page of the camera configuration wizard requires that a camera name be entered. Select the 
make and model of the camera you are configuring and the IP address and Port that has been previously 
assigned to the camera. The IP address and port are set by using the camera manufacturers 
configuration software or through the use of the camera’s web browser interface. 

12.2.1.2 Camera Authentication Page 

 
Camera Authentication 
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Importance of Page: This page provides authentication, if needed. 

Fields: 

 Username – Enter a username, if needed. 

 Password – Enter a password, if needed 

 Verify Password – Re-enter the password for accuracy. 

Why Change from Default Settings: If your camera requires authentication enter it on this page. If the 
camera has been configured to allow anonymous connections, leave the information blank.  

The terminal uses the authentication information when connecting to the camera. Authentication 
information is setup in the camera by using the camera manufacturers configuration software or through 
the use of the camera’s web browser interface. 

12.2.1.3 Camera Model Options 

 
Camera Model Options 

Importance of Page: This page allows additional camera configuration. 

Fields: 

 Include Camera Options – This checkbox shows addition options when checked. 
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 Options – The options shown vary by make and model of the camera hardware. Please see 
camera documentation for their help. 

Why Change from Default Settings: The camera can be controlled in finer deta 

Some cameras support additional configuration options. These options can be configured on this page. If 
you wish to use the default options then leave the Include Camera Options unchecked. The newly 
created camera will appear in the ThinManager tree as follows. 

 
Camera Tree View 
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12.2.2 IP Camera Group Configuration 
The camera group configuration wizard can be launched by right clicking on the Cameras branch of the 
ThinManager tree and selecting the Add Camera Group option. 

 

 
Add Camera Group Wizard 

Enter the Camera Group Name and select Finish. The Camera group will be shown in the ThinManager 
tree as follows. 
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Camera Group Tree View 
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12.2.3 IP Camera Administration 
Once a camera is configured in ThinManager, the Connect tab can be used to connect to the camera 
and perform camera administration from ThinManager. 

 

 
Camera Connect Tab 

Camera log in information may be requested when using the connect tab. The authentication information 
entered during the camera configuration is not used when using the connect tab. 
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13 Display Clients 

Display Client is the term used to denote the graphic rendering of the output from a Display Server. This 
could be a traditional Terminal Server session, IP Camera display, a Terminal-to-Terminal Shadow 
session or a workstation session.  

 

 

13.1 Display Client List 
The Display Client List Wizard can be launched by either: 

 Right clicking on the Display Client branch and choosing the Add Display Client command 

  Right clicking on the Display Client branch and choosing the Edit Display Client command. 

 

Display Client List Wizard 

The opening window of the Display Client List Wizard will show any Display Clients that are defined or 
will be blank if none have been defined. 

Fields: 

 (Unnamed)  – The list box shows Display Clients that are created. 

Buttons: 



 

250    Display Clients ACP ThinManager 6.0 

 Add Group – This will launch the Display Client Wizard to create a new Display Client.  

 Edit Group – This will open the properties for a highlighted Display Client. 

 Delete Group – This will remove a highlighted Display Client from the list. 

 Cancel – This will close the wizard without action. 

 OK - This will close the wizard after accepting changes. 

13.1.1.1 Display Client Name Page 

 

Display Client Name Page 

Importance of Page: This page starts the configuration wizard, sets the name, and the type of Display 
Client. 

Fields: 

 Group Name – This field is used to name the Display Client. 

Settings: 

 Type of Display Client drop-down box selects the function of the Display Client. 

o Terminal Services – This creates a Display Client that allows a terminal to connect to a 
terminal server, login, and run a session. 
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o Terminal Shadow – creates a Display Client that allows a terminal to be shadowed by 
another terminal. 

o Camera – creates a Display Client that allows the use of IP Cameras. 

o Workstation – creates a template for workstation deployment. The Workstation Display 
Client gets assigned to a specific workstation when it is applied to a terminal. See Virtual 
Workstations for details. 

Buttons: 

 Permissions - The button will launch the Permissions window that allows Permissions to be set 
for TermSecure. This is discussed in Permissions. 

Why Change from Default Settings: The group needs a name and a type assigned to it. 

This section covers Terminal Services Display Clients. Once the Type of Display Client is set to 
Terminal Services select Next to configure the group options. 
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13.2 Terminal Services Display Clients 
The Terminal Services Display Clients of ThinManager have the same function as the Terminal Server 
Groups from pre-3.2 versions of ThinManager and the Application Groups of ThinManager 3.2 and 3.3. 
They allow a terminal to connect to a terminal server, login, and run a session. The specific terminal 
server that the terminal connects to is based on the Display Client configuration and options. 

13.2.1.1 Display Client Options Page 

 

Display Client Options 

Importance of Page: This page allows the configuration of Display Client parameters 

Checkbox: 

 Allow group to be tiled – If checked, this allows the Display Client to be tiled in SessionTiling. 
See SessionTiling Options for details. 

 Allow Group to be moved (MultiMonitor) – If checked, this allows a Display Client to be moved 
from one MultiMonitor screen to another. See MultiMonitor for details. 
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 Include IP Camera Overlays –This will allow IP Camera overlays to be added to this Display 
Client. 

 Always maintain a connection – This keeps a session active, reconnecting and restarting if it is 
closed. If unchecked, the user can close a session and another session won’t start automatically.  

 Connect at boot-up – If checked, the terminal will start a session for this Display Client at boot 
up. If unchecked, a user action is required to start the session. 

 Disconnect in background – If checked, a Display Client being used in a MultiSession 
configuration will disconnect once it is moved into the background. This could be done to require 
fewer resources.  

Why Change from Default Settings:  The Always maintain a connection and Connect at boot up 
checkboxes, if unselected, will lower the demand on the terminal servers by allowing sessions to be 
closed until needed.  

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

 

13.2.1.2 Terminal Services Display Client Type Page 

 

Terminal Services Display Client Type 

Importance of Page: Each Terminal Services Display Client can use a single protocol to connect to the 
terminal servers. 
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Settings: 

 Citrix ICA – This allows the use of the Citrix© ICA protocol in client to server communications. 

 Citrix Device Services – This is a legacy version of the ICA protocol used on Windows NT and 
Windows 2000 terminal servers. 

 Remote Desktop Protocol (RDP) – This is the default protocol from Microsoft©. It is 
automatically installed on Microsoft© terminal servers. 

Why Change from Default Settings: Change to the Citrix© ICA protocol if the Citrix© ICA protocol is 
going to be used instead of the default RDP. 

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

 

13.2.1.3 Terminal Services Display Client Options Page 

 

Terminal Services Display Client Options 

Importance of Page: This page sets the roles of the Display Client. 

Checkbox: 

 SmartSession Group –  - This adds SmartSession to the Display Client, which provides load 
balancing between member terminal servers.   
SmartSession uses CPU availability, memory, and the number of sessions on the member 
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terminal servers to determine the load on the servers. Thin clients connect to the terminal server 
in the Display Client with the most available resources. See SmartSession Option for details. 

 Application Link Group (AppLink) –  - AppLink, provides the Initial Program function to thin 
clients that connect to members of the Display Client. The Initial Program function launches a 
program instead of the desktop. Closing the program will end the connection and force a 
reconnection to a session running the application. See AppLink Option for details. 

 Enforce Primary - This allows a thin client to connect to its original terminal server if that terminal 
server has failed and recovered. This is not available if SmartSession is selected. 

 Instant Failover (requires license) - This provides Instant Failover where the terminal will 
connect to two terminal servers in the Display Client. The terminal will have an active session on 
two terminal servers but will only display one session. If the first terminal server fails, the session 
of the second terminal server session is immediately displayed, eliminating any downtime due to 
terminal server failure. 

 Allow Auto-Login - If checked, the terminal will use the login information supplied in the terminal 
configuration to automatically logon to the terminal server. If unchecked, the user will be required 
to manually login to the terminal server.  

Why Change from Default Settings: Display Client features like SmartSession and Instant Failover are 
added on this page. You can force users to manually login to a session by deselecting the Allow Auto-
Login checkbox. 

Note: Enforce Primary is not available with SmartSession. 

13.2.1.4 SmartSession Option 

SmartSession is a load balancing strategy that allows terminals to connect to the member of a Terminal 
Services Display Client that has the most available resources. ThinManager monitors the CPU load, 
memory availability, and number of sessions on the terminal servers and ranks them by availability. 
When a thin client connects to a member of a Terminal Services Display Client with SmartSession, the 
terminal connects to the terminal server with the lightest load. 

 

SmartSession 

Each member terminal server needs SmartSession configured in the Terminal Server Display Server 
Wizard. See Terminal Server Capabilities Page for details. 
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Once ThinManager has polled the terminal servers and established the availability of their resources, 
ThinManager passes the Server Ranking to the thin clients for its connection instructions. 

 

ThinManager Interface – Server Rank Tab 

The Server Rankings are displayed on the Server Rank tab when a Terminal Services Display Client is 
highlighted in the ThinManager tree. In the example above a thin client would connect to Green22 
because it has the lowest load. 

13.2.1.5 AppLink Option 

AppLink provides the Initial Program functionality to a Terminal Services Display Client. If AppLink is 
enabled, the path to an Initial Program is entered into the AppLink Page of Terminal Services Display 
Client Wizard. This program will be the only program to run in that session.  

Note: If the AppLink option is not used then the terminal services session will display a desktop. 

 

Note: If a Terminal Services Display Client contains several terminal servers, the path must be valid on all 
terminal servers. If different terminal servers have different paths to the desired program, write a batch file 
to open the program. 
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13.2.1.6 Instant Failover Option 

Terminal Services Display Clients can provide Instant Failover without using the Instant Failover 
Module. With Instant Failover a terminal will connect to a session on two terminal servers. Both sessions 
are active but only one is displayed. If the first terminal server fails, the second session is immediately 
displayed, eliminating any downtime due to terminal server failure. 

Note: AppLink and Auto-Login is normally used with Instant Failover to provide instant access to an 
application. 

Instant Failover is configured by selecting the Instant Failover checkbox on the Terminal Services 
Display Client Options page of the Terminal Services Display Client Wizard, 

Instant Failover works with the terminal servers of a Display Client, not between different Display Clients.  

Note: Do not use the Instant Failover Module when using Instant Failover in Display Client. 

In a standard Terminal Services Display Client, the terminal will use the first listed terminal server as 
the primary server and will use the second listed terminal server as the secondary server. 

If using SmartSession, the primary session will be on the server with the lightest load and the backup 
session will be on the terminal server with the second lightest load. 
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13.2.1.7 Display Client Members Page 

 

Display Client Members 

Importance of Page: This allows the selection of the terminal servers that will be members of the Display 
Client. Adding multiple terminal servers to the Selected Terminal Server list will establish failover. 

List Box: 

 Available Terminal Servers – This is the list of the terminals configured in the Terminal Server 
Configuration Wizard and available to the terminal. 
If the Available Terminal Server list box is empty the Terminal Server Configuration Wizard can 
be launched with the Edit Server List button to define the terminal servers. 

 Selected Terminal Servers – This is the list of terminal servers that the Display Client will use. 
Move the terminal servers to this list with the left and right arrow or by double clicking on the 
name.  
Listing two or more terminal servers configures Failover.  
The terminal will connect to the terminal servers in the order listed unless SmartSession is used. 
The terminal will connect to the terminal server with the lightest load if SmartSession is being 
used. 

Buttons: 
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 Arrows – The left and right arrows move the terminal servers between list boxes. The up and 
down arrow change the order that the terminal servers are used. The top terminal server is 
considered the primary terminal server.  

 Edit Server List – This launches the Terminal Server Configuration Wizard that allows 
terminal servers to be defined within ThinManager. Selecting Manage > Terminal Server List 
from the ThinManager menu will also launch the Terminal Server Configuration Wizard. 

Why Change from Default Settings: It is critical to list the terminal servers that the Display Client will 
use. The wizard will not advance without a terminal server selected.  

If the Available Terminal Servers column is empty, the Terminal Server List Wizard needs to be run to 
define the terminal servers. Select the Edit Server List to launch the Terminal Server Configuration 
Wizard and define the terminal servers. 

If the Display Client is using the SmartSession option, the Next button will launch the SmartSession 
Settings page.  

If the Display Client is not SmartSession Group the Finish button will complete the Display Client 
configuration. 

13.2.1.8 Display Client SmartSession Settings Page 

 

Smart Session Settings 
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Importance of Page: This allows tweaking of SmartSession values by adjusting the weights of the 
SmartSession settings. 

ThinManager multiplies the CPU utilization, Memory utilization, and number of sessions on the terminal 
server by the Weight shown to define the SmartSession terminal server’s available resources.  

The higher the Weight, relative to the others, the greater the importance that parameter has in 
determining the load for SmartSession. 

The SmartSession load = (CPU weight * CPU Utilization %) + (Memory weight * Memory Utilization %) + 
(Session weight * Session Utilization %) 

Settings: 

 CPU Utilization Weight – This is the CPU multiplier. 

 Memory Utilization Weight – This is the Memory multiplier. 

 Session Weight – This is the Session multiplier. 

Queuing controls the rate that terminals connect to the terminal servers in the Display Client to allow 
processor intensive applications to load one at a time instead of many sessions forming at once, bringing 
the server to a halt. As terminals that use SmartSession Queuing boot, they request their terminal server 
from ThinManager. ThinManager will send the first terminal to the terminal server with the lightest load 
and will put the other terminals in a queue for the interval defined in the Min _ Sec field. This allows the 
terminal server load to stabilize and allows ThinManager to re-sample the loads and send the terminal to 
the terminal server with the lowest current load. 

Fields: 

 Min _ Sec – This is the amount of seconds that a terminal will wait in the queue before being sent 
to a terminal server that has another terminal connecting. The terminal may wait longer than this 
value to connect if the CPU of the terminal server exceeds the Maximum CPU Utilization 
defined on the SmartSession Configuration page of the Terminal Server Configuration 
wizard. See SmartSession Configuration Page for details. 

 Max _ Sec – This is the maximum amount of seconds that a terminal will wait in the queue before 
being sent to the terminal server to login, regardless of the load. 

Checkbox: 

 Infinite - If the Infinite checkbox is selected, ThinManager will wait until the CPU utilization of the 
terminal server has regained an acceptable range before sending other terminals to it to login. 

Why Change from Default Settings: The values can be tweaked to alter performance, if needed. 

 

Note: The Weighs are relative. Increasing all three Weights from “1” to “10” doesn’t change the relative 
values. 

If the Display Client uses the AppLink option, an AppLink page will be displayed by selecting the Next 
button. 
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13.2.1.9 Display Client Linked Application Page 

 

AppLink Path 

Importance of Page: This page configures the Display Client as an AppLink group where it will launch a 
single application in the session. If this application is closed the terminal will reconnect and re-launch the 
application. 

Fields: 

 Program Path and Filename - Enter the path to the desired application in the field.  

Note: Quotation marks may be needed when there is a space in the path. 

 Command Line Options – This field provides a space for command line options and switches. 
This field may not be required. 

 Start in the following folder - This field is provided in case you need to specify the working 
directory for the program when using a relative path for the initial program. This field may not be 
required. 

Buttons: 

 Browse – The Browse button will allow you to select the executable file using a file browser. 
Make sure the path is correct on all terminal servers. 
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Note: If a Terminal Services Display Client contains several terminal servers, the path must be valid on all 
terminal servers. If different terminal servers have different paths to the desired program, write a batch file 
to open the program. 

Why Change from Default Settings: This allows you to control a user’s access. If the Display Client 
uses AppLink the user will not get a desktop or icons but will be limited to the application specified. 
Closing it will re-launch the program, assuring that it is always running. 

Selecting the Finish button will close the Display Client List wizard and display the created terminal 
server groups. 

 

13.3 Camera Display Clients  
The Camera Display Client configuration wizard can be launched by right clicking on the Camera branch 
of the ThinManager tree and selecting the Add Display Client option. 

 

Camera Display Client Wizard – Name 

Importance of Page: Allows naming and selection of Display Client type. 

Fields: 

 Client Name – Name for Display Client. 
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 Type of Display Client – Drop-down to select type of Display Client. 

Button: 

 Permissions – Sets TermSecure permissions. See Permissions for details. 

Why Change from Default Settings: The display client needs a name. 

Enter the name of the Display Client and any TermSecure permissions on this page. 

 

Camera Display Client Options 

Importance of Page: Sets Display Client options. 

Checkbox: 

 Allow Display Client to be tiled – Allows tiling of the client. 

 Allow Display Client to be moved (MultiMonitor) – Allows the Display Client to be opened in 
any MultiMonitor window. 

Why Change from Default Settings: Provides additional options. 

Select if this Display Client can be tiled and if when using MultiMonitor it can be moved to a different 
screen. 
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13.3.1.1 Overlay Layout Page 

 

Camera Display Client Overlay Layout 

Importance of Page: Sets camera layout 

Settings: 

 Choose Camera Overlay – Allows you to set the layout of the displays. You may have a single 
overlay or multiple overlays on the Display Client. 

 Display Size – Sets the size (resolution) of the display to be shown. 

Buttons: 

 Add Overlay – Adds an overlay to the Display Client. 

 Remove Overlay – Removes a highlighted overlay from the Display Client. 

Why Change from Default Settings: You need at least one overlay in the Display Client. 

This page determines the layout of the camera overlays. You can define your own custom layout or 
choose from predefined layouts. The Display Size selection should be set to the resolution of the 
terminal screen to which the Display Client will be added. The picture on this page represents the overlay 
layout. 
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Camera Display Client Layout Selection 

Use the layout drop down to select the desired layout. 
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Camera Display Client 2x2 Layout Selection 

Once a layout has been selected, it will be represented graphically. Select Next to configure the overlays. 
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13.3.1.2 Overlay Cameras Page 

 

Camera Display Client Overlay definition 

Importance of Page: Configures the overlays. 

Fields: 

 Overlay Name – Name for the overlay (filled in by default). 

Settings: 

 Left – Sets the left side of the overlay in pixels. 

 Top – Sets the top of the overlay in pixels. 

 Width – Sets the overlay width in pixels. 

 Height – Sets the overlay height in pixels. 

Buttons: 

 Add – Adds a camera to the overlay. 

 Delete – Removes a highlighted camera from the overlay. 

 Set Initial Camera – Sets the initial camera from a series of cameras. 

 Overlay Options – Launches the Overlay Options page. 
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Checkbox: 

 All Cameras Available – This makes all cameras available if checked. If unchecked the Add 
button allows specific cameras to be added.  

Why Change from Default Settings: Each Camera Display Client needs overlays. 

Each overlay will be given a default name. The grey region of the screen representation is the overlay 
which is currently being configured. If the All Cameras Available checkbox is checked, all of the 
cameras will be available to be selected by the user at the terminal. 

 
Set Initial Camera Dialog 

Selecting the Set Initial Camera button allows the camera the overlay will start on at boot up to be 
selected.  
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Overlay Camera Selection 

If the All Cameras Available checkbox is unchecked, cameras must be added manually. Use the Add 
button to add cameras to the list. Adding more than one camera allows the user to select from these 
cameras at the terminal and allows the cycling between the listed cameras. 
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Camera Selection 

 
Overlay Options 

Clicking the Overlay Options button will allow the setting of additional overlay options. 

General Options: 
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 Enable Overlay – This option allows the overlay to be started in a disabled non-visible state. The 
TermMon ActiveX Control can be used by an application to enable the overlay. 

  Interactive – This option allows the user on the terminal to interact with the overlay. If the user 
clicks in the overlay area, he can perform functions such as switching cameras and making the 
overlay full screen. 

 Scale – This option will scale camera frames to be to the size of the overlay window. Aspect ratio 
will be maintained. 

 Crop – This option will crop the camera frame if it is larger than the camera overlay. This option 
when combined with the Scale option will always fill the entire overlay area. 

 Show Complete Camera Name – Using this option allows the entire path of the camera to be 
displayed. The path includes any groups of which the camera is a member. 

 Border Size – This setting determines the size of the overlay outside border. 

Title Options: 

 Title Position – This is the position of the camera name within the overlay. 

 Title Size – This is the size of the camera name when displayed within the overlay. Set this to 
Don’t’ Show Title if you do not want the camera name displayed. 

Cycling Options: 

 Enable Cycling – Check this setting to cycle between the cameras assigned to the overly. 

 Cycle Time – This is the time in seconds that the overlay will display each camera before 
switching to the next camera. 

 
Camera Display Client Tree View 
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Once a Camera Display Client has been configured it will be reflected in the ThinManager tree under 
Display Clients->Camera. 

 
Terminal Configuration Display Client Selection 

During the terminal configuration, select the desired Display Clients for the terminal. Multiple Display 
Clients can be added to the configuration for a MultiSession configuration. 
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Camera Display Client Terminal Tree View 

When the terminal is running, the Camera Display Client status will be reflected in the ThinManager 
terminal tree view. The status of each Camera Overlay and Camera will be displayed. A green lightning 
bolt on the Display Client icon represents that Display Client is in the foreground. A yellow lightning bolt 
on the Display Client icon represents that the Display Client is in the background. A green lightning bolt 
on the overlay icon represents an active overlay. A green lightning bolt on the camera icon represents an 
active connection to the camera.  
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13.3.2 Adding a Camera Overlay to a Display Client 

 
Terminal Configuration Display Client Options 

During the terminal configuration check the Include IP Camera Overlays option to add camera overlays 
to a Display Client. 
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Terminal Configuration Overlay Layout 

Camera Overlays can be configured before completing the Terminal Configuration wizard,  

 
Terminal Configuration Add Camera Overlay 

Clicking the Add Overlay button will allow the creation of the overlay. Enter the name position and size of 
the desired overlay. 
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Camera Overlay Layout 

Once an overlay has been added, it will be represented as a white outlined square on the layout page. 
Selecting the Next button will allow the completion of the configuration camera overlays 
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Overlay Camera Selection 

The camera overlay configuration can be completed as described in the IP Camera Display Server 
Configuration Wizard section. 

13.3.3 Camera Overlays and TermMon ActiveX Control 
Camera Overlays can be controlled by an application by using the TermMon ActiveX Control. The Control 
can be used to perform operations such as switching cameras and changing the overlay size and 
position. See TermMon ActiveX for details.  
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13.4 Terminal Shadow Display Clients 
Terminal Shadow Display Clients allow a terminal to shadow another terminal. The Shadow Display Client 
can contain a specific terminal or several terminals. 

13.4.1.1 Group Name Page 

 

Terminal Shadow Display Client - Group Name Page 

Importance of Page: This page starts the configuration wizard, sets the name, and the type of Display 
Client. 

Fields: 

 Group Name – This field is used to name the Display Client. 

Settings: 

 Type of Display Client drop-down box selects the function of the Display Client. 

o Terminal Services – This creates a Display Client that allows a terminal to connect to a 
terminal server, login, and run a session. 
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o Terminal Shadow – creates a Display Client that allows a terminal to be shadowed by 
another terminal. 

Buttons: 

 Permissions - The button will launch the Permissions window that allows Permissions to be set 
for TermSecure. This is discussed in Permissions. 

Why Change from Default Settings: The group needs a name and a type assigned to it. 

This section covers Terminal Shadow Display Clients. Configure the Display Client by selecting 
Terminal Shadow from the Type of Display Client drop-down after naming the group. 

Select the Next button to continue. 

 

Terminal Shadow Display Client –Display Client Options 

Importance of Page: This page allows the configuration of Display Client parameters 

Checkbox: 

 Allow group to be tiled – If checked, this allows the Display Client to be tiled in SessionTiling. 
See SessionTiling Options for details. 

 Allow Group to be moved (MultiMonitor) – If checked, this allows a Display Client to be moved 
from one MultiMonitor screen to another. See MultiMonitor for details. 
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 Include IP Camera Overlays –This will allow IP Camera overlays to be added to this Display 
Client. 

 Always maintain a connection – This keeps a session active, reconnecting and restarting if it is 
closed. If unchecked, the user can close a session and another session won’t start automatically.  

 Connect at boot-up – If checked, the terminal will start a session for this Display Client at boot 
up. If unchecked, a user action is required to start the session. 

 Disconnect in background – If checked, a Display Client being used in a MultiSession 
configuration will disconnect once it is moved into the background. This could be done to require 
fewer resources.  

Why Change from Default Settings:  The Always maintain a session for this group and Start a 
session at boot-up for this group checkboxes, if unselected, will lower the demand on the terminal 
servers by allowing sessions to be closed until needed.  

Select Next to continue, Finish to save and close, or Cancel to close without saving. 

13.4.1.2 Terminal Shadow Display Client Page 

The Terminal Shadow Display Client page allows the selection of the terminal or terminals to be 
shadowed. 

 

Terminal Shadow Display Client – All Terminals Available 
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Importance of Page: This page selects what terminals are available to be shadowed using Terminal-to-
Terminal Shadowing. 

Checkbox: 

 All Terminals Available – This checkbox allows all terminals to be shadowed. Unselect it to limit 
Terminal-to-Terminal Shadowing to specific terminals.  

 Interactive Shadow – This checkbox allows interactive shadowing of the terminals. 

Fields: 

 Terminal to Shadow – This list box shows the terminals available to shadow. 

Buttons: 

 Add – This button adds terminals to the Terminal to Shadow list box when All Terminals 
Available is unselected. 

 Delete – This button deletes a highlighted terminal from the Terminal to Shadow list box when 
All Terminals Available is unselected. 

Why Change from Default Settings: The default setting grants permission to shadow all of the 
terminals. Unselecting the All Terminals Available checkbox allows specific terminals to be added. 
Additionally, multiple shadow groups can be created, each with a specific terminal or group of terminals. 

 

By default the Shadow Group is configured to allow all terminals to be shadowed. Unselecting the All 
Terminals Available checkbox will allow the designation of specific terminals. 
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Terminal Shadow Display Client –Select Terminals 

Select the Add button to launch the terminal selection window. 
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Select Terminal or Group Window 

Select a terminal for shadowing by highlighting it in the Select Terminal or Group window and selecting 
the OK button. The window will close after each selection. 

To add multiple terminals repeat the process by selecting the Add button on the Terminal Shadow 
Display Client page. 
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Terminal Shadow Display Client – Selected Terminals 

The Terminals to Shadow textbox will display the terminals added to the list. 

 

Terminal Selector 
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When a terminal launches a Shadow Display Client that has multiple members a Select Terminal to 
Shadow window will be displayed to allow the selection of the terminal to shadow. Highlight the desired 
terminal and select the OK button. 

13.4.1.3 Display Client List Window 

 

Available Display Clients 

After a Display Client is configured the Display Client List will show configured Display Clients. 

Additional groups can be configured by selecting the New Group button.  

The Display Client List wizard can be closed by selecting OK. 
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14 Failover and Instant Failover 

14.1 Failover Introduction 
ACP uses specific terms to cover different topics that are concerned with keeping data viable during 
computer failure.  

Replacement: If a terminal fails or is destroyed, the session stays active on the terminal server while the 
thin client is replaced. This is covered in Adding Thin Client Hardware. 

Failover: Failover is the ability to switch between multiple terminal servers if a terminal server fails. This 
is built in to every ThinManager System and thin client. This is covered in Failover. 

Instant Failover: Instant Failover is the ability of thin clients to connect and login to two terminal servers 
simultaneously. This allows applications to be pre-loaded so that a failure to one terminal server causes 
minimal impact because the terminal will quickly switch to an existing session. This is covered in Instant 
Failover. 

Redundancy: Redundancy refers to multiple ThinManager Servers. Thin clients are not dependent on 
ThinManager after booting and will continue to run if the ThinManager Server fails. However, rebooted 
terminal will wait until the ThinManager Server is restored until it boots and receives its configuration. For 
this reason many people use a backup, or Redundant ThinManager Server. This is covered in 
Redundancy Overview. 

14.2 Failover  
ThinManager gives every thin client has the ability to switch between multiple terminal servers if a 
terminal server fails. Each thin client has a socket connection to its terminal servers. If the socket breaks 
the thin client will try to reconnect to the primary Terminal Server. If the terminal server fails to respond to 
the terminal, it will drop the broken connection and connect to a backup terminal server, allowing it to 
continue to function.  

Failover requires:  

 Two or more terminal servers  

 Identical Microsoft user accounts on each, or domain permissions on both  

 Identical applications on each, with the same path, to make life easier  
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Failover Step 1 – Session on Primary Terminal Server 

The thin client is configured to use two or more terminal servers. 

 

Failover Step 2 – Primary Terminal Server Failure 

If the connection between the thin client and terminal server fails the thin client will retry the connection. 
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Failover Step 3 – Thin Client Automatically Switches to Secondary Terminal Server 

If the thin client cannot connect to the primary terminal server it will automatically switch to the next 
terminal server in the list, and start a new session. 

 

Failover Step 4 – Thin client has Session Running on Secondary Terminal Server 

Once connected it will login and launch the AppLink application. Any runtime data will remain constant 
since both servers are drawing the same runtime data from the production floor. 

Note: This does not synchronize the hard drives. Failover gives you the ability to continue to run the thin 
client by connecting to a backup. Data pulled from an outside source like a PLC or file server would be 
the same on either terminal server.  

14.2.1 Failover Setup in Terminal Services Display Clients  
Failover is configured in the Display Client Configuration Wizard. Terminal Services Display Clients allow 
a terminal to run a session from a list of terminal servers. The Display Client will have Failover capability if 
two or more terminal servers added to it.  

Launch the Display Client Wizard by right clicking on the Display Clients branch in the tree. Alternatively, 
you can right click on an existing Terminal Services Display client in the tree and select Modify. 
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Display Client List 

Select the Add button to add a new Display Client, or highlight an existing Terminal Services Display 
Client and select the Edit button to edit an existing Display Client. 

 

Display Client Wizard – Display Client Members  

Member terminal servers are added on the Display Clients Members page. Adding two or more terminal 
servers to the Selected Terminal Servers field will enable failover. The terminal will connect to the 
terminal servers in the order given, unless the Display Client is using SmartSession.  
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Terminal Services Display Client Options  

SmartSession uses the CPU usage, Memory usage, and the number of sessions on a terminal server to 
determine its load. Terminals using Terminal Services Display Clients with SmartSession will start a 
session on the server with the lightest load, instead of the order listed.  

Selecting the SmartSession checkbox on the Display Client Options page of the Display Client 
Wizard configures SmartSession. When SmartSession is used the Enforce Primary checkbox is no 
longer relevant. 
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14.3 Instant Failover  
Every ThinManager thin client can be configured to use basic failover. Detecting that the primary server is 
down and connecting to a backup server is usually achieved in10 to 20 seconds, depending on the 
monitoring configuration. Some applications will need additional time to launch and initialize the 
programs. Instant Failover was developed for people who need the session to switch to another terminal 
server and start running immediately, without any delays for starting the applications.  

When using Instant Failover, the thin client starts sessions on two servers at once. The sessions are 
cascaded on the thin client, with the primary session on top. If the primary terminal server fails, the 
preexisting secondary session is switched to the forefront.  

Note: Use a Username, Password, and Initial Program to allow the thin client to login automatically and 
start a program so that the background session is immediately ready and not needing a login and 
program launch.  

 

Instant Failover Step 1 – Session on Two Terminal Servers 

Instant Failover configures the thin client to make connections to two terminal servers for each AppLink 
Display Client. These will be cascaded so only the primary session is shown. There is an optional hot key 
toggle available to allow toggling between sessions. See Hotkey Configuration for details.  

This allows the thin client to connect and initialize a session on a backup server so you don’t have to wait 
for the session to load. 
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Instant Failover Step 2 – Primary Terminal Server Failure 

The thin client has a socket connection to each terminal server so it will quickly detect a terminal server 
failure. 

 

Instant Failover Step 3 – Switching to Backup Session on Secondary Terminal Server 

As soon as the thin client detects the failure of the primary terminal server the thin client will switch to the 
backup session and pull it to the foreground. Since the session is already initialized you don’t have to wait 
for your control system to load. 
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Instant Failover Step 4 – Session on Secondary Terminal Server 

Instant Failover allows the thin client to use two active sessions to prevent downtime. 

Note: Instant Failover is free from ThinManager but usually requires two application licenses since you 
have two active sessions. Please see your application vendors for details on their licensing policies. 

If three or more terminal servers are in the Selected Terminal Server list, the thin client will connect to a 
new backup to ensure that it has an active backup. 

If the Enforce Primary feature is used, the thin client will switch back to the primary once it is back 
online.  

14.4 Instant Failover Configuration 
Instant Failover is configured as part of Terminal Services Display Clients Wizard. 

14.4.1 Instant Failover Setup in Terminal Services Display Clients  
Terminal Services Display Clients allow a terminal to run a session from a list of terminal servers. The 
Display Client will have Instant Failover capability if two or more terminal servers added to it and the 
Instant Failover option is selected. This is configured in the Terminal Services Display Client Wizard.  

Launch the Display Client Wizard by right clicking on the Display Clients branch in the tree. Alternatively, 
you can right click on an existing Terminal Services Display client in the tree and select Modify. 
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Display Client List 

Select the Add button to add a new Display Client, or highlight an existing Terminal Services Display 
Client and select the Edit button to edit an existing Display Client. 
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Display Client Wizard – Terminal Services and Workstations Options Page 

Select the Instant Failover check box on the Display Client Options page to enable instant failover for 
the Display Client.  

Note: Do not use the Instant Failover Module when using Instant Failover within a Display Client  

The Terminal Services Options page allows the configuration of other parameters in addition to the 
Instant Failover such as SmartSession and AppLink. See Terminal Services Display Client Options for 
details. 

Each Terminal Services Display Client needs two or more terminal servers to get Instant Failover to 
function. This is done on the Display Clients Members page of the Display Client Wizard.  

 

Display Client Wizard – Display Client Members Page  

Select two or more terminal servers from the Available Terminal Servers list and move them to the 
Selected Terminal Servers list by highlighting and double clicking, or by using the Arrow button.  

The thin client will start sessions on the top two terminal servers in the Select Terminal Server list, with 
the top terminal server as the primary and the second terminal server as the backup, unless 
SmartSession was chosen on the Group Options page.  

If more than two terminal servers are selected, the thin client will connect to the other terminal servers if 
one of the other terminal servers fails.  
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14.4.2 Switching Between Sessions with Display Clients 
Instant Failover can be configured to allow a user to toggle between the two instant failover sessions 
when the thin client is using Display Clients by using a hotkey. To configure the hotkey run the Terminal 
Configuration Wizard for the terminal or terminal group that is using a Terminal Services Display Client 
with Instant Failover and proceed to the Hotkey Configuration page. 

 

Terminal Configuration Wizard – Hotkey Configuration Page  

When a thin client is using Terminal Services Display Clients, selecting the Enable Instant Failover 
Hotkeys check box will allow the user to switch between instant failover sessions using the default CTL + 
F9 hot key.  

The default hotkey can be changed by selecting the upper Change Hotkeys button and launching the 
Select Hotkeys windows.  

Note: The hotkey will not work properly if Enforce Primary is selected as a Display Client option on the 
Terminal Services Options page. As soon as you try to switch to the backup the thin client will switch you 
back to the Primary Terminal Server. It is recommended that you uncheck the Enforce Primary option if 
you plan on using the Instant Failover hotkey. 
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Select Hotkeys Windows 

The hot keys needed to switch between instant failover sessions can be changed on the Select Hotkeys 
window. Select the Control Key or Alt Key radio button and a function key from the drop down box and 
select the OK button to accept the changes.  

14.4.3 Instant Failover Tree Icons 
Under each Terminal are icons representing the Terminal Servers that they connect to. The lightning bolt 
color indicated the connection status. 

 

Terminal Server Connection Icons 

A Red lightning bolt represents a lack of connection to the terminal server. 

A Green lightning bolt represents a connection to the terminal server with an active session. 

A Yellow lightning bolt represents a connection to the terminal server with an active session that is the 
backup in Instant Failover mode.  
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Instant Failover 

If a terminal that is configured for Instant Failover is expanded in the ThinManager tree, the Primary 
Terminal Server should have a green lightning bolt, while the Secondary Terminal Server should have a 
yellow lightning bolt.  

In this example the primary session is on Green22 and it shows a green lightning bolt icon. Blue21 is the 
secondary session and has a yellow lightning bolt icon. Peach23 is the third server in the list and has a 
red lightning bolt icon. This means that it doesn’t have an active session but is available if server 1 or 
server 2 go offline. 
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15 Modules 

15.1 Module Overview 
Modules are software components that can be loaded to increase or modify the functionality of the 
terminal. Modules include touch screen drivers, sound drivers, and special device drivers. Modules are 
included with ThinManager and are registered automatically during ThinManager installation. Updates to 
modules (primarily touch screens) are posted on the ThinManager website for download and installation. 

Note: “Installing a module” refers to the registration of the module with the ThinManager Server, while 
“Adding a module” refers to attaching the module to a particular group or terminal. 

This section includes: 

 A list of available Modules.  

 Instructions on installing and adding Modules. 

 Details on specific modules.  

Note: Certain modules, like the video modules, do not need to be added to specific terminals but will be 
downloaded automatically in ThinManager. These modules do have to be installed in ThinManager to be 
available for the download to happen.  
These modules may need to be added to the terminal in older versions of ThinManager that are using 
new firmware. 

15.1.1 Module List 
ThinManager divides the modules into a number of categories or types to make navigation of the module 
list easier. Although details on the specific modules will follow, the types and modules include: 

Note: Certain modules are used in limited, specific cases and are considered advanced modules. These 
are marked with a (*). See Advanced Modules for details. 

ICA - See ICA Modules 

 Citrix ICA UseAlternateAddress Module 

 Citrix ICA wfclient.ini Extension Module 

 Citrix Receiver Version 12 (Package 6 only) 

 ICA Client Version 6.0 (*) 

 ICA Client Version 8.0 (*) 

Keyboard – See Keyboard Modules 
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 Key Block Module 

 Key Block Single Key Module 

 Keyboard Configuration Module 

 Share Keyboard and Mouse Master Module 

 Share Keyboard and Mouse Slave Module 

Local Storage - See Local Storage Modules 

 USB Flash Drive Module 

 USB Memory Card Reader Module (Package 5 only) 

Miscellaneous - See Miscellaneous Modules 

 Add Serial Port 

 Firmware Update Module (formerly the Disk On Chip / Compact Flash Update Module) 

 Instant Failover Module (*) (Package 5 only) 

 Local Printer Module 

 MultiMonitor Module (Package 5 only) 

 MultiMonitor2 Module (Package 5 only) 

 Redundant Ethernet Module 

 Second Network Module 

 Serial to TCP Module 

 TMTerm DLL Configuration Module 

 Terminal Shadow Module 

 TermMon ActiveX Configuration 

 Time Zone Redirection Module 

 User Override Module 

Mouse - See Mouse Modules 

 Mouse Configuration 

 PS/2 Mouse Configuration (Package 5 only) 

 Serial Mouse Driver 

 Share Keyboard and Mouse Master Module 

 Share Keyboard and Mouse Slave Module 

RDP - See RDP Modules 

 RDP Experience Module 

 RDP Module for ThinManager v2.4 and Older (Package 5 only) 

 RDP Port Module 

 RDP Serial Port Redirection Module 

 RDP Session IP Module 

Screen Saver - See Screen Saver Modules 
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 MultiSession Screen Saver Module 

 Screen Saver Module 

Sound - See Sound Modules 

 AMD cs553x Sound Driver 

 Intel 8x0 Sound Driver 

 Intel HDA Sound Driver 

 Universal Sound Driver 

 VIA 82xx Sound Driver 

TermSecure - See TermSecure Modules 

 RF Ideas pcProx Module 

 RF Ideas pcProx USB Module 

 TermMon ActiveX Configuration Module 

 USB Flash Drive Module 

 Wavetrend Tag Reader Module (Package 5 only) 

Touch Screen - See Touch Screen Modules 

 Arista ARP-16XXXAP-ACP Touch Screen Driver 

 CarrollTouch Touch Screen Driver 

 Contec Touch Screen Driver (Package 5 only) 

 DMC TSC Series Touch Screen Driver 

 DMC Touch Screen Driver (Package 5 only) 

 Dynapro Touch Screen Driver 

 eGalax Touch Screen Driver 

 Elographics Touch Screen Driver 

 Gunze AHL Touch Screen Driver 

 Hampshire TSHARC Touch Screen Driver 

 MicroTouch Touch Screen Driver 

 Panjit TouchSet Touch Screen Driver 

 PenMount Touch Screen Driver 

 Ronics Touch Screen Driver (Package 5 only) 

 Touch Control Touch Screen Driver 

 Touch International IR Touch Screen Driver (Package 5 only) 

 USB Touch Screen Driver 

 Xycom 33XX Touch Screen Driver (Package 5 only) 

 Zytronic Touch Screen Driver 

Video Driver - See Video Driver Modules.  

 Custom Video Mode Module  
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Video2 Driver - See Video Driver Modules.  

 Custom Video Mode Module  

 (*) Denotes an advanced module See Advanced Modules for details. 

15.2 Installing a Module   
Note: Modules will generally be installed by the firmware package.  This section describes the process to 
add or update a single module. 

Installing a Module adds a new module to ThinManager so that it is available to Terminal Groups and 
Terminals. To install a module, open the Modules window by selecting Install > Modules from the 
ThinManager menu bar to launch the Modules window.  

 

Modules Window 

The Module window shows all of the modules installed on the ThinManager Server.  
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Sorted Modules 

The installed modules can be sorted by using the Module Type and Package dropdown lists. 

To install additional modules select the Install Module button. This will launch a file browser window.  
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Module File Browser Window 

Browse to the new module, usually downloaded from the ThinManager web site (www.thinmanager.com). 
Highlight the new module, and select the Open button. This will add the new module to the list of 
modules. 

Selecting the Remove Module from All Terminals  button will remove the highlighted module from all 
terminals. It does not uninstall the module from the ThinManager Server; it just removes its use by all 
groups and terminals. 

Select the Done button to close the Modules window. 
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15.3 Adding a Module to a Group or Terminal 
Modules are added to terminals or groups of terminals on the Module Selection page of the Terminal 
Configuration Wizard or the Terminal Group Configuration Wizard. 

 

Terminal Configuration Wizard - Module Selection 

To add a Module to a Terminal, select the Add… button to launch the Attach Module to Terminal 
window. 
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Attach Module to Terminal 

The Attach Module to Terminal window will show the modules that are available to the terminal. The 
Module Type drop-down box sorts the modules by categories to make the modules easier to find. 

Highlight the desired module and select the OK button to add the module to the configuration. 
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Terminal Configuration Wizard - Module Selection 

Terminals that are members of a Group may show icons to represent the properties of added modules. 

  The Group icon represents modules assigned at the 
group level. 

  The Group icon with a red slash through it indicated that 
the module set at the group level that will not function with the selected package. 

 No icon indicates that the module was added to that 
particular Group or Terminal and not a parent Group. 

 

Note: Any module with a red slash through it will prevent the terminal from starting a session. 
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15.4 Changing Module Parameters 
Many modules have parameters that can be changed. With the new inheritance rules from ThinManager 
3.0 module parameters can’t be changed for modules that are inherited from a parent group. Changes 
must be made at the level that the module was added. 

 

Module Configuration 

Highlighting a module on the Module Selection page and selecting the Configure button will open the 
Module Properties window and allow changes to the module configuration. 
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Module Properties 

On the Modules Properties window, select the parameter to change, select the new value in the drop-
down list, and click the Set button. This will change the setting.  

The Set to Default button will restore the module to the default settings. 

Note: The Set button must be selected to apply the change. 

Select the Done button to close the Module Properties window and to return to the Group or Terminal 
Configuration Wizard. 
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Module Icons in ThinManager 

The status of the modules is displayed on the Modules tab of the Details pane of ThinManager. 
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15.4.1.1 Module Loading Order 

Highlighting a module and selecting the Move Up or Move Down button can change the order that the 
modules load. 

 

Module Loading Order 

The loading order of modules rarely needs to be adjusted. 

15.5 Individual Module Details 
ThinManager divides the modules into a number of categories or types to make navigation of the module 
list easier. The types and modules include ICA, Local Storage, Miscellaneous, Mouse, RDP, Screen 
Saver, Sound, TermSecure, Touch Screen, and Video.  

15.6 ICA Modules 
The ICA Modules are advanced modules for advanced users of the ICA client communication protocol. 
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15.6.1 Citrix ICA UseAlternateAddress Module 
 

The Citrix ICA UseAlternateAddress Module is used by advance Citrix users to specify connections to 
Citrix Servers.  

Configuration includes Use Alternate Address, Browser Protocol, and HttpBrowser Addresses.  

15.6.2 Citrix ICA wfclient.ini Extension Module 
The Citrix ICA wfclient.ini Extension Module is used by advanced Citrix users. This module allows up 
to 8 strings of text to be added to the wfclient.exe for passing Citrix parameters. 

15.7 Keyboard Modules 
The Keyboard Modules are modules used to control or alter keyboard behavior. 

15.7.1 Key Block Module 
The Key Block module traps certain keystrokes and prevents them from being sent to the terminal server 
for processing. 

 

Key Block Module 

The key combinations to be blocked can be configured by in the Module Properties. To launch this, 
highlight the module on the Module Selection page and select the Configure button. A Module 
Properties dialog box will be displayed. Select the parameter to change in the Module Properties 
window, select the Value in the dropdown box and click the Set button. 

The key combinations that have a value of YES will be blocked from reaching the terminal server. 
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15.7.2 Key Block Single Key Module 
The Key Block Single Key module traps specific individual keystrokes and prevents them from being sent 
to the terminal server for processing. 

15.7.3 Keyboard Configuration Module 
The Keyboard Configuration Module allows key settings on a keyboard attached to a thin client to be set. 

 

Keyboard Configuration Module Parameters 

The Keyboard Configuration parameters include: 

 Num Lock State – This allows the Number Lock to be set to On at startup, Off at startup, always 
On, or always Off. 

 Cap Lock State – This allows the Caps Lock to be set to On at startup, Off at startup, always 
On, or always Off. 

 Scroll Lock State – This allows the Scroll Lock to be set to On at startup, Off at startup, always 
On, or always Off. 

 Repeat Delay (ms) – This parameter sets the amount of time that a key needs to be held down 
before it starts repeating the keystroke. If this parameter is set to Disable a key will only send one 
keystroke even if the key is held down. 

 Repeat Rate (char/sec) – This parameter sets the number of characters per second that a held 
down key will send. 

 Disable Repeat for Enter Key – This parameter, when set to Yes, will prevent the Enter key 
from repeating if it is held down. 

 Keyboard Layout – This parameter allows the thin client to use keyboards other than the default 
English (United States) keyboard map. 
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15.8 Local Storage Modules 
The Local Storage modules allow the use of USB ports on thin clients. The USB ports are not active by 
default for security. 

15.8.1 USB Flash Drive Module 
The USB Flash Drive Module allows USB flash drives to connect to a terminal. The parameters include: 

 

 
USB Flash Drive Module Properties 

The USB Flash Drive Module has several parameters. 

 Drive Access Rights in Session - ReadWrite allows the user to read and write to the flash 
drive. ReadOnly allows the user to read data but not write data, and None sets the flash drive to 
access only the unique serial number to make it usable as a TermSecure ID device. 

 Use with TermSecure - This needs to be set to YES to allow the device to be a TermSecure 
identifier. A NO setting, in conjunction with a ReadWrite Access Rights setting, will allow the 
device to be used as a remote storage drive  

 Allow Manual Login - This value, when set to Yes, will allow a TermSecure user to log into a 
terminal without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure 
ID device to log in.  

 Prompt for Password - This value, when set to Yes, will require a TermSecure User to enter 
their password for access, even if the password is configured in ThinManager. 
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15.8.2 USB Memory Card Reader Module 
The USB Memory Card Reader Module allows USB card readers to connect to a terminal. The 
parameters include: 

 Number of Slots in Reader - This value sets the number of slots that the card reader uses. 

 Read Only Access - This value, when set to Yes, will limit the user to reading the card. This 
value, when set to No, will allow the user to read and write to the card. 

15.9 Miscellaneous Modules 
These are modules that don’t fit in other categories. 

15.9.1 Add Serial Port 
The Add Serial Port Module is only used to configure the serial ports of daughter boards that add 
additional serial ports to terminals. Add a module for each additional serial port. Each module will let the 
user configure one additional port.  

 Port Number - This value is to be set to the port number of the new port. 

 Port Address - This value is to be set to the port address of the new port. 

 IRQ - This value is to be set to the IRQ of the new port. 

 UART- This value is set to the chipset type for the new port. 

15.9.2 Firmware Update (Disk On Chip / Compact Flash) Update 
Module 

The Firmware Update is the new name for the Disk On Chip/Compact Flash Update module in 
ThinManager 3.1. 

ACP enables some models of terminals to store the firmware with Disk On Chip or Compact Flash 
storage so that the unit doesn’t have to download the entire firmware at boot but can boot locally and 
download just the configuration to save bandwidth. This is most commonly used with units that will 
connect over low bandwidth networks, like wireless networks or WANs. These units can use the Firmware 
Update module to download and flash new firmware when the firmware is updated in ThinManager. 

The ability to update stored firmware terminals eliminates the need to send the terminal back to the 
manufacturer to update the firmware. 

Note: The firmware download can vary, depending on the bandwidth of the connection and the size of the 
firmware update.  
It is recommended that updates be done over a wired LAN instead of over a wireless connection, when 
possible. 

The Firmware Update module has two configurable parameters.  

 Confirm at Terminal - This setting, if set to Yes, will prompt the operator to choose between 
immediately updating firmware or waiting until the next boot up. If Confirm at Terminal is set to No, 
the firmware download will take place immediately. 

 Force Update - Normally a stored firmware terminal with the Firmware Update module will check 
firmware version numbers at boot and only download a new firmware if the versions are different. 
This setting, if set to Yes, will force the terminal to always download the firmware for re-flashing. 
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Note: The module will download firmware when it detects a different firmware. Since this will only happen 
at the first reboot after updating the ThinManager firmware, it is safe to leave this module added to 
terminals permanently when Force Update is set to No. It does not need to be added and removed each 
time the firmware is updated. However, since it will update when the firmware is different, it will try to 
update the firmware if you boot it from a ThinManager server with older firmware. 

15.9.2.1 Firmware Update Program 

Once the new firmware has downloaded, an update program will run on the terminal to rewrite the new 
firmware to the storage. The program will display a warning stating that the terminal must not be reset or 
powered off during the process, usually around 30 seconds. Ignoring the warning can corrupt the stored 
firmware, so it is important to leave the terminal alone for that period of time.  

Note: Heed the warning. The terminal must not be reset or powered off during the brief period that the 
update program is writing the firmware to the firmware storage device.  
It is recommended that updates be done over a wired LAN instead of over a wireless connection, when 
possible. 

15.9.2.2 Stored Firmware Terminal Configuration 

A stored firmware terminal loads the firmware locally before connecting to the ThinManager server. The 
stored firmware terminals have a setup program that allows configuration of the connection. Enter the 
program by selecting any key when Select any key to configure is displayed during the boot process. A 
setup screen will be displayed.  

 

Thin Client Configuration Editor – Default Values 

The IP Addressing method is set to DHCP by default.  
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Thin Client Configuration Editor – Changing Values 

To change a value, navigate with arrow keys to the desired property. Pressing the Enter key will allow the 
input and acceptance of new values. 

 

Thin Client Configuration Editor – Static IP Addresses 

The changes may be saved or discarded before the boot process is resumed. 

15.9.3 Local Print Module 
The Local Print Module simplifies printing through the parallel port on thin clients.  

There are three steps: 

1. Install the print driver on the terminal servers that the client will connect to. 

2. Add the Local Print Module to the thin client as described in Adding a Module to a Group or 
Terminal. 

3. Configure the Print Driver Name parameter in the module to contain the print driver’s name. 
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Local Print Module Properties 

 Printer Driver Name - The Local Print module works when the name of the print driver is 
entered in the Value field for the Printer Driver Name. The Print Driver name is provided by 
the properties page for the printer. 

The Printer Property page for a printer can be launched by selecting Start > Settings > Printers and 
selecting the appropriate printer. This will launch the Printer Queue window. 

 

Printer Queue window 

Select Printer > Properties to launch the Printer Properties page. 
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Advanced Printer Properties 

The Printer Property page shows the Print Driver name on the Advanced tab. This is the name that 
needs to be entered into the Local Print Module. 

Note: When printing from the client, the printer will be displayed as Printer/username/session number. 
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15.9.4 MultiMonitor Module 

 

MultiMonitor  

The MultiMonitor Module was introduced to allow MultiMonitor capable thin clients to be configured for 
use with MultiMonitor before MultiMonitor was integrated into ThinManager 3.1.  

Note: This module provides primitive functionality compared to the integrated settings of ThinManager 
3.1+ and is no longer used.  

See MultiMonitor for details. 

15.9.5 Redundant Ethernet Module 
Some thin clients have two network ports. The Redundant Ethernet module allows the thin client to use 
both ports with a single IP address and a single MAC address.  

The thin client will use the primary (LAN1) port under normal conditions. If this port, cable, or switch fails, 
the Redundant Ethernet module will allow the thin client to activate and switch to the backup (LAN2) port 
in a seamless fashion. 

15.9.6 Second Network Module  
Some thin clients have two network ports. The Second Network module allows the thin client to use both 
ports on different networks. 
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Second Network Module 

 IP Method – This allows the second port to use DHCP or a static IP. 

 IP Address (Static Only) – This allows the second port to be assigned a static IP address. 

 NetMask (Static Only) – This allows the second port to be assigned a subnet mask. 

 Router (Static Only) - This allows the second port to be assigned a router. 

15.9.7 Terminal Shadow Module  
This module needs to be installed in ThinManager but is not applied to a terminal. A terminal will 
automatically download this module if it is needed. 

15.9.8 TermMon ActiveX Configuration Module  
This configures the TermMon ActiveX control that collects terminal information and can perform terminal 
functions. It is listed as both a Miscellaneous Module and a TermSecure Module but is described in the 
TermSecure section. 
See TermMon ActiveX Control for details. 

15.9.9 Terminal Shadow Module 
The Terminal Shadow module enables the Terminal-to-Terminal shadowing feature that was added in 
ThinManager 3.2. This module isn’t added to a terminal but is automatically downloaded to terminals 
using terminal-to-terminal shadowing. This terminal needs to be available on ThinManager and is 
installed automatically to ThinManager when ThinManager 3.2+ is installed or ThinManager is updated to 
v3.2+.  
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15.9.10 Time Zone Redirection Module 
The Time Zone Redirection Module allows a terminal to display local time when it is connected to a 
terminal server in another time zone. 

 

Time Zone Module Properties 

 Time Zone - This parameter can be highlighted to activate the Value drop-down that contains 
time zones. Select the Set button to accept the changes. 

Windows terminal servers need to have time zone redirection allowed in the Group Policy Console. 

The Allow Time Zone Redirection policy is found under Local Computer Policy\Computer 
Configuration\Administrative Templates\Windows Components\Terminal Services\Client\Server 
data redirection folder for Server 2003 or Local Computer Policy\Computer 
Configuration\Administrative Templates\Windows Components\Terminal Services\Terminal 
Server\Device and Resource Redirection for Server 2008 of the Group Policy. 

Please see Microsoft documentation for information on Group Policy. 

15.9.11 User Override Module  
The User Override Module is a temporary module that allowed users of ThinManager 3.1 to use the User 
Override function in Display Clients It is no longer needed in ThinManager 3.2+. 

See Display Client Override for the current method of User Override. 
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15.10 Mouse Modules 

15.10.1 Mouse Configuration Module 
The Mouse Configuration Module allows USB or PS/2 mice to be configured and allows the use of two 
mice. Configuration of mouse settings include:  

 Primary Mouse Type -This setting allows both a PS/2 mouse and USB mouse to be used on 
a terminal. This setting will define which mouse is considered the primary mouse.  

 Mouse Protocol - This value allows the selection of different protocols used by the mouse. 

 Scroll Mouse - The value, when set to Yes, allows a scroll mouse to function on a terminal. 

 Acceleration Multiplier - This value allows the mouse movement to be slowed down or sped 
up. 

 Acceleration Threshold (pixels) - This value is the number of pixels a mouse must move 
before the acceleration multiplier takes effect. 

 Left Button – This will disable the left mouse button when set to Disabled. 

 Right Button – This will disable the right mouse button when set to Disabled. 

 Scroll Button – This will disable the scroll button when set to Disabled. 

 Scroll Wheel – This will disable the scroll wheel when set to Disabled. 

These parameters can be changed by highlighting the parameter and choosing a new value in the Value 
dropdown box. Use the Set button to accept the new parameter value. 

 

Mouse Configuration Module 

ThinManager supports USB mice. The Mouse Configuration Module allows configuration of USB mice.  
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A thin client can have both a USB and a PS/2 mouse installed. This module allows the selection of the 
primary mouse when using two mice. 

15.10.2 PS/2 Mouse Module 
The PS/2 Mouse Module is the forerunner of the Mouse Configuration Module. It allows the changing of 
PS/2 settings like mouse type, acceleration and threshold. All of these features are now available in the 
Mouse Configuration Module. 

 Mouse Type -This value allows the selection of PS/2 or USB mouse type. 

 Scroll Mouse - The value, when set to Yes, allows a scroll mouse to function on a terminal. 

 Acceleration Multiplier - This value allows the mouse movement to be slowed down or sped up. 

 Acceleration Threshold (pixels) - This value is the number of pixels a mouse must move before 
the acceleration multiplier takes effect. 

15.10.3 Serial Mouse Driver 
The Serial Mouse Driver allows a serial mouse to be used with thin clients. 

 

Serial Mouse Module 

Mouse Type - This value defines what type of mouse is used. 

Serial Port – Set this value to the serial port number used for the mouse. 

15.10.4 Share Keyboard and Mouse Modules 
The Share Keyboard and Mouse module allows several thin clients to be controlled with a single 
keyboard and mouse without the need of a KVM switch (Keyboard/Video/Mouse). 
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The Share Keyboard and Mouse has a Master module that is added to the controlling terminal, and a 
Slave module that is added to the dependent terminals. 

 

Shared Keyboard and Mouse Layout 

The Share Keyboard and Mouse can be used by placing several monitors connected to thin clients, side-
by-side or top-to-bottom. The Share Keyboard and Mouse Master module is loaded on the center thin 
client. This module is configured by adding the IP addresses of the secondary slave thin clients. The 
other terminals receive the Share Keyboard and Mouse Slave module.  Once the Share Keyboard 
and Mouse Master Module is added to a terminal, it can be configured by highlighting it in the Installed 
Module window and selecting the Configure button. 

 

Share Keyboard and Mouse Master Module Properties 

 Left Terminal IP Address - Enter the correct IP address for the Slave terminal on the left of the 
master terminal, if used, and select the Set button. 

 Right Terminal IP Address - Enter the correct IP address for the Slave terminal on the right of 
the master terminal, if used, and select the Set button. 

 Top Terminal IP Address - Enter the correct IP address for the Slave terminal on the top of the 
master terminal, if used, and select the Set button. 
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 Bottom Terminal IP Address - Enter the correct IP address for the Slave terminal on the bottom 
of the master terminal, if used, and select the Set button. 

 Allow Interactive Shadow of Master - Normally a terminal with the master module loaded is 
blocked from interactive shadow. If you want to allow interactive shadowing on the master, 
highlight the Allow Interactive Shadow of Master parameter, select Yes from the Value drop-
down, and select the Set button. 

The Share Keyboard and Mouse Slave module is loaded on the secondary thin clients using the same 
methods as other modules are loaded.  

 

Share Keyboard and Mouse Slave Module Properties 

 Master IP Address - This setting allows the slave module to be configured to connect to a 
specified master by entering the IP address of the master terminal and selecting the Set 
button. 

Select the Done button when finished. 

Once the ACP Enabled thin clients are booted, the mouse on the master thin client can be moved 
seamlessly into the other desktops. The keyboard will be active in whatever screen the mouse pointer is 
on. 

This allows an operator to have control of several displays with only one keyboard and mouse. The 
mouse movement is seamless, allowing access to displays without switching. 

Note: A Master Share Keyboard and Mouse session cannot be interactively shadowed in ThinManager 
unless it is configured to allow it. 

The keyboards and mice for the slave thin clients can be left attached but stowed away until a multi-user 
configuration is needed. 
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The Share Keyboard and Mouse Master module is licensed for each master thin client. The Share 
Keyboard and Mouse Slave module is free. Each master module can have 1 to 4 slave units. Future 
releases will expand the number of slaves that the master can control. 

15.11 RDP Modules 

15.11.1 RDP Experience Module 
The RDP Experience Module allows a session connected to a Windows 2003 terminal server with RDP to 
add features to the session.  

 

RDP Experience Module Parameters 

The RDP Experience Module parameters are:  

 Allow Desktop Background - This setting, if set to Yes, will allow a terminal to show a desktop 
background. 

 Show Window Contents While Dragging - This setting, if set to Yes, will allow a terminal to 
show window contents while dragging. 

 Allow Menu and Window Animation - This setting, if set to Yes, will allow a terminal to show 
window and menu animations. 

 Allow Themes - This setting, if set to Yes, will allow a terminal to show a desktop Theme. 

In order to use these features, they must be enabled by using the Windows Group Policy Editor. See 
Microsoft documentation for details. 
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15.11.2 RDP Module for ThinManager v2.4 and Older 
The RDP Module for ThinManager v2.4 and Older module is used to allow older versions of 
ThinManager to use RDP. 

ThinManager didn’t support RDP until the v2.4.1 release. Users with older versions of ThinManager can 
use the RDP client communication protocol with older versions of ThinManager by adding the RDP 
Module for ThinManager v2.4 and Older to the terminal and installing a ThinManager firmware that is 
v02.05.00 or later. 

15.11.3 RDP Port Module 
The RDP Port Module allows that port that RDP communicates to the terminal server to be changed from 
the default 3389 to another port. 

 

RDP Port Module Parameters 

The RDP Port Module allows the port that RDP uses to be changed from the default 3389. 

 RDP Server Port Number (decimal) - Enter the new port number for RDP in this value. 

15.11.4 RDP Serial Port Redirection Module  
The serial ports on a thin client can be remapped by adding the RDP Serial Port Redirection module to 
the thin client without additional configuration. Once the thin client is booted, the COM1 in the session will 
refer to the COM1 on the terminal, while the COM2 in the session will refer to the COM2 on the terminal. 
This function requires Windows 2003 to work. 

Additionally the COM Port Mapping needs to be allowed. This is done on the Terminal Services 
Configuration Console. To open the Terminal Services Configuration Console in Windows 2003 select 
Start > Administrative Tools > Terminal Services Configuration. 



 

ACP ThinManager 6.0 Modules    329 

 

Terminal Services Configuration Console 

Launch the RDP-tcp Properties page by highlighting the Connections folder in the tree pane and 
double-clicking the RDP-tcp in the right pane. This will launch the RDP-tcp Properties page. 
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COM Port Mapping Allowed 

The Com port mapping checkbox must be unselected to allow the RDP Serial Port module to function 
on the Windows 2003 terminal server. 
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15.11.5 RDP Session IP Module 
The RDP Session IP Module allows a terminal to use an alias IP address for a specific Display Client 
session. 

 

RDP Session IP Module 

The RDP Session IP module has three settings: 

 Group Name – This specifies the Display Client to use. 

 Session IP Address – This is the IP address to use as the alias. 

 Session IP Address for Instant Failover – This is the IP address to use for a backup session it 
the Display Client is configured to use Instant Failover. 
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15.12 Screen Saver Modules 

15.12.1 MultiSession Screen Saver Module 
The MultiSession Screen Saver Module is a screen saver for use on terminals configured with 
MultiSession. See MultiSession Overview for details. 

 

MultiSession Screen Saver Module Parameters 

The MultiSession Screen Saver Module has two modes. It can be set to cycle through the MultiSession 
windows when the terminal is inactive, or it can be set to return to the main MultiSession screen when the 
terminal is inactive. 

The parameters are: 

 Mode - The Cyclic mode will switch between all active sessions on the terminal. The 
GotoFirstGroup mode will switch the terminal to the main session when it is inactive. 

 Start Delay Time in secs - This is the number of seconds of inactivity that the terminal will allow 
before starting the screen saver. 

 Switch Interval in secs (Cyclic only) - This is the number of seconds that the terminal will 
display each session when using the Cyclic mode. 
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15.12.2 Screen Saver Module 
Screen Saver Module is a module that loads a screen saver on the client. The screen saver will run 
when the terminal is idle to protect the monitor. Since the screen saver runs on the client, it saves CPU 
resources on the terminal server.  

 

Screen Saver on Thin Client 



 

334    Modules ACP ThinManager 6.0 

 

Screen Saver Module Parameters 

The Screen Saver Module configuration includes: 

 Screen Saver - the graphic that is displayed when the screen saver is active. 

 Wait Time in Minutes - the length of time that the terminal needs to be idle before the screen 
saver starts. 

 Use Disable Time Period - the screen saver can be set to be disabled or unavailable during a 
time block. This could be used to prevent the screen saver from running during normal business 
hours. 

 Disable Start Time (0-23) - This sets the start of the disabled time block. 0 is Midnight 
and 23 is 11:00 p.m. 

 Disable End Time (0-23) - This sets the end of the disabled time block. 0 is Midnight and 
23 is 11:00 p.m. 

 Force Off when Start Hour is Reached - If set to Yes, this will turn the screen saver off 
when the Disable End Time is reached. 

 

15.13 Sound Modules  
The use of sound from a thin client requires four things: 

 Hardware with a Line Out/Speaker plug 

 Amplified speaker(s)  

 The Universal Sound Driver Module 



 

ACP ThinManager 6.0 Modules    335 

 Either Windows RDP Session or Citrix server-side software.  

Plug the speaker(s) into the Line Out plug on the terminal, add the module, and connect to the terminal 
server.  

ThinManager 4.1 simplifies sound by providing a Universal Sound Driver Module. This module can be 
added to any thin client that has an audio jack to enable sound. 

Note: Some thin clients, like the Advantech PCM-5820, may require that a sound harness be plugged 
into the motherboard. 

 

Universal Sound Driver Parameters 

These Sound modules have several settings: 

 Audio Bandwidth (ICA Only) - This parameter can be set to Low, Medium, or High bandwidth 
when using Citrix ICA. 

 Sound in Session - This setting, when set to Enabled, will allow sound generated within the 
session to be played through the terminal. When this is set to Disabled the session sounds will be 
turned off but system sounds will still be generated during TermSecure login for audio feedback 
during the login process.  

 Terminal Sound Effects - This setting, when set to Enabled, will allow terminal sound effects 
like TermSecure login sounds on the terminal. 
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15.14 TermSecure Modules  

15.14.1 RF Ideas pcProx Module 

Note: ThinManager supports the RFIdeas pcProx Enroll Series 81 readers (Serial: RDR-xx81AKx). 

The RF Ideas pcProx Module uses a serial device that allows a terminal to use RF Ideas pcProx cards 
as TermSecure ID cards 

 

RF Ideas pcProx Module Parameters 

. The parameters are: 

 Port - This selects the port that the RF Ideas pcProx card reader is installed. 

 Number of Data Bits – Different cards use different numbers of data bits in their format. This 
sets the number of data bits to match that used by the card as an identifier. The choices are 26, 37, 
or Raw. 

 Use Facility Code - This value, when set to Yes, will require the addition of the card’s Facility 
Code to the Card / Badge ID number. 

 Allow Manual Login - This, when set to Yes, will allow a TermSecure user to log into a terminal 
without a TermSecure ID device. If set to No, TermSecure users must use a TermSecure ID device to 
log in.  

 Prompt for Password - This, when set to Yes, will require a TermSecure to enter their password 
for access, even if the password is configured in ThinManager.  
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 Zero Pad Facility Code and ID – This will add a zero to the number string. This is rarely needed. 

See Card and Badge Configuration for a TermSecure User for details. 

15.14.2 RF Ideas pcProx USB Module 

Note: ThinManager supports the RFIdeas pcProx Enroll Series 81 readers (USB: RDR-xx81AKU). 

The RF Ideas pcProx USB Module uses a USB device that allows a terminal to use RF Ideas pcProx 
cards as TermSecure ID cards 

 

RF Ideas pcProx USB Module Parameters 

. The parameters are: 

 Mode – This allows the device to be used in TermSecure Mode or Wedge mode. The Wedge 
mode sends data straight to the session as a keyboard wedge. 

 Allow Manual TermSecure Login - This, when set to Yes, will allow a TermSecure user to log 
into a terminal without a TermSecure ID device. If set to No, TermSecure users must use a 
TermSecure ID device to log in.  

 Prompt for TermSecure Password - This, when set to Yes, will require a TermSecure to enter 
their password for access, even if the password is configured in ThinManager.  

See Card and Badge Configuration for a TermSecure User for details. 

15.14.3 TermMon ActiveX Configuration 
This configures the TermMon ActiveX control that collects terminal information and can perform terminal 
functions. 
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TermMon ActiveX Module Parameters 

Normally the TermMon ActiveX, when registered on a terminal server, allows a terminal server session to 
communicate with its terminal and act upon it without the need of the TermMon ActiveX module. The 
TermMon ActiveX module can be added to the terminal configuration to either deny the default terminal 
server to terminal access or to allow access to other sessions and PCs. 

 Allow ActiveX Connections - This value, when set to Yes, will allow the ActiveX control to 
function. Setting this value to No will prevent any ActiveX communication to the terminal, including 
the default terminal server to terminal access. 

 Only Allow Connections from Session - This value, when set to Yes, will allow other terminal 
server sessions and PCs to communicate to the terminal with the ActiveX functions. If set to No, the 
only communication allowed is between the terminal and a session on the terminal server belonging 
to the terminal, providing that the Allow ActiveX Connections is set to Yes.  

See TermMon ActiveX Control for details. 

15.14.4 USB Flash Drive Module 
The USB Flash Drive Module can be used to allow USB flash drives to be used as TermSecure ID 
devices. It is also listed under Local Storage modules. 

See USB Flash Drive Module in the Local Storage Modules for details. 

15.14.5 Wavetrend Tag Reader 
The Wavetrend Tag Reader Module allows a terminal to use Wavetrend RFID cards as TermSecure ID 
cards. This allows a user to login through TermSecure when they approach the terminal and logs them 
out when they leave the area. The distance required to login and log out are configurable in the module. 
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Wavetrend Tag Reader Module Parameters 

The parameters are: 

Port - The WaveTrend Tag Reader Module connects to a thin client through the serial port. The Port 
setting specifies which COM Port the reader is attached to. 

Use Vendor Code - This, if set to YES, includes the vendor code as part of the identifier number.  

Allow Manual Login - If set to YES, this allows a TermSecure User to use the hotkey to initiate logins, or 
the device. If set to NO, it will force a TermSecure User to use a device to login. 

Prompt for Password - NO allows the device to login without a password. YES forces every TermSecure 
User to enter a password after using the device. 

Entry Signal Strength - The signal strength required to register the card as in range. 

Exit Signal Strength - The signal strength required to register the card as out of range. 

Entry Sensitivity - The number of reads above the Entry Signal Strength reads that are required to 
register as “Entered”. 

Exit Sensitivity - The number of reads below the Exit Signal Strength that are required to register as 
“Exited”. 

15.15 Touch Screen Modules   
 Arista ARP-16XXXAP-ACP Touch Screen Driver 

 CarrollTouch Touch Screen Driver 

 Contec Touch Screen Driver 

 DMC TSC Series Touch Screen Driver 
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 DMC Touch Screen Driver 

 Dynapro Touch Screen Driver 

 Elographics Touch Screen Driver 

 Gunze AHL Touch Screen Driver 

 Hampshire TSHARC Touch Screen Driver 

 MicroTouch Touch Screen Driver 

 Panjit TouchSet Touch Screen Driver 

 PenMount Touch Screen Driver 

 Ronics Touch Screen Driver  

 Touch Control Touch Screen Driver 

 Touch International IR Touch Screen Driver 

 USB Touch Screen Driver 

 Xycom 33XX Touch Screen Driver 

 

Touch Screen Parameters 

Some, but not all, touch screen modules have parameters that can be modified. These may include: 

Connection 

 Connection Type – Sets whether the touch screen uses Serial or USB to connect. 

 Port or Port (Serial Only) – Sets the COM port that a serial touch screen is connected to. 

 Baud Rate - Sets the speed used for communication between the terminal and the touch screen 
on some serial touch screens. 
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 Monitor Number – Used to specify which monitor in a MultiMonitor scheme will use for the touch 
screen. MultiMonitor thin clients with multiple touch screens will need a module loaded for each touch 
screen used. 

 Controller Type - Sets the model of touch screen controller on some touch screens. 

Calibration 

 Number of Calibration Points – This sets the number of calibration points that the calibration 
program uses during the calibration process. 

 Calibration Margin Percentage – This sets the distance from the edge of the screen that the 
calibration points are displayed. 

 Calibration Hotkey – This allows a function key to be set as a hotkey so that the calibration can 
be launched from a keyboard.  

 Calibration Hotkey Modifier– This setting adds CTL or ALT to the hotkey to launch the 
calibration from the keyboard, if desired. 

 Calibration Touch Down Time (seconds) – This setting, when enabled, will launch the 
calibration program when the screen is touched and held for the assigned number of seconds. This 
cannot be used with the Right Click Hold Time. 

 Calibration (entered automatically) – This is set automatically by machine. These are the 
values set during the calibration process. 

 Orientation (entered automatically) - This is set automatically by machine. Used at the direction 
of Tech Support in error correction. 

 Swap XY Coordinates – If X and Y are reversed, this setting will correct the orientation. 

Touch Settings 

 Double Touch Area (pixels) – This sets the size of the area that a second touch will register as 
a double touch. 

 Double Touch Time (milliseconds) - The amount of time between touches that qualifies as a 
double touch. 

 Touch De-Bounce Timeout - a time interval used to prevent a single touch from being registered 
as multiple touches. 

Right Click 

 Right Click Hold Time (milliseconds) - This setting, when enabled, will treat a touch that is held 
for the assigned number of seconds as a Right Click of the mouse. This cannot be used with the 
Calibration Touch Down Time. 

 Right Click Area (pixels) - This sets the size of the area that a second touch will register as a 
right click. 

15.15.1 USB Touch Screen Driver Module 
The USB Touch Screen Driver Module is designed to be used by any touch screen that uses a USB 
connection to the thin client. 
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15.16 Video Driver Modules 
The method of downloading video drivers was changed in ThinManager 3.0. In previous versions all of 
the video drivers were contained in the firmware and were downloaded at boot. In v3.0 the video was split 
out of the firmware and each thin client will only download the video driver that it needs. 

One does not need to add the video module to the terminal but only needs to have the video module 
installed in ThinManager to make it available. As each terminal connects to ThinManager it will download 
the correct module.  

These modules are normally installed with ThinManager. See Installing a Module to see how to update or 
add new modules. 

Note: Users with ThinManager 2.6 and earlier may need to add the individual video module to the 
terminal if using certain models of thin clients. This doesn’t apply to ThinManager 3.0 and later. 
See http://www.thinmanager.com/support/downloads.shtml for details. 

15.17 Advanced Modules 
Advanced Modules are modules that are rarely used because they address a limited specific issue and 
are not needed in normal configurations. These include the Core Video Modules, Legacy Video Module, 
ICA Client Modules, and Instant Failover Module. 

These modules are hidden unless the Show Advanced Module checkbox is selected on the Attach 
Modules to Terminals window. 

 

Advanced Module -Instant Failover  

15.17.1 ICA Client Version 6.0/8.0/Citrix Receiver Version 12 
The ICA Client Module Client Version 8.0 is a module is not added to terminals but needs to be 
installed in ThinManager for terminals using the ICA protocol. If a terminal is configured to use the ICA 
client communication protocol on the Terminal Server Specification page of the Terminal 
Configuration Wizard, the terminal will automatically download the v8.0 module to enable ICA 
functionality. 
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If a user wants to use the 6.0 version of the ICA protocol they will need to add the ICA Client Module 
Client Version 6.0 to the terminal. 

15.17.2 Instant Failover Module 
The Instant Failover Module is to be used only with terminal configurations that use the legacy 
“Individual Terminal Servers” method instead of the preferred Display Clients method.  

Since the use of Display Clients is a preferred method of getting terminal services sessions over using the 
legacy “Individual Terminal Servers” the module is hidden from view unless the Show Advanced Modules 
checkbox is selected. 

Instant Failover allows a terminal to connect to a session on two terminal servers. Both sessions are 
active but only one is displayed. If the first terminal server fails, the second session is immediately 
displayed, eliminating any downtime due to terminal server failure. See Instant Failover for details. 

Note: The Instant Failover Module is only used with terminals using Individual Terminal Servers. (See 
Terminal Server Specification Page). 
Terminals using Display Clients use a checkbox to enable Instant Failover. (See Instant Failover with 
Terminal Services Display Clients). 
Do not use this module while using Display Clients. 

The Instant Failover function requires an Instant Failover license for each terminal that uses it. 

15.17.2.1 Instant Failover Configuration When Using Individual Terminal 
Servers 

The thin client cascades both sessions, with the primary in front. You cannot see the secondary session 
as it is hidden in back. There is an option that allows one to switch between sessions with a hot key. 

 

Instant Failover Module Properties 
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 Hot Key Session Switching  - If this parameter is set to Enabled, the hot key combination will 
allow the toggling between sessions.  

 Hotkey Combination is CTRL+ - The value of the hot key is defaulted to CTRL+F9 but can be 
assigned to any function key. 

15.17.2.2 Advanced Video Modules 

The Core Video Module, Core Video2 Module, and Legacy Video Module do not need to be added to a 
terminal but need to be installed in ThinManager. The terminal will download it if needed. These modules 
are installed during ThinManager installation so should not be a concern. 
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16 Citrix ICA 

ACP ThinManager supports two client/server communication protocols, the Microsoft© RDP and the Citrix 
ICA. Terminals and Display Clients can be configured to use one or the other with a simple radio button.  

16.1 Terminals Using Display Clients with ICA 
If a terminal is using the display clients to receive applications then Terminal Services Display Clients can 
be configured to use the ICA protocol. These display clients will show up in the Available Display Clients 
list on the Display Client Selection Page. 
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Terminal Using Display Clients and ICA Display Clients 

Select the desired Display Clients from the Available Display Clients list and move them to the Selected 
Display Clients list. The terminal will use the Display Clients selected, both RDP and ICA. 

16.2 Display Client Configuration Wizard 
A Display Client can be configured to use the ICA protocol on the Terminal Services Display Client 
Type page of the Display Client Configuration Wizard. 

 

Terminal Services Display Client Type Page 

Importance of Page: Configures the Display Client to use the Citrix ICA Protocol 

Settings: 

 Citrix ICA Servers – This allows the Display Client to use the Citrix ICA as its protocol. 

 Citrix Device Services Servers – This allows the Display Client to use archaic Device Services 
Servers. 

 Remote Desktop Protocol Servers – This uses the default Microsoft © RDP as its protocol. 

Why Change from Default Settings: You need to select the Citrix ICA Servers to use the ICA protocol. 

Select Next to continue. 
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16.2.1.1 Citrix ICA Page 

  

Citrix ICA Page 

Importance of Page: Configures the Citrix Settings 

Settings: 

 Encryption Level – This drop-down sets the Citrix encryption level. 

Fields: 

 ICA Browser Address – Entering the ICA browser address aids in connection across routers, 
subnets, and domains. 

 Enter the name of a Published Application - This field allows the desired published application 
to be designated when the Use a Citrix Published Application checkbox is selected. 

Checkbox: 

 Use a Citrix Published Application – This checkbox, if selected, will allow usage of Citrix 
Published Applications to deploy programs to the thin client. 

Why Change from Default Settings: Check the Use a Citrix Published Application checkbox and 
enter the published application in the Enter the name of a Published Application field to use an ICA 
published app.  

This finishes the wizard, graying out the Next button and activating the Finish button. 
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Note: Published Application should have a continuous name and not contain spaces. 

If the Display Client is using a Citrix Published Application the wizard will finish with this page. 

If the Display Client is not using Citrix Published Application the wizard will continue to allow the selection 
of Terminal Servers that are configured to use the ICA protocol. See the Terminal Server Capabilities 
Page for details. 

16.2.2 Terminal Using Citrix and Individual Terminal Servers  
The Terminal Connection Type page of the Terminal Configuration Wizard allows the selection of the 
desired Client Communication Protocol on terminals is using the legacy “Individual Terminal Servers” 
instead of the preferred Display Client method. 

 

Terminal Configuration Wizard - Connection Type 

Select the Citrix ICA radio button to use the ICA protocol.  

Once the Citrix ICA protocol is selected the wizard will display the Citrix ICA Configuration page. 
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16.2.2.1 Citrix ICA Configuration Page 

 

Terminal Configuration Wizard - Citrix ICA Configuration 

Importance of Page: Sets the ICA encryption Level and enables use of Published Applications. 

Fields: 

Encryption - The Encryption drop-down box sets the level of Citrix encryption. 

Buttons: 

 Are you using Published Applications – This allows the usage of Citrix Published Applications 
for deploying programs. 

Why Change from Default Settings: Citrix ICA has a feature called Published Applications. If you are 
using Published Applications, select the Yes radio button, then select the Next button to continue to the 
Citrix Published Application dialog. 

If you are not using Published Applications, select the No radio button, then select the Next button to 
continue to the Terminal Server Selection page. 
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16.2.2.2 Citrix Published Applications Page 

 

Terminal Configuration Wizard - Citrix Published Applications 

Importance of Page: Defines what Citrix published application to have the terminal  

Fields: 

 Published Application Name – Enter the name of the desired published app you wish to run. 

 ICA Browser – Enter the ICA master browser name, if needed. 

Why Change from Default Settings: Allows use of a published application. 

Enter the name of the desired Published Applications in the Published Applications Name field. Do not 
use spaces in the name when creating a Published Application for Terminal Services. 

Citrix uses ICA Browsers as part of the system. Because the ICA client may have problems detecting an 
ICA browser across a router or switch, an ICA Browser field is provided for entering the name of an ICA 
browser. 

Select the Finish button to create the Terminal, or select the Next button to rejoin the main configuration 
path to configure more options. 

Terminals using the Select Individual Terminal Servers will be shown the Terminal Server Selection 
page where the desired terminal servers can be selected. 
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17 Hotkeys 

ThinManager provides hotkeys for switching between Display Clients, initiating SessionTiling, and other 
functions. 

17.1 Terminal Configuration Wizard Hotkeys Display 
Clients  

The Terminal Configuration Wizard has several hotkeys that can be configured 
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17.1.1.1 Terminal Interface Options Hotkeys 

 

Terminal Interface Options Page 

A terminal using multiple Display Clients will need to have a method to switch between sessions. This is 
configured on the Terminal Interface Options page. 

Group Selector Options allow on-screen switching of sessions. 

 Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-
down menu that can be activated by mouse.  

 Enable Tiling – This checkbox, when selected, allows the Display Clients to be tiled on the 
monitor to provide an overview of all the sessions at once. See SessionTiling Options for details. 

 Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

The Selector Options button will launch the Group Selector Options window that allows configuration 
of the on-screen Group Selector bar. 
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Group Selector Options Window 

The Group Selector Options window has several settings. 

 The Auto-hide Group Selector checkbox will hide the Group Selector until the mouse is moved 
to that space. 

 The Tile on Group Selector activation checkbox, when selected, will tile the Display Clients 
when the auto-hid selector is chosen. This allows the user to select from the available sessions. 

 The Group Selector Menu Size drop-down box allows the setting of the size of the Group 
Selector font.  

Select the OK button to accept changes or the Cancel button to close. 

17.1.1.2 SessionTiling Options 

Selecting the Enable Tiling checkbox on the Terminal Interface Options page of the Terminal 
Configuration wizard will allow the sessions to be tiled for selection. 

 

Tiled Sessions on a Terminal 

Once the sessions are tiled the session selection can be made by: 

 Using the Group Selector, if selected on the Terminal Interface Options page. 
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 Clicking on the desired session if the Tile Interactive checkbox is unselected on the Tile 
Options page. 

 Right clicking on the desired session if the Tile on right click (mouse or touchscreen) 
checkbox is unselected on the Tile Options page. 

The Tiling Options button will launch the Group Selector Options window that allows configuration of 
the on-screen Group Selector bar. 

 

Tile Options 

The Tile Options window has several settings. 

 Show Grid – This checkbox, when selected, will show the tiled sessions in a grid with each grid 
labeled with the session name as while the session is loading. 

 Tile Inactivity Time – This field sets the length of time that the terminal screen will stay focused 
on a selected session before reverting back to a tiled state due to inactivity.  

 Tile Display Clients at startup – This checkbox, when selected, will show the sessions tiled 
when the terminal first connects to its sessions. 

 Include Main Menu as tile – This checkbox, when selected, will include a session displaying the 
TermSecure Main Menu. 

 Tile on Right click (mouse or touchscreen) - This checkbox, when selected, will initiate tiling 
when a session is right clicked. 

 Tile Interactive – This checkbox, when selected, will allow a user to click into a tiled session and 
control it interactively without switching focus to a single session. To focus on a single session 
use the Group Selector Dropdown or the tiling hotkey (CTL + T), if enabled. 

Select the OK button to accept changes or the Cancel button to close. 
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17.1.1.3 Hotkey Configuration  

 

Hotkey Configuration Page 

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations 
that allow switching between sessions. 

 Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching 
between the two active sessions of a Display Client that is using Instant Failover. 

 Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between 
different sessions of a terminal using MultiSession. 

 Enable Tiling Hotkey – This checkbox, if selected, allows SessionTiling to be activated by a 
hotkey combination. 

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the 
hotkeys to be changed from the default. 
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Select Instant Failover Hotkeys  

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting 
the Alt Key radio button or using the drop-down to select another function key. 

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the 
MultiSession switching hotkeys to be changed from the default. 

 

Select MultiSession Switching Hotkeys 

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. This 
can be changed by selecting the Alt Key radio button or using the drop-down to select another hot key. 

Selecting the Change Hotkeys button when Enable Tiling Hotkeys is selected will allow the hotkeys to 
be changed from the default. 
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Select SessionTiling Hotkeys 

The default hotkey for SessionTiling activation is set to Control+t. This can be changed by selecting the 
Alt Key radio button or using the drop-down to select another hot key. 

Select the OK button to continue or the Cancel button to close without accepting changes. 
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17.1.1.4 TermSecure Hotkeys 

When the Enable TermSecure checkbox is checked on the Terminal Server Specification page 
additional TermSecure functionality is enabled to access to the main menu for logging into TermSecure. 

 

Terminal Interface Options – TermSecure Enabled 

The Terminal Interface Options page will display the Show Main Menu on Group Selector checkbox. 

The Main Menu Options button will launch a window for Main Menu settings. 

 

Main Menu Options 
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The Main Menu Options window has several settings. 

 Allow reboot/restart – This checkbox, if selected, will add a Reboot and a Restart button on the 
main TermSecure login window. 

 The Show Main Menu on Group Selector, when selected, will add the main TermSecure menu 
as an option on the Group Selector dropdown. 

 Show Virtual Keyboard – This checkbox, if selected, will prompt the display of a virtual keyboard 
for TermSecure logins. This is helpful for thin clients with touch screens. 

Select OK to save setting or Cancel to close without saving. 

The Hotkey Configuration page has an additional TermSecure setting when the Enable TermSecure 
checkbox is checked on the Terminal Server Specification page. 

 

Hotkey Configuration – TermSecure Enabled 

The Enable Main Menu Hotkey checkbox, when selected, will allow the TermSecure Main Menu to be 
launched with a hotkey combination. The Change Hotkey button allows the default CTL+m combination 
to be changed. 
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Select HotKeys Window for Main Menu 

The default hotkey for the Main Menu is set to Control+m. This can be changed by selecting the Alt Key 
radio button or using the drop-down to select another hot key. 

Select the OK button to continue or the Cancel button to close without accepting changes. 

TermSecure is covered more thoroughly at TermSecure User Configuration Wizard. 
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18 Multiple Monitors 

18.1 Introduction to Multiple Monitors 
ACP ThinManager has two methods of providing multiple monitors in a thin client system - the Share 
Keyboard and Mouse method and the MultiMonitor method. 

The Share Keyboard and Mouse module allows several thin clients, each with a single video port, to be 
controlled with a single keyboard and mouse without the need of a KVM switch (Keyboard/Video/Mouse). 
The Share Keyboard and Mouse system ties several desktops together with a common mouse and 
keyboard so that the user has increased real estate under their control. Because each screen is still an 
independent desktop, programs don't need to be rewritten in a new resolution for a larger desktop. 
Instead, one would run the normal sized application on each of the desktops, allowing the operator to 
view different windows on different monitors. 

See Share Keyboard and Mouse Modules for details on deployment. 

The MultiMonitor method uses specific thin clients that have multiple video ports built into the hardware. 
Each MultiMonitor thin client can have from two to five monitors attached. These monitors can be 
configured to merge into an expanded desktop (called “spanned” by ACP) or can display individual 
desktops (called “screened”  by ACP), or combinations of “spanned” and “screened” sessions. 

WinTMC now supports MultiMonitor if the PC has Windows running on multiple video cards. 

See MultiMonitor for details on deployment. 

18.2 Share Keyboard and Mouse Modules 
The Share Keyboard and Mouse module allows several thin clients to be controlled with a single 
keyboard and mouse without the need of a KVM switch (Keyboard/Video/Mouse). 

The Share Keyboard and Mouse has a Master module that is added to the controlling terminal, and a 
Slave module that is added to the dependent terminals. 
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Shared Keyboard and Mouse Layout 

The Share Keyboard and Mouse can be used by placing several monitors connected to thin clients, side-
by-side or top-to-bottom. The Share Keyboard and Mouse Master module is loaded on the center thin 
client. This module is configured by adding the IP addresses of the secondary slave thin clients. The 
other terminals receive the Share Keyboard and Mouse Slave module. 

 

Share Keyboard and Mouse Master Module 

Once the Share Keyboard and Mouse Master Module is added to a terminal, it can be configured by 
highlighting it in the Installed Module window and selecting the Configure button. 
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Share Keyboard and Mouse Master Module Properties 

 Left Terminal IP Address - Enter the correct IP address for the Slave terminal on the left of the 
master terminal, if used, and select the Set button. 

 Right Terminal IP Address - Enter the correct IP address for the Slave terminal on the right of 
the master terminal, if used, and select the Set button. 

 Top Terminal IP Address - Enter the correct IP address for the Slave terminal on the top of the 
master terminal, if used, and select the Set button. 

 Bottom Terminal IP Address - Enter the correct IP address for the Slave terminal on the bottom 
of the master terminal, if used, and select the Set button. 

 Allow Interactive Shadow of Master - Normally a terminal with the master module loaded is 
blocked from interactive shadow. If you want to allow interactive shadowing on the master, highlight 
the Allow Interactive Shadow of Master parameter, select Yes from the Value drop-down, and 
select the Set button. 

The Share Keyboard and Mouse Slave module is loaded on the secondary thin clients using the same 
methods as other modules are loaded.  
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Share Keyboard and Mouse Slave Module Properties 

 Master IP Address - This setting allows the slave module to be configured to connect to a 
specified master by entering the IP address of the master terminal, and selecting the Set button. 

Select the Done button when finished. 

Once the ACP Enabled thin clients are booted, the mouse on the master thin client can be moved 
seamlessly into the other desktops. The keyboard will be active in whatever screen the mouse pointer is 
on. 

This allows an operator to have control of several displays with only one keyboard and mouse. The 
mouse movement is seamless, allowing access to displays without switching. 

Note: A Master Share Keyboard and Mouse session cannot be interactively shadowed in ThinManager 
unless it is configured to allow it. 

The keyboards and mice for the slave thin clients can be left attached, but stowed away until a multi-user 
configuration is needed. 

The Share Keyboard and Mouse Master module is licensed for each master thin client. The Share 
Keyboard and Mouse Slave module is free. Each master module can have 1 to 4 slave units.  
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18.3 MultiMonitor  
 

MultiMonitor is configured in the Terminal Configuration Wizard or the Group Configuration Wizard.  

18.3.1.1 MultiMonitor Hardware Specification 

 

MultiMonitor – Terminal Hardware 

MultiMonitor configuration is initiated in the Terminal Configuration Wizard when a MultiMonitor-capable 
thin client is selected on the Terminal Hardware page. 

Select the Next button to continue. 
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MultiMonitor – Enable MultiMonitor 

MultiMonitor requires the use of Display Clients. Once the Use Display Clients checkbox is selected on 
the Terminal Server Specification page the Enable MultiMonitor checkbox becomes visible. 

Select the Use Display Clients and the Enable MultiMonitor checkboxes, and then select the Next 
button.  

Note: WinTMC now supports MultiMonitor if the PC has Windows running on multiple video cards. 
Selecting the Enable MultiMonitor checkbox will allow you to configure a WinTMC client for MultiMonitor 
use. 

Select the Next button to continue. 
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18.3.1.2 MultiMonitor Monitor Configuration 

 

MultiMonitor – Video Settings 

The MultiMonitor Video Setting allows the user to choose how many monitors will be connected to the 
MultiMonitor thin client using the Number of Monitors radio button. 

The Color Depth dropdown allows the color depth to be set for all the monitors. 

The Resolution and Refresh Rate can be set for each monitor using the dropdowns. 
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MultiMonitor – Video Settings 

The monitors do not need to use the same resolutions but can be individually configured. 

Select the Next button to continue. 
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18.3.1.3 MultiMonitor Monitor Layout Page 

 

MultiMonitor – Monitor Layout 

The Monitor Layout page allows the configuration of the MultiMonitors. 

The Choose your monitor layout dropdown will display the various physical arrangements that the 
monitors can be placed in. Select the layout that matches your layout.  

                                

Sample Monitor Layouts 

The Main Monitor radio button determines which screen is considered the main monitor. This monitor will 
display the TermSecure login window, Main Menu, and ThinManager messages. 

The Choose your screen layout dropdown with allow the assignment of sessions to the monitors. The 
monitors can be combined into a “Spanned” session that contains two or more monitors or they can be 
configured to hold an individual session per monitor, called “Screened”, or a combination of the two. 
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Samples of Four-Monitor Configurations 

Note: The desktop of a spanned session is limited to 4096x2048. The selection of monitor resolution on 
the MultiMonitor Video Settings page can affect the number of monitors that you can add to a spanned 
session. 

The TermSecure Initial Screen radio button determines which screen is considered the main monitor for 
TermSecure. This monitor will display the TermSecure Main Menu window and messages. 

Select the Next button to continue. 
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18.3.1.4 MultiMonitor Display Client Selection Page 

 

MultiMonitor – Display Client Selection 

The Display Client Selection page allows Display Clients to be assigned to each screen.  
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MultiMonitor – Display Client Selection 

Highlight the desired group and select the arrow to move it to the desired screen.  

The number of available screens is based on the combination of screened and spanned sessions 
selected on the Monitor Layout page. Each screen can have more than one Display Client. 

The Override button allows you to assign a different user account or video resolution to a Display Client. 
Highlight a Display Client and select the Override button to launch the Override Setting window. 
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Override Setting Window 

The override function is important when you want to run several copies of the same application on the 
MultiMonitor terminal because Microsoft limits each user to a single instance of an application by default. 
Without the override function you will get a single application that bounces from window to window. 

Check the Override checkbox of the setting you desire to override and fill in the appropriate fields. 

Select OK to accept the changes and select Cancel to cancel the changes. 

Select the Next button to continue. 
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18.3.1.5 MultiMonitor Selection Configuration 

 

MultiMonitor - Screen Options 

Terminals using MultiSession can be configured to allow sessions to be moved from monitor to monitor 
for user preference. This is configured by selecting the Allow groups to move to/from screen checkbox. 
If left unselected the sessions will stay in the assigned monitor. 

The Screen Options settings are: 

 Allow groups to move to/from screen – This checkbox, if selected, will allow a session 
from a MultiSession group to be moved to or from the monitor to suit a user’s preference. 

 Main Monitor – This drop-down sets what monitor in a spanned set will display the Display 
Client Selector menu. 

 Selector Options – This button launches the Group Selector Options window to allow 
configuration of the Display Client selector. 
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Group Selector Options Window 

The Group Selector Options allows configuration of the Display Client selection when using MultiSession. 

 Show Group Selector – This checkbox, if selected, will display the Display Client Selector to 
allow the user to switch between MultiSession groups. 

 Enable Tiling – This checkbox, if selected, allows multiple sessions to be tiled to allow a 
visual selection.  

The Selector Options button launches the Group Selector Options window. 

 

Group Selector Options Window 

The Group Selector Options Window has three settings. 

 Auto-hide Group Selector – This checkbox, if selected, will hide the drop-down Display Client 
selector unless the mouse is hovering over the top center of the screen. This checkbox, if 
unselected, will show the drop-down Display Client selector at the top center of the screen. 

 Tile on Group Selector activation – This checkbox, if selected, will tile the sessions when an 
auto-hid group selector is activated. 

 Group Selector Menu Size – This drop-down sets the size of the text in the group selector. 

The Tiling Options button launches the Tile Options window. 

 

Tile Options Window 

The Tile Options Window has five settings. 

 Show Grid – This checkbox, when selected, will separate tiled sessions with black lines. 
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 Tile Inactivity Time – This is the amount of time in seconds that will elapse before an inactive 
session will revert to a tiled mode.  

 Tile Display clients at startup – This checkbox, when selected, will tile the display clients when 
the terminal first connects. 

 Include Main Menu as tile – This checkbox, when selected, will display the TermSecure Main 
Menu as a tiled group. 

 Tile on Right click (mouse or touch screen) - This checkbox, when selected, will allow a right 
click in a session to activate tiling. Holding a finger on a touch screen will trigger tiling if the Right 
Click Hold Time (milliseconds) is used in the touch screen module. 

 Tile Interactive – This checkbox, if selected, will allow a user to select a tiled session and 
interact with it without un-tiling the sessions. 
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18.3.1.6 Allow Group to Move Configuration 

Each Display Client that is to be allowed to move needs to have this property configured in the Display 
Client Wizard. Open the Display Client Wizard for the desired Display Client and navigate to the 
Display Client Options page. 

 

Display Client Wizard – Display Client Options 

To configure a Display Client to be moved from one MultiMonitor screen to another, select the Allow 
Group to be moved (MultiMonitor) checkbox and select the Finish button to accept the change.  

See Display Client List for details on the Display Client Wizard. 
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19 Virtualization in ThinManager 

19.1 Virtualization Overview 
A virtual machine is an isolated and independent install of an operating system within a host operating 
system. It allows one computer to run several virtual computers on one physical device. Virtualization, the 
use of virtual machines, allows the quick deployment and repetition of computers, often by duplicating a 
folder with a few files. 

ThinManager 4.1 includes virtualization tools to help manage virtual servers and virtual workstations in a 
thin client system. 

19.2 VCenter Servers 
VCenter is a virtual machine management tool from VMWare. It allows IT administrators to control and 
manage multiple ESX servers and their virtual machines in a single console. 

ThinManager can connect to a VCenter Server and allow the control and management of the virtual 
machines. 
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VCenter Servers Branch in the ThinManager Tree 

The ThinManager tree has a VCenter Servers branch. 

Right-click on the VCenter Servers branch to add a VCenter Server. It will launch a VCenter Server 
Property Wizard. 
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19.2.1.1 Virtual Machine Host Name 

 

Virtual Machine Host Name Page 

Importance of Page: Virtual Machine Host Name Page allows a VCenter Server to be defined for use 
within ThinManager. 

Settings: 

 VCenter Server Name – Enter the name of the VCenter Server you wish to connect to. 

 VCenter IP Address – Enter the IP address of the VCenter Server. 

 User Name – Enter an administrative account on the VCenter Server to allow a connection. 

 Password – Enter the password of the administrative account. 

 Verify Password – Re-enter the password of the administrative account for verification. 

Buttons: 

 Discover – This button will fill in the IP address of the listed VCenter Server. 

Why Change from Default Settings: 

ThinManager won’t connect to a VCenter Server unless you tell it to. 

Select Finish to complete the configuration. 
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Connecting to VCenter Server 

Once the VCenter Server is defined and the VCenter Server Property Wizard is closed, ThinManager 
will connect to the VCenter Server. 
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Connected VCenter Server 

Once the VCenter Server has connected the VCenter Servers branch can be expanded to see the virtual 
machine information imported from the VCenter Server. 

 

VCenter Server Tree Icons 

The tree will show the defined VCenter Servers, datacenters in the VCenter Server, and virtual machines. 

The virtual machine icons show the state they are in; stopped, suspended, or running. 

19.2.2 VCenter Server Right-Click Menus 
The branches of the VCenter Server tree have various right-click menus: 

 VCenter Servers:  

o Add vCenter Server – Launches the VCenter Server Property Wizard to allow a 
VCenter Server to be defined. 

 Defined VCenter Servers:  

o Remove – Removes the defined VCenter Server from ThinManager. 

 Datacenter:  

o Rename – Allows you to rename the datacenter. 

o Delete – Allows you to delete the datacenter. 

 Virtual Machine:  

o Power Operations: 

 Power On – Turns on a stopped or suspended virtual machine. 

 Power Off – Turns off a stopped or suspended virtual machine. 

 Suspend – Suspends a running virtual machine and stores the state. 

 Reset – Cycles power to the virtual machine to restart the virtual machine. 

o Snapshot: 

 Take Snapshot – Captures and stores the state of the virtual machine. 

 Revert to Current Snapshot – Reapplies the stored state of a previously saved 
virtual machine. 
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 Snapshot Manager – Launches the Snapshot management tool. 

o Rename – Allows the virtual machine to be renamed. 

o Remove from Inventory – Removes the virtual machine from the tree without deleting 
the files. 

o Delete – Removes the virtual machine from the tree AND deletes the file system. 

19.2.2.1 Snapshots 

Snapshots save the state of the virtual machine in a file. Snapshots allow you to preserve a working 
status before applying new applications, programs or updates. If the changes fail or are undesired, then 
the snapshot can be restored allowing the virtual machine to return to the pre-change state. 

Right-clicking on the virtual machine and selecting Snapshot>Take Snapshot will launch the Create 
Snapshot window. 

 

Create Snapshot Window 

The Create Snapshot window allows you to name the snapshot and enter a description. 

Select OK to save the snapshot or Cancel to close without saving. 

Multiple snapshots of a virtual machine can be taken. 

Right-clicking on the virtual machine and selecting Snapshot>Revert to Current Snapshot will apply the 
last snapshot taken. 

Right-clicking on the virtual machine and selecting Snapshot>Snapshot Manager will launch the 
Snapshot Manager window. 
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Snapshot Manager 

The Snapshot Manager window shows all saved snapshots for the selected virtual machine. The 
Snapshot Manager window shows the name, description, and creation date of a highlighted snapshot. 

Buttons: 

 Revert To – This applies the selected saved snapshot.  

 Delete – This deletes a highlighted snapshot. 

 Delete All – This deletes all saved snapshots. 

 Edit – Opens the Create Snapshot window to allow changes to the name and description. 

 OK – Closes the Snapshot Manager. 

A dialog box will require confirmation before changes are made. 

 

Revert to Snapshot Warning 
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19.3 Virtual Terminal Servers 
Virtual terminal servers can be added to ThinManager using two methods, Add Terminal Server and 
Add Virtual Terminal Server. 

Add Terminal Server – You can define a virtual terminal server as a regular terminal server in the 
Terminal Server Wizard.  

Right-click on the Terminal Server branch and select Add Terminal Server to launch the Terminal Server 
Wizard. Add the virtual terminal server as you would a regular terminal server. This doesn’t give you any 
special configuration or tools. 

Add Virtual Terminal Server – You can define a virtual terminal server as a virtual terminal server in the 
Terminal Server Wizard.  

Right-click on the Terminal Server branch and select Add Virtual Terminal Server to launch the 
Terminal Server Wizard.  

 

VCenter Server Virtual Machine Selection List 

The second page of the Terminal Server Wizard will display a Virtual Machine Selection Page. 

Highlight the desired virtual machine and select the Next button. 
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Terminal Server Name Page 

The Terminal Server Wizard will continue with the virtual terminal server filling in the fields. 

These fields, and the schedule button, are the same as on the normal Terminal Server Wizard. See 
Terminal Services Display Servers for details. 

Select Next to continue configuring the virtual terminal server, select Finish to save the configuration and 
close the wizard, or select Cancel to close the wizard without saving the changes. 
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Virtual Terminal Servers in the ThinManager Tree 

 

Terminal Server Tree Icons 

Virtual Terminal Servers will show a different icon than a standard terminal server. 

A virtual terminal server that is defined as a standard terminal server will show the standard terminal 
server icon. 
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Selected Terminal Servers in a Display Client 

Virtual and standard terminal servers are treated identically when choosing display clients. 

19.4 Virtual Workstations 
Windows workstations, XP Pro, Vista Business, or Windows 7 Pro, can be virtualized for deployment as a 
desktop. ThinManager can deploy these virtual desktops to thin clients to limit the upkeep and 
management of the operator’s workstation. 

19.4.1 Workstation Display Clients 
First a Workstation Display Client needs to be created. This will act as a template for the workstation 
deployment. Later when the Workstation Display Client is added to a terminal you will need to assign 
which virtual workstation. 

Launch the Workstation Display Client Wizard by right-clicking on the Display Client branch of the 
ThinManager tree or by right-clicking on the Workstation Display Client branch of the ThinManager tree. 
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Client Name Page of Display Client Wizard 

Enter a name for the Workstation Display Client. Select Workstation from the Type of Display Client 
drop-down if you launched the wizard from the Display Client branch. 

Select Next to continue with the wizard. 
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Display Client Option Page of Display Client Wizard 

The Workstation Display Client adds Virtual Workstation Options to the Display Client Options page 
of the Display Client Wizard. The Client Options and Display Client Connection Options are the same 
as other Display Clients. See Terminal Services Display Clients for details. 

Virtual Workstation Options: 

 Start Virtual Machine if necessary: This checkbox, if selected, will automatically start a 
suspended or stopped virtual machine when it connects. 

 Suspend Virtual Machine when not needed: This checkbox, if selected, will suspend the virtual 
machine when the terminal is powered off. 

Select Next to continue with the wizard. 
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Terminal Services Display Client Options Page of Display Client Wizard 

The Display Client presents the Display Client Wizard similar to the Terminal Services Display Client 
Wizard, with the exception of omitting the addition of terminal servers. Since workstations have a one-to-
one relationship to the terminals the workstations are assigned when the terminal is configured. 

Select Finish to accept the changes and close the wizard. 
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Display Client Icons 

When the Workstation Display Client is created it will be added to the tree with the Workstation Display 
Client icon. 
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19.4.2 Terminals and Virtual Workstations 
Workstations can only deploy their session once to a remote user so the workstation is assigned to its 
remote connection when the Workstation Display Client is applied to a terminal. 

Open the Terminal Configuration Wizard for the terminal that you want to assign a workstation to. 

 

Display Client Selection of the Terminal Configuration Wizard 

The Workstation Display Clients will show up in the Available Display Clients list on the Display Client 
Selection page of the Terminal Configuration Wizard. Move the desired Workstation Display Client to the 
Selected Display Client list for deployment. 

 

Workstation Display Client Icon 

Workstation Display Clients have their own icon. 
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Select Next to continue the wizard. 

 

Complete the Workstation Display Client Configuration Page 

The next page of the wizard is the Complete the Workstation Display Client Configuration Page. 

Importance of Page: Each deployment of a Workstation Display Client needs to be tied to an available 
workstation. 

Buttons: 

 Add Workstation – This button will launch a window that allows a workstation to be designated 
for use by this terminal. 

 Add Virtual Workstation – This button will launch a window that allows a virtual workstation to 
be designated for use by this terminal. 

 Remove – This button remove a highlighted workstation from the Selected Workstation list. 

 Edit – This button will re-open the window that allowed a workstation to be added to the Selected 
Workstation list. 

 Arrows – This button will change the loading order of the assigned workstations. 

Fields: 

 Selected Workstations – This textbox will display the workstations assigned to the terminal. 

Why Change from Default Settings: 



 

ACP ThinManager 6.0 Virtualization in ThinManager    395 

ThinManager won’t connect to workstation unless you tell it to. 

 

Add Workstation Window 

Selecting the Add Workstation button on the Complete the Workstation Display Client Configuration 
Page will launch the Add Workstation window. 

Enter the name and address of the workstation in the appropriate fields.  

Select Add to accept the configuration or select Cancel to close the window. 
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Add Virtual Workstation Window 

Selecting the Add Virtual Workstation button on the Complete the Workstation Display Client 
Configuration Page will launch the Add Virtual Workstation window. 

The VCenter Server tree will be displayed in the Available Virtual Workstation pane. Highlight the desired 
virtual workstation and select the Add button to apply the virtual workstation to the terminal.  

Select Cancel to close the window without accepting the configuration. 
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Complete the Workstation Display Client Configuration Page 

Once a workstation or virtual workstation is assigned to the terminal it will be displayed in the Selected 
Workstations window. 
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Workstation in ThinManager Tree 

The ThinManager tree will display the workstation icons for the terminal once the terminal is restarted to 
apply the configuration changes. 
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20 Scheduling 

ThinManager allows tasks to be automated with the Schedule function. This applies to Terminals, 
Terminal Groups, Terminal Servers, TermSecure Users, and the ThinManager Server.  

 

20.1 Terminal Schedule 
Selecting the Schedule button on the Terminal Options page will launch the Event Schedule window 
and allow a schedule to be created for terminal events.  
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Terminal Configuration Wizard - Terminal Options Page 

Check the Set Schedule checkbox and select the Schedule button to launch the Event Schedule 
window. 

Note: The Schedule for Terminal Groups is the same as for individual terminals. It has an advantage of 
applying the scheduled events to a whole group of terminals instead of requiring a configuration for each 
event on each terminal. 

 

Event Schedule 

The Event Schedule will list events for the terminal or group. It has four buttons: 

 The Add button will launch a Schedule window to allow an event to be configured. 

 The Edit button will allow a highlighted event to be changed. 

 The Delete button will remove a highlighted event. 

 The OK button will accept changes and close the Event Schedule window. 

Events can be added by selecting the Add button to launch the Schedule window. 
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Schedule Window 

The Schedule window has several configuration settings. 

Event Type is a drop-down box that allows event selection: 

 Disable Terminal - This will prevent a terminal from being used, although its terminal server 
sessions will still be running on the terminal servers.  

 Enable Terminal - This will allow a disabled terminal to become active again. 

 Reboot Terminal - This will cycle power on the terminal and reload its configuration. 

 Reset Terminal Sessions - This will logoff the sessions that the terminal has open on terminal 
servers. 

The Repeat Interval radio buttons allow the event in the Event Type drop-down to be run Once Only, 
Weekly/Daily, Monthly, or Yearly.  

 Selecting Once Only will show a Select Date field for the event.  

 Selecting Weekly/Daily will show a Weekly Schedule list for the event to run. The Every Day 
button will select all the days in the list. 

 Selecting Monthly will show a Select Day of Month field for the event.  

 Selecting Yearly will show a Select Date field for the event.  

The Time field allows the selection of the time that the event should occur.  

Select the OK button to close the Schedule window.  
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Select Add to add another event to the Event Schedule or select OK to close the Event Schedule 
window and return to the terminal configuration. 

 

20.2 Terminal Server Schedule 
The Terminal Server Name page of the Terminal Server Wizard has a Schedule button to configure a 
schedule for terminal server events. 

 

Terminal Server Wizard – Terminal Server Name Page 

Select the Schedule button on the Terminal Server Name page of the Terminal Server Wizard to launch 
the Event Schedule window. 
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Event Schedule 

The Event Schedule will list events for the terminal or group. It has four buttons. 

 The Add button will launch a Schedule window to allow an event to be configured. 

 The Edit button will allow a highlighted event to be changed. 

 The Delete button will remove a highlighted event. 

 The OK button will accept changes and close the Event Schedule window. 

Events can be added by selecting the Add button to launch the Schedule window. 
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Schedule Window 

The Schedule window has several configuration settings. 

Event Type is a drop-down box that allows event selection: 

 Disable Terminal Server - This will disconnect all the thin clients connected to the terminal 
server. The sessions will remain idle on the terminal server unless they are set to disconnect in 
the Terminal Services Configuration console. See Disable Terminal Server for details. 

 Enable Terminal Server - This will allow a disabled terminal server to accept thin client 
connections again. 

 Reboot Terminal Server - This will cycle power on the terminal server and restart it. 

The Repeat Interval radio buttons allow the event in the Event Type drop-down to be run Once Only, 
Weekly/Daily, Monthly, or Yearly.  

 Selecting Once Only will show a Select Date field for the event.  

 Selecting Weekly/Daily will show a Weekly Schedule list for the event to run. The Every Day 
button will select all the days in the list. 

 Selecting Monthly will show a Select Day of Month field for the event.  

 Selecting Yearly will show a Select Date field for the event.  

The Time field allows the selection of the time that the event should occur.  

Select the OK button to close the Schedule window.  

Select Add to add another event to the Event Schedule or select OK to close the Event Schedule 
window and return to the terminal server configuration. 
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20.3 ThinManager Server Schedule 
The ThinManager Server Configuration Wizard has a System Schedule page that allows the 
Scheduler to be launched. This allows tasks to be scheduled for the ThinManager Server. 

 

20.3.1.1 System Schedule 

 

System Schedule 

Select the Edit Schedule button to launch the Event Schedule window. 
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Event Schedule Window 

The Event Schedule window allows events to be scheduled by selecting the Add button when system is 
displayed in the Select Event Category drop-down box.  
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Schedule for Weekly Event 

The Schedule dialog allows events to be scheduled for the ThinManager. The two main events are Run 
Report and Backup Configuration Database. 

Select the desired event in the Event Type drop-down. 

If Run Report is chosen, select the desired report in the Report Template File drop-down. 

If Backup Configuration Database is chosen the backup file will be automatically chosen if the Auto 
Generate Filename checkbox is selected. To use a different filename, uncheck the Auto Generate 
Filename checkbox and enter the desired name in the Report Output Filename. A Browse button will 
appear to allow selection of the file. 

The Repeat Interval radio buttons control the frequency of the event. The time selection varies with the 
Repeat Interval chosen. 
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Schedule for Monthly Event 

Select the appropriate time for the event and select OK to accept the configuration and Cancel to cancel 
the changes. 

While the Event Schedule window is open, other scheduled events can be viewed by selecting the event 
type in the Select Events Category drop-down. The event categories are system (ThinManager Server), 
terminal (Terminals), terminalserver (Terminal Servers) and user (TermSecure Users). 
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Events Schedule 

New events cannot be added for the non-system categories, but existing events can be changed by 
highlighting an event and selecting the Edit button. Events can be deleted by selecting the Delete button. 

The OK button accepts the changes and closes the window. 
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20.4 TermSecure User Schedule 
TermSecure Users and TermSecure User Groups have a schedule on the User Options page of the 
TermSecure User Configuration Wizard. 

 

TermSecure User Terminal Configuration Wizard – User Options Page 

Check the Set Schedule checkbox and select the Schedule button to launch the Event Schedule 
window. 

Note: The Schedule for TermSecure User Groups is the same as for individual TermSecure Users. It has 
an advantage of applying the scheduled events to a whole group of users instead of requiring a 
configuration for each event on each user. 
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Event Schedule 

The Event Schedule will list events for the TermSecure User or TermSecure User group. It has four 
buttons: 

 The Add button will launch a Schedule window to allow an event to be configured. 

 The Edit button will allow a highlighted event to be changed. 

 The Delete button will remove a highlighted event. 

 The OK button will accept changes and close the Event Schedule window. 

Events can be added by selecting the Add button to launch the Schedule window. 
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Schedule Window 

The Schedule window has several configuration settings. 

Event Type is a drop-down box that allows event selection: 

 Disable User - This will prevent a user from logging in through TermSecure or will disconnect 
and existing session. 

 Enable User - This will allow a user to become active again. 

The Repeat Interval radio buttons allow the event in the Event Type drop-down to be run Once Only, 
Weekly/Daily, Monthly, or Yearly.  

 Selecting Once Only will show a Select Date field for the event.  

 Selecting Weekly/Daily will show a Weekly Schedule list for the event to run. The Every Day 
button will select all the days in the list. 

 Selecting Monthly will show a Select Day of Month field for the event.  

 Selecting Yearly will show a Select Date field for the event.  

The Time field allows the selection of the time that the event should occur.  

Select the OK button to close the Schedule window.  

Select Add to add another event to the Event Schedule or select OK to close the Event Schedule 
window and return to the terminal configuration. 
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21 Reports 

21.1 Reports Overview 
ThinManager has the ability to run reports to show and collect data on the ThinManager system. These 
reports can show the event log, configurations, uptimes, and other data. 

A Reports tab on the Details pane will show a report for a highlighted ThinManager Server, terminal, 
terminal group, terminal server, TermSecure user, or TermSecure user group. 

Reports can be scheduled to be run and saved as *.html files for storage or further analysis. 

21.2 Report Template Installation 
ThinManager will install a number of reports into the ThinManager folder (C:\Program 
Files\Automation Control Products\ThinManager\Report Templates) 
during installation. 

Additional report templates can be downloaded from http://www.thinmanager.com/support/downloads.php 
as they become available. 

New reports are installed by selecting Install > Reports from the ThinManager menu. This launches the 
Reports window. 
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Reports Window 

Select the Install button to launch a file browser.  

 Report Templates – If this radio button is selected the file browser will browse for *.html 
files.  

 SQL Files – If this radio button is selected the file browser will browse for *.sql files. 

 Images, Finished Reports, etc. – If this radio button is selected the file browser will browse 
for assorted files. 
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File Browser 

Each report has a *.html component and a *.sql component. Select the Report Templates radio 
button, browse to the new *.html file and select Open to install. Select the SQL Files radio button, 
browse to the new *.sql file and select Open to install. Once these two components are added the 
report will be available. 

21.3 Selecting Reports 
The reports are displayed on a Report tab in ThinManager. To select which report will be displayed on 
the Report tab select View > Reports from the ThinManager menu to launch the Select Reports window. 
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Select Reports Window 

The Select Reports window has four fields that determine which report is displayed on the report tab. 

 System Report – This selects the report to display on the report tab when the ThinManager 
Server is highlighted. 

 Terminal Report – This selects the report to display on the report tab when a terminal or 
terminal group is highlighted. 

 Terminal Server Report – This select the report to display on the report tab when a terminal 
server is highlighted. 

 TermSecure User Report – This selects the report to display on the report tab when a 
TermSecure User or TermSecure User Group is highlighted. 

Use the drop-down list to select the desired report. 
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21.4 Report Tab 
The reports selected in the Select Reports window will be displayed on the Report tab in ThinManager. 

 

Report Tab 

Highlight the desired ThinManager Server, terminal, terminal group, terminal server, TermSecure user, or 
TermSecure group, and then select the Report tab to display the report. 



 

418    Reports ACP ThinManager 6.0 

 

21.5 Print Report 
A Report can be printed by selecting the Report tab then selecting View > Print from the ThinManager 
menu. A Print window will be displayed to allow the selection of the printer. 

 

Print Window 

Highlight the desired printer and select the Print button to print the report. 
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21.6 Scheduling Reports 
Reports can be scheduled to be run once at a specified time or to be run regularly at a specific time. The 
reports are saved as *.html files for storage or further analysis. 

To schedule report generation open the ThinManager Server Configuration Wizard by highlighting the 
ThinManager Server and selecting File > Modify. 

 

ThinManager Server Configuration Wizard – System Schedule 

Navigate to the System Schedule page and select the Edit Schedule button to launch the Event 
Schedule window. 
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Event Schedule Window 

Select the Add button to open the Schedule window. 
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Schedule Window 

The Schedule window allows system events to be configured. 

  Event Type – This drop-down allows the event to be chosen. There are two types: 

 Backup Configuration Database – This allows a scheduling of automatic configuration 
backups. 

 Run Report – This allows a report to be run and saved as a *.html file on a regular 
basis. 

 Report Template File - This drop-down allows the selection of the report to run. 

 Report Output File – This applies the naming convention to the saved reports. 

 Auto Generate Filename – This checkbox, if selected, will save the file to the 
ThinManager folder with the report name and a time stamp as its title.    

 If the Auto Generate Filename is unselected, the field allows entry of the desired 
filename. The filename needs to end in .html. 

There are a few switches that allow the file name to be modified with a timestamp for 
identification purposes. If you do not use a timestamp, the file will be overwritten each 
time the report is run. 

 %c – Adds date and time 
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 %h – adds hour (0-24) 

 %M – adds minute (0-59) 

 %x – adds date 

 %X – adds time 

 Repeat Interval – These radio buttons allow the frequency of the report generation to be set. 

 Time – The fields to set the time of the report generation changes to match the Report 
Interval selected by the radio button. The Time field may allow dates, days, hours, or 
intervals to be set for the report. 

Once the report is configured, select OK to accept the report schedule. 

 

Event Schedule 

The scheduled report will be displayed in the Event Schedule window. 

 Select Add to add another report schedule. 

 Select Edit to edit the schedule of a highlighted report.  

 Select Delete to delete the schedule of a highlighted report.  

 Select OK to accept the schedules and close the window. 

When a report is run the files are saved for viewing. 
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Saved Reports 

Once the report has run it can be opened in a web browser. 

 

Report Shown in Internet Explorer 
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Once the report is generated the data can be saved or reformatted as desired using standard HTML 
tools. 

21.7 Changing the Report Logo 
Each report template has a ThinManager TM3 logo as part of the report header. This can be changed to 
your company logo. 

1. Create a copy of the desired logo in *.jpg format with a 
size of 150x50 pixels. A white background is helpful if the 
logo is irregularly shaped. 

2. Name the file logo150x50.jpg. 

3. Copy the logo150x50.jpg into the ThinManager folder 
(C:\Program Files\Automation Control 
Products\ThinManager\Reports by default). 

4. Open the report to see the change. 

The new logo will be displayed on all reports. 
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22 WinTMC Fat Client 

22.1 WinTMC Overview 
WinTMC is a ThinManager Client for PCs running Windows NT/2000/XP/Vista/Windows 7 operating 
systems. WinTMC provides similar functionality to that of a Terminal. The WinTMC client can use failover, 
Instant Failover, SmartSession, MultiSession, and AppLink, among others. Once the WinTMC client is 
installed the client can be managed remotely through ThinManager instead of locally. 

Note: WinTMC should not be installed on a computer that is running ThinManager. A port conflict will 
prevent either from running properly. WinTMC is meant for PCs and not servers. 

WinTMC must use Display clients. 

WinTMC supports MultiMonitor if the PC has Windows running on multiple video cards. 

WinTMC does not support Tiling. 

See WinTMC Installation for details on installation. 
 

22.2 Local WinTMC Configuration  
When WinTMC starts, a Configure button will be displayed on the splash screen.  
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WinTMC Splash Screen 

Click on the Configure button to specify the ThinManager Server(s) to use.  

 

WinTMC ThinManager Server List Configuration 

The ThinManager Server List allows the WinTMC to be pointed to one or more ThinManager Servers to retrieve its 
configuration. 

Enter the IP address or name of your ThinManager Servers in the Enter new ThinManager Server 
Name or IP Address field and click the Add button to add them to the Current ThinManager Servers list.  

The WinTMC will try to connect to the ThinManager Servers in the order listed, so the order can be 
changed with the Move Up and Move Down buttons. 
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Unneeded ThinManager Servers can be removed with the Delete button. 

This configuration menu can be password protected by selecting the Set Password button. Once the 
password is set, when WinTMC is started and the Configure button is clicked, a password will be required 
to change the configuration. 

 

No ThinManager Server Specified 

If the OK button is selected without entering a ThinManager Server, an error window will remind you to enter a 
ThinManager Server address. 

Once the local configuration is set, WinTMC will connect to a ThinManager Server and attempt to retrieve 
its configuration.  

 

Terminal Replacement Dialog 

If the WinTMC PC has not been defined, the user will be prompted with a dialog box to allow for the 
creating a new configuration or replacing an existing terminal configuration on the ThinManager Server.  

This functionality is similar to that of the create/replacement menu on a Thin Client. See Replace or 
Create New Mode for details on that method. 

Once the WinTMC has been assigned a configuration you will not need to make a selection again. 

If you want to run WinTMC without the configure button, you can run it from a command line with the 
ThinManager Servers separated by semi-colons (i.e. WinTMC TMS1; TMS2; TMS3). This will 
eliminate the configure button when WinTMC is started.  
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22.3 WinTMC Configuration in ThinManager  
If you want to pre-create a WinTMC client in ThinManager using the Terminal Configuration Wizard, 
select GENERIC for the Make/OEM and PersonalComputer for the Model on the Terminal Hardware 
page of the Terminal Configuration Wizard. 

 

WinTMC Settings in Terminal Hardware  

The Terminal ID will fill in with the name of the PC. 

The Terminal Configuration Wizard for a WinTMC client is the same as for a thin client with a few 
exceptions. These include: 
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22.3.1.1 WinTMC Video Mode Page 

 

Video Resolution for WinTMC 

The Video Mode for WinTMC includes a setting for FullScreen. 
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22.3.1.2 WinTMC Settings Page 

 

WinTMC Settings 

The Terminal Configuration Wizard includes a WinTMC Settings page. 

WinTMC clients can also be configured on the WinTMC Settings page. These only apply to connections 
made by the WinTMC fat client.  

The settings include: 

Redirect Local Resources: 

 Redirect Serial Ports - This checkbox, if selected, will make local serial ports available in a 
session. Serial Port redirection does not work when you connect to a terminal server running 
Windows 2000 or earlier. 

 Redirect Drives - This checkbox, if selected, will make local drives available in a session. 
Drive redirection does not work when you connect to a terminal server running Windows 
2000 or earlier. 

 Redirect Printers - This checkbox, if selected, will make your local printer available in a 
session.  

 Redirect Sound - This checkbox, if selected, will allow audio played in your session to play 
locally. Sound redirection does not work when you connect to a terminal server running 
Windows 2000 or earlier. 
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 Redirect Smart Cards - This checkbox, if selected, will make your smart card available in a 
session. Smart card redirection does not work when you connect to a terminal server running 
Windows 2000 or earlier. 

Client Control Settings: 

 Allow Client to be closed - This checkbox, if selected, will enable your user to close the 
client (WinTMC program). 

 Allow client to be sized - This checkbox, if selected, will enable your user to resize the 
client. 

 Always maintain monitor connection – Enable this setting to keep the monitoring 
connection active when WinTMC is closed to allow shadowing. Unselecting this checkbox will 
release the WinTMC license when the WinTMC program is closed but will deny shadow 
access. 

 Show groups in separate windows – This checkbox, if selected, will display multiple 
Display Clients as separate windows rather than in one window shell. 

Experience Settings: 

 Show Desktop Background -  This checkbox, if selected, will enable your user to select a 
Windows Desktop Background. If not selected, the background will be a solid color.  

 Show window contents while dragging - This checkbox, if selected, will show the window 
contents to be shown while the window is being dragged.  

 Show menu/window animations - This checkbox, if selected, will enable menu/window 
animations on the client.  

 Show Themes -  This checkbox, if selected, will enable your user to select a Windows 
Theme.  

Note: These functions may be denied by user policies or terminal server configuration. Check the 
Microsoft Local Policy, Group Policy, and Terminal Services Configuration. See Non-ThinManager 
Components for details. 

22.3.2 MultiMonitor WinTMC  
ThinManager now supports MultiMonitor for WinTMC if the PC has Windows running on multiple video 
cards.  

Selecting the Enable MultiMonitor checkbox will allow you to configure a WinTMC client for MultiMonitor 
use. 
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MultiMonitor – Enable MultiMonitor 

MultiMonitor requires the use of Display Clients. Once the Use Display Clients checkbox is selected on 
the Terminal Mode Selection page the Enable MultiMonitor checkbox becomes visible. 

Select the Use Display Clients and the Enable MultiMonitor checkboxes, and then select the Next 
button.  

The Terminal Configuration Wizard will display the MultiMonitor Video Settings page, Monitor Layout 
page, and Display Client Selection page like it does for thin clients. See MultiMonitor for details. 

22.3.3 WinTMC Modules 
WinTMC clients cannot use the ThinManager modules because they are running Windows locally. One 
must install touch drivers, sound drivers, printers, and etc. through the local Windows operating system 
instead of relying on ThinManager modules. 

22.3.4 WinTMC Licensing 
A PC running as a WinTMC terminal requires a WinTMC license in addition to the Terminal Connection 
license. 

WinTMC licenses are sold without redundancy and inherit the redundancy of the Terminal Connection 
licenses in the Master License.        See Licensing ThinManager for details. 
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23 Shadowing  

Shadowing is a popular management tool that allows an authorized user to view what is running on a 
remote client. There are two methods: 

 ThinManager Shadow 

 Terminal-to-Terminal Shadow 

 

23.1 ThinManager Shadow 
Shadowing of a terminal can be initiated from within ThinManager by using the Shadow tab in the Detail 
pane of ThinManager. To shadow, highlight the desired terminal in the ThinManager tree and select 
the Shadow tab. 
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Shadow – Shadow Scaled to Window 

The shadowed terminal can be viewed full-sized or scaled to fit in the Details pane. Select RemoteView > 
Shadow scaled to Window to scale the session and unselect the option to view it life sized. 

23.1.1 Shadow Access 
Access to the shadow function is controlled by membership in ThinManager User Groups. By default only 
administrators are allowed to shadow. 

Shadowing privileges can be established through the use of ThinManager Security Groups. The  

 ThinManager Administrators and Administrators can shadow terminals and interactively 
control the terminal session. 

 ThinManager Power Users can shadow terminals from within ThinManager but cannot interact 
with the session. They are in View-only mode. 

 ThinManager Interactive Shadow Users can shadow terminals from within ThinManager and 
can interact with the session. 

 ThinManager Shadow Users can shadow terminals from within ThinManager but cannot interact 
with the session. They are in View-only mode. 

 ThinManager Users cannot shadow a terminal. 

. See ThinManager Security Groups for details. 
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RemoteView > Interactive Shadow on the menu bar prevents the interaction with the shadowed session 
if unselected. 

RemoteView > Scaled to Window on the menu bar, if selected, will display the entire session in the 
Shadow tab. If unselected, it will display the session at normal size with scroll bars, if needed. 

 

23.1.2 Configure Shadowing 
Shadowing can be configured on the Terminal Options page of the Terminal Configuration Wizard or 
Terminal Group Configuration Wizard. 

 
Terminal Configuration Wizard - Shadow Configuration 

The Allow terminal to be shadowed drop-down box allows the configuration of Shadowing Options. 

 No - Prevents members of the Group from being shadowed. 

 Ask - Will display a message window that will prompt for a positive response before the 
shadowing is allowed. 

 Warn - Will display a message window alerting the terminal that it is to be shadowed, but 
doesn’t require a positive response before the shadowing is allowed. 

 Yes - Allows shadowing to occur without warning or recipient input. 
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Allow Interactive Shadow will allow members with Interactive Shadow privileges to shadow the terminal. 
The Interactive Shadow privileges are configured in the ThinManager Server Configuration Wizard. See 
ThinManager Server Configuration Wizard or ThinManager Security Groups for details. 

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. 
Unselecting the Allow Interactive Shadow checkbox will prevent shadowing from within ThinManager.  

23.1.3 Shadow Keystrokes 
Because the CTL+ALT+DEL and the CTL+ESC keystrokes can’t be sent to the local machine to the 
shadowed thin client, there is a menu item to send these commands. Select RemoteView > Send Key > 
Send Ctl+Alt+Del or RemoteView > Send Key > Send Ctl+Esc to send these commands. 

Note: The Key Block Module will block these commands from being sent to a shadowed session. 

Changing the tab or selecting another tree icon will break the shadow connection. 

 

23.1.4 Terminal-to-Terminal Shadowing 
Terminal-to-Terminal shadowing is made possible with Terminal Shadow display clients. A Terminal 
Shadow display client allows a terminal to shadow another terminal without needed to run the 
ThinManager interface or to be logged in as an administrator. This Shadow Group can contain a specific 
terminal or several terminals. 

See Terminal Shadow Display Clients for details on configuring Terminal Shadow display clients. 
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23.1.4.1 Terminal Shadow Display Client 

 

Terminal Shadow Display Client - Group Name Page 

Configure the Terminal Shadow Display Client by selecting Terminal Shadow from the Type of Display 
Client drop-down after naming the group. 

Select the Next button to continue. 
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23.1.4.2 Terminal Shadow Configuration 

The Terminal Shadow Display Client page allows the selection of the terminal or terminals to be 
shadowed. 

 

Terminal Shadow Display Client – All Terminals Available 

By default the Shadow Group is configured to allow all terminals to be shadowed.  

Unselecting the All Terminals Available checkbox will allow the designation of specific terminals. 
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Terminal Shadow Display Client –Select Terminals 

Select the Add button to launch the terminal selection window. 
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Select Terminal or Group Window 

Select a terminal for shadowing by highlighting it in the Select Terminal or Group window and selecting 
the OK button. The window will close after each selection. 

To add multiple terminals repeat the process by selecting the Add button on the Terminal Shadow 
Display Client page. 
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Terminal Shadow Display Client – Selected Terminals 

The Terminals to Shadow textbox will display the terminals added to the list. 

23.1.4.3 Shadow Selection Screen 

When a terminal launches a Shadow Display Client that has multiple members a Select Terminal to 
Shadow window will be displayed to allow the selection of the terminal to shadow. 
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Terminal Selector 

Highlight the desired terminal and select the OK button. 
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24 ThinManager Security 

24.1 ThinManager Security Groups 
Access to ThinManager can be assigned to Windows User Groups on the ThinManager Security 
Groups page. 

 

ThinManager Security Groups 

ThinManager allows different levels of access and functionality based on standard Windows groups.  
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Standard Windows Groups can be created in the Computer Management console and given different 
privileges in ThinManager. 

ThinManager comes with privileges pre-defined for six groups: 

 Administrators - The Microsoft defined Administrator group is given all privileges by default in 
ThinManager. This may be denied by unselecting the various Windows User Group 
Permissions. 

 ThinManager Administrators have full permission to do anything within ThinManager including 
the power to logoff sessions, kill processes, send messages, restart terminals, calibrate touch 
screens, change terminal configurations, update firmware, update the TermCap, and restore 
configurations. Administrators and members of ThinManager Administrators can shadow 
terminals and interactively control the terminal session. These privileges may not be removed 
and will be grayed out. 

 ThinManager Interactive Shadow Users - Members of this group may shadow a terminal 
interactively. 

 ThinManager Power Users can logoff sessions, kill processes, send messages, restart 
terminals, and calibrate touch screens. They cannot change terminal configurations, update 
firmware, update the TermCap, and restore configurations. ThinManager Power Users can 
shadow terminals from within ThinManager but cannot interact with the session. 

 ThinManager Shadow Users - Members of this group may shadow a terminal but not 
interactively. 

 ThinManager Users can view only. They cannot logoff sessions, kill processes, send messages, 
restart terminals, or calibrate touch screens. ThinManager Users cannot shadow a terminal. 

Additional Windows User Groups can be configured by selecting the Add Group button to launch the 
New Windows Group window. 

 

New Window User Group Window 

Adding a Windows Group name in the field of the New Window Group window and selecting the OK 
button will add the Windows User Group to the drop-down list. 

Note: This doesn’t create the user group on any servers. This just adds the name of an existing group to 
the list that ThinManager is maintaining. 
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New ThinManager Security Group 

Select the group from the Windows Users Group drop-down. Choose the permissions you want to grant 
to the group by double clicking on the function in the Available Windows User Group Permissions list. 
Members of the Windows User Group will have the selected permissions the next time they login. 

Although ThinManager has Windows User Groups pre-configured with privileges, these groups have not 
been created on the terminal servers. 

To create a Windows User Group, open the Computer Management Console by selecting Start > 
Settings > Control Panel > Administrative Tools > Computer Management. 
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Created ThinManager Security Groups 

Highlight Groups in the tree and select Action > New Group. 

Name the group and select the Create button.  

Add Users to the Windows User Group. 

Members of the Windows User Group will have the selected permissions the next time they login. 

If groups are not created, members of the standard Windows Administrator group have full privileges in 
ThinManager while members of the standard Windows User group will be denied access. 

Note: The thinserver service will need to be stopped and restarted and the users will need to re-login for 
the changes to take effect. 
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24.2 ThinManager Server Security  
ThinManager has a number of security settings for the ThinManager Server. Open the ThinManager 
Server Configuration Wizard by right clicking on the ThinManager Server in the tree and selecting 
Modify, or highlight the ThinManager Server and select Edit > Modify from the menu. 

 

ThinManager Server Configuration Wizard 

The second page of the wizard has two settings related to security: 

 Allow unknown terminals to connect - This, when unchecked, will prevent any new terminals 
connecting to the system. 

 Require passwords on unknown terminals -  This checkbox, if checked, allows new terminals 
to be added, but only if the installer has the password. 

Note: The use of this password setting in ThinManager is an effective way to limit hardware addition to 
authorized users. DO NOT use the password setting in the BIOS of the hardware. Forgetting the BIOS 
password can make the unit inoperable. 
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Terminal Replacement 

On the Terminal Replacement page of the ThinManager Server Configuration Wizard is the Enable 
replacement checkbox. This allows failed terminals to be replaced. If this is unchecked, terminals can still 
be added, but only by using the Create New Terminal process. 

This is a global setting that affects all terminals connected to this ThinManager Server. The Enable 
replacement checkbox is also found on the Terminal Configuration Wizard of each terminal and the 
Terminal Group Configuration Wizard of each Terminal Group so that the setting can be applied to 
individual terminals and Terminal Groups. 
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24.2.1 Windows Security 
The ACP ThinManager system delivers a Windows 2000/2003/2008 desktop to each thin client by 
default. Each thin client has full access to the server resources, as if it is the server. However, just 
because the thin client has the ability to have full access to the server resources doesn’t mean that the 
user should be granted full access to the server. To prevent unauthorized changes to the server, it is 
recommended that each user profile have security policies applied through the System Policy Editor to 
limit access to the needed functions. Windows 2000/2003/2008 Security procedures are discussed in the 
Windows on-line help and in many books and articles. 

Administrators usually require that each user login to a terminal with their personal account and have the 
Microsoft policy determine the user’s access rights. 

Note: Task Manager has a feature that allows the launching of applications. If using an Initial Application, 
access to Task Manager should be denied in the security policy or with the Key Block Module to prevent 
a user from launching unauthorized programs. 
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25 TermSecure 

 

25.1 TermSecure Overview 
TermSecure is a ThinManager feature that allows users to logon to a thin client and access user-specific 
or terminal-specific Display Clients. This does not replace the Windows logon, but adds an additional 
layer of security and control.  

TermSecure has two main strategies: 

 SecureAccess or Terminal-specific Applications: You can assign a display client to a 
terminal and keep it hidden from operators with Permissions. A user with the proper 
TermSecure credentials will be able to reveal and access the hidden application. 
 
An example would be a recipe program that would allow a supervisor to initiate a product 
change. This belongs to the station on the floor but you want to prevent users from initiating 
the change. 

 SmartContext or User-specific Applications: You can assign Display Clients to a 
TermSecure user and they can get access to it from any terminal in the plant. This can be 
initiated by either manual login or the use of an authentication device.   
This allows a user to leave one terminal, logon to a different terminal, and reconnect to their 
session, essentially having the session follow him from terminal to terminal. 
 
An example would assign a session with reports to a quality control worker who could login 
anywhere and retrieve their reports. 

SecureAccess or Terminal-specific Applications are controlled with Permissions. 

SmartContext or User-specific Applications are controlled by adding the Display Client to the 
TermSecure User configuration. 

Note: TermSecure requires the usage of Display Clients instead of using individual terminal servers.  

Five licenses of TermSecure are included with each Master License activation. Additional TermSecure 
licenses can be purchased to add to the Master License. 
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25.2 Users Types 
There are three types of users in a ThinManager system. Windows Users and TermSecure Users are 
important to TermSecure. 

25.2.1 Windows Users 
Windows Users are the Microsoft accounts created in Windows that allow access to the Windows 
terminal servers. These are configured within Windows and authenticated by Windows. They can be 
given varying levels of access and power using Windows User Groups and Group Policies. 

25.2.2 TermSecure Users 
TermSecure Users are users who can go to a thin client and receive access to specific Display Clients 
due to their membership in a TermSecure Access Group. The login and authentication is done by 
ThinManager a level above the Windows login.  

TermSecure grants and limits access to terminals and Display Clients but a Windows User login is still 
required to actually logon to the terminal server. 

25.2.3 ThinManager Security Group Users 
ThinManager Security Group Users are Windows User Group members who have been configured in 
the ThinManager Server Configuration Wizard to have varying levels of access and control within the 
ThinManager program. 

These groups are configured on the ThinManager Security Groups page of the ThinManager Server 
Configuration wizard. See ThinManager Security Groups for details. 
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25.3 Deploying TermSecure 
TermSecure may require a number of steps to configure and deploy TermSecure: 

1. TermSecure Access Groups can to be created to use Permissions (optional). 
See Creating Permissions Groups for details. 

2. Terminals can be assigned TermSecure Access Groups to limit access to specific users 
(optional). 
See Permission Groups for Terminals for details. 

3. Display Clients can be assigned TermSecure Access Groups to limit access to specific users 
(optional). 
See Permission Groups for Display Clients for details. 

4. TermSecure Users need to be created. 

5.  TermSecure Users can be assigned to TermSecure Access Groups (optional).  
See TermSecure User Configuration Wizard for details. 

6. A Login strategy needs to be put in place. The TermSecure User can use the Terminal Login, 
their TermSecure login, or a Windows login to access the terminal servers.  
See Windows Login Information for details. 

7. USB drives and ProxCards, if used, need to have the identification number entered in their 
configuration (optional).  
See Card/Badge Information for details. 

8. The TermSecure User can then login to a thin client using TermSecure  
TermSecure prompts the TermSecure User to login to the terminal servers using a Windows User 
account, or it will pass the pre-configured Windows User account information to the terminal 
server for auto-login, based on the login strategy selected.  

9. The TermSecure User is granted access to all Display Clients that share the same TermSecure 
Access as the TermSecure User, and is denied access to Display Clients that they don’t share a 
TermSecure Access Group membership.  



 

ACP ThinManager 6.0 Permissions    453 

 

26 Permissions 

Permissions restrict access to applications unless a person has been given a TermSecure login and the 
matching permission set. 

26.1 Creating Permissions Groups 
Permissions grant or limit access through the TermSecure Access Groups. Select the Permissions 
button in the Terminal Configuration Wizard, the Terminal Group Configuration Wizard, the Display 
Client Wizard, the TermSecure User Wizard, or the TermSecure Users Group Wizard to set these up. 

 Terminal Permissions is the list of named permission groups whose members may 
access a terminal. The Unrestricted group does not require a membership to 
access.  

 Terminal Group Permissions is the list of named permission groups whose 
members may access a terminal belonging to the Terminal group. The Unrestricted 
group does not require membership to access.  

 Display Client Permissions is a list of named permission groups whose members 
may access and view a Display Client. The Unrestricted group does not require a 
login. 

 TermSecure User Permissions is a list of named permission groups to which a 
TermSecure User belongs.  

 TermSecure User Group Permissions is a list of named permission groups to 
which members of a TermSecure User Group belong.  

A TermSecure User can use a terminal when they share membership in a TermSecure 
Access Group. 

A TermSecure User can use a Display Client when they share membership in a TermSecure 
Access Group. 
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26.1.1.1 Creating a TermSecure Access Group  

Selecting Manage > TermSecure Access Groups from the ThinManager menu will launch the Access 
Groups window. 

 

Access Groups Window with Default Groups 

Select the Add button to add an Access Group. The Add button launches an Access Group window. 

 

Permission Group Creation Window 

Enter a name for the new TermSecure Access Group and select OK to create the group. 
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Additional TermSecure Access Groups Created 

The created Access Groups will be displayed in the Access Group window. These TermSecure Access 
Groups, like Microsoft User Groups, do not have settings and parameters, but instead get their 
usefulness by adding members to them or applying restrictions to them. 
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26.2 Permission Groups for Terminals 
TermSecure Access Groups are assigned to a terminal with the Permissions button on the first page of 
the Terminal Configuration Wizard. 

Note: Removing the Unrestricted group from a terminal and replacing it with a TermSecure Access group 
will render the terminal functionless until a member of the group logs in. 

Open the Terminal Configuration Wizard for an existing terminal by double clicking on it in the tree. Start 
the Terminal Configuration Wizard for a new terminal by selecting Edit > Add Terminal. 

 

Terminal Configuration Wizard 

Select the Permissions button on the first page of the Terminal Configuration Wizard to launch the 
Permissions window to apply the TermSecure Access Groups to the terminal. 
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 Permissions Window 

By default, the terminal uses the Unrestricted access group, allowing anyone access to the Display 
Clients that are assigned to the terminal. 

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be 
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or 
highlighting the desired group and selecting an arrow. 

 

Object Permissions 

If the terminal has the Unrestricted access group removed from Member Of list and is replaced by other 
Access Groups, TermSecure will deny access to the terminal except for members of the selected access 
groups. 

Note: Removing the Unrestricted group from a terminal and adding a different group will render the 
terminal functionless until a member of the group logs in. 

Select OK to close the Permissions window. 
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26.3 Permission Groups for Display Clients 
TermSecure Access Groups are assigned to a Display Client with the Permissions button on the first 
page of the Display Client Wizard. 

Open the Display Client Wizard for an existing Display Client by double clicking on it in the tree. Start the 
Display Client Configuration Wizard for a new Display Client by right clicking on the Display Client branch 
icon and selecting Add Display Client. 

 

Display Client Configuration Wizard 

Select the Permissions button on the first page of the Display Client Configuration Wizard to launch the 
Permissions window to apply the TermSecure Access Group to the Display Client. 
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 Permissions 

By default, the Display Client uses the Unrestricted access group, allowing anyone access to the 
Terminal Server. 

If Additional Permission Groups are configured, they will be displayed in the Available list. Access can be 
granted or denied by moving the Access Groups into or out of the Member Of list by double clicking or 
highlighting the desired group and selecting an arrow. 

 

Permissions Changed 

If the Display Client has the Unrestricted access group removed from Member Of list and is replaced by 
other Access Groups, TermSecure will deny access to the terminal except for members of the selected 
access groups. 

Note: Removing the Unrestricted group from a terminal and adding a different group will hide the Display 
Client until a member of the group logs in. 

Select OK to close the Permissions window. 
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26.4 Permission Groups for TermSecure Users 
TermSecure Access Group permissions can be applied to TermSecure Users. This is useful for 
SecureAccess or Terminal-specific Applications. 

Create a TermSecure User to apply the permissions by right clicking on the TermSecure User branch of 
the ThinManager tree and selecting Add TermSecure User.  

TermSecure Access Groups are configured on the first page of the wizard by selecting the Permissions 
button. 

26.4.1.1 TermSecure User Information 

 

TermSecure User Information 

Selecting the Permissions button will open the Permissions window that allows the assignment of a 
TermSecure Access Groups. 
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 Permissions 

The Permissions window for TermSecure Users does not show the Unrestricted or the All Users 
groups, just the created groups. Access can be granted or denied by moving the Access Groups into or 
out of the Member Of list by double clicking or highlighting the desired group and selecting an arrow. 

Select OK to close the Permissions window. 

Select Next to continue with the TermSecure User Configuration Wizard. 
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26.4.1.2 Card / Badge Information 

The second page of the TermSecure User Configuration Wizard is the Card/Badge Information page. 

 

Card / Badge Information Page 

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, 
HID ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered 
later. See Card and Badge Configuration for a TermSecure User for details 

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs, as login devices will 
need the appropriate module added. See TermSecure Modules for details. 

Select the Next button to continue with the configuration. 
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26.4.1.3 Display Client Selection 

The next page of the TermSecure User Configuration Wizard is the Display Client Selection page. 

 

Display Client Selection 

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User. 

Add User specific Display Clients? - This setting, if set to No, will allow the TermSecure User to access 
the display client hidden on a terminal with the TermSecure Access Group permissions. This is used with 
SecureAccess or Terminal-specific Applications. 

This setting, if set to Yes, will allow the selection of Display Clients for the TermSecure User that will be 
added to the terminal when the TermSecure User logs in top the terminal. This is used with SmartContext 
or User-specific Applications. 

Select the Next button to continue with the configuration. 
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26.4.1.4 Terminal Interface Options 

The next page of the TermSecure User Configuration Wizard is the Terminal Interface Options page. 

 

Terminal Interface Options 

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User so a 
terminal using MultiSession will need to have a method to switch between sessions.  

See Terminal Interface Options for details. 
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26.4.1.5 Terminal Hotkey Options 

The next page of the TermSecure User Configuration Wizard is the Terminal Hotkey Options page. 

 

Terminal Hotkey Options 

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations 
that allow switching between sessions. 

See Terminal Hotkeys for details. 
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26.4.1.6 User Options 

The final page of the TermSecure User Configuration Wizard is the User Options page. 

 

User Options 

See User Options for details. 

Select Finish to finish the configuration. 
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26.5 Shortcut Method of Adding TermSecure Access 
Groups 

Members can be added to TermSecure Access Groups quickly through the TermSecure Access Group 
Wizard. 

Open the TermSecure Access Group Wizard by selecting Manage > TermSecure Access Groups from 
the ThinManager menu. This will launch the Access Groups window. 

 

Access Groups Window 

Highlight the desired TermSecure Access Group and select the Edit button. 
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Access Group Window 

Select the Edit Members button to launch the Access Group Members window. 

 

Access Group Members Window 

Select the Terminals, Display Clients, or TermSecure Users radio button to configure that category 
and select the Add button. 
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Select Terminal Window 

A Select Terminal window will be displayed with a tree of the configured terminals and terminal groups. 

Select the desired terminals and terminal groups and select OK for each addition. 

 

Access Group Members 
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The Access Group Members window will show the members of the TermSecure Access Group. These 
can be removed by highlighting and selecting the Remove button. 

Display Clients and TermSecure Users can be added by the same process of adding by selecting the 
appropriate radio button. 

 

Display Client Selection 

 

Member Display Clients  

Members can be removed by highlighting them and selecting the Remove button. 
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472    Permissions ACP ThinManager 6.0 

 

26.6 TermSecure User Configuration Wizard 
A TermSecure User can be configured with a user name, password, and user-specific Display Clients. 
When the user logs into a terminal with that identity, TermSecure will allow the user access to the 
personalized Display Clients for that user in addition to the Display Clients already assigned to the 
terminal. 

Note: The TermSecure Users branch of the ThinManager tree will not be visible unless a Master License 
is installed on the ThinManager Server. 

The TermSecure User Configuration Wizard is launched by right clicking on the TermSecure Users 
branch of the ThinManager tree and select Add TermSecure User.  

26.6.1.1 TermSecure User Information 

The first page of the TermSecure User Configuration Wizard is the TermSecure User Information 
page. 

 

ThinManager User Information 
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The TermSecure User Information has fields for the user name and password that will be used by the 
TermSecure User to log into ThinManager security to access TermSecure functions.  

The TermSecure User Information is for account information: 

 User Name - Enter the user name that the user will use to log into the TermSecure system. 
Although this can be the same as the Windows user name, the TermSecure user name is 
independent of the Microsoft Windows login. This TermSecure user name can be tied to a 
Windows login later in the wizard on the Windows Login Page.  

 Password - Enter the password for the TermSecure User in this field. 

 Verify Password - Re- enter the password for the ThinManager User in this field.  

 The Password Options button launches the Password Maintenance Options window that 
regulates rules for the ThinManager User password. 

 

Password Maintenance Options 

Password Complexity Requirements: 

 Minimum Password Length - Sets the amount of characters that the password must contain to 
be valid. 

 Must contain numbers - This checkbox, if checked, will require that the password contain at 
least one number in it. 

 Must contain symbols - This checkbox, if checked, will require that the password contain at 
least one symbol in it. 

 Must contain capital letters - This checkbox, if checked, will require that the password contain 
at least one capital letter in it. 

Password Maintenance: 

 Allow User to change password - This checkbox, if checked, will allow the user to change the 
password at the TermSecure menu. 

 Force User to change password at next login - This checkbox, if checked, will require the user 
to change the password at the TermSecure menu when they login the next time. 
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 Force User to change password periodically - This checkbox, if checked, will require the user 
to change the password at the TermSecure menu on the schedule set by the User must change 
password every X days field. 

 User must change password every X days - This field sets the time period between the 
scheduled password changes caused by the Force User to change password periodically 
checkbox. 

The OK button closes the window with any changes. The Cancel button closes the window without 
changes. 

Group: 

 The Change Group button opens the Choose User Group window that allows a User to be 
placed in an existing TermSecure Users Group. 

 

Choose User Group 

If TermSecure User Groups have been created, the Choose User Group window will display the 
TermSecure User Group branch of the ThinManager tree. 

 To add the TermSecure User to a TermSecure Users Group, highlight the desired TermSecure 
Users Group and select the OK button. 

 To change the TermSecure User to a different TermSecure Users Group, highlight the desired 
TermSecure Users Group and select the OK button. 

 To remove the TermSecure User from all TermSecure Users Groups, highlight the top-level 
Users branch and select the OK button. 

The OK button closes the window with any changes. The Cancel button closes the window without 
changes. 

Copy Settings: 
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 The Copy Settings from another User checkbox, if selected, activates the Copy From button 
that allows the configuration of an existing TermSecure User to be applied to the current 
TermSecure User. 

 The Copy From button opens the Select User window that allows the selection of the desired 
TermSecure User configuration. 

 

Select User Window 

The Select User window will show a tree with the existing TermSecure User Groups and the TermSecure 
Users.  

Highlight the TermSecure User whose configuration you want to copy and select the OK button. The OK 
button closes the window with any changes. The Cancel button closes the window without changes. 
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26.6.1.2 Card / Badge Information 

The next page of the TermSecure User Configuration Wizard is the Card/Badge Information page. 

 

Card / Badge Information Page 

The Card / Badge Information Page enables the use of Identification devices such as USB flash drives, 
HID ProxCards, and WaveTrend Radio Frequency IDs (RFIDs) as login devices. This will be covered 
later. See Card and Badge Configuration for a TermSecure User for details 

Note: Terminals using the USB flash drives, HID ProxCards, and WaveTrend RFIDs, as login devices will 
need the appropriate module added. See TermSecure Modules for details. 

Select the Next button to continue with the configuration. 
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26.6.1.3 Display Client Selection 

The next page of the TermSecure User Configuration Wizard is the Display Client Selection page. 

 

Display Client Selection 

The Display Client Selection page allows Display Clients to be assigned to the TermSecure User. When 
the TermSecure User logs onto a terminal, these Display Clients will be available on the terminal for him. 

Add User specific Display Clients? - This setting, if set to Yes, will allow the selection of Display Clients 
for the TermSecure User that will be added to the terminal when the TermSecure User logs in top the 
terminal. This provides the user-specific Display Clients. 

This setting, if set to No, will rely on Permissions to grant access to terminal-specific Display Clients. 

Select the Next button to continue with the configuration. 
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26.6.1.4 Display Client Specification 

The next page of the TermSecure User Configuration Wizard is the Display Client Specification 
page. 

 

Display Client Specification Page 

The Display Client Specification page allows Display Clients to be assigned to the TermSecure User if 
the Add User specific Display Clients? radio button is set to Yes. 

Move a Display Client you want the TermSecure User to use into the Selected Display Clients list by 
double-clicking on it in the Available Display Clients list or by highlighting it and clicking the Right 
Arrow button. 

To add a new Display Client, select the Edit Display Clients button to launch the Display Client Wizard. 
See Display Client List for details. 

Select the Next button to continue with the configuration. 
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26.6.1.5 Windows Login Information 

The next page of the TermSecure User Configuration Wizard is the Windows Log In Information 
page. 

 

Windows Login Information 

The Windows Log In Information page allows the configuration of how the TermSecure User will log on 
to the Windows terminal servers. 

There are several Windows login options for the TermSecure User. 

1. The TermSecure User can use the terminal’s username and password to auto-log on to the 
terminal server. To do this, check the Use Terminal Configuration Login Information checkbox 

2. The TermSecure User can use the TermSecure User username and password to auto-log on to 
the terminal server. To do this, check the Same as TermSecure User username/password 
checkbox. The TermSecure User username and password must match a Windows User 
username and password to get authenticated by Windows. 

3. The TermSecure User can use a separate username and password to auto-log on to the terminal 
server. To do this, use the fields for the Username, Password, and Domain that are provided. 

4. The TermSecure User can be required to manually log onto the terminal servers. To do this, 
leave the checkboxes unchecked and the Username, Password, and Domain empty. 
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Select the Next button to continue with the configuration. 

26.6.1.6 Terminal Interface Options 

The next page of the TermSecure User Configuration Wizard is the Terminal Interface Options page. 

 

Terminal Interface Options 

The Terminal Interface Options page sets the menus and hotkeys for the TermSecure User so a 
terminal using MultiSession will need to have a method to switch between sessions.  

Group Selector Options allow on-screen switching of sessions. 

Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the 
properties that were configured for use with the terminal. 

 Show Group Selector on Terminal - This checkbox, if selected, will display an on-screen drop-
down menu that can be activated by mouse.  

 Enable Tiling - This checkbox, if selected, allows the sessions to be tiled so that the user can 
make a visual selection of the desired selection. 

 Screen Edge Group Selection - This checkbox, if selected, will activate a feature that will switch 
windows if the mouse is moved off screen. 

 Selector Options - This button, if selected, will launch the Group Selector Options window. 

 Tiling Options - This button, if selected, will launch the Tile Options window. 
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Group Selector Options Window 

The Group Selector Options window has several settings. 

 The Auto-hide Group Selector checkbox will hide the Group Selector until the mouse is moved 
to that space. 

 The Tile on Group Selector checkbox, when selected, will tile the Display Clients when the auto-
hid selector is chosen. This allows the user to select from the available sessions. 

Select the OK button to accept changes or the Cancel button to close. 

The Tiling Options button will launch the Group Selector Options window that allows configuration of 
the on-screen Group Selector bar. 

 

Tile Options 

The Tile Options window has several settings. 

 Show Grid – This checkbox, when selected, will show the tiled sessions in a grid with each grid 
labeled with the session name as while the session is loading. 

 Tile Inactivity Time – This field sets the length of time that the terminal screen will stay focused 
on a selected session before reverting back to a tiled state due to inactivity.  

 Tile Display Clients at startup – This checkbox, when selected, will show the sessions tiled 
when the terminal first connects to its sessions. 

 Include Main Menu as tile – This checkbox, when selected, will include a session displaying the 
TermSecure Main Menu. 

 Tile on Right click (mouse or touchscreen) - This checkbox, when selected, will initiate tiling 
when a session is right clicked. 

 Tile Interactive – This checkbox, when selected, will allow a user to click into a tiled session and 
control it interactively without switching focus to a single session. To focus on a single session 
use the Group Selector Dropdown or the tiling hotkey (CTL + T), if enabled. 

Select the OK button to accept changes or the Cancel button to close. 

The Main Menu Options button will launch the Main Menu Options window that allows configuration of 
the TermSecure Main Menu. 
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Main Menu Options Window 

The Allow Reboot/Restart checkbox, if selected, will add a Reboot and Restart button to the main menu. 

26.6.1.7 Terminal Hotkey Options 

The next page of the TermSecure User Configuration Wizard is the Terminal Hotkey Options page. 

 

Terminal Hotkey Options 

Terminal Hotkeys on the Hotkey Configuration page allows the selection of keyboard combinations 
that allow switching between sessions. 

Use Terminal Settings - This checkbox, when selected, will let the TermSecure User inherit the 
properties that were configured for use with the terminal. 
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 Enable Instant Failover Hotkeys - This checkbox, if selected, allows the hot key switching 
between the two active sessions of a Display Client that is using Instant Failover. 

 Enable Group Hotkeys - This checkbox, if selected, allows the hot key switching between 
different sessions of a terminal using MultiSession. 

 Enable Tiling Hotkey – This checkbox, if selected, allows SessionTiling to be activated by a 
hotkey combination. 

Selecting the Change Hotkeys button when Enable Instant Failover Hotkeys is selected will allow the 
hotkeys to be changed from the default. 

 

Select Instant Failover Hotkeys  

The default hotkey for Instant Failover switching is set to Control+F9. This can be changed by selecting 
the Alt Key radio button or using the drop-down to select another function key. 

Selecting the Change Hotkeys button when Enable Group Hotkeys is selected will allow the 
MultiSession switching hotkeys to be changed from the default. 
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Select MultiSession Switching Hotkeys 

The default hotkey for MultiSession switching is set to Control+Page Up and Control+Page Down. This 
can be changed by selecting the Alt Key radio button or using the drop-down to select another hot key. 

Selecting the Change Hotkeys button when Enable Tiling Hotkeys is selected will allow the hotkeys to 
be changed from the default. 

 

Select SessionTiling Hotkeys 

The default hotkey for SessionTiling activation is set to Control+t. This can be changed by selecting the 
Alt Key radio button or using the drop-down to select another hot key. 

Select the OK button to continue or the Cancel button to close without accepting changes. 
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26.6.1.8 User Options 

The final page of the TermSecure User Configuration Wizard is the User Options page. 

 

User Options 

Log In / Log Out Options 

 Inactivity Timeout - TermSecure will log a TermSecure Users off the terminal after this much 
inactive time has passed.  

 Reset Sessions at Logout - This checkbox, if selected, will logoff a session when the 
TermSecure User logs off. 

 Activate User Group at Log In - This checkbox, if selected, will display the TermSecure User’s 
first Display Client when the user logs in to the terminal. 

User Schedule 

 Set Schedule - 

Selecting the Schedule button on the User Options page will launch the Event Schedule window and 
allow a schedule to be created for terminal events. 

See Terminal Schedule for details. 

Terminal Effects 
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 Enable Terminal Effects - This allows the use of Terminal Effects. This currently includes sliding 
Windows and message rollups. 

Shadowing 

 Allow terminal to be shadowed - This drop-down box allows the configuration of Shadowing 
Options. 

o No - Prevents the TermSecure Users from being shadowed. 

o Ask - Will display a message window that will prompt for a positive response before the 
shadowing is allowed. 

o Warn - Will display a message window alerting the terminal that it is to be shadowed, but 
doesn’t require a positive response before the shadowing is allowed. 

o Yes - Allows shadowing to occur without warning or recipient input. 

 Allow Interactive Shadow - This checkbox, if selected, will allow members with Interactive 
Shadow privileges to shadow this TermSecure User. 

Shadowing is initiated from the Shadow tab on the Details pane of the ThinManager program. 
Unselecting this will prevent shadowing from within ThinManager. 

Select Finish to finish the configuration. 



 

ACP ThinManager 6.0 Permissions    487 

 

26.7 TermSecure Users Group Configuration Wizard 
TermSecure Users can be organized into TermSecure User Groups, just as Terminals can be organized 
into Terminal Groups. Each setting of the TermSecure Group has a Group Setting checkbox. If this box is 
selected then that setting will be applied to each member of the TermSecure Group. 

The TermSecure Users Group Configuration Wizard can be launched by right clicking on the 
TermSecure Users branch of the tree and selecting Add TermSecure User Group.  

26.7.1.1 TermSecure User Group Information 

The first page of the TermSecure Group Configuration Wizard is the TermSecure User Group 
Information page. 

 

ThinManager User Group Information 

The TermSecure User Group Information has fields for the group name and membership.  

 User Name - This field names the TermSecure User Group. 

Group Setting - This checkbox, if selected, applies this configuration to all members of the group. 
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The rest of the TermSecure Group Configuration continues as the TermSecure User Configuration, with 
the addition of the Group Setting checkboxes. 

 

TermSecure Group Configuration Wizard 

Group Settings that are selected will be grayed out for members of the group. Group Settings that 
aren’t selected will be available for configuration on the individual TermSecure User configuration page. 
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TermSecure Group Member 

Select Finish to complete the configuration. 
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26.8 Adding a TermSecure User to the TermSecure 
User Group 

To add a TermSecure User to a TermSecure User Group, create a new TermSecure User by right 
clicking on the TermSecure Users branch in the ThinManager tree and select the Add TermSecure 
User option or double click on an existing user to launch the wizard. 

 

TermSecure User Information Page 

Select the Change Group button. This will launch the Choose User Group window. 
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Choose User Group Window 

Highlight your TermSecure Users Group and select OK. This will accept the changes and close the 
window. 
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TermSecure User Information Page 

The TermSecure User Group will now be displayed in the Group field. 

Select Next to continue. 
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Card/Badge Information 

The Card/Badge Information options are available because these are individual settings, not group 
settings. 

Select Next to continue. 
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Display Client Specification 

Each of the settings that have the Group Setting checkbox selected in the TermSecure User Group 
wizard will be grayed out because the Group Setting enforces the configuration of each chosen 
parameter. 

Select the Finish button to accept the configuration. 
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26.9 TermSecure Login 
To log in a TermSecure User on a terminal, go to a terminal that has the Enable TermSecure checkbox 
selected on the Terminal Server Specification page.  

Type the default CTL+m or other designated hotkey at the keyboard or select from group selector 

The Main Menu will be displayed on the terminal. 

 

TermSecure Main Menu 

The About button to see details about the terminal. 

 

About Menu 

Select OK to close the About window. 

Select the Log In button to login. 

 

TermSecure Log On Screen 

Enter your TermSecure User user name in the Enter User Name field. 

Select OK. 
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Password Screen 

Enter the password in the field. 

Select the OK button. If the user name and password are correct, ThinManager will allow the login. 

 

ThinManager With TermSecure Log On 

Once a TermSecure User is logged into a terminal, ThinManager will display the TermSecure User’s 
name after the terminal name in the tree.  

ThinManager will add the name of the terminal after the TermSecure User name in the tree. 

Right-clicking on a terminal and selecting Go to TermSecure User will move the focus to the 
TermSecure user that is logged into the terminal. 

Right-clicking on a TermSecure user and selecting Go to Terminal will move the focus to the terminal 
that the TermSecure user is logged into. 
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26.9.1 Logging Out 
The TermSecure User can be logged out by: 

 Opening the TermSecure Main Menu (type CTL+m) on the terminal and selecting the Log Off 
button. 

 Right clicking on the TermSecure User in the ThinManager tree and selecting Logoff User. 

 Restarting or Rebooting the terminal that has a TermSecure User logged in. 

 

Main Menu 

The Switch User button will log off the TermSecure User and open the Login screen for another 
TermSecure User. The Log Off button will log of the TermSecure User and return to the terminal’s 
display. 

26.10 TermSecure Menu 
The TermSecure Menu that is displayed on a terminal that allows TermSecure Users to manually log on 
to a terminal is configurable for use with TermSecure. This menu is generated from the terminal and not 
the terminal server session.  

 

Basic TermSecure Menu 

The TermSecure Menu can be configured by a number of settings in the Terminal Configuration Wizard 
and TermSecure User Wizard. 

The Main Menu is activated on the Terminal Interface Options page of the Terminal Configuration 
Wizard and/or TermSecure User Configuration Wizard. 

26.10.1.1 Main Menu Configuration - Terminal Configuration Wizard 

Open the Terminal Configuration Wizard by double clicking on the desired terminal in the ThinManager 
tree. Terminals using Display Clients will display the Terminal Interface Options page. This page will 
display Main Menu options when TermSecure is enabled for the terminal. 
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Terminal Interface Options Page 

A terminal using MultiSession will need to have a method to switch between sessions. This is configured 
on the Terminal Interface Options page. For terminals using TermSecure, additional Main Menu options 
are available, as shown. See Terminal Interface Options for a terminal for a comparison. 

Group Selector Options allow on-screen switching of sessions. 

 Show Selector on Terminal - This checkbox, if selected, will display an on-screen drop-down 
menu that can be activated by mouse.  

 

On-Screen Group Selector 

 Screen Edge Display Client Selection - This checkbox, if selected, will activate a feature that 
will switch windows if the mouse is moved off screen. 
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 Selector Options button will launch the Group Selector Options window that allows 
configuration of the on-screen Group Selector. 

 

Group Selector Options Window 

The Auto-hide Group Selector checkbox, if selected, will hide the Group Selector until the 
mouse is move to that space. 

The Tile on Group Selector activation checkbox, when selected, will tile the Display Clients 
when the auto-hid selector is chosen. This allows the user to select from the available sessions. 

The Group Selector Menu Size drop-down box allows the setting of the size of the Group 
Selector font.  

Main Menu Options allow on-screen switching of sessions. 

 The Main Menu Options button will launch a window for Main Menu settings. 

 

Main Menu Options 

The Main Menu Options window has several settings. 

 Allow reboot/restart – This checkbox, if selected, will add a Reboot and a Restart button on the 
main TermSecure login window. 

 Show Main Menu on Group Selector - This checkbox, if selected, will display the TermSecure 
Main Menu as an option on the Group Selector drop-down. 

 Show Virtual Keyboard – This checkbox, if selected, will prompt the display of a virtual keyboard 
for TermSecure logins. This is helpful for thin clients with touch screens. 

The Allow reboot/restart checkbox, if selected, will add a Shut Down button to the TermSecure Main 
Menu. The Shut Down button leads to a menu with a Restart and Reboot button. 
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Main Menu with Shut Down Button 

Once the user logs out, a Shut Down button will appear on the Main Menu. Selecting the Shut Down 
button will launch the Shut Down Menu. 

 

Shut Down Menu 

The Shut Down window has two buttons. 
 Restart, when selected, will log off the TermSecure User, reload the configuration and load any changes. 

 Reboot, when selected, will log off the TermSecure User, power off the terminal and reload firmware and 

configuration. 

 

Terminal Virtual Keyboard 

If the Show Virtual Keyboard checkbox is selected a virtual keyboard will be displayed on the terminal. 
This is helpful for touch screen users. 

Select OK to save setting or Cancel to close without saving. 
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26.10.1.2 Main Menu Hotkey - Terminal Configuration Wizard 

The Hotkey Configuration page has an additional TermSecure setting when the Enable TermSecure 
checkbox is checked on the Terminal Server Specification page. 

 

Hotkey Configuration – TermSecure Enabled 

The Enable Main Menu Hotkey checkbox, when selected, will allow the TermSecure Main Menu to be 
launched with a hotkey combination. The Change Hotkey button allows the default CTL+m combination 
to be changed. 
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Select HotKeys Window for Main Menu 

The default hotkey for the Main Menu is set to Control+m. This can be changed by selecting the Alt Key 
radio button or using the drop-down to select another hot key. 

Select the OK button to continue or the Cancel button to close without accepting changes. 

 

Main Menu 

The Main Menu can be launched with the Ctrl+ m hotkey if the Enable Main Menu Hotkey checkbox is 
selected. 



 

ACP ThinManager 6.0 Permissions    503 

 

26.11 Card and Badge Configuration for a 
TermSecure User 

TermSecure allows the use of USB drives and RFID cards as login devices at terminals. This is 
configured on the Card/Badge Information page of the TermSecure User Configuration Wizard. The 
TermSecure Users Configuration Wizard can be launched by double clicking on a TermSecure User in 
the ThinManager tree or by right clicking on the TermSecure Users branch of the tree and selecting Add 
TermSecure User.  

  
Card / Badge Information Page 

 This user will use a card, badge, or other device to log in - This checkbox, if selected, 
enables the use of a USB device, card or badge to login to a terminal. 

 Enter Card/Badge ID number - This field is for the unique identification number of the ID 
device. This can be filled manually or automatically. See Automatic Card/Badge ID Number 
Entry and Manual Card/Badge ID Number Entry for instructions on the methods. 

 Always Prompt for Password - This checkbox, if selected, will require a password in 
addition to the ID device to login to a terminal as a TermSecure User. 
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26.11.1 Automatic Card/Badge ID Number Entry 
ThinManager can be configured to automatically add the Card/Badge ID number. There are a few 
conditions that need met to allow this to happen.  

 The Display “Create New User” dialog for unknown users check box on the Options 
page must be selected.  

 The terminal must use Display Clients. 

 The terminal needs the Enable TermSecure checkbox on the Terminal Specification page 
of the Terminal Configuration Wizard. 

 The USB Drive module, RF Ideas pcProx Module, or Wavetrend Tag Reader Module 
need added to the terminal. The USB Drive module needs the Use with TermSecure 
parameter set to Yes. 

 The user needs to scan the card or insert the USB drive to start the TermSecure 
Configuration Wizard. 

Automatic Card/Badge use starts with the enabling of the Create New User dialog box. This is configured 
on the Options window that is opened by selecting View > Options. 

 

Options Window 

The Display “Create New User” dialog for unknown users check box, if selected, will launch the 
TermSecure User Configuration Wizard on the ThinManager Server when an unknown ID device (USB 
key or ID card) is read by a terminal. Once this checkbox is selected, scanning a new ID card or inserting 
an undefined USB key will launch the TermSecure User Configuration Wizard with the Enter 
Card/Badge ID number automatically filled in. 
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TermSecure User Configuration – TermSecure User Replacement 

When a new card is scanned or a new USB key is inserted into a USB slot on the terminal the 
TermSecure User Configuration is launched with an option to assign the card to an existing user. 

Selecting Next will open the TermSecure User Configuration Wizard and allow a new TermSecure user to 
be configured. 

Selecting Assign Card Number to Existing User will launch the Select TermSecure User to replace 
window to assign the card/badge number to an existing TermSecure User account.  
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Select TermSecure User To Replace Window 

Highlight the desired TermSecure user and select OK. The wizard will display the TermSecure User 
Information page with the selected user entered. 
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TermSecure User Information Page 

If a TermSecure user was selected for the badge, the user will be displayed in the User Name field of the 
TermSecure User Information page. 

Selecting Next will continue with the configuration and show the Card/Badge Information page. 
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Card/Badge Information Page 

The card, badge, or USB drive number will be entered in the Enter Card/Badge ID number field.  

Select Back to change the configuration, select Next to continue, select Finish to accept the changes, or 
select Cancel to cancel changes. 
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26.11.2 Manual Card/Badge ID Number Entry 
Although the easiest method for assigning a card or badge is automatic as described in the Automatic 
Card/Badge ID Number Entry section, ThinManager can be configured for manual entry 

If the Display “Create New User” dialog for unknown users check box on the Options window is 
unselected, the Enter Card/Badge ID number field will need to be entered manually. The Card/Badge ID 
number is accessible in the event log. To configure a terminal to allow a device one needs to: 

 Turn the Event Log on 

 Have the appropriate hardware on the terminal, either a USB port or a ProxCard reader. 

 Add the appropriate module. 

 Use the device once to have the device’s identifier entered to the event log. 

 Open the TermSecure User Configuration Wizard and enter the ID number to tie the 
TermSecure User to the device. 

 Login with the ID device. 
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26.11.2.1 Event Log 

The Event Log is configured in the ThinManager Server Configuration Wizard. 

Open the ThinManager Server Configuration Wizard by double clicking on the ThinManager Server 
icon in the tree, or highlighting it and selecting Edit > Modify from the menu. 

Navigate to the Historical Logging page. 

 

Historical Logging Page 

All events may be selected to be logged, but the Terminal Events checkbox is critical to the TermSecure 
Device detection. Select the Terminal Events checkbox and select the Finish button. 

26.11.2.2 USB Device Module 

When using the USB drive as a TermSecure identifier, the USB Flash Drive Module needs added to the 
terminal. 

See USB Flash Drive Module for details. 

26.11.2.3 ProxCard Reader Module 

A ProxCard Reader works much the same as the USB device, but uses a different module, the RF Ideas 
pcProx Module. 

See RF Ideas pcProx Module for details. 



 

ACP ThinManager 6.0 Permissions    511 

 

26.11.2.4 WaveTrend Tag Reader Module 

A WaveTrend Tag Reader works much the same as the USB device, but uses a different module, the 
WaveTrend Tag Reader Module. 

See Wavetrend Tag Reader for details. 

 

26.11.2.5 Device Identifier Number 

Next the ID device needs to be scanned or inserted to help find the ID number. 

Insert the USB device or scan the ProxCard on the terminal. 

A TermSecure message should be displayed. 

 

TermSecure Message 

The ID device will not work so the terminal will send a message with the ID device’s identifier number. 

 Record this number. 

This number is also entered in the event log if the Terminal Events were selected in the ThinManager 
Server Configuration Wizard. 

 Open ThinManager. 

 Highlight the terminal in the tree and select the Event Log tab. 

The ID for the device is entered in the log. 

 

ThinManager Event Log 
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Next the ID number needs to be associated with the TermSecure User. 

 Open the TermSecure User Configuration Wizard for the user you want to have use that ID 
device. 

 Navigate to the Card / Badge Information page. 

 

Card / Badge Information Page 

 Select the This user will use a card, badge, or other device to log in checkbox. 

 Enter the ID Identifier from the earlier steps into the Enter Card/Badge ID number field. 

 Select the Always Prompt for Password, if desired. 

Now the Terminal is configured, the ID device is identified, and the TermSecure User is configured to use 
the device. 

 Insert the USB device into the USB port on the thin client or scan the ProxCard on the card 
scanner. 

The USB device will log the TermSecure User into the terminal server. 

 Open ThinManager. 

 Highlight the ThinManager Server and select the Event Log tab. 
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Event Log 

The Event Log will show the results of the successful login. The terminal will have the TermSecure User 
added to its icon in the tree, while the TermSecure User icon will show the name of the terminal that it is 
logged into. 
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27 TermMon ActiveX Control 
The TermMon ActiveX Control can be used to collect information about a terminal and perform terminal 
functions. For the purposes of this document Control will refer to the TermMon ActiveX Control. 

This section is not meant as a tutorial on ActiveX controls but is a datasheet on the properties and 
functions of the TermMon ActiveX control. 

27.1 Registering the Control 
The TermMon ActiveX Control can be found on the ThinManager CD as termmon.ocx. 

The Control must be registered before it can be used. Copy the file termmon.ocx to the computer 
where you want to use it. Register the OCX by executing regsvr32 <path\termmon.ocx>. 

27.2 Using the Control 

27.2.1 TermMon ActiveX Configuration Module 
If running the Control in the terminal’s terminal services session, no special configuration of the terminal 
in ThinManager is required. The TermMon ActiveX Control Configuration Module is not required. 

If the Control is not run in the terminal’s terminal services session, the TermMon ActiveX Control 
Configuration Module must be added to the terminal configuration in ThinManager. In the module 
configuration, Allow ActiveX Connections must be set to YES and Only Allow Connections from 
Session must be set to NO. 

The TermMon ActiveX Control Configuration Module can be used to prevent a connection from an 
application running in the terminal’s terminal services session. This is accomplished by adding the 
TermMon ActiveX Control Configuration Module to the terminal in ThinManager and setting the Allow 
ActiveX Connections option to NO.  

27.2.2 Read-Only Properties 
The following properties are read only strings. An event will be generated any time one of these 
properties changes. The Enable method must be invoked prior to reading these properties. 

 TerminalName - This is the name of the terminal. 

 TerminalModel - This is the terminal model number. 

 TerminalIP - This is the terminal IP address. 

 TerminalMAC - This is the terminal MAC Address. 

 TerminalBootLoaderVersion - This is the terminal network boot loader version. 

 TerminalFirmwareVersion - This is the firmware version that the terminal is running. 

 TerminalWindowsUsername - This is the Windows Username that is specified in the terminal’s 
ThinManager configuration. 
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 TermSecureUsername - This is the TermSecure username of the TermSecure user currently 
logged onto the terminal. If no TermSecure user is logged on, this value will be blank. 

 TermSecureWindowsUsername - This is the Windows Username associated with a 
TermSecure user. This is the Windows Username for all TermSecure user sessions. If no 
TermSecure user is logged on, this value will be blank. 

 TerminalServerGroupList - This is a comma-separated list of Display Clients currently running 
on the terminal. 

 ConnectionState - This is the Control’s connection state with the terminal. 

 CurrentTerminalServerGroup - This is the Display Client that is currently being displayed on the 
terminal. 

 CurrentWindowsUsername - This is the Windows Username of the session where the Control 
has been executed. This property is not available when the RunInSession property is set to 
False. 

 TerminalServerName - This is the name of the Terminal Server where the Control is running. 
This property is not available when the RunInSession property is set to False. 

27.2.3 Read-Write Properties 
These properties can be set by the application. 

 RunInSession - When the RunInSession property is set to True, the Control will be running in the 
terminal’s terminal services session. The terminal IP address will be determined automatically by 
the control. 

 OverrideIP - If the RunInSession property is set to False, the OverrideIP property specifies the IP 
Address of the terminal that the Control will connect to. 

Note: To use the OverrideIP property, the TermMon ActiveX Control Configuration Module must be 
added to the terminal configuration in ThinManager. In the module configuration, Allow ActiveX 
Connections must be set to YES, and Only Allow Connections from Session must be set to NO. 

 WatchdogTime – This is the number of seconds before the watchdog will reset the terminal 
session. Once this property is set to a non-zero value, the property must be updated before the 
watchdog time reaches zero. To disable the watchdog, set this property to zero. The watchdog is 
disabled by default. 

Note: The Enable Method does not need to be called for watchdog operation. Watchdog operation is 
independent of the Enable and Disable Methods. 

 ActiveScreen – For MultiMonitor configurations, this is the active screen number. A value of zero 
(default) will set the active screen to the screen the mouse pointer is on when a method or 
command is executed. A non-zero value will set the Active Screen to the screen number 
specified. All methods and commands will be executed on the specified screen. 

27.2.4 Events 
When a property value changes, an event will be generated by the Control. When an Event occurs the 
event code can be used to determine the property that changed. The Enable method must be invoked in 
order to receive events (except for WatchdogTime). The event code is provided by the Control as follows: 

 TermMonEvent.TerminalName     

 TermMonEvent.TerminalModel     
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 TermMonEvent.TerminalIP     

 TermMonEvent.TerminalMAC     

 TermMonEvent.TerminalBootLoaderVersion   

 TermMonEvent.TerminalFirmwareVersion   

 TermMonEvent.TerminalWindowsUsername   

 TermMonEvent.TermSecureUsername    

 TermMonEvent.TermSecureWindowsUsername   

 TermMonEvent.TerminalServerGroupList   

 TermMonEvent.ConnectionState    

 TermMonEvent.CurrentTerminalServerGroup   

 TermMonEvent.CurrentWindowsUsername   

 TermMonEvent.TerminalServerName    

 TermMonEvent.WatchdogTime 

27.2.5 Methods 
 Enable - Invoking this method will enable the Control. The Control will attempt to connect to the 

terminal and generate events to update the Control Properties. The Control will maintain a 
connection to the terminal as long as it is enabled. 

 Disable - Invoking this method will cause the Control to break the connection with the terminal. 
Events will be generated to clear the Control Properties. 

 Command - The Command method can be used to send terminal action commands. The 
Command method requires one parameter which is the terminal command to be performed. The 
Enable method must be invoked before these commands can be executed (except for noted 
exceptions). The supported commands are: 

o Reboot - This command will initiate a terminal reboot. 

o Restart - This command will initiate a terminal restart. 

o Calibrate - This command will initiate a touch screen calibration. 

o GotoMainMenu - This command will cause the Main Menu to be displayed. 

o SwitchToNextGroup - This command will switch to the next Display Client. 

o SwitchToPrevGroup - This command will switch to the previous Display Client. 

o SwitchInstFailover - This command will switch the instant failover group. 

o ChangeTermSecureUser - This command will disconnect any current TermSecure user 
sessions and then display the TermSecure Log On menu. 

o LogOffAndChangeTermSecureUser - This command will log off any current 
TermSecure user sessions and then display the TermSecure Log On menu. 

o LogOffTermSecureUser - This command will log off any current TermSecure user 
sessions and will return to a Display Client which is assigned to the terminal. If no Display 
Clients have been configured on the terminal, the TermSecure Log On menu will be 
displayed.  

o DisconnectTermSecureUser - This command will disconnect any current TermSecure 
user sessions and will return to a Display Client which is assigned to the terminal. If no 
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Display Clients have been configured on the terminal, the TermSecure Log On menu will 
be displayed.  

o DisconnectSession - This command will disconnect the Terminal Services Session 
running on the terminal. This command does not require that the Enable Method be 
invoked prior to execution. 

o LogOffSession - This command will log off the Terminal Services Session running on 
the terminal. This command does not require that the Enable Method be invoked prior to 
execution. 

o TileStart - This command will tile the Display Clients on the current Screen. 

o TileEnd - This command will un-tile the Display Clients on the current Screen. 

 

The Command Method constants are provided by the Control as follows: 

o TermMonCommand.Reboot 

o TermMonCommand.Restart 

o TermMonCommand.Calibrate 

o TermMonCommand.GotoMainMenu 

o TermMonCommand.SwitchToNextGroup 

o TermMonCommand.SwitchToPrevGroup 

o TermMonCommand.SwitchInstFailover 

o TermMonCommand.ChangeTermSecureUser 

o TermMonCommand.LogOffAndChangeTermSecureUser  

o TermMonCommand.LogOffTermSecureUser 

o TermMonCommand.DisconnectTermSecureUser 

o TermMonCommand.DisconnectSession 

o TermMonCommand.LogOffSession 

o TermMonCommand.TileStart 

o TermMonCommand.TileEnd 

 

 ChangeTerminalServerGroup - This method can be used to change the Display Client currently 
displayed on the terminal. This method requires one parameter which is the name of the Display 
Client that the terminal should switch to. 

 TermSecureCheckAccess - This method can be used to query the access rights of a 
TermSecure user. This method requires two parameters. The first parameter is the name of the 
user. The second parameter is the name of the Access Group. This method returns the result of 
the query as follows: 

o TermMonConst.Timeout - The request timed out. 

o TermMonConst.Busy - The Control is busy with another request. 

o TermMonConst.InvalidMember - The user is not a member of the specified 
TermSecure Access Group. 

o TermMonConst.ValidMember - The user is a member of the specified TermSecure 
Access Group. 
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o TermMonConst.UserNotFound - The TermSecure Username was not found. 

o TermMonConst.GroupNotFound - The Access Group Name was not found. 

 GetGroupScreen - This method can be used to determine which screen the specified Display 
Client is currently on for MultiMonitor configurations. This method requires one parameter which 
is the name of the Display Client. 

 TermSecureLogonUser - This method can be used to Log On a specified TermSecure user. 
This method requires two parameters. The first parameter is the name of the TermSecure user. 
The second parameter is the password of the TermSecure user. The password will be encrypted 
before being sent to the terminal. This method returns a result as follows: 

o TermMonConst.Success - The TermSecure user was successfully logged on. 

o TermMonConst.Timeout - The request timed out. 

o TermMonConst.Busy - The Control is busy with another request. 

o TermMonConst.UserNotFound - The TermSecure username was not found. 

o TermMonConst.BadPassword - The TermSecure password was invalid. 

o TermMonConst.NoPermission - The TermSecure user does not have permission to 
use the terminal. 

o TermMonConst.PasswordChangeReq - The TermSecure user is required to change 
his password. 

o TermMonConst.NoWindowsUsername - This TermSecure user does not have a 
Windows Username specified in the TermSecure user configuration. This is only required 
for Terminal Services Display Clients assigned to the TermSecure User. 

o TermMonConst.NoWindowsPassword - This TermSecure user does not have a 
Windows Password specified in the TermSecure user configuration. This is only required 
for Terminal Services Display Clients assigned to the TermSecure User. 

 CameraOverlayEnable - This method is used to enable a camera overlay. This method requires 
two parameters. The first parameter is the name of the Display Client the overlay is on. The 
second parameter is the name of the overlay. 

 CameraOverlayDisable - This method is used to disable a camera overlay. This method requires 
two parameters. The first parameter is the name of the Display Client the overlay is on. The 
second parameter is the name of the overlay. 

 CameraOverlayCycleStart - This method is used to start camera cycling for a camera overlay. 
This method requires two parameters. The first parameter is the name of the Display Client the 
overlay is on. The second parameter is the name of the overlay. 

 CameraOverlayCycleStop - This method is used to stop camera cycling for a camera overlay. 
This method requires two parameters. The first parameter is the name of the Display Client the 
overlay is on. The second parameter is the name of the overlay. 

 CameraOverlaySwitchNext - This method is used to switch to the next camera in a camera 
overlay list. This method requires two parameters. The first parameter is the name of the Display 
Client the overlay is on. The second parameter is the name of the overlay. 

 CameraOverlaySwitchPrev - This method is used to switch to the previous camera in a camera 
overlay list. This method requires two parameters. The first parameter is the name of the Display 
Client the overlay is on. The second parameter is the name of the overlay. 

 CameraOverlayFullscreenEnter - This method is used to make the current camera in a camera 
overlay enter full screen. This method requires two parameters. The first parameter is the name 
of the Display Client the overlay is on. The second parameter is the name of the overlay. 
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 CameraOverlayFullscreenExit - This method is used to make the current camera in a camera 
overlay exit full screen. This method requires two parameters. The first parameter is the name of 
the Display Client the overlay is on. The second parameter is the name of the overlay. 

 CameraOverlaySwitchByName - This method is used to change cameras in a camera overlay. 
This method requires three parameters. The first parameter is the name of the Display Client the 
overlay is on. The second parameter is the name of the overlay. The third parameter is the name 
of the camera. The camera name must include the full path if the camera is in a camera group. 

 CameraOverlayMove - This method is used to change the position of a camera overlay. This 
method requires four parameters. The first parameter is the name of the Display Client the 
overlay is on. The second parameter is the name of the overlay. The third parameter is the x 
location. The forth parameter is the y position. 

 CameraOverlayResize - This method is used to change the size of a camera overlay. This 
method requires four parameters. The first parameter is the name of the Display Client the 
overlay is on. The second parameter is the name of the overlay. The third parameter is the width. 
The forth parameter is the height. 

 CameraOverlayResizeMove - This method is used to change the size and position of a camera 
overlay. This method requires six parameters. The first parameter is the name of the Display 
Client the overlay is on. The second parameter is the name of the overlay. The third parameter is 
the x position. The forth parameter is the y position. The fifth parameter is the width. The sixth 
parameter is the height. 
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27.2.6 Control Constants 
Constant values provided by the Control are as follows: 

TermMonEvent 

 TerminalName    1 

 TerminalModel    2 

 TerminalIP    3 

 TerminalMAC    4 

 TerminalBootLoaderVersion  5 

 TerminalFirmwareVersion  6 

 TerminalWindowsUsername  7 

 TermSecureUsername   8 

 TermSecureWindowsUsername  9 

 TerminalServerGroupList  10 

 ConnectionState   11 

 CurrentTerminalServerGroup  12 

 CurrentWindowsUsername  13 

 TerminalServerName   14 

 WatchdogTime    15 

 

TermMonCommand 

 Reboot     100 

 Restart     101 

 Calibrate    102 

 GotoMainMenu    103 

 SwitchToNextGroup   104 

 SwitchToPrevGroup   105 

 SwitchInstFailover   106 

 ChangeTermSecureUser  107 

 LogOffAndChangeTermSecureUser 108 

 LogOffTermSecureUser   109 

 DisconnectTermSecureUser  110 

 DisconnectSession   111 

 LogOffSession    112 

 TileStart    113 

 TileEnd     114 
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TermMonConst 

 Success    0 

 Fail     1 

 Disconnected    2 

 Connected    3 

 Timeout    4 

 Busy     5 

 Updating    6 

 RequestFailed    7 

 InvalidMember    8 

 ValidMember    9 

 UserNotFound    10 

 GroupNotFound    11 

 BadPassword    12 

 NoPermission    13 

 PasswordChangeReq   14 

 NoWindowsUsername   15 

 NoWindowsPassword   16 

 

27.3 TermMon ActiveX Demo Application 
The TermMon ActiveX Demo Application can be used to demonstrate the features of the Control. The 
demo application is found on the ThinManager CD in the Terminal ActiveX folder as TermMon.exe. 

To start the application in graphical mode, run TermMon.exe in a terminal’s terminal services session. 
This will allow the Control functionality to be demonstrated. 

The demo application can also be run non-graphically using command line options. The format is as 
follows: 

TermMon -c <command> -f <output path and filename> -d <data> -a 
<ip address> 

The following commands are terminal action commands: 

 Reboot 

 Restart 

 Calibrate 

 GotoMainMenu 

 SwitchToNextGroup 

 SwitchToPrevGroup 
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 SwitchInstFailover 

 ChangeTermSecureUser 

 LogOffAndChangeTermSecureUser 

 LogOffTermSecureUser 

 DisconnectTermSecureUser 

 ChangeTerminalServerGroup -d <groupname> 

The following commands return the result in the output filename. 

 TerminalName -f <output filename> 

 TerminalModel -f <output filename> 

 TerminalIP -f <output filename> 

 TerminalMAC -f <output filename> 
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28 Non-ThinManager 
Components 

Microsoft Terminal Servers play an important role in the ThinManager system. It is recommended that you 
become familiar with the documentation provided by Microsoft about their server. The following 
information is provided as an aid to understanding terminal services and is not a substitute for Microsoft 
documentation. 

Microsoft Terminal Services requires a license, either a TS CAL (Terminal Services Client Access 
License) on a 2003 Server or a RDS CAL (Remote Desktop Services Client Access License) on a 2008 
Server. 

This section covers: 

 Server 2003 

 Server 2008 

 DHCP (Dynamic Host Configuration Protocol) Servers 

 Terminal Services Licensing 

28.1 Windows Server 2003 

28.1.1 Installing Terminal Services 
A Windows 2003 Server can be made a terminal server by installing the Terminal Services role. This can 
be done with either the Manage Your Server or through the Add/Remove Programs > Add/Remove 
Windows Components. 
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Manager Your Server 

Select the Add or remove a role link on the Manager Your Server splash screen to install the Terminal 
Services role and/or the Terminal Services License Server role. 
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Windows Component Wizard 

Terminal Services can be installed by selecting the Terminal Server checkbox in the Windows 
Component Wizard.  

The Windows Component Wizard is launched by selecting the Add/Remove Windows Component 
button on Control Panel > Add/Remove Programs. 

Each Microsoft terminal server system will need a Microsoft Terminal Server Licensing server install. This 
doesn’t have to be a separate computer but is a program installed on an existing computer. It is installed 
by selecting the Terminal Server Licensing checkbox on the Windows Component Wizard. 

See Microsoft Licenses for details. 
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28.2 Creating Microsoft User Profiles 
A terminal needs a valid Windows User Profiles to log onto a terminal server.  

Open the Computer Management Console by selecting Start > Administrative Tools > Computer 
Management in Windows 2003/2008 to create a user profile. 

 

Computer Management Console 

Highlight the User sub-folder of Local Users and Groups in the Computer Management tree pane.  

Select Action > New User. This will launch a New User dialog box.  
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New User Dialog  

Enter the user name for the user in the User name field. 

Enter a password in the Password field.  

Re-enter the password in the Confirm password field.  

The User must change password at next logon check box forces the user to change the password. 

Select the Create button to finish the profile.  

Select the Close button to return to the Computer Management Console. 

Note: Users need to be added to the Remote Desktop Users group or the Administrators group to be 
allowed to connect to a terminal server. 
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28.3 Software Installation On Windows 2003 
Microsoft Windows 2003/Server requires that software be added in the “Install Mode” through the 
Control Panel > Add/Remove Programs.  

Select Start > Settings > Control Panel > Add/Remove Programs to launch the Add/Remove 
Programs dialog box. 

Note: Some software, especially downloaded software, doesn’t allow the installer to install it through the 
Add/Remove Programs tools. To manually put the machine into the install mode open a command prompt 
and type: 
change user /install 
This command sets the machine to install mode. When finished, type: 
change user /execute 
This command returns the machine to the normal run mode. 

 

Add/Remove Programs 

Select the CD or Floppy button on the Add/Remove Programs dialog box to open the Installation 
wizard.  
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Install Program Window 

The wizard will prompt for the installation of the software disk. Select Next to display the Run Installation 
Program dialog box. 

Note: If the new program starts in autorun and proceeds without going through the following procedures, 
either stop the autorun and use the wizard to initiate the installation, or use the change user 
/install command to place the machine in the install mode. Use the change user /execute 
command when finished to return the machine to the Run mode. 

 

 

Run Installation Program 
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Enter the command line of the installation program and select Finish, or select the Browse button to 
select the installation file. 

 

Browse File Window 

Selecting the Browse button on the Run Installation dialog box will launch a Browse File window. 
Highlight the installation file and select Open. This will begin the application setup. 

 

After Installation Window 

As the installation begins, an After Installation dialog box is displayed. It requests that the Next button 
be selected when the installation is finished. When this button is selected a second confirmation window 
is displayed. 
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Finish Install Window 

Select the Finish button when the installation is finished. 

Note: If a choice is given to Reboot Now or Reboot Later, choose to reboot later once the entire setup is 
completed and the dialog boxes are cleared. 

 

28.3.1 Terminal Services Configuration 
Microsoft provides the Terminal Services Configuration interface to configure how terminal services is 
handled on each terminal server. 

Select Start > Programs > Administrative Tools > Terminal Services Configuration to launch the 
Terminal Services Configuration Console. There are two folders, Connections and Server Settings. 

28.3.2 Terminal Services Connections 
The Terminal Services Configuration tree has a Connections folder. Highlighting this folder will display 
the installed client communication protocols.  
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Terminal Services Configuration\\Connections Console - Connections 

Double clicking on the RDP-tcp icon on the right will launch the RDP-tcp Properties  
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28.3.2.1 RDP-tcp Login Settings 

 

RDP-tcp Login Settings 

The Login Settings should use the Use client-provided logon information radio button so that each 
user will login with a unique account. 

The Always prompt for password should be unselected to allow auto-logins. 
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28.3.2.2 RDP-tcp Sessions Settings 

 

Individual User Account Sessions Configuration 

Each user account can be configured individually in the Computer Management interface. These can be 
set to end a disconnected session or an idle session after a period of time. The Terminal Services 
Configuration Console allows these settings to be made for every user of the terminal server, speeding 
configuration time. 
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RDP-tcp Sessions Settings 

The Sessions tab of the RDP-tcp Properties allows all users to be configured with a consistent 
disconnect policy by selecting the Override user settings checkbox. 

Selecting End Session setting for the When session limit is reached or connection is broken and 
selecting the Override user settings will cause a new session to be created when a terminal disconnects 
and reconnects.  
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28.3.2.3 RDP-tcp Client Settings 

 

RDP-tcp Client Settings 

The Client Settings tab of the RDP-tcp Properties allows the color depth to be set in the Limit Maximum 
Color Depth drop-down. 

Drive mapping, LPT port mapping, COM port mapping, and audio mapping are allowed if the appropriate 
Disable the following checkboxes are un-selected. 

Audio mapping is disabled by default. You need to uncheck the Audio mapping checkbox to allow a thin 
client to play sound. 
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28.3.2.4 RDP-tcp Network Adapter Settings 

 

RDP-tcp Network Adapter Settings 

The Network Adapter tab of the RDP-tcp Properties can be used to limit the number of active users to 
aid in application licensing compliance. 

28.3.3 Terminal Services Connections 
The Terminal Services Configuration tree has a Connections folder. Highlighting this folder will display 
the installed client communication protocols.  
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Terminal Services Configuration\\Connections Console - Connections 

The Server Settings have several settings that can control the terminal services experience. 

28.3.4 Licensing Mode 
Microsoft expanded the Terminal Services Client Access License (TS CAL) program in Windows 2003. 
TS CALs are available in two types, TS Device CALs and TS User CALs.  

 The TS Device CAL licenses one device to connect to any Microsoft Terminal Servers as any 
user. This functions like the previous Windows 2000 TS CAL. 

 The TS User CAL licenses one user for any device to connect to any Microsoft Terminal 
Servers. 

To change between the Per Device licensing and Per User licensing, double-click Licensing to launch 
the Licensing Mode window. 
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Terminal Services Configuration Console- Licensing Mode 

Select the desired mode from the Licensing Mode dropdown box and click OK. 

28.3.5 Permission Compatibility 
Microsoft has increased the security in each successive release of its terminal server software. These 
new policies prevent users from accessing the system folder, *.ini files, the registry, and other resources. 
Some programs such as HMI, SCADA, database, and control software  need access to these resources 
to function. Instead of making all the users administrators, the security can be set to the less strenuous 
Windows NT 4.0-style security.  

 

Terminal Services Configuration Console- Permission Compatibility 

Launch the Permission Compatibility window by double-clicking on the Permission Compatibility 
setting. Select the Relaxed Security radio button and select the OK button. 
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28.3.6 Restrict Each User to a Single Session 
The Restrict Each User to a Single Session  setting prevents duplicate and orphaned sessions by 
limiting each user to a single login. 

Double-clicking the setting will launch a settings window. 

 

Terminal Services Configuration Console- Single Session Per User 

The Restrict each user to one session checkbox is selected by default in Windows 2003. 

Note: Keep this setting selected. MultiSession will still work as long as each session is using a different 
AppLink program. 

28.3.7 License Server Discovery Mode 
A new feature in Windows 2003, Service Pack 1 and later, is a setting to point the terminal server to a 
specific Terminal Server Licensing Server. This is the License server discovery mode setting in 
Terminal Services Configuration. This is easier than hard coding the license server into the registry. 
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Terminal Server License Server Discovery Window 

Launch the Terminal Server License Server Discovery Window by double-clicking the License server 
discovery mode setting in Terminal Services Configuration window. 

Entering a valid Microsoft Terminal Server Licensing Server name in the Use these license servers field 
will force the terminal server to use the defined server as the license server. This keeps the terminal 
server from getting confused when there are multiple license servers. 

The Automatically discovered license servers field would be automatically populated with license 
servers found by the terminal server and can be used as a reference. The Check names button will 
check the validation of the name in the Use these license servers field. 
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28.4 Windows 2008 Server  

28.4.1 Adding Terminal Server Role 
Windows 2008 Server, like Windows 2003 Server, allows two RDP connections for administrative 
purposes. To make the Windows 2008 Server a terminal server where many people can access 
applications requires adding the Terminal Services Role. 

Open the Server Manager window. 

 

Server Manager Window 

Highlight Roles in the tree and select Add Roles in the right pane. A wizard will launch allowing you to 
add Terminal Services as a role. 

Highlights of the Role Wizard include: 
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Role Wizard - Select Server Roles 

The Role Wizard lists a dozen roles that are available.  

Check the Remote Desktop Services (or Terminal Services) checkbox and any other roles desired. 

Select Next to continue. 
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Role Wizard –Select Role Services 

Terminal Services has several options: 

Terminal Server – the basic terminal services option. Check this option 

TS Licensing – This makes the server a 2008 License Server.  
You need a 2008 License Server and 2008 Terminal Services Client Access Licenses (TS 
CALs) to operate.  
Select this if this server will be your Terminal Services License Server. 

Select Next to continue. 
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Role Wizard – Specify Licensing Mode 

Windows 2008 TS CALs, like Windows 2003 TS CALs, are available as Per Device or Per User.  

The terminal server should match the mode that the license server is using.  

Select Next to continue. 
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Role Wizard – Confirm Installation Selections 

The Add Roles Wizard will end with a list of the configurations that will be installed. 

Select Install to add the role(s). Once the wizard is finished it will assume the role of a terminal server. 
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28.4.2 Adding Applications in Windows 2008 
Applications on terminal servers need to be installed in the Install Mode. Open the Control Panel and 
click on the Install Application on Terminal Server icon to start the installation wizard. 

 

Install Application on Terminal Server Icon 

A wizard will run that allows the installation of the application. 

The Install Mode can also be entered by typing change user /install at a command prompt. 
You can then run the setup.exe to install your application.  

 Type change user /execute when finished installing to leave the Install Mode. 
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28.4.3 Create Users 
Users management is located in the Server Manager console. 

 

Server Manager – Local Users and Groups 

Users need to be members of the Remote Desktop Users group to access the terminal server. 

28.4.4 Allowing Application Access  
Applications installed on a terminal server are not available to remote users unless the Terminal Server 
Settings are changed to allow access to the applications. You can either allow access to all applications 
or allow access to specific applications in the TS RemoteApp Manager. 

28.4.4.1 Allowing Application Access – All Applications 

Applications installed on a terminal server are not available to remote users unless the Terminal Server 
Settings are changed to allow access to the applications. 

You can change the settings to allow access to all installed applications in the TS RemoteApp Manager. 
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TS RemoteApp Manager 

Highlight TS RemoteApp Manager under the Terminal Services branch of the Server Manager tree. 

Select the Change link for the Terminal Server Settings to launch the RemoteApp Deployment 
Settings page. 
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RemoteApp Deployment Settings 

Select the Terminal Server tab of the RemoteApp Deployment Settings page. 

Select the Allow users to start both listed and unlisted programs on initial connection radio button 
in the Access to unlisted programs section. 

This will allow any program to be run by an authorized user. 

You can also select and define specific applications that can be run by configuring them in the TS 
RemoteApp Manager. 
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28.4.4.2 Allowing Application Access – Specific Applications 

You can control application access on Windows 2008 Server by only allowing access to specific 
applications. 

 

TS RemoteApp Manager 

Highlight TS RemoteApp Manager under the Terminal Services branch of the Server Manager tree. 

Select the Add RemoteApp Programs link in the Actions column on the right of the screen to launch the 
RemoteApp Wizard. 
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RemoteApp Wizard 

The RemoteApp Wizard shows a list of applications installed on the Windows 2008 Server. 

Select the checkbox for each application that you want available for deployment as a ThinManager 
Display Client. 

Select Next to complete the wizard. A remote user can run any checked application. 

28.4.5 Installing ThinManager 
It is a common practice to install ThinManager on a terminal server but ThinManager is independent of 
terminal services and doesn’t need to be installed on a terminal server.  

Applications on terminal servers need to be installed in the Install Mode. Open the Control Panel and 
click on the Install Application on Terminal Server icon to start the installation wizard. 

 

Install Application on Terminal Server Icon 
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Once the wizard begins navigate to the ThinManager setup.exe program and continue with the wizard. 
See Installation of ThinManager for details. 

The Install Mode can also be entered by typing change user /install at a command prompt. 
You can then run the setup.exe to install ThinManager. 

Type change user /execute when finished installing to leave the Install Mode. 

 

28.4.6 Allow Inbound Traffic to Firewall 
ThinManager requires communications to the thin clients. This communication is blocked by default in the 
firewall and needs to be allowed.  

You can either open the firewall to all traffic or open the specific ports needed. 

28.4.6.1 Allow All Inbound Traffic 

You can configure the firewall by selecting Windows Firewall with Advanced Security in the Server 
Manager tree. 

 

Windows Firewall with Advanced Security 

Highlight Windows Firewall with Advanced Security in the Server Manager tree. Right click and select 
Properties to launch the Properties window. 
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Windows Firewall with Advanced Security Properties 

Select the profile tab that matches the type of network you are using, Domain, Private, or Public profile. 

Change the Inbound connections to Allow and select OK to accept the change. 

This will allow the thin clients to connect to ThinManager through the firewall. 
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28.4.6.2 Open Ports in Firewall 

You can open specific ports in the Windows 2008 Server firewall instead of allowing all inbound 
connections if you prefer. 

Open the Local Security Policy by selecting the Start > Administrative Tools > Local Security Policy. 

 

Local Security Policy 

Expand the Windows Firewall with Advanced Security to show the Inbound Rules. 

Right click on the Inbound Rules and select New Rule. A wizard will launch that allows configuration of a 
new port. 

You need to run the wizard twice, once to allow UDP 4900 and once to allow TCP 2031. 
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Rule Wizard – Rule Type 

Select Port as the rule you are configuring and select Next to continue. 
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Rule Wizard – Protocols and Ports 

You will need to select the protocol and port for each rule. You will need to run the wizard once for UDP 
4900 and once for TCP 2031. 

Select the protocol and enter the port as shown in Rule Wizard – Protocols and Ports. 

Select Next to continue. 
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Rule Wizard – Action 

Select Allow the Connection. 

Select Next to continue. 
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Rule Wizard – Profile  

Select the network(s) that the rule will apply to. 

Select Next to continue. 

A Name page will allow you to name the rule and add a description for management and organizational 
purposes. 

Select Finish to save and apply the rule. 
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Applied Rules 

Repeat for UDP 4900 or TCP 2031. 

This will allow thin clients to use port 4900 to download the firmware and allow the thin client to use port 
2031 to download the configuration but will keep other ports closed on the firewall. 
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28.4.7 Local Security Policy – User Access Controls 
You may need to go to the Local Security Policy and change the User Account Control: Behavior of 
the elevation prompt for administrators in Admin Approval Mode to Elevate without prompting for 
ThinManager to run properly. 

Open the Local Security Policy by selecting the Start > Administrative Tools > Local Security Policy. 

 

Local Security Policy – User Account Controls 

Highlight Local Policies > Security Options in the tree. 

Browse to User Account Control: Behavior of the elevation prompt for administrators in Admin 
Approval Mode and change the setting to Elevate without prompting. 

This may be needed to run ThinManager as a non-administrator. 
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28.5 Command Prompt 
Terminal Services has several commands that aid in managing the terminal server. Some useful ones 
are:  

 

Command Action 

change logon Temporarily disables logons to a Terminal Server 

change port Changes COM port mappings for MS-DOS program compatibility 

change user /install Puts the server into “Install Mode” 

change user /execute Removes the server from “Install Mode” 

Ipconfig Displays the IP addresses of the network card 

Logoff Logs off a user from a session and deletes the session from the server 

net send username “message” Sends a message to a user. username is the NT/2000 user name that the 
person or terminal is logged in as. “message” is the text of the message. 
Quotation marks are needed for any messages containing a space. 

query process Displays information about processes running on a Terminal server 

query session Displays information about sessions on a Terminal server 

query termserver Displays a list of all Terminal servers on the network 

query user Displays information about user sessions on a Terminal server 

reset session Resets a session to known initial values 

Shadow Monitors another user's session 

Tsdiscon Disconnects a client from a terminal server session 

Tsshutdn Shuts down the terminal server in an orderly manner 

See the Windows online help for additional commands and parameters. 

Other useful commands include: 

Command Action 

gpedit.msc Launches the Group Policy Editor 

tscc.msc Launches the Terminal Services Configuration Console 

tsadmin Launches the Terminal Services Manager 
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28.6 Alternative Terminal Keystrokes 
Certain keystrokes are not available in a terminal session. Microsoft has provided these alternatives. 

 

Keystroke Function 

ALT+PAGE UP  Switches between programs from left to right.  

ALT+PAGE DOWN  Switches between programs from right to left.  

ALT+INSERT  Cycles through the programs in the order they were started.  

ALT+HOME  Displays the Start menu.  

CTRL+ALT+BREAK  Switches the client between a window and full screen.  

CTRL+ALT+END  Brings up the Windows 2000 Security dialog box.  

ALT+DELETE  Displays the Windows menu.  

CTRL+ALT+Minus (-) symbol on the 
numeric keypad  

Places a snapshot of the active window, within the client, on the Terminal server 
clipboard (provides the same functionality as pressing PrintScrn on a local 
computer.)  

CTRL+ALT+Plus (+) symbol on the 
numeric keypad  

Places a snapshot of the entire client window area on the Terminal server 
clipboard (provides the same functionality as pressing ALT+PrintScrn on a local 
computer.)  
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28.7 DHCP Server Setup 
Dynamic Host Configuration Protocol (DHCP)  is a program that assigns IP addresses to devices on a 
network. DHCP server can be used to provide IP addresses to thin clients. It can also be configured to 
point the thin clients to the ThinManager Servers with Option 66, Boot Server Host Name. 

28.7.1.1 Scope Options 

The DHCP Server needs Option 066 configured before it will provide the ThinManager Server IP address 
that the terminal needs to boot. 

 

Boot Server Host Name 

The Boot Server Host Name, Option 066, assigns a ThinManager server to the terminal.  

Open the Scope Options dialog box by highlighting the Scope Option folder in the tree pane of the 
Computer Management Console under the Services and Application > DHCP folder and selecting 
Action > Configure Options. 

Scroll through the list window and check the Option 066 check box.  

Enter the IP address of the desired ThinManager server in the String Value field.  

The DHCP Server can issue the IP address for a Primary ThinManager Server and a Secondary 
ThinManager Server by listing the IP addresses of both, separated with a space. 
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28.7.1.2 DHCP Properties 

The DHCP Server can be configured to check for duplicate IP addresses before issuing a new address. 
This is a good feature to use. 

Highlight DHCP under Services and Applications in the Computer Management tree and select 
Action > Properties, or right-click on DHCP and select Properties. The DHCP Properties window will 
launch. 

 

DHCP Properties – Advanced Tab 

Select the Advanced tab. Replace the zero in the Conflict detection attempts field with an integer. This 
will prompt the DHCP Server to check for duplicate IP addresses before assigning an IP address. 

Select OK when finished. 
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28.8 Group Policy 
Windows has a number of features that can be allowed or prevented with a Group Policy. Group Policy is 
configured in the Group Policy Object Editor snap-in to the Microsoft Management Console. 

Access the Group Policy Editor by typing gpedit.msc at a command prompt to launch the Microsoft 
Group Policy Editor. 

 

Group Policy Settings 

Expanding the tree will show Group Policy settings that can affect the terminal server experience. 

Please refer to Microsoft documentation for information on using these features. 
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28.9 Microsoft Licenses 

28.9.1 Microsoft Client Access Licenses (CALs) 
Thin Clients require a terminal server with Windows 2003 or 2008 Server with Terminal Services 
enabled as an operating system. 

Each of these operating systems requires a standard Microsoft Client Access License (CAL) for each 
connection to the server. These are based on concurrent use; a 5-pack would allow more than five users 
to access server resources, but only five users at a time.  

28.9.2 Microsoft Terminal Server Licenses  
Terminals, such as thin clients and fat clients, require a license to access terminal services in addition to 
the standard Microsoft Client Access License (CAL). This is called the Microsoft Terminal Services 
Client Access License (TS CAL)  in Windows 2003 and is called the Remote Desktop Services Client 
Access License (RDS CAL) in Windows 2008. 

Windows 2003 terminal servers require Windows 2003 TS CALs and Windows 2008 terminal servers 
require Windows 2008 RDS CALs. 

Note: This document will refer to all terminal services CALs as a TS/RDS CALs. 

. This licensing is per seat; ten terminals would require ten TS/RDS CALs, even if only two were 
connected at a time.   

These can be installed as Per Device or Per User. 

 The TS/RDS Device CAL licenses one device to connect to any Microsoft Terminal Servers 
as any user. This functions like the previous Windows 2000 TS CAL. 

 The TS/RDS User CAL licenses one user for any device to connect to any Microsoft Terminal 
Servers. 

All TS/RDS CALs are installed on a Terminal Services Licensing Server. This acts as a repository for 
all TS/RDS CALs. The terminal servers request TS/RDS CAL authentication from the Terminal Services 
Licensing Server as terminals attach to terminal servers. 

Note: The Terminal Server Licensing Server does not need to be a separate computer. It is a program 
that can be installed on any existing server.  

The Terminal Services Licensing server is activated through the Internet by connecting to the Microsoft 
Certificate Authority and License Clearinghouse.  

Windows 2003 and 2008 Servers with Terminal Services enabled will issue 90-day or 120-day temporary 
licenses while the Terminal Services Licensing server is being setup and activated. If this period has 
elapsed, the terminal will not connect to the terminal server and will display an “Error Number 50” 
message box. 

Windows Server is not normally sold with TS CALs. These need to purchased separately and installed on 
the Terminal Services License server.  
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28.9.3 Microsoft Terminal Server Licensing Activation 
In Windows 2003 and 2008, all the TS CALs are installed on a single Terminal Server Licensing Server. 
This allows a single site for management and authentication of terminal server connections. A server 
becomes a Terminal Server Licensing Server by selection of the option during the installation phase or by 
selecting Add/Remove Programs > Add/Remove Windows Components from the Control Panel and 
selecting the Terminal Services Licensing. 

The licensing of the Microsoft components of a Windows 2003 or 2008 terminal server is a two-step 
process; one must first authorize the Terminal Server Licensing Server, then one must activate the 
licenses. The license activation will be repeated for each license pack. 
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29 ThinManager Troubleshooting 
Guide  

This is a list of common configuration errors and a guide for fixing them. 

Note: When any problem arises, check Downloads at www.thinmanager.com for the latest firmware and 
any service packs. The problem you are experiencing may have already been fixed and released in a 
later version of firmware and using the latest version will cure the current problem. Try applying the latest 
firmware, and then reboot the thin client to see if the problem still exists. The current version (v.2.06.X) is 
backwards compatible to earlier versions of ThinManager (2.3.1, 2.4, 2.5, etc.) 

29.1 Section 1 - From Power on to Terminal Server 
Login  

1) Powering on the Thin Client 
A) No Power 

 Check power cable, power supply, and power outlets. 

B) No Video 
 Check video cable and monitor.  

Warning: Never go into the thin client BIOS and change the 
Integrated Peripherals>Display Status from CRT to LCD. This 
changes the video output of the motherboard from the VGA port to a 
socket on the motherboard used for integrated LCD panels. Changing 
this from CRT will prevent any video from being displayed on a 
monitor. 

2) Booting - ACP Network Boot Loader 
A) Cannot get IP address using DHCP 

 Is the thin client set to DHCP? They are set to DHCP by default, but can be changed. 

 Is the Thin Client on the same side of the router as the DHCP server? 

 Does the DHCP server have addresses to give out? 

B) Cannot get IP address using Static IP menu 
 Certain models (ThinAdapters and older DC-40-100s with black PS/2 ports) cannot use 

static IP. 

 Static IP hasn't been set. Use the spacebar when the "Select any Key to Configure IP 
Settings" is displayed and set the client IP address 
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3) Cannot Load Firmware 

A) Is Thin Client connecting to ThinManager Server? 

i) Using DHCP 

 Has Option 066 been set to the ThinManager Server IP 
Address? 

 Is there a link light on the network port? 

 Check router address, IP Addresses, and Subnet Mask 

ii) Using Static IP 

 Has the ThinManager Server IP Address been entered in the IP 
Configuration Menu? 

B) Is the network blocked? 

ACP Enabled thin clients that communicate through routers, gateways, 
or firewalls may need some ports opened to allow data flow through 
these devices. If the thin client communicates through one of these and it 
is having trouble, check to see if these ports are allowed.  

The required ports are:  

 UDP/4900 - TFTP - Used for the TFTP download of the firmware.  

 TCP/2031 - Configuration - Used to pass the configuration from the ThinManager 
Server to the thin client.  

 TCP/1494 - Citrix - Used by the ICA protocol (if using ICA instead of RDP).  

 TCP/3389 - RDP - Used by the RDP protocol (if using RDP in v2.4.1 or later).  

 TCP/5900 - Shadowing - Used to shadow terminals.  

 TCP/1758 – Multicast – Used for firmware download unless multicast is turned 
off on the ThinManager Server Configuration Wizard.  

 Ping and DHCP - These need configured as needed.  

C) Loads firmware intermittently/slowly 

 Check for IP conflicts 

 Check cable connections 

 Make sure ThinManager Server CPU usage is below 100% 

 Check the IGMP settings on the routers. If the IGMP is blocked, the Multicast of 
firmware will be interrupted. Unselecting Multicast in the ThinManager Server 
Configuration wizard will allow firmware downloads if the IGMP is blocked. 

4) Thin Client Loads Firmware but shows blue message screen 

A) "Please Define on Server"  

 Enter ThinManager and define the terminal. 

B) "License Not Available"  

 Check your license usage in ThinManager. You are out of an ACP-supplied 
License 

C) "This Terminal Disabled"  

 A ThinManager administrator has disabled this terminal. Re-enable it. 

D) "Network Error - Check Network Connections"  

 Check the network cable. Link light and network. 

E) Was Disabled, but did not go on when Re-enabled. 

 Reboot. 

F) Terminal Selection menu is shown, but keyboard does not work 
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 Check keyboard and reboot 

 Use PS/2 splitter if the unit has only one PS/2 port 

 Switch the mouse and the keyboard if plugged into a PS/2 splitter. 

5) Graphical ACP Logo is shown, but boot process stops 

A) Does not attempt to connect to the terminal server 

 Check Terminal Configuration Wizard to make sure a terminal server is specified  

B) Cannot Connect to Server xxx (0.0.0.0) 

 The terminal server doesn't have an IP address configured in the Terminal 
Server Configuration Wizard. 

 If using DNS, check the terminal server's registration. 

 If you are using a Citrix Published Application, you may need to specify the ICA 
browser. 

C) Cannot Connect to Server xxx (w.x.y.z) 

 Check the event viewer. If it says "Could not issue client license", you need a 
Microsoft Terminal Server Client Access License (MS TS CAL) and/or a 
Microsoft Terminal Server Licensing server. 

 Check the Subnet Mask in the ACP Boot Loader on the thin client. If it is set to 
255.255.255.255 instead of 255.255.255.0, it will fail to connect to the terminal 
server.  
Reboot the thin client and use the spacebar when the "Select any Key to 
Configure IP Settings" is displayed. Change the subnet mask in the ACP Boot 
Loader menu. 

D) Error 50 - Disconnected 

 Check the event viewer. If it says "Could not issue client license", you need a MS 
TS Cal / MS TS Licensing server. 

6) Attempts to connect to terminal server, but dies 

 Some servers (Dell and its Dellwall.bmp, for example) load a complex bitmapped background that 
can interfere with loading. Find the offending wallpaper file on the console session and renamed it 
so that it doesn't load at login 

7) Connects to connect to terminal server, but cannot login 

 Is the user a valid user? Is the password correct? 

 Does the user have permission to connect through Terminal Services (user properties in the User 
Manager) 

 If logging in to a Windows 2003/2008 terminal server, is the user a member of the Administrators 
group or Remote Desktop Users group? 

 Check the event viewer. If it says "Could not issue client license", you need a Microsoft TS Cal 
and or a Microsoft TS Licensing server. 

8) Login to Terminal Server prompts for password even though the username and password are 
filled in ThinManager 

 The password may be entered wrong in ThinManager. 

 Windows 2000 Server is set to always prompt for password at login for RDP users. Select 
Programs>Administrative Tools>Terminal Services Configuration and double click on RDP-
tcp Properties in the right-hand window. Uncheck the Always Prompt for Password checkbox 
on the Login Settings tab. 
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29.2 Section 2 - Thin Client is Booted, Connected, and 
Running a Session on the Terminal Server 

9) Disconnects randomly 

 Make sure each user is logging on with a unique user name. Windows 2003/2008 will only allow 
one session per name by default. 

 Check the physical network connection. 

 Check for a different computer (e.g. a laptop) with the same IP address. 

 Slow down the Monitoring Interval on the Monitoring Connection page of the Terminal 
Configuration Wizard by increasing the timeout and retry values. 

10) The session in Windows 2003requires frequent logins 

 Turn off the Windows screen saver. User accounts in Windows 2003 use a secure screen saver 
by default that requires this frequent login. 

11) Mouse works but the application is unresponsive 

 Application on terminal server is locked up - kill the application and let the thin client reconnect to 
terminal server and restart the application 

12) Sound doesn't work 

 Make sure that you are using a Windows 2003/2008 terminal server 

 Make sure that Audio Mapping is allowed on the Client Settings of the RDP-tcp Properties in the 
Terminal Server Configuration Console. 

 Make sure that you are using a  thin client that has sound capability 

 Add the Universal Sound Module to that thin client 

 Connect a powered speaker to the "Line Out" plug. Line Out isn't amplified so it requires a 
powered speaker. 

 Properly working thin clients will play sounds at boot. 

13) The touch screen doesn't work 

 Make sure you are using the right Touch Screen Module for the touch screen controller. 

 Make sure that the serial cable is plugged into the correct serial port 

 Make sure that the Touch Screen Module is using the correct baud rate. 

14) The touch screen mouse doesn't match the touches. 

 Calibrate the touch screen by highlighting the unit in the ThinManager tree and select Tools > 
Calibrate Touch Screen. 

15) Changes to the configuration in ThinManager don't show up on the thin client. 

 Reboot the thin client. Changes are only set to a thin client at bootup. 

16) The configuration of the primary ThinManager Server and the secondary ThinManager Server 
are different. 

 Synchronize the configurations by selecting Manage>ThinManager Server List and selecting 
Auto-synchronize in the ThinManager Server List Wizard. 

17) The terminals in the tree on the primary ThinManager Server show green while the terminals 
on the secondary are all red. 

 Add both ThinManager Servers to the ThinManager Server Monitor List in the Terminal 
Configuration Wizard (then reboot the terminals and synchronize the ThinManagers as in Number 
15 and Number 16). 

18) The client is showing the time of the terminal server in a different time zone and not the local 
time. 

 Use the Time Zone Redirection Module on the client with the local time zone selected. 
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 Make sure that the security policy of the terminal server or domain allows it. Look at Computer 
Configuration > Administrative Templates> Windows Components > Terminal Services 
>Client/Server data redirection >Allow Time Zone Redirection and set it to Enabled 

19) When "Terminal Servers" is highlighted in the ThinManager tree, the Details pane doesn't 
show OK for the connections. 

A) No login information supplied  

 Run the Terminal Server List Wizard and add an administrative user name and 
password on the Terminal Server Name page of the Terminal Server List Wizard.  

B) User specified does not have permission to connect  

 This indicates that the Terminal Server had an invalid username and password 
added on the Terminal Server Name page of the Terminal Server List Wizard. 
Run the Terminal Server List Wizard and change to an administrative user name 
and password on the Terminal Server Name page of the Terminal Server List 
Wizard. 

 Use the domain in the Domain field on the Terminal Server Name page of the 
Terminal Server List Wizard. 

 If not in a domain, try using the terminal server name in the Domain field on the 
Terminal Server Name page of the Terminal Server List Wizard. 

C) WTSAPI32.dll connection failed  

 This occurs when the terminal server is off or unreachable. Try pinging the 
terminal server. 

20) The Users, Sessions, and Processes tabs don't show data for a terminal server  

A) No login information supplied  

 Run the Terminal Server List Wizard and add an administrative user name and 
password on the Terminal Server Name page of the Terminal Server List Wizard.  

B) User specified does not have permission to connect  

 This indicates that the Terminal Server had an invalid username and password 
added on the Terminal Server Name page of the Terminal Server List Wizard. 
Run the Terminal Server List Wizard and change to an administrative user name 
and password on the Terminal Server Name page of the Terminal Server List 
Wizard. 

 Use the domain in the Domain field on the Terminal Server Name page of the 
Terminal Server List Wizard. 

 If not in a domain, try using the terminal server name in the Domain field on the 
Terminal Server Name page of the Terminal Server List Wizard. 

21) The Users and Sessions tabs show data for a terminal server, but the Processes tabs shows 
no data. 

 Shorten the name of the terminal.  
Microsoft truncates the terminal names to 15 characters. The Process information won't display 
for terminals with a name longer than 15 characters. 

22) When shadowing a client the mouse doesn't work in the shadowed session. 

 The user must be logged into the shadowing computer as an administrator or as a ThinManager 
Administrator to use interactive shadowing. 

 The interactive shadow must be checked in RemoteView on the ThinManager menu. 

 A terminal using the Share Keyboard and Mouse module will only be interactive if the mouse is 
active in that session. 
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